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Read me

. This manual intends among other things to let you know the structure
of ArcView GIS software, know how to make use of the menus,
buttons and tools associated with the software and know how to add
existing data and create new data, manipulate your data and compose a
map.

. Each of the exercise in this manual is divided into steps. You are
expected to read the contents of each step and do exactly what you are
asked to do.

. Each exercise has an introduction that explains what the goals
of the exercise are and what tasks you can expect to
accomplish.

. Whenever you encounter problem in executing any step call the
attention of the instructor to the problem. Do not leave any step un-
done.

5. Name of object you’ll use to carry out an action is bolded.

6. We include self-test exercises for you also. This would enable self-

appraisal. So, endeavor to attempt all the tests.



Exercise 1
Working with ArcView GIS

1.1 Basics of ArcView GIS

Welcome to the first exercise in basics of ArcView. The goal of this exercise is to
introduce you to ArcView and its capabilities. You'll examine ArcView by opening an
ArcView project and exploring each of its components.

Estimated time to complete: 10 minutes

Step 1 Start ArcView

Click Start, then Programs, then select ArcView GIS Version 3.1 (or higher) or
ArcView GIS Virtual Campus Edition in the ESRI programs group. If the Welcome to
ArcView GIS dialog appears click Cancel.

Step 2 Examine the interface

At the top of the ArcView window is a menu bar with four pulldown menus: File,
Project, Window, and Help. These menus are available when the Project window
(the smaller "Untitled” window within the ArcView window) is active. Below the
menu bar is the button bar with two buttons, Save and Help. Below the button bar is
the toolbar. It doesn't contain any tools yet. Move your mouse pointer over the
buttons. The function of each is displayed in the status bar at the bottom of the
ArcView window.

Step 3 Open a project

Next, from the File menu, choose Open Project. In the Open Project dialog,
navigate to the introavibasics\lesson01 folder created when you downloaded the data
for this lesson. Click on 101_ex01.apr (the project for Exercise 1 of Lesson 1) from
the left scrolling list. Click OK. ArcView projects always have an “.apr” extension.

Step 4 Select multiple views

Currently, the Views icon is highlighted. The New, Open, and Print buttons at the
top of the window let you create new views, open existing views, and print a view
that's highlighted in the list. The buttons at the top of the window will change for each
document type. On the right side of the window, you see the names of the two views
currently contained in this project. You want to work with both views at the same
time so you need to highlight both of them. Hold down the Shift key and click on the
Population Density view. Now both views in the list are highlighted.

Step 5 Open the views

Next, open both views by clicking the Open button at the top of the Project window.
The two view windows open and ArcView's interface (menus, buttons, and tools)
changes to reflect the view document type. You can tell that the Population Density
view is active because its title bar is highlighted and its window is in the foreground.



Step 6 Make a view active

Each theme in the Population Density view has a title and information that describes
what the theme shapes represent. The World Cities theme represents cities of the
world. The Countries by Population Density theme shows countries. (Notice that
some of the countries display in yellow. This indicates that they've been selected as a
separate group.) In the background is a theme showing a grid of latitude and
longitude. Click on the Gross National Product title bar. It becomes the active view.
Again you see a theme of world cities, a theme of countries, and a theme of latitude
and longitude; however, in this view, the countries are shown according to their gross
national product (GNP).

Step 7 Close a view

Each of these views displays the world differently. In ArcView, you can display the
same source data differently by changing the properties of the views. Close the Gross
National Product view by clicking on the icon in the upper left corner of the
Gross National Product window and choose Close from the menu. The view
window closes.

Step 8 Open a theme attribute table

Now you'll look at the attributes that are linked to the features in the Countries by
Population Density theme. Notice that the gray area containing the name and the
symbols for the Countries by Population Density theme appears raised, indicating that
this theme is active. Open the table for the active theme by clicking the Open Theme

Table button on the View button bar. Use the scroll bar at the right of the table
and scroll down until you see the selected records (highlighted in yellow). You may
want to widen the table window to see the fields better.

Step 9 Promote the selected records

Some of the African countries and their table records are highlighted in yellow. You
can't see any of the selected table records unless you scroll down the table and even
then, you can't see all the selected records together as a group. With the Table window

active, click the Promote button (or, from the Table menu, choose Promote).
ArcView moves the highlighted records to the top of the table.

Step 10 Examine the other attributes

View the rest of the theme's attributes by scrolling to the right in the table. Notice that
the table contains attribute information on growth rate and the total population for
1980 (Grw_rate80, Tot_pop80 for each country.

Step 11 Open a chart

Next, you will open a chart showing the birth and death rates for the highlighted
African countries. Click on the Project window title bar to make it active. Click on
the Charts icon. The Birth/Death Comparison chart is highlighted in the list. Click
the Open button. The Birth/Death Comparison chart is now the active document, and
AThVims interface changes to display the menus, buttons, and tools you use to work
with charts.



Step 12 Open a layout

The chart is covering up the Project window, so bring the Project window to the front
by choosing less01_1.apr from the Window menu. Next, click on the Layouts icon to
display the list of layouts in the project. Click the Open button to display the
Population Growth Rates layout. The Population Growth Rates layout opens and
ArcView's interface changes to display the menus, buttons, and tools you use for
working with layouts. This layout contains the Population Density view and its
symbols, the Countries by Population Density table, the Birth/Death Rates chart, and
additional graphics and text. Note: If you don't see the chart and table on the layout,
make sure that both the chart and table are open in your ArcView window. Close the
Layout, then reopen it.

Step 13 Save the project

From the File menu, choose Close All. Again from the File menu, choose Close
Project. When asked if you want to save changes to the project click Yes. Oaly the
main ArcView window remains open and active. You've now seen an ArcView
project and some of the documents it can contain (views, tables, charts, layouts).
You've also seen that each document type has its own interface containing menus,
buttons, and tools. In the lessons that follow, you'll perform specific GIS tasks using
views, tables, charts, and layouts in a project. After you've completed all the lessons,
you'll be ready to tackle your own ArcView project.

Self test

(1) AscView project components (such as views and tables) are called:
c Files

c Documents

E aprs

C Archives

(2) Views display geographic data organized as:

c Tables

c Layouts

c Charts

C Themes

(3) How do make a view active?
c Open an attribute table

e Click Help button

e Add it to a layout

L Click its title bar



(4) In ArcView the available menus, buttons, and tools are the same for a view as they are for
a table.

e True
E False

(5) When you want to create a cartographic quality map in ArcView, you work with this
ArcView document

C Layout
C Chart
C Link

e Script

Getting data into ArcView

1.2 Add themes to a view
In this exercise you will add themes onto a view and you would examine other
properties of a theme.

Estimated time to complete 15 minutes

Step 1 Start ArcView

If ArcView is not running, start ArcView. If the Welcome to ArcView GIS dialog
appears, click Open an existing project and click OK. If the dialog doesn't appear or
if ArcView is already running, from the File menu, choose Open Project. Navigate to
the introav\basics\lesson02 folder and open the ArcView project LO2_ex0l.apr.
Because no views have been created yet, you see an empty Project window.

Step 2 Create a new view

With the Views icon highlighted, click New button (or, double-click the Views icon).
A new, empty view window, Viewl, opens. You can resize and reposition this
window anytime you need to. The gray area on the left side of the view is the Table of
Contents. It's empty now, but when you add a theme to the view, the theme's name,
the symbol used to draw it, and a check box indicating whether it's currently displayed
will appear in the Table of Contents.

Step 3 The Add Theme dinlog

From the View menu, choose Add Theme. The Add Theme dialog displays. Navigate
to the lesson02 folder in your exercise data folder. ArcView lists the geographic data
sources available in this directory. You will see four data sources: boundary-outline,
drainage, rainfall, and settlements,



Step 4 Add a theme to the view document

Now, you'll add a theme from the boundary-outline data source. Double-click
boundary-outline to add it to the view as a theme. The theme's name and a symbol
appear in the view Table of Contents. Your view now contains one theme, boundary-
outline. By default, ArcView doesn't draw the theme. To display the theme, turn it
on by clicking its check box -!. ArcView draws the features in the theme (lines)
using the current symbol. When you add a theme to a view, ArcView randomly
assigns a color to the theme. Therefore, the boundary-outline theme may be a
different color in your view. Tumning a theme on simply allows it to display.

A theme doesn't have to be turned on for you to perform ArcView operations on it,
and turning a theme off doesn't remove it from the view.

Step 5 Add other themes to the view document
Next, you'll add themes based on the drainage, rainfall, and settlements data sources.

Click the Add Theme button @ to display the Add Theme dialog again. Navigate
to the lesson02 folder. You see the same list of data sources.

Step 6 Select several themes in the Add Theme dialog
Click on the rainfall. Then, hold down the Shift key and click once on drainnage
and once on settlements. All three data sources are highlighted.

Step 7 Add the themes and turn them on

Click OK to add these three themes to the view. Click on the check box — next to
each name to draw each theme. Your view now contains three additional themes: the
drainage theme containing line features, the settlements theme containing points, and
the rainfall theme containing polygons.

Step 8 Select an image data source

Click the Add Theme button. Navigate to the lesson02 folder. Click the dropdown
arrow for the Data Source Types list then click Image Data Source. The aerial
photograph image source appears in the list on the left side of the dialog. The .tif
ending indicates a type of image format.

Step 9 Add the image to the view and turn it on

Double-click syria.tif. ArcView adds this satellite image to the view. Click the check
box for the syria.tif theme to tum it on. ArcView draws the photograph as a black and
white image in the view. The image draws on top of the other themes. That's because
ArcView first draws the theme listed at the bottom of the Table of Contents then
draws each theme listed above it. Thus, the syria.tifl theme draws last. You can
change the drawing order by dragging themes up or down in the Table of Contents.

Step 10 Make the image theme active
You want the image to display in the background (behind the other themes) so you'll
drag it to the bottom of the Table of Contents. To do so, you must first make the



syria.tif theme active. Click once on the syria.tif theme in the Table of Contents to
make it active. Now it appears raised in the Table of Contents.

Step 11 Change the theme draw order

Click the syria.tif theme's name (or the raised gray area surrounding it), hold down
the left mouse button and drag to the bottom of the Table of Contents, then release the
button. ArcView draws the image theme first this time then draws all the other themes
on top of it.

Step 12 Close the project

You'll close the project without saving. From the File menu, choose Close All. Again
from the File menu, choose Close Project. Click No when you're prompted to save
your changes. You can see how easy it is to create a view and add themes to it from a
variety of data sources. Once you've added themes to a view, you can change the
appearance of the view by turning themes on and off and by moving themes up and
down in the Table of Contents.

Self test

(1) In ArcView, every theme, no matter the data type, must have an attribute table.

(2) The order of the themes in the Table of Contents does not affact their display within a
View.

c True
c

False

(3) ArcView supports only one image format.
e True

c False

{4) in a theme attribute table, each record {or row) represents a:

¥ Column

e Graphic element

c Feature

c Chart

(5) In which field of a theme attribute table can you find the feature type of a theme?
e Shape

E 1y
CID

10



9 Form

(6) What is true about the order of the themes in the TOC

C The order changes the speed of display.

c The ordet ensures that themes are alphabetical for better readabllity
C A theme must be at the top to be active

c Themes are displayed in order from top to bottom.

Which feature type is stored as a pair of x,y coordinates?

c Point

c Polygon

c Image

c Line

Which one of the following ArcView functions can you use with satellite image data?
C Image Query Builder

e Identify

c Image tegend Editor

c Open Theme Table

1.3 Understand theme tables

When you add a theme based on a feature data source, a theme attribute table (or
simply theme table) is also added to the project. A theme table contains descriptive
information about the features in the theme. The theme table is formatted in rows and
columns, called records and fields, respectively. Each field contains all the values for
an attribute; each record represents a single feature in the theme. Because attributes
are linked to the features they describe, you can access them by clicking on a feature
in the view, or you can find a feature in the view by clicking on its record in the table.

Estimated time to complete: 15 minutes

Step 1 Open the project
Start ArcView if it is not already open. From the File menu, choose Open Project
and navigate to the introav\basics\lesson02 folder and open L02_ex02.apr.

Step 2 Make a theme active

Click on the geology name or its legend symbol in the Table of Contents to make it
active. The theme appears raised in the Table of Contents.
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Step 3 Open the theme table

Click the Open Theme Table button on the View button bar. A table window
opens containing the attributes of the geology theme. When the table opens, you see
the first five fields: Shape, Area, Perimeter, Type_dep and Geol_time. The Shape
field tells you the type of feature (i.e., point, line, or polygon) the theme represents.

The Shape field is created by the system. You cannot edit it.

The table also contains geological formations found in Syria and the geological time
of deposition. To see the fields, using the scroll bar at the bottom of the table, scroll to
the right.

Step 4 Resize and reposition the view and table documents

Make Viewl active by clicking on its title bar. Move it to the upper left corner of the
ArcView window then resize it so that it fills the upper portion of this window. Make
the Attributes of geology table active. Move it to the lower left corner of the ArcView
window then resize it so that it fills the lower portion of this window.

Step 5 Use the Select Feature tool

Now you'll use the Select Feature tool to select the formations at any part of the
view. Make the view active by clicking on its title bar. On the View toolbar, click the

Select Feature tool and then click on any part of the view. The formation
highlights in the view and its record highlights in the table. ArcView scrolls the table
so the highlighted record displays at the top of the table.

Step 6 Select more than one feature

The first item is selected. Now you want to select for more areas. Hold down the
Shift key, and then click on any other part of the view you want. ArcView selects and
highlights the buildings.

Step 7 Promote the selected theme attribute table records to the top
Because the table is large, you can't see all of the highlighted records. To see the
highlighted records together in the table, you'll use the Promote function. Make the

table window active by clicking on its title bar. Click the Promote button on the
Table button bar. The highlighted records display at the top of the table.

Step 10 Close the project

Close the project without saving. From the File menu, choose Close Project. Click
No when you're prompted to save your changes .By selecting features in a view, you
can access their attributes in the theme table. You'll learn other ways to select features
and access information about them later in this course.



Displaying themes
1.4 Display features based on their attributes
Estimated time to complete: 20 minutes

Step 1 Start ArcView and open the project

If necessary, start ArcView. From the File menu, choose Open Project and open
introavibasics\lesson03\L03_ex01.apr.When the project opens you see a view with
one theme, Regions. Notice that, by default, ArcView assigns the same color to all the
regions. You'll use the Legend Editor to display the regions based on population.

Step 2 Open the Legend Editor

Double-click the Regions theme in the Table of Contents to display the Legend
Editor. The Theme dropdown list displays the name of the curmrent theme,
Regions.shp. The Legend Type field shows that every feature in the theme is
displayed with a single symbol

Step3 Select a legend type

Click on the Legend Type down arrow and select Unique Value. Notice that the look
of the Legend Editor has changed; it displays new choices that apply only to the
Unique Value legend. Each feature with a unique attribute value will be represented
by a unique symbol in the Symbol column. There are no symbols shown because you
haven't yet selected an attribute to symbolize.

Step 4 Select a values field

Click on the Values field and scroll down in the list until you see Pop_94, then click
on it. Now each county has a unique symbol in the Symbol column. The Value
column lists the Pop_94 value for each region. The Count column tells you how many
counties each symbol represents.

Step 5 Apply changes made in the Legend Editor

Click Apply. If necessary, minimize the Legend Editor or move it out of the way so
you can see the view. Each county now has its own symbol because each has a unique
population value. Looking at this map, you decide that grouping the counties into
classes would be better for your presentation.

Step 6 Change the legend type

If necessary, restore the Legend Editor. This time, choose Graduated Color from the
Legend Type dropdown list. The Legend Editor shows no symbols in the symbol
column yet; the Graduated Color legend requires that you choose an attribute to
classify. It divides the counties into groups based on their attributes. It then assigns
colors in graduated shades to the symbols for the classes.
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Step 7 Select a classification field

Click the Classification Field down arrow. Scroll down and click Pop_94 to select it.
Once you select an attribute, ArcView applies a defauit classification method, called
Natural Breaks, to divide the counties into five classes. (You'll leam how to change
the classification method and number of classes later in the exercise.)

Step 8 Use a differeat color scheme

Select Green monochromatic from the Color Ramps dropdown list.

The symbols for the five classes graduate in color from light green (for regions with
the lowest population) to dark green (for regions with the highest population). This is
called a color ramp.

Step 9 Apply your changes
Click the Apply button. The view now has a different symbol for each of the five
population classes. The color ramp makes it easy to see the population distribution.

Step 10 Work with the Dot legend type

Now you'll loock at some of the other legend types to see how they display the
Population data. In the Legend Editor, select Dot from the Legend Type dropdown
list. The Legend Editor shows a Density Field, where you choose the attribute for
density calculations. It also has a Dot Legend field, used to specify how many people
will be represented by each dot.

Step 11 Select a Density Field

From the Density Field dropdown list, select Pop_94. Click the Calculate button.
ArcView calculates the number of people each dot will represent and puts this value
in the Dot Legend field. ArcView takes the size of the window and the screen
resolution into account, so the value it calculates may vary based on your system’s
configuration. Click Apply. ArcView creates a dot density map in the view.

1.5 Classify features

In the previous exercise, you worked with the Legend Editor to change legend types,
but ofien you may also want to change the number of classes or the way the classes
are divided. Changing classes can affect the way data appears and how it is
interpreted, so it's important to choose a classification method carefully. In this
exercise, you will divide a group of regions into high, medium, and low population
classes. You'll create three classes using different classification methods to see how
the map representing region population changes.

Estimated time to complete: 15 minutes
Step 1 Start ArcView and open the project

If necessary, start ArcView. Open introavibasics\lesson03\L03_ex02.apr.
You see a view of the Regions theme with no classification applied.
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Step 2 Open the Legend Editor

In the view Table of Contents, double-click the Regions theme to open the Legend
Editor. Choose Graduated Color from the Legend Type dropdown list. Choose
Pop_94 from the Classification Field dropdown list. By default, ArcView creates five
classes using the Natural Breaks method. You want oaly three classes, however, and a
different classification method.

Step 3 Change the classification type

Click the Classify button. The Classification dialog is displayed. Choose Quantile
from the Type dropdown list and 3 from the Number of classes dropdown list. Click
OK. The Classification dialog disappears and you're returned to the Legend Editor.

Step 4 Apply your changes

In the Legend Editor, click Apply. You can see that the regions have been evenly
divided into three classes. The population range of the three classes varies widely,
however.

Step 5 Select a different classification type
Click the Classify button in the Legend Editor. In the Classification dialog, choose
Equal Interval in the Type dropdown list.

Step 6 Apply your changes

Click the Apply button in the Legend Editor then close the Legend Editor. This time,
ArcView divided the entire population range of the regions into three classes that each
has an equal range. The number of regions in each class varies, but the intervals
between high and low values in the classes is the same.

Step 7 Close the project

Close the project without saving. From the File menu, choose Close All. Again from
the File menu, choose Close Project. Click No when you're prompted to save your
changes. You've now seen how to change classification methods to display your data
in different ways.

1.6 Symbolize themes

You've seen how classifying features can change the way a map displays. Now you'll
leam how to change the symbols that represent features. The Legend Editor and
Symbol Window allow you to change the color, size, pattern, and other properties of
map symbols. In other exercises, you've classified the regions based on population.
You now want to change the colors and symbols used in the map.

Estimated time to complete: 15 minutes
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Step I Start ArcView and open a project

If necessary, start ArcView. Open introavibasics\lesson03\L03_ex03.apr. When the
project opens, you see a view with three themes: a point, a line, and a polygon
theme. The Regions.shp theme is already classified using the Equal Interval method
and a blue-green monochrome color ramp. The Road-network.shp theme is a line
theme in which each road has been classified. You want to make the map more
informative and attractive by changing the symbols and colors used to display the
features in each theme.

Step 2 Open the Marker Palette

You can change the color, size, and symbol for any feature in a theme by editing the
symbol in the Legend Editor and Symbol Window. In the view Table of Contents,
double-click the Towns theme to display the Legend Editor. Double-click the Towns
point symbol to open the Marker Palette in the Symbol Window.

Step 3 Select a marker symbol

Notice that some of the point symbols in the Marker Palette are solid black and
some are green with a black outline. If you select a solid black marker, the entire
symbol will be one color (whichever color is currently being used by the symbol in
the Legend Editor). If you select a green marker, the symbol will be colored in the
center with a black outline. Click on any green point symbol in the Marker Palette.
From the Size dropdown box, select 10. Notice that the symbol in the Legend Editor
has changed. Click Apply in the Legend Editor.

Step 4 Select a line symbol

The Road-network theme uses three colors of lines to represent road types. You'll
make them more distinctive by using a double line symbol for Dual lane. In the view
Table of Contents, double-click the Road-network theme. The Legend Editor shows
the current symbols. Doubleclick the line symbol next to Dual Lame (divided)
highway in the Legend Editor. The Pen Palette in the Symbol Window opens. Click
on a double line symbol. Click Apply in the Legend Editor

Step 5 Select an area symbol

You might want to use a pattern for the Regions.shp theme display. You can choose a
different pattern for each symbol, or you can apply one pattemn to all the symbols.
Double-click the Reglons.shp theme in the view. The Legend Editor shows the
Region symbols. Double-click the first symbol in the Legend Editor. The Fill
Palette opens. In the Legend Editor window, hold down the Shift key and click on
the other two symbols to highlight them as well. In the Fill Palette, click on a new fill
pattern of your choice. Notice that all the symbols in the Legend Editor show the new
pattern.

Step 6 Modify the area symbol

You can change the color of any symbol using the Color Palette. For polygon
features, you can change the color of the fill or the outline. You'll give the region
features a more subtle appearance by changing their outline to gray. Click on the

16



Color icon (the one with the paint brush ) at the top of the Symbol Window.
From the Color dropdown list, select Qutline. Click on a gray-colored square.
Notice that the three symbols in the Legend Editor now have a gray outline.

Step 7 Apply your changes
Click the Apply button in the Legend Editor. The Regions.shp theme displays the
new pattern and outline color.

Step & Close the project

From the File menu, choose Close All. Again from the File menu, choose Close
Project. Click No when you're prompted to save your changes. You've experimented
with classifying features and changing the symbols used to display them. This can
have great impact on the way the information is interpreted and how the map is
interpreted.

1.7 Label data

You've seen how classifying features can change the way your map looks and how
you can display map features based on their attributes. You bave also learned how to
change the symbols that represent features. In this exercise, you will add text labels to
features and customize the view's display properties.

Estimated time to complete: 20 minutes

Step 1 Open the project

If necessary, start ArcView. Open the project introav\basics\lesson03\L03_ex04.apr.
When the project opens, you see a view with three themes: a point, a line, and a
polygon theme. The Regions.shp theme is already classified using the Equal Interval
method and a blue-green monochrome color ramp. The Road-network theme is a line
theme in which each road has been classified.

Step 2 Change the view's background color

Notice that the view's background color is white by default. This is usually attractive
on the screen, but assigning a new background color could enhance the readability of
the theme's features. From the View menu, choose Properties. In the View Properties
dialog, click the Select Color button. Click on the light purple box in the Color
Picker, and click OK. Click OK in the View Propertties dialog to apply the new back
ground color to the view.

Step 3 Label data based on an attribute

You are going to label the Regions with their respective names. Click on the check
box next to the Town theme name to turn it off. Click on the check box next to the
Road-network theme name to tumn it ofF as well. The view redraws to reflect your new
choices. Click once on the Regions.shp theme name in the Table of Contents to make
it active. Now it appears raised in the Table of Contents. From the Theme menu,
choose Properties. Click the Text Labels icon. Make sure Region_name is the
choice in the Label Field scrolling bar. Click OK. From the Theme menu, choose

17



Auto-label. Click OK to accept the defaults in the Auto-label dialog. Before you
change the current labels' default font, select all the labels by choosing Select All
Graphics from the Edit menu. Now, from the Window menu, choose Show Symbol
Window. The Font Palette displays. Select Arial Black and Size 12. Close the Font
Palette and unselect all labels by clicking anywhere in the view with the Pointer tool

Step 4 Customize the label settings

Rather than labeling every county automatically, now you will manually label some
of them instead. From the Edit menu, choose Select All Graphics. Press the Delete
key on your keyboard. Before adding labels, you'll set the default properties for the
Label tool. The labels will be added using the seitings you specify. From the
Graphics menu, choose Text and Label Defaults. The Default setting for text and
label tools dialog appears. Click on the Label tool shown in the left side of the dialog.
The rest of the dialog updates to reflect the available settings for the Label tool. If it
isn't already blank, remove the checkmark from Use Symbol Window settings for text
by clicking on it. In the Font scrolling list, choose Courier New font. Set the size to

12 and the style to Bold Italic. Click OK. Click the Label tool @ Click inside the
regions you want labeled to add their county names. If you need to move any of the
labels, use the Pointer tool to select a label and move it to a new location.

Step 5 Close the project

Close the project without saving. From the File menu, choose Close All. Again from
the Fill menu, choose Close Project. Click No when prompted to save your changes.
Choose Exit from the File menu to close ArcView.

Self test

(1) You can display a theme based on one of its attributes by selecting an attribute field in the
Legend Editor

c True
C False

(2) You create your own symbo) palette and load it into ArcView
e True

C False

(3) The default symbol for a point feature is a:

e Solid fill square

c Solid fill circle

c Open square

c Open circls
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{4) A chart legend allows you to display more than one feature attribute at a time.
& True
e False

{5) Which classification method groups features into classes having an equal range of
values?

C Graduated Symbo!
e Unigue Value

c Equa! Interval

c Quantile

(6) In a color ramp, the colors of classes graduate based on the lowest to highest field values.
e True
c False

(7) if you want a labe! to point to the feature you are labsling, which of the following label
types could you use in ArcView?

c U.S. Interstate Highway Shiekd label
c Banner label

e Callout labe!

e Spline Text label
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Exercise 2
Working with features

2.1 Get information about features
In this exercise, you will work with a theme on Syria

Estimated time to complete: 15 minutes

Stepl Start ArcView and open the project

Start ArcView. Navigate to the folder \introaviquery\ lesson01 and in the folder,
open LO1_ex0l.apr. You see a view with rain-fed suitability areas of Syria You want
to get information about areas suitable for absolute rain-fed farming.

Step 2 1dentify a feature
With the Identify tool (@) selected, click on any part of the theme. The feature
flashes in the view and a window displays. The left side of the Identify Results

window lists the feature you identified and the right side lists its attributes. These are
the same attributes that are stored in the theme's attribute table.

Step 3 Select some features

Close the Identify Results window. Click the Select Feature tool @ Holding down
the Shift key, click on any part of the theme again. ArcView highlights the selected
features in yellow. If you select the wrong feature, you can unselect it by holding
down the Shift key and clicking on it again.

Step 4 Examine the highlighted records

Click the Open Theme Table button on the View button bar. The theme attribute
table opens. At first, you may not see any highlighted records. To see the entire group
of selected records at the same time so you can compare them, you'll use the Promote
button to move them to the top of the table.

Step 5 Promote the selected records to the top

Click the Promote button on the Table button bar. The selected records now
appear at the top of the table.

Step 6 Arrange the view and table windows to sce them both

Click on the table's title bar. Drag the table to the upper left corner of the ArcView
window. Now click on the view’s title bar and drag it to the lower right comer. Make
the view window smaller if necessary.

Step 7 Find areas suitable for rain-fed agriculture

Make the Table window active. Click the Identify tool on the Table toolbar. Scroll
down the table until you see a record labeled Suitable. Click on the record. The
Identify Results window displays and the feature you selected flashes in the view. If
you don't see the feature flash, click on the record again.

20



Step 8 Restore the view and close the project

Click the Select None button and close the table. Resize the view window so that
it is approximately the same size as before you opened the table. If you are continuing
on to the next exercise, leave the project open. Otherwise, choose Close All from the
File menu. From the File menu again, choose Close Project. Click No when you're
prompted to save your changes.

2.2 Select features based on their attributes

Assuming you are about to start a project at two towns in Syria and in your
preliminary report you need to give the geographical location of these two towns. You
will use the two names to search for the locations in a database.

Estimated time to complete: 5 minutes

Step 1 Open the project

If LO1_exOl.apr is open, continue to Step 2. Otherwise, start ArcView and open the
project introav\query\lesson01\LO1_ex02.apr. You will see a view with towns
theme.

Step 2 Find the geographical location of a town

With the Towns theme active, click the Find button on the view button bar, Type
Tartus in the text box that displays. Click OK. ArcView searches the attribute table
for the first occurrence of Tartus and selects it. ArcView highlights the record and
the corresponding feature in the view. ArcView also pans the view so the highlighted
feature displays in the center.

Step 3 Examine the town

Click the Promote button ArcView displays the selected record at the top of the
table. By scrolling to the right, you can see the longitude and latitude of this town.
Follow the same step to search for a town called Wuguf.

Step 4 Find area suitable for farming in Aleppo

Make Precipitation theme active. Click the Query Builder button on the view
button bar to display the Query Builder dialog. The Query Builder dialog contains a
list of attribute fields (lef), a set of operators (center), and a list of attribute values
(right). When you click on a field in the Fields list, all the unique values for that field
display in the Values list, as long as the Update Values option is checked (this is the
default). To build a query, you double-click on a field, click (or double-click) on an
operator, then double-click on a value. As you build the query, it displays in the query
text box in the lower left comer of the dialog. You can also type your query directly in
the query text box. Once you enter the query in the text box, you apply it by selecting
New Set, Add To Set, or Select From Set. New Set creates a new set of selected
features that match your query. Add To Set adds features that match your query to the
existing selected set. Select From Set selects features that match your query from the
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previously selected set. With one query, you'll select all contiguous areas known as
farming zone in Hama province of Syria

Step 5 Choose & field

In the Query Builder dialog, scroll down to the bottom of the Fields list, then click on
“[Preciptn]." Double-click on "[Preciptn]” to place it in the query text box. Click on
“[>=]" and type in 200. Click the New Set button. ArcView highlights them in the
view. You may need to move the Query Builder dialog box so you can see the view.
To see all the area that meet the criterion set above, you'll zoom out to them.

Step 6 Zoom out to see all the selected lots
With the view active and Precipitation theme also active, click the Zoom to Selected

button ArcView zooms out so you can see all the selected features. The result
shows that all the areas in the hama province excep! areas in the eastem part are
within the farming zone.

Step 7 Close the project

In this exercise, you used the Find button to locate and select a feature from an
attribute value then used the Query Builder to select a group of features by specifying
an attribute and the desired value for it. In the next exercise, you'll use the Query
Builder from the Theme Properties dialog to select the features you want to display in
the view. From the File menu, choose Close All. From the File menu again, choose
Close Project. Click No when you're prompted to save your changes.

2.3 Filter features

For this exercise, suppose you're a member of an agricultural commission concermed
about the decline of citrus-growing areas due to residential and commercial
development. You want to create a map showing the current citrus-growing areas,
then use it to track future changes in land use.

Estimated time to complete: 15 minutes

Step 1 Open the project

Start ArcView, if necessary. Open the project introaviquery\lesson01\L01_ex03.apr.
You see a view showing streets and land parcels. According to the agricultural
commission, the land parcels were once used exclusively for growing citrus and other
agricultural products, but in recent years they have been converted to residential and
commercial land use. Areas where streets are dense (toward the center of the view)
have undergone the heaviest development. For each feature in the Parcels theme, there
is a land use code. A code of 732 indicates that the land is used for growing citrus.
You will build a query in the Theme Properties dialog to filter the Parcels theme so
that only the land parcels used for growing citrus will be displayed.



Step 2 Display the Theme Properties dialog

With the Parcels theme active, from the Theme menu, choose Properties. The Theme
Properties dialog displays. By default, the Definition icon is highlighted on the lefi. If
the icon isn't highlighted, click on it to highlight it.

Step 3 Build an expression

Click the Query Builder button in the Theme Properties dialog. The Query
Builder dialog displays. It looks like the Query Builder you access from the View
interface, but instead of the New Set, Add To Set, and Select From Set buttons, it
has OK and Cancel buttons. Make sure the Update Values check box is checked. In
the Fields list, double-click on "[Landuse].” Because there are a lot of unique values
in this field, it may take a while for them to update in the Values list. Click the equals
sign (=) button. Scroll down in the Values list until you find 732 and double-click on
it.

Step 4 Select the parcels that match your query

Click OK in the Query Builder then click OK in the Theme Properties dialog to
display parcels that match your query. ArcView displays the features that match your
query. Now the view shows only the parcels that are used for growing citrus; the other
parcels do not display in the view. Notice that the remaining citrus groves are located
mainly on the outskirts of the city. Next, you'll zoom in to the new Parcels theme.

Step 5 Zoom in to the Parcels theme

Click the Zoom to Active Themes button ArcView zooms in so that the active
theme, Parcels, fills the view. Now you have a theme that shows only the parcels used
for citrus. As land use pattems continue to change, you can copy and then update your
data (o reflect these changes. In this way, you create multiple versions of the data,
each one representing a different time period. By filtering each version of the data,
you can create a series of maps that show changes in citrus-growing areas over time.

Step 6 Close the project
From the File menu, choose Close All. Again from the File menu, choose Close
Project. Click No when you're prompted to save your changes.

Self test

(1) The placement of operators in a query expression doesn't affect which features are
selected.

e True
C False

(2) You cannot easily zoom in to selected feature.
c True
e False
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(3) The placement of parentheses in a query expression doesn't affect which features are
selected

C True

c False

(4) You can select features only with a graphic box or circle
c True

c False

(5) One of the fastest ways to get information about a specific feature is to use the:
C |dentify tool

c Promote button

c Clear Selected Features button

c Query Builder

(6) To remove all features from a selected set, you need to:

c Click the Switch Selection button

& Doubte-click the Identify tool

C Click the Select None button

c Click the Promote button

(7) Which tool can you use to select features based on several attributes?
c Find tool

C Select too!

c Select by Graphics button

C Query Builder

2.4 Measuring distances and projecting themes

For this exercise, you will measure some distances, find area of interest and play with
different projections.

Estimated time to complete: 35 minutes

Step 1 Start ArcView and open the project

If necessary, start ArcView. Open the project Introaviquery\lesson02\L02_ex01.apr.
When the project opens, you see a view containing three themes. All of these themes
contain geographic data stored in decimal degrees. (Recall that decimal degrees are
degrees of latitude and longitude expressed as a decimal rather than as degrees,
minutes, and seconds.) Before you make any measurements in the view, you'll tell
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ArcView the type of units in which the data is stored and the type of units you want to
use for measuring.

Step 2 Open the View Properties dialog

From the View menu, choose Properties to open the View Properties dialog. To
specify the units in which the coordinates of the data are stored, you'll set the map
units.

Step 3 Set the map units

Click on the Map Units down amow, then click on decimal degrees in the list. This
indicates that all the data in the current view is stored in decimal degrees. To specify
the units ArcView will use to report measurements, you'll set the distance units. Click
on the Distance Units down arrow and choose meters. Click OK to apply your
settings to the view. Next, you'll use the Measure tool to determine the distance from
the Damascus city to the Aleppo city.

Step 4 Perform the first measurement

Click on the Measure tool £} The mouse pointer changes to a ruler. Now click on
the symbol used to represent Damascus city. Drag the cursor to the symbol
representing Aleppo city. Notice that ArcView draws a line segment from the
building to wherever you position the mouse pointer in the view and reports the length
of this line in the status bar (at the bottom of the ArcView window). With the mouse
pointer directly over the Aleppo city point, double-click to end the line. ArcView
reports the measurement in meter. ArcView reports two values: Segment Length and
Length. Segment Length is the length of the current line segment, while Length is the
total length of all segments that comprise the line. In this case, both measurements are
the same, 350,490.32 meters. (In this exercise, your measurements may vary slightly
from those reported.)

Step 5 Perform the second measurement

Click on the same Damascus point again. This time, drag the mouse pointer to the
Tiyas town. With the mouse pointer directly over the Tiyas point, double-click to end
the line. ArcView reports the measurement in the status bar.

Step 6 Measure area of an object
You'll use the Rectangle tool to draw the shape of a field, 110 x 90 meters.

Step 7 Draw the shape of the field

Click on the Draw tool Select the Rectangle tool from the dropdown list of
tools. Click inside the Tiyas town point, hold down the mouse button, and drag a
rectangle that measures approximately 110 meters by 90 meters. (Check the status
bar to see the Extent--width and height--of the rectangle as you draw it.) When you're
satisfied with the rectangle (your measurements don't have to be exact), release the
mouse button. Next, you'll use the Size and Position function to set the exact
measurements for the rectangle.
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Step 8 Set the exact measurements for the rectangle

From the Graphics menu, choose Size and Position. The Graphic Size and Position
dialog displays. In the dialog, set the width to 110 meters and the height to 150. Click
OK. Now the rectangle has the correct dimensions for a soccer field. To reposition the
rectangle, you'll use the Pointer tool.

Step 9 Reposition the rectangle

Click on the Pointer tool and position the mouse pointer over the rectangle. The
mouse pointer changes to a four-headed arrow. Now, hold down the mouse button and
move the rectangle to any position on the map. In this way, you can determine the
best locations for the field. But suppose you want to change the orientation of the
field? No problem. Just use Size and Position to change the dimensions of the
rectangle.

Step 10 Change the dimensions of the rectangle

From the Graphics menu, choose Size and Position. This time, change the width to
1000 meters and the height to 1000 meters. Click OK. Now you can use the Pointer
tool gain to reposition the rectangle.

Step 11 Set map projection
Click File then Close All to close View1. Open View2.

Step 12 Choose a projection for the view

From the View menu, choose Properties. Click the Projection button. The
Projection Properties dialog opens. Click on the Type down arrow then choose
Mercator from the list. Click OK again click OK in the View Properties dialog to
apply the Mercator map projection to the view.

Step 13 Measure the distance from Damascus to Aleppo

With the Measure tool, again measure the distance from Damascus to Aleppo. The
new measurement is larger than the previous measurement (Your measurements may
vary). The ellipse is now a circle (its true shape). The Mercator map projection
preserves the property of direction and the shape of features, but sacrifices accurate
distance and area, You'll change the projection again.

Step 14 Change the projection again

From the View menu, choose Properties. Click the Projection button. In the
Projection Properties dialog, click on Peters in the Type dropdown list. Click OK
againn click OK in the View Properties dialog to apply the Peters map projection.

Step 15 Measure the distance from Damascus to Aleppo

With the Measure tool, measure the distance between the two cities. The new
measurement is smaller than the last measurement. The circle is now egg-shaped. The
Peters projection preserves accurate area but sacrifices the properties of shape,
distance, and direction. The two previous projections, Peters and Mercator, are most
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suitable for regions near the equator. Next, you'll use a projection that's suitable for
the Syria.

Step 16 Change the projection again

From the View menu, choose Properties. Click the Projection button to display the
Projection Properties dialog. Click on the Category down arrow then select UTM
1983. Click on the Type down arrow to display a list of zones. Select Zone 37 (Note:
Syria falls to zone 37 and 38 but most part is in the zone 37). Click OK again click
OK in the View Properties dialog to apply the new projection. Now you'll measure
the distance between Damascus and Aleppo

Step 17 Measure the distance from Damascus to Aleppo

Click on the Measure tool and measure once more the distance between Damascus
and Aleppo. This time, the distance (~350) is almost the same to the one measured in
step 4 and the ellipse is now a circle. After working through this ArcView
demonstration, you can see how shape and distance change from one projection to
another. Much of the data you buy is stored in geographic coordinates, usually
decimal degrees. As you've seen, you can work with this data without projecting it, or
you can apply any of the standard or custom projections ArcView supports. Data
stored in decimal degree is most flexible

Step 18 Close the project

From the File menu, choose Close All. Again from the File menu, choose Close
Project. Click No when you're prompted to save your changes. If you want to go on
1o the next lesson, leave ArcView running. Otherwise, choose Exit from the File menu
to exit ArcView.

Self test

(1) Latitude/Longitude is a spherical coordinate system.

C True

C False

(2) The Measure tool is used to find the distance between features.

c True

c False

(3) In ArcView, you can measure the distance of only one line segment.
c True

e False
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(4) A view's map units and distance units must be set to the same unit of measure.
e True
c False

(5) What can you use to change the proportions of a graphic in a view?
c Select Feature tool

C Resize too
e Size and Position option under the Graphics menu
c Select Graphic tool

(6) If you look in the View Properties dialog and see "unknown" for both the map units and
distance units, it means that your view contains projected data.

C True
Cc

False

(7) Where can you change a view's distance units?
e Legend Editor

c View Properties dialog

# Theme Properties dialog

c Projection Properties dialog

Managing scale

2.5 Change the scale of a view

For this exercise, suppose you work with a Non-governmental Organization (NGO)
and a company who is interested in opening a new international sales office in Italy
approaches your organization for help. As the European market analyst for the
organization, you have been asked to study potential sites - among them Milano,
Genova, Roma, Napoli, and Palermo. After much research, you have concluded that
Milano is the best site for the new office. You want to present your arguments to the
management. Some of them are not familiar with your market region, so you want to
use maps at the beginning of your presentation to orient them to the European sales
region and the potential sites you considered. Then you want to zoom in on Milano as
you describe why it is the best site for the new international sales office.

Estimated time to complete: 15 minutes
Step 1 Start ArcView and open the project
Start ArcView, and open the project introaviquery\lesson03\L03 ex0l.apr, if

necessary. When the project opens, you see a view of the world from space showing
the European sales region, the country of Italy, and the proposed sites (not
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distinguishable at this scale). This is the scene you want to show at the beginning of
your presentation. Notice that the scale box on the right-hand side of the view toolbar
shows a value of 1:188,403,856. This value is the scale fraction or scale ratio. It tells
the relationship between the size of the area in the view and the size of the same area
in the real world. In this case, it means that 1 inch on the screen represents
188,403,856 inches on the Earth. ArcView calculates a view's scale using the current
map units. To determine how the map units for this view are set, you'll display the
View Properties dialog. Note: During this exercise, do not maximize or resize the
view window, as this alters the view's scale. Your scale values may vary slightly from
those shown, depending on your screen’s resolution, font size, and other factors.

Step 2 Display the View Properties dialog

From the View menu, choose Properties. The View Properties dialog displays. You
see that the map units are set to meters and the Projection field shows that one of the
Orthographic projection types has been applied to the view. The Comments section
tells you that the map projection for this view is The World from Space.

Step 3 Close the View Properties dialog

Click the Cancel button to close the View Properties dialog. For your next scene in
the presentation, you want to show a more detailed view of the European sales region,
so you'll zoom in to that theme.

Step 4 Zoom in to the European sales region

With the Sales Reglon theme active, click the Zoom to Active Themes button .
ArcView zooms in so that features in the Sales Region theme fill the view window.
Note that the value in the scale box changes to 1:30,929,728. (The actual scale box
value displayed in your window may vary slightly from this exercise.) This is the
scale ArcView calculated based on the size of the view window and the size of the
real-world area shown. Notice that the denominator of the scale fraction, 30,929,728,
becomes smaller as you zoom in. For the next scene, you want to zoom in to the Italy
theme to look more closely at the proposed office sites.

Step 5 Zoom in to the Italy theme

Make the Italy theme active and click the Zoom to Active Themes button &3,
ArcView zooms so that features in the Italy theme fill the view window. The value in
the scale box changes to 17,274,333, (The actual scale box value displayed in your
window may vary slightly from this exercise). When you present your arguments for
citing the new sales office in Milano, you want to show Milano at the center of the
view. So, next, you'll select it and zoom in to it.

Step 6 Select Milano in the Proposed Sites theme

Make the Proposed Sites theme active. Click on the Select Feature tool @ Now
click on the feature (point) that represents Milano. ArcView selects and highlights it.
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Step 7 Zoom to Milano

Click the Zoom to Selected button ArcView pans the view so Milano appears in
the center of it. In this case, ArcView doesn't zoom in any further, so the scale
remains the same. At any time during the presentation you're planning, you may want
to return to a view of the entire sales region. You could make the Sales Region theme
active then click the Zoom to Active Themes button. Or, you could click the Zoom

~
to Previous button to go back to the previous zoom. Instead, you'll enter a value
in the scale box. In Step 4, you zoomed in to show all the features in the Sales Region
theme. The value in the scale box was 30,929,728. You will use this value (rounded
off) to set the scale directly.

Step 8 Set the scale

Click in the scale box, drag the cursor to highlight the current value, then type
32,000,000 and press Enter. The view redraws at this scale. Notice that the view is
still centered on Milano. You will reposition the display using the Pan tool.

Step 9 Reposition the display

Click on the Pan tool Move the mouse pointer (now a hand) anywhere over the
display. Hold down the mouse button and drag the display (slightly) up and to the left,
then release the button. ArcView redraws the view, filling in any blank areas. You're
ready for your presentation. You've practiced several ways of zooming in and out and
you have set the view scale directly. Your presentation using ArcView's world data
and zooming tools will help your audience visualize the sales region and the site
you're proposing for the new sales office.

Step 10 Close the project
From the File menu, choose Close All. Again from the File menu, choose Close
Project. Click No when you're prompted to save your changes.

2.6 Set theme scale thresholds

Suppose you're a part of research team that is collecting data on consumption pattems
for a city area, The project is designed in such a way that data collected on households
on highway roads are separated from the ones from the streets in the city. You need to
display the location of each household. GPS (Global Positioning System) was used to
collect the locations. Your task is to come up with a way to store all the themes you
need for the project in the same view and be able to work with them at different
scales. For example, when you examine locations along the city streets, you need to
zoom in more than when you examine locations along highways. At each scale, you
want to display certain themes but not others. To support the different scales you'll be
working at, you'll use ArcView's display theme property to set scale thresholds for
drawing themes.
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Estimated time to complete: 15 minutes

Step 1 Open the project

Start ArcView, if necessary, and open the project
introav\query\lesson03\L03_ex02.apr. When the project opens, you see a view
containing five themes. The Text theme contains the names of towns and major
highways, the City locations theme contains the locations of households along the
streets in the city, the Highway locations theme contains the locations of households
along the highways, the Road-network theme shows road network of the city, and the
Streets theme contains all the city streets for the city area. Right away, you can see
that this view is cluttered. At this scale, you can't interpret the information each theme
presents without manually turning each theme off and on. To see the Highway
locations better, you'll turn some themes off. Note: During this exercise, do not
maximize or resize the view window, as this alters the view's scale. Your scale values
may vary slightly from those reported, depending on your screen's resolution, font
size, and other factors.

Step 2 Turn off the City locationsand Streets themes

Click on the check box next to the City locations and Streets themes to turn them
off. Now you can easily see where the Highway locations are, which highways they're
on, and which cities they're near. To see the City locations instead, you'll tum on
different themes.

Step 3 Turn on some different themes

Click on the check boxes next o the Text, Highway Accidents, and Road-network
themes to turn them off. Do the same for the City locations and Streets themes to tum
them on. Now you can see the city accidents, but at this scale, you don't clearly see
which streets they're on. To zoom in enough to see which street each accident is on,
you'd have to click the Zoom In button about six times. Because of the density of the
streets, the view takes a long time to draw, so you won't use this method of zooming
in. Instead, you'll set a scale directly in the scale box.

Step 4 Set a scale in the scale box

Click in the scale box, highlight the current value, then change the value to 150,000
and press Enter. At this scale, you can see the City locations and the streets they're
on. You'll use ArcView's display theme property to set a scale threshold that prevents
the streets from drawing until you've zoomed in enough to see them clearly (about
1:150,000 scale). Next, you'll return to the original view scale.

Step 5 Return to the original view scale
Click the check boxes next to the themes that are tumed off to turn them on. Click the

Zoom to Full Extent button & ArcView zooms out so you can see all the features
in all the themes. Next, you'll set a scale threshold for the Streets theme.
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Step 6 Set a scale threshold for the Streets theme

With the Streets theme active, choose Properties from the Theme menu to display
the Theme Properties dialog. Scroll down to the Display icon along the left margin
and click on it. Type 150000 in the Maximum Scale input field. Don't enter a value in
the Minimum Scale input field. Click OK. Because the value in the view scale box is
larger than 150,000, the Streets theme no longer draws, even though it's turned on in
the Table of Contents.

Step 7 Change the scale to 149,999

Click in the scale box, highlight the current value, change the value to 149,999 and
press Enter. The Streets theme draws when the scale box contains a value smaller than
150,000.

Step 8 Zoom in and set a scale threshold for the Text theme

Click the Zoom to Full Extent button. Make the Text theme active and choose
Properties from the Theme menu. Click on the Display icon along the left margin.
Type 150000 in the Minimum Scale input field. Click OK. Now the Text theme won't
draw if the value in the scale box is smaller than 150,000.

Step 9 Change the scale to 149,999

In the view, click in the scale box, highlight the current value, and type 149,999,
Press Enter. The Streets theme draws and the Text theme doesn't. The City locations
are no longer covered up by text and you can see the streets they're on. You can set a
range of scales for displaying a theme. For example, if you set a minimum scale
threshold of 50,000 and a maximum scale threshold of 100,000, the theme will
display only when the value in the scale box is between these two values. You've
completed your task of creating a way to display themes associated with this project.
By setting theme scale thresholds, you can display the information you need at the
right scale, allowing you to work effectively with many themes in the same view.

Step 10 Close the project

From the File menu, choose Close All. Again from the File menu, choose Close
Project. Click No when you're prompted to save your changes.

Exit ArcView.

Self test

(1) You can enter a specific scals in the scale box to zoom in or out on a view.

c True

c False

{2) For ArcView to report the view scale, you must set the map units in the View Properties
dialog.

C True

& False
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(3) Zooming in or zooming out does not change the scals of the view.
C True
# False

(4) To display properly, all themas in a view must have the same scale threshold set.

True

(® False

{5) Where do you set the scale threshold for a theme?
c In the Theme Properties Display section

c In the Theme Properties Definition section

C In the Query Buitder

C

In the scale box

(6) A 1:20,000 scale is larger than a 1:30,000 scale.
e True
9 False

(7) In ArcView, the scale reported In the view's scale box is a:
C Decimal value

c Representative fraction

e Verbal scale

e Linear scale
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Exercise 3
Presenting information

3.1 Prepare data for charting

In some cases, presenting your reports in chart forms helps to convey your ideas
quickly to the intended audience. ArcView GIS has a light’'s weight charting
capabilities. You'll learn how to do this in these exercises using data from the Far
East.

Estimated time to complete: 15 minutes

Step 1 Start ArcView and open the project

Start ArcView and open the project introav\present\lesson01\L01_ex01.apr. When
the project opens, you see a view with two themes: Siberian Rivers and Far East (a
theme showing the region of Siberia and adjacent countries). The Siberian Rivers
theme is active.

Step 2 Open the Attributes of Siberian Rivers table

Open the theme table for the Siberian Rivers theme. The table contains the names of
the major Siberian rivers, their lengths in miles, and other attributes. You want to
create a chart comparing the attributes in this table. In the process, you may select
certain records in the table to chart. But selecting these records also highlights the
corresponding features in the view. If you don't want to highlight these features, you
can make a separate copy of the theme table and use it to create your chart. The copy
isn't linked to the view, so you can select its records without affecting the view. To
make a copy of the theme table, you'll export it to a DBASE file.

Step 3 Export the theme attribute table to a dBASE file

With the Attributes of Siberian Rivers table active, from the File menu, choose
Export. The Export Table dialog displays. dBASE is the selected (default) format.
Click OK. Another Export Table dialog displays, where you specify the name and
location of the file to which you want to export the table. Specify your c:\temp folder
as the folder where you want to save the export table. Type rivers.dbf as the
filename. Click OK. A new file is created containing all the records from the attribute
table. Next, you'll add the new file to your project as a table using the Project window.

E . Click the Add

Step 4 Add the new file to your project as a table

Make the Project window active then click the Tables icon
button to display the Add Table dialog.



Step 5 Open the new table

If necessary, navigate to your c:Mtemp folder. Select rivers.dbf and click OK. The
rivers.dbf table displays, and its name is added to the list of tables in the project. Next,
you'll hide some of the fields in rivers.dbf and rename it to make the name more
descriptive.

Step 6 Rename the table and hide fields

With rivers.dbf active, from the Table menu, choose Properties. The Table
Properties dialog displays. The bottom of the dialog contains a scrolling list of the
table’s fields with checkmarks indicating whether or not each field is visible. In the
Title field at the top of the dialog, type Major Siberian Rivers. In the scrolling list at
the bottom of the dialog, click on the checkmarks next to the River_ and River_id
fields to make them invisible. Click OK. The River_ and River_id fields are now
hidden.

Step 7 Close the table
Close the Attributes of Siberian Rivers table. Your data is now ready for charting.

3.2 Create and edit a chart

Now you’ll create a chart comparing the attributes of Siberian rivers. You'll use the
Major Siberian Rivers table you created in the previous exercise to generate the chart.
When you create a chart, ArcView displays it with a default format, axes, title, and
legend, and assigns a default set of colors to the data markers (e.g., columns, bars, pie
slices). You can change the way a chart looks by modifying any of its elements.

Estimated time to complete: 20 minutes

Step 1 Open the project

If LO1_ex01.apr is open, go to Step 2. Otherwise, start ArcView if necessary and open
the project introav\present\lesson01\L01_ex02.apr. When the project opens, you see
a view showing the Siberian Rivers and Far East themes. From the Window menu,
choose Major Siberian Rivers. The Major Siberian Rivers table opens.

Step 2 Open the Chart Properties dialog

Click the Create Chart button to open the Chart Properties dialog. In the Name
field, change the name to River Lengths. The Fields scrolling list displays the names
of all chartable (numeric) fields in the active table, except hidden fields.

Step 3 Chart the Length field

In the Fields list, click on Length then click Add. This places the Length field in the
list of groups to be charted. Below the Fields list, the Label series using dropdown list
displays the fields you can use to label each item in your chart.
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Step 4 Plot the river lengths

In the Label series using dropdown list, click the down arrow and choose Name.
Click Add then Click OK. ArcView plots the river lengths in the default chart format.
The River Lengths chart compares the values of a single variable (length). For this
type of comparison, a column or bar chart is best. Next, you'll refine the chart. (You
may want to enlarge the chart window so the elements are easier to see). Notice the
labels on the y-axis. The lowest is 1000, the highest 3000, and the increment is 200.
You'll madify these settings using Chart Axis Properties so the data markers for
shorter rivers are more prominent. A colored bar, or data marker, indicates the length
of each river. The name of each river appears in the chart's legend.

Step 5 Display the Chart Axis Properties dialog box

With the chart active, click on the Chart Element Properties tool &), Click
anywhere on the y-axis of the chart. The Chart Axis Properties dialog displays.

Step 6 Refine the chart

In the Scale max text box, highlight the default value and type 3500. This sets the
upper limit on the y-axis. (The lower limit is already set to 0). In the Major unit text
box, replace the default value with 500 to adjust the increment. In the Axis label text
box at the bottom of the dialog, highlight "Y Axis" and replace it with the word
Miles. Click on the Axis label check box (near the top left of the dialog box) to tum it
on. Click OK. The chart redraws with the changes you made. The chart looks better,
but it's still rather difficult to follow the y-axis labels across to the columns.

Step 7 Add gridlines to make the chart easicr to read

Click again on the chart's y-axis to reopen the Chart Axis Properties dialog. Click the
Major grid check box then click OK. The chart redraws with gridlines that make it
easier to read. Notice that the attribute you're charting, "Length,” is currently
displayed along the bottom of the chart. This is the Group label. You'll also add an x-
axis label to the bottom of the chart.

Step 8 Add an x-axis label to the bottom of the chart

Click anywhere on the chart's x-axis to open its Chart Axis Properties dialog. In the
Axis label text box at the bottom of the dialog, highlight "X Axis" and replace it with
the words Note: The Mississippi River is 2470 miles long. Click the Axis label
check box to tum it on. Click OK. Now you'll give your chart a title.

Step 9 Give your chart a title

Click on the word "Title" at the top of your chart to open the Chart Title Properties
dialog. The title has five fixed positions you can click on: top, bottom, left, right, or
middle. (If you choose the middle position, you can place the title anywhere you
wish.) You'll leave the title at the top (the default position). In the text box, type
Major Siberian Rivers. Click OK. The chart redraws with the new title. Your chart
looks good, but you want to change the gray color representing the Yenisey to a more
vivid color. For this, you'll use the Chart Color tool.
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Step 10 Change a data marker color

Click the Chart Color tool @ in the Chart toolbar. When the Symbol Window
displays, open the Color Palette. In the Color Palette, click on the russet square (the
square diagonal to black). A black border appears around the square to indicate that
it's selected. In the chant, click on the gray data marker for the Yenisey River. The
color of the data marker changes to russet, and the legend symbol changes to match.
Close the Symbol Window.

3.3 Query a chart

Because ArcView charts are dynamically linked to the tables from which they're
created, you can get information from the table by simply clicking on the chart. In
addition, you can edit the source table for the chart and the chart immediately reflects
the change. You'll further refine the charts you made in the previous exercise here,

Estimated time to complete: 10 minutes

Step 1 Open the project

If either LO1_exOl.apr or LOl_ex02.apr is open, go to Step 2. Otherwise, start
ArcView if necessary and open the project introavipresent\lesson01\L01_ex03.apr.
When the project opens, you see a view containing the Siberian Rivers and Far East
themes. From the Window menu, choose River Lengths. The River Lengths chart
opens. Each data marker in this chart corresponds to a record in the Major Siberian
Rivers table. Using the Identify tool, you can click on any data marker to display the
corresponding record in the table.

Step 2 Identify a river

Click the Identify tool on the Chart toolbar if it's not already selected. Click on
the green data marker for the Amur River. The corresponding record displays in the
Identify Results window. Clicking on additional data markers adds them to the
Identify Results window.

Step 3 Make the view active

Close the Identify Results window. Make the view active by clicking on its title bar.
With the view active, you can see that the Kolyma River in northeastern Siberia is
extremely remote and inaccessible, making it too expensive and difficult to launch an
expedition there. You want to remove the Kolyma from your chart.

Step 4 Remove a record from the chart

From the Window menu, choose Major Siberian Rivers. Again from the Window
menu, choose River Lengths. The table and chart are now visible in front of the view.
Resize them to fit in the bottom half of your ArcView window. Click on the title bar

of the chart to make it active. Click the Erase tool @ In the chart click on the
yellow data marker for the Kolyma River. Notice that the Kolyma data marker
disappears from the chart. In the table, all records are selected except the Kolyma
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record. Only the selected records are charted. Notice also that the colors of the data
markers have shifted one position to the right, eliminating the russet color.

Step 5 Close the project
From the File menu, choose Close All. Again from the File menu, choose Close
Project. Click No when you're prompted to save your changes.

Self test

(1) Bar charts are usefu! for comparing discrete data values.
¥ True
e False

(2) After you create a chart, it will not reflect changes in the table data.
C True
C False

(3) Line charts are useful for showing trends.
| &

C False

True

(4) You cannot modify a chart's title.
c True
C False

(5) In which dialog can you add or delete a chart's Groups?
c Chart Properties

& Element Editor

C Group Properties

c Group Editor

(6) Which tool do you use to query a chart data marker?
c Edit too!

e Chart Element Properties tool

c Chart Elements tool

c Identify too!
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{7) Which tool can you use to delete a data marker from a chart?
¥ Element too)

c Select too}

c Chart Data too!

c Erase tool

(8) On an ArcView chart, a "group” is analogous to a:
c Theme

C Data marker

& Record

c Field

Creating map layouts

3.4 Create a basic map layout

In this exercise and the next; you'll create a layout that includes a view of land use and
land cover of Syria, a table of the LULC theme, and a chart comparing the area of
each land use and cover.

Estimated time to complete: 20 minutes

Step 1 Open the project

Start ArcView and open the project introavipresent\lesson02\L02_ex01.apr. When
the project opens, you see a view, a table, and a chart. You'll create a layout
containing these documents.

Step 2 Create a layout

Make the Project window active by clicking on its title bar or by choosing
102_ex01.apr from the Window menu. Click the Layouts icon then click New. A
blank layout page appears. If the orientation of your layout page is landscape
(horizontal), choose Page Setup from the Layout menu and change the orientation to
portrait (vertical). The layout page is too small to work with effectively, so you'll
enlarge it.

Step 3 Enlarge the layout window
Click on the icon in the Layout window's title bar and select Maximize to make the

layout window full-size. Click the Zoom to Page button to fit the layout page to
the enlarged layout window. Now that the layout page is larger, you see grid dots.
These dots are used to snap elements to precise locations in the layout. Grid dots
appear only on the screen, not on the printed layout. If you don't want to show the grid
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as part of an on-screen presentation, you can hide it by clicking Hide Grid in the
Layout menu. Before you add elements to your layout, you'll set up the layout page.

Step 4 Edit the page setup

From the Layout menu, choose Properties. The Layout Properties dialog displays.
Change the name in the Name field to Land Use and land cover. In the Horizontal
text box, change the grid spacing to 0.5. In the Vertical text box, change the grid
spacing to 0.5. This sets the grid points 0.5 inches apant. Click OK.

Step 5 Change the page size

From the Layout menu, choose Page Setup. The Page Setup dialog displays. Click
the Page Size dropdown amrow and choose Letter 8.5 x 11.0 in. Click OK. The layout
will be sized to fit an 8 1/2 x 1l-inch piece of paper. You can even choose the

N
orientation of the paper — Landscape or portrait. Click on Landscape symbol L=
Now that you've finished the basic page setup for the layout, you can begin to add
views, tables, charts, and other elements using the Frame tool. The Frame tool is
actually a set of dropdown tools on the Layout toolbar. There is an icon for each of
the following types of frames: view, legend, scale bar, north arrow, chart, table,
and picture. You'll use the View Frame tool first.

Step 6 Create a view frame

Click the bottom right comer of the Frame tool and hold down the mouse button
to display the dropdown tools. The View Frame tool is the first icon in the list. Click
on it to select it. Inside the layout, place the mouse pointer (now crosshairs) on the
upper left grid point, then click and drag to draw a view frame in the upper portion of
the layout. When you release the button, the View Frame Properties dialog displays.

Step 7 Add a view to the frame

Click on the Land use /land cover of Syria view in the View scrolling list. Live Link
is already checked, specifying that the view frame will be linked to the view. This
means that changes to the view will be automatically reflected in the view frame.
Scale is set to Automatic, so the view will be resized to fit inside the view frame.
(When you choose Preserve View Scale or User Specified Scale, the scale of the view
is fixed in the view frame, and you may not see the entire view).

Step 8 Set the view to always display

Click on the Display dropdown list and choose Always. When you choose Always,
the view in the view frame will continuously display, even when the layout document
is not active. Presentation, the default choice in the Quality dropdown list, indicates
that the view rather than a shaded box will display in the frame.

Step 9 Draw the view in the frame

Click OK. The Land use /land cover of Syria view draws in the view frame. The four
black handles indicate that this frame is currently selected.
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Step 10 Create a legend frame
Click on the Frame tools dropdown list. This time, choose the Legend Frame tool

Inside the layout below the view frame, click and drag to draw a box for the
legend frame about one-third the size of the view frame. When you release the mouse
button, the Legend Frame Properties dialog displays. The View Frame scrolling list
shows the view frames that have already been placed in the layout.

Step 11 Add a view legend to a frame
Click on ViewFramel: Land use /land cover of Syria then click OK. The legend
associated with this view frame draws on the layout. If you don't like the size of the

legend, you can change it with the Pointer loolm. You'll do that in the next step.

Step 12 Resize a frame

Click on the Pointer tool @. Move the mouse pointer over one of the four handles
around the legend frame until it changes to a double-headed arrow. Hold the mouse
button down and drag the handle to change the size. The legend frame snaps to the
nearest grid point and the legend redraws. To move a layout element without resizing
it, select it with the Pointer tool, move the mouse pointer over the element (not on a
handle) until it changes to a four-headed arrow, and drag the element to a new
location as you hold the mouse button down. Next, you'll add a scale bar to the layout.
The scale bar has its own frame in the layout and is associated with a view frame.

Step 13 Create a scale bar frame

Choose the Scale Bar Frame tool from the Frame dropdown tools. Drag a scale
bar frame box in the layout just as you did the view and legend frames. The Scale Bar
Properties dialog displays. In the Scale Bar Properties dialog, select ViewFramel:
Land use /land cover of Syria 1991. Click the dropdown arrow for the Style field and
choose a scale bar style, then click OK. The scale bar draws inside the scale bar
frame in the layout. If you like, resize or reposition the frame using the Pointer tool.

Step 14 Select and draw a north arrow

Finally, you'll add a north arrow to the layout Select the North Arrow Frame tool
from the Frame dropdown tools. Drag a north arrow frame box in the layout. The
North Arrow Manager dialog displays. Select a north arrow and click OK. The north
arrow draws inside its frame. Use the Pointer tool if you want to resize or reposition
the north arrow. Your layout now contains all the main map elements. In the next
exercise, you'll add a table and chart to your layout.

Self test

(1) The grid of dots that appears when you're creating a layout also appears on the printout
unless you tum it off.

c True
e Failse
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(2) To create a map with a scale bar, north arrow, and legend in ArcView, you must create a
layout document.

e True
e False

{3) Quantitative informaticn is data that is expressed numerically and can be measured.
c True
C

False

(4) It's possible to show too much detalil in a map.
@ True
C False

(5) View frames always reflect any change you make to the view.

(7) In which dialog do you set the page size for a layout?
C Layout Properties

e View Properties

c Layout Edit too!

e Page Setup

(8) What is a scale bar linked to?

c View frame

c Theme

e Table

@ Layout
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3.5 Adding finishing touches to the layout
In the next exercise you'll add other elements to complete the layout.

Estimated time to complete: 10 minutes

Step 1 Open the project

If L02_ex0l.apr is open, go to Step 2. Otherwise, start ArcView il necessary and open
the project introav\present\lesson02\L02_ex02.apr. If the layout is not the active
document, from the Window menu, choose Land use /land cover of Syria. You see
a layout composed of a map showing the land use and land cover of Syria, along with
a legend, north arrow, and scale bar.

Step 2 Create a chart frame

Select the Chart Frame tool EE] from the Frame dropdown tools. Draw a chart frame
in your layout. The Chart Frame Properties dialog displays.

Step 3 Add the chart
In the Chart Frame Properties dialog, select Land use & land cover of Syria and
click OK. The chart draws inside the chart frame.

Step 4 Create a table frame

Next, select the Table Frame tool 2 from the Frame dropdown tools. Draw a table
frame in your layout. The Table Frame Properties dialog displays.

Step 5 Display the table in the layout

Choose the Land use /land cover of Syria table and click OK. The table draws in
your layout. If you like, reposition it with the Pointer tool. Your layout is complete for
now. It contains all the elements needed to clearly present the information you've
assembled on land use and land cover of Syria. Later, you could add a title and size
and position all the elements into the most pleasing composition. A layout is created
by combining ArcView documents, such as views, charts, and tables, with map
elements, such as a legend, scale bar and north arrow. Each element is added by
creating a frame on the layout page using a Frame tool. The last item is, however,

grid.

Step 6 Add Grid

Grid coordinate is essential for map production. Fortunately, ArcView GIS comes
with an extension for this purpose. Now, Click on the File menu and Extensions sub-
menu. Scroll to Graticules and Measured Grids of the Dialog box that appears.

Check the box and Click OK. ArcView adds a tool . Click on this tool.

Step 7 Using the tool

From the first window that appears uncheck Create a measured grid. Click Next.
Check Labels only from the Choose option for your graticule. From Choose
latitude and longitude option, enter 1 for degrees for each box and click Next follow
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by Finish. Click on the Pointer tool and Click anywhere on the layout. Note: This
extension has many features you can play around it at your post.

Step 8 Export the layout

In most cases you will need to export your layout to other sofiware formats for other
purposes. Click File and Export. A file save dialog box appears. Enter Land-use for
the File Name. For Directory, scroll to your temp folder on your local disk. Select
appropriate drive letter for the Drives. Click on the List Files of Type option. A list of
formats supported by the ArcView GIS appears. Select JPEG. Click on the Options.
From the dialog box Type 300 for the Resolution (DPI) and Select 100 for Quality.
Click OK. Click OK again. You can use any of the Desktop publishing sofiware such
as Adobe PhotoShop to process the image further or insert the image directly into a
Word processing document.

Step 9 Close the project
From the File menu, choose Close All. Again from the File menu, choose Close
Project. Click No when you're prompted to save your changes

Self test

{1) Templates are used to create more than one layout with the same format.
e True
c False

(2) A template stores the locations of frames in a layout.
c True
c False

(3) You cannot simplify a legend frame.

(4) You can use the Text tool to change the color of text.
C True
e False

(5) A legend is the only layout element that can be simplified.
c True
c False



{6) Which tool can you use to add text to a map?
c Text Editor

c Text Frame tool

e Text tool

e Text Palette

{7) Which tool would you use if you wanted to add a graphic shape to a layout?
c Draw tool

e Graphics tool

c Simplify too!

c Pointer tool

(8) Which diatog would you open if you wanted to change the rotation angle of text on a
layout?

L rex Properties

# Layout Properties
c Symbo! Window
c Font Palstte

(9) A graticule is different from a measured grid because it uses lines of longitude and
lattitude to labe! a map, while a measured grid uses lines of linear distance.

c

e False

True
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Exercise 4
Working with records

Selecting table records, just like selecting theme features, is a fundamental concept in
ArcView GIS. You must know the process for selecting and querying table records to
fully understand and get the most information from your data. When you select
records in a table, you can work with specific groups or subsets of data. Often, table
records represent features in a theme, but this is not always the case. A table can be
completely unrelated to a theme, yet you can still manipulate it in ArcView and use its
data to derive statistics and create reports and charts.

4.1 Select records

For this exercise, suppose you are a rangeland manager. It is your job to identify areas
in your mandate areas that are threatened by drought. In your GIS database, two
themes represent rainfall data. One theme contains line features (contour lines) that
define the boundaries of areas with given amounts of rainfall. The other theme
contains polygons that define the areas between the lines. Each polygon is coded with
the highest rainfall value of its two bounding lines. So, if the 200 mm and 250mm
lines bound a polygon, it receives the maximum value of 250 millimeters of annual
rainfall. You'll use the Query Builder to find and select polygons that receive less than
300 millimeters of rain per year. These areas are considered drought-threatened. From
the selected set of records, you could derive statistical information and present the
information in a chart.

Estimated time to complete: 10 minutes

Step 1 Start ArcView and open the project

If necessary, start ArcView. Next, open the project
introavitables\lesson01\L01_ex01.apr.-When the project opens, you see a view with
two themes: Contours.shp and Rainfallshp. You'll also see the Attributes of
Rainfall.shp table.

Step 2 Open the Query Builder

Make the Attributes of Rainfall.shp table active then click Query Builder button .
The Query Builder dialog displays with the name of the active table in its title bar.
The Query Builder dialog is where you build the query expression that ArcView uses
to select records from a table. In this case, you want 1o find all areas that receive less
than 300 mm of rain per year.

Step 3 Create a query expression

Make sure the Update Values check box is checked. In the dialog, scroll down in the
Fields list until you find [Rainfall] and double-click on it. Click the less than (<)
button then double-click on 300 in the Values list.



Step 4 Examine the selected records

Click New Set button to select all the records that match your query. Close the Query
Builder dialog. The records selected by the query expression are highlighted in the
attribute table and the associated features are highlighted in the view. To see the

- L
selected records all together, click the Promote button to move them to the top
of the table. On the top, left side of the toolbar, you can see that 7 of 67 records are
selected. You will work with these records in the next exercise.

4.2 Work with selected records

In this exercise, you'll continue where you left off in the previous exercise. You'll use
ArcView's statistics function to calculate the total area of the district threatened by
drought and use the summarize function to determine how this area is distributed
between the various rainfall contours. Then you'll create a chart to show your results.

Estimated time to complete: 20 minutes

Step I Open the project
If necessary, make the Attributes of Rainfall.shp table active. Records with an annual
rainfall of less than 300 mm (millimeters) have already been selected.

Step 2 Make a ficld active

Click the Promote button to move the selected records to the top of the table. In
the Attributes of Rainfall.shp table, scroll to the last field on the right, Areakm (area
in kilometer), and click on the title of the Areakm field to make it the active field (the
field name cell will appear shaded).

Step 3 Generate statistics

From the Field menu, choose Statistics. A message box displays statistics about the
Areakm field's values for the selected records. You'll see that 41999.1664 square
kilometers of the district receive less than 300 mm of rainfall annually. Click OK to
dismiss the message box. Next, you'll use Summarize to determine how this total
area is distributed between the various rainfall contours.

Step 4 Make the summary field active
In the Attributes of Rainfall.shp table, click on the Rainfall field name to make it
active. You'll summarize the selected records based on the values in this field.

Note:

You can summarize selected records in a table based on the values in the
activefield (in this case, Rainfall). For each unique value in the active field,
ArcView creates a record in the new summary table, Each record contains a
Count field that shows the number of records with that value. Additional
fields contain any summary statistics (e.g., average, minimum, maximum)
vou reauested for fields other than the active field
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Step 5 Summarize the selected records

From the Field menu, choose Summarize. The Summary Table Definition dialog
displays. In the Field dropdown list, click on Areakm. In the Summarize by
dropdown list, click on Sum. Click Add. Your selection moves to the box on the
right. Next, click the Save As button and navigate to your \temp directory. Save the
table as rainsum.dbf. Click OK to retum to the Summary Table Definition dialog.
Click OK again to create the summary table.

Step 6 Examine the results

Examine the rainsum.dbf table. You can see that the new table has three records, one
for each unique Rainfall value. The Count field tells you how many selected records
each value has For example, five areas receive 200 mm of rain a year. The
Sum_Areakm field tells you the total size (in square kilometers) of areas vulnerable
to drought, according to the amount of rainfall they receive. You want to share these
findings with the policy makers, so you'll create a chart showing the information in
the summary table.

Step 7 Display the Chart Properties dialog

A chart is a good way to graphically display tabular information and give it immediate
impact. Your audience doesn't have to think about the difference between 6,228;
14,642; and 21,129 square kilometers. They see and understand. Click on the

rainsum.dbf table to make it active then click the Create Chart button . The
Chart Properties dialog displays.

Step 8 Create a chart

In the Chart Properties dialog, select Sum_Areakm in the Fields scrolling list. Click
Add. Sum_Areakm appears in the Groups list on the right. This is the field ArcView
will plot on the chart. Now, select Rainfall in the Label series using dropdown list.
ArcView will use this field to label each set of related values in the chart.

Step 9 Add the chart to your project

Click OK to apply your selections and close the Chart Properties dialog. ArcView
creates the chart and adds it to your project. Notice that a red symbol appears at the
top of the chart's legend, but you don't see a red column in the chart. That's because
ArcView uses the smallest value of Sum Areakm (6,228.31, rounded down to 6,000)
as the minimum value on the y-axis. Now you know which areas in your district are
vulnerable to drought and you know the size of these areas. Armed with maps, tables,
and charts, you have the tools you need for further studies.

Step 10 Close the project

From the File menu, choose Close All. Again from the File menu, choose Close
Project. Click No when you're prompted to save your changes.
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Self test

(2) You can get summary statistics for any set of records in a table.
c True
& False

(2) The Query Builder button on the table interface works the same as the Query Builder
button on the view interface.

# True
e False

{3) You can select multiple records with the Select Record too!.
¥ True
e False

{4) When you get summary stafistics for a set of records, the results are placed in a new
tabla.

(5) You can create a summary table only from numeric fields in a table.
c True
¥ False

{6) To get statistics for a set of records, first you need to:

e Select the themse

e Make the field that you want stalistics for the active field
c Create a summary table

c Choose Summarize from the Field menu

(7) A chart can display only one attribute field for a set of records.
e True
e False

Working with fields and records

There are a variety of ways to edit tables in ArcView. You can give fields altemate
names, specify which fields display, alter the display width of fields, and add and
delete fields. Tabular data doesn't have to be in a theme attribute table for you to edit
it. ArcView supports many table formats,

49



4.3 Modify fields
For this exercise, you will calculate population density for each of the provinces in

Syna,

Estimated time to complete: 15 minutes

Step 1 Start ArcView and open the project

If  necessary, start  ArcView. Next, open the project in
introavitables\lesson02\L02_ex01.apr. When the project opens, you see a view with
one active theme, Population.shp. This theme shows the population figure and area in
square kilometer for each of the provinces in Syria.

Step 2 Open the theme attribute table

Open the attribute table for the theme by clicking the Open Theme Table button
on the view button bar. Examine the fields in the table by scrolling to the right. By
default, all fields in the table are visible; however, you may not be interested in all of
them. For example, the Shape, Area, Perimeter fields in this table may not contain
information that's useful for your calculation. You will hide these fields so they don't
appear in the table.

Step 3 Open the Table Properties dialog

With the table active, choose Properties from the Table menu. The Table Properties
dialog displays with a list of field names and a column indicating which fields in the
table are visible.

Step 4 Hide fields

Click on the checkmarks next to the following fields to tum them off and make them
invisible: Shape, Area, Acres and Perimeter. In the Alias column, type in Regional
pame for the region_nam, Population in 1994 for Pop-94 and Area (square
kilometer) for the Area-km2.

Step 5 Apply your changes
Click OK and see changes you made. Notice that you can't see the complete names
for some of these fields because the fields are too narrow. Next, you will widen them.

Step 6 Widen the fields' display

Position your mouse pointer over the field divider (the vertical line to the right of the
field name) for the Area (square kilometer) field until it becomes a two-headed
arrow. Drag to the right to widen the field so that the entire name displays. Do the
same for the other fields you want, Afier you resize a field, the new display size is
saved when you close the table or the project that contains it. The next time you open
the table, ArcView displays the field at the saved size. Now that you have hidden
fields, assigned more meaningful field aliases, and widened fields, the data is tailored
to your project. In the next exercise, you'll add a new field to the table.
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Step 7 Start editing the table

Before you add a field to the attribute table, you must enable editing. With the
Attributes of Population.shp table active, from the Table menu, choose Start
Editing. Notice that the field names in the table become non-italic when editing is
enabled.

Step 8 Add a field
From the Edit menu, choose Add Field. The Field Definition dialog box displays.
This is where you define the properties of the new field. In the Name field type
Pop_density. The new field will be a number field, and the default values for Type
and Width are correct but for Decimal Places Type 4. Click OK. The new field is
added to the table.

Step 9 Calculate values for the new field
Now you'll calculate the values for the new field. Make the new field active. Click the

Calculate button to display the Field Calculator dialog box. This is where you
define the mathematical expression that ArcView will use to calculate values for the
active field. The new field will hold value for the population density for each province
(population divided by area).

Step 10 Enter a mathematical expression

In the Fields list, double-click on [population in 1994]. In the Requests list, double-
click on the / sign. Finally, in the Fields list, double-click on [Area (square
kilometer]. Your mathematical expression displays in the text box (lower left) as you
define it. Click OK to have ArcView calculates the values for the new field.

Step 11 Save the edits

From the Table menu, choose Stop Editing. Click Yes when asked to save your
edits. Notice that the field names redisplay in italics to indicate that they are not
editable. By adding a new field and calculating new values for this field, you've
isolated the data you need for your project. In the next exercise, you'll generate
statistics and new data for the project.

Step 12 Close the Project

From the File select Close All - Close Project When prompted to save the project
say No.

Self test

{1)You can change a field's display width using the mouse.
> True
e False
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{2) You cannot make fields invisible in ArcView.

(3) You can genserate summary statistics for afl the records in a table.
& True
e False

(4) You must define the number of decimal places when adding a numeric field to a table in
ArcView.

C True
c False

(5) Which dialog allows you to add or modify field values using an expression?
c Query Builder

c Field Calculator

c Statistics window

c Table Properties

(6) To edit a table you need to:

C Choose Table Editor from the View menu

C Choose Start Editing from the Table menu

c Click the Query Buildsr button on the Table interface
c Choose Edit Table from the Table menu

(7) In a theme attribute table, each of these represents a feature.
e Point

c Record

C Column

C Field

Accessing tables

Ofien, you have additional information about features that is not contained in a
theme's attribute table. The data may be in other tables or text files. You can access
such data by joining or linking to the source file. After you access the data, you can
perform operations on it just like you can do with data contained in a theme attribute
table. You can also create connections to external files of any format, including
images, to enhance your ArcView projects In ArcView, you can combine, or join,
tables and work with them as if they were one. ArcView's Join function uses the
values in a common field 10 match the records in both tables. The fields do not have to
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be named the same, but they must be of the same field type (i.e., number, string, date,
or Boolean) for the join to work.

4.4 Join tables

For this exercise, suppose you're working on a project that involves using weather
data. In your search for weather data to be used, you were given 2 files containing
required data. You will join these files together and view the information using
Arcview.

Estimated time to complete: 20 minutes

Step 1 Start ArcView and open the project

If necessary, start ArcView, and open the project
introav\tables\lesson03\L03_ex01.apr. When the project opens, you'll see a view of
the outline of Syria boundary and a point theme of weather stations in Syria.

Step 2 Add a table to the project
You'll add a table containing weather data of these stations to the project then join it
to the theme (weather-stations.shp) attribute table. Make the Project window active.

With the Tables icon selected, click the Add button to display the Add Table
dialog. On the dialog, navigate to \introavtables\lesson3\ and select
weather_data.dbf file.

Step 3 Examine a table information

Click OK to add the weather_data.dbf table to your project. When the table opens,
notice that the first field contains the names of the weather stations. This is the same
with the name in the attribute table. You'll use this field to join the two tables. Joining
tables allows you to attach tabular data to the themes in a view. In this exercise, when
you join the data in the weather_data.dbf table to the data in the theme attribute
table, weather_data.dbf is the source table and the theme attribute table is the
destination table (the table to which fields are appended). Tables are joined based on
a field that is common to both tables; in this case, Station.

Step 4 Prepare to join tables

To see both tables during the join, you'll reposition them. Move the weather_data.dbf
table to the upper left comer of the ArcView window. Click on the Station field to
make it active. Now make the theme table (Attributes of Weather_stations) active,
Move it to the lower right corner of the ArcView window. Scroll to the Station field
and click on it to make it active.

Step 5 Join the tables

Click the Join button ArcView appends the fields in the weather_data.dbf table
to the theme attribute table and closes weather data.dbf. Records in the theme
attribute table have a one-to-one relationship to records in the weather_data.dbf table.
That is, for each weather station in the theme attribute table, there is only one record
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of weather data value. Scroll to the right in the table and notice that it now contains
fields from the weather_data.dbf table.

Step 6 1dentify a feature

Click the Identify tool then click on any point in the view to display its attributes
in the Identify Results window. You'll see now that the attribute table has more fields.
When you're finished, close the Identify Results window.

Ste7 Close the project
From the File menu, choose Close All. Again from the File menu, choose Close
Project. Click No when you're prompted to save your changes.

Self test

(1) Joining tables is appropriate when the records in one table have a one-to-many
relationship with records in the second table.

e True
E False

(2) After joining two tables, you can usse the Identify tool to get attribute information from both
tables.

c True
|

False

(3) After linking two tables, you can use the Query Builder to select records in both tables.
c True

e False

(4) You can use the data in two separate tables by linking the tables.

(5) When there is one record in a table that maiches to one record in a second table, what
type of relationship do the records in the two tables have?

E Many-to-many
e One-to-many
C

& One-to-one

Many-to-one
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{6) When creating a hot link, where do you define it?

E Table Properties diatog
C

¥ View Properties dialog

Hot Link menu

c Thame Proparties dialog
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Exercise 5
Querying features

Spatial query is the process of selecting features based on their geographic
relationship, or spatial relationship, to other features. For example, you might be
interested in finding out which features are within a certain distance of other features,
which are adjacent to other features, which are contained inside other features, or
which intersect other features. In ArcView, you can perform spatial queries using
features from different themes. The process of overlaying one theme with another in
order to determine their geographic relationships is called spatial overlay.

5.1 Find features nearby

For this exercise, one of the criteria for selecting sites for a proposed project’s survey
are districts (Nahia) where there are no major towns (urban areas) within 20 km in
Syria. Your task is to identify these district areas.

Estimated time to complete: 20 minutes

Step 1 Start ArcView and open the project

Start ArcView, and open the project introav\analyze\lesson01\L01_ex01.apr. When
the project opens, you see a view with two themes: a point theme called Urbanized-
areas and a Polygon theme called Syria-nahia. The Syria-nahia theme is active.
You'll use this feature to select district areas within 20 Km of urbanized areas. The
Syria-nahia theme is the target theme while the Urbanized-areas theme is the selector
theme.

Note: The target theme must be active to perform a theme-on-theme selection.

Step 2 Open the Select By Theme dialog

From the Theme menu, choose Select By Theme. Select By Theme dialog box will
displays. This dialog is where you specify the type of spatial relationship you want to
analyze with theme-on-theme selection. ArcView supports these types of spatial
relationships: Are Completely Within, Completely Contain, Have their Center In,
Contain the Center Of, Intersect, and Are Within Distance Of. Theme's feature type
determines what types of spatial relationships you can analyze; you'll choose the
selector theme first.

Step 3 Specify the spatial query

In the Select By Theme dialog, select Urbanized-areas in the lower dropdown list (if
it's not already selected). Choose Are Within Distance Of in the top dropdown list.
Type 20 in the Selection distance field. (The distance is in km because the map units
are set to km in this view).
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Step 4 Create the selection
Click New Set. ArcView finds all Nahia within 20 km of the urban areas of Syria,
The opposite of this selection is what you want. You will now select this.

Step 5 Reverse your selection
With the Syria-nahia theme active, open the table by clicking Open Table tool .

Click on Toggle Records tool. The Records selected now are all Nahia that have
no urban areas within 20 km.

Step 5 Check the result

Click on the Promote tool @ If you look at the last row of Button’s bar, 94 out 210
is diplayed. It means 94 out of 210 districts in Syria have no urban areas within 20
km.

Step 6 Close the project

You've seen how theme-on-theme selection can be used to support real decision-
making, In only a few moments, you found districts in Syria that meets your criteria.
From the File menu, choose Close All. Again from the File menu, choose Close
Project. Click No when you're prompted to save your changes.

5.2 Find adjacent features

ArcView can find features adjacent to a specific feature or features you select.
Suppose you are part of a team mapping areas vulnerable to disasters. One of the hot
spots for this mapping is the fault zone. Your task is to identify all the fault zones of
Syria and list all districts adjacent to any of these zones. You are also required to find
total areas of districts under fault zones,

Estimated time to complete: 15 minutes

Step 1 Start ArcView and open the project

Start ArcView if necessay, and open the project
introav\analyze\lesson01\L01_ex02.apr. When the project opens, you will see a
view with two themes, Faults and Syria-districts. The Syria-districts theme is active.
You're now ready to find out all districts in Syria that are adjacent to fault line.

Step 2 Define the selection

From the Theme menu, choose Select By Theme to display the Select By Theme
dialog. Choose Faults in the lower dropdown list if it's not already selected. Choose
Are Within Distance Of in the top dropdown list. Type 0 in the Selection distance
field.

Step 3 Create the selection

Click New Set. ArcView selects districts adjacent to the fault line. To find out how
many districts are selected, you'll open the theme table. Click the Open Theme Table
button. Click the Promote button to move the selected records to the top. Looking at
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the status bar to the left of the toolbar, you can see that the 27 out of 210 districts in
Syria are adjacent to any of the fault zone. Next, you will answer the second question,
what is the total area of districts under fault zone?

Step 4 Find the total area

In the Attributes of Syria-districts table, click on the Area field to make it active.
Click the Field Menu and select Statistics. A dialog box displays which shows the
sum of area of the selected districts “Sum: 49922.065". That is, total areas of Syria
adjacent to fault line is 49,922.065 km’

Step 5 Close the project
From the File menu, choose Close All. Again from the File menu, choose Close
Project. Click No when you're prompted to save your changes.

Self test

(1) The process of superimposing layers (themes) of geographic data that occupy the same
space in order to study the relationships between them is called:

c Graphic ovemplot
C Spatial overlay
c Selection orientation
c Object selection

(2) A proximity query finds features that are within a specified distance of other features.
True

c False

(3) When performing theme-on-theme selection, what is the theme whose features will be
used to select other features called?

c The target theme
c The selector theme
c The analysis theme
e The object theme

(4) The spatia relationship in which features are completely within a polygon feature is called
containment.

c True
e False
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(5) Whsn performing theme-on-theme selection, to find adjacent features, which option would
you choose to complete the "Select features of active theme that...” portion of the selection
statement?

c Are within a distance of
c Intersect

e Share common boundary
c Are within

5.3 Find intersecting line features

Suppose that a vuinerability mapping carried out in a community shows that there are
lots of earthquake faults. Consequent to this, a committee was set up to develop a plan
to deal with potential flooding and health risks associated with the rupture of water
and sewer lines in the event of a major earthquake. As the first step in the study, the
committee is expected to use ArcView GIS to find those water and sewer pipelines
that intersect earthquake faults. As a member of the committee and who knows how
to use ArcView GIS, you were asked to camry out this task.

Estimated time to complete: 20 minutes

Step 1 Start ArcView and load the project

If necessary, start ArcView, and open the project
Introav\analyze\lesson02\L.02_ex01.apr. When the project opens, you see a view
with two themes, Pipclines and Faults. To find out which pipelines intersect faults,
you'll use theme-on-theme selection. The Pipelines theme is the target theme while
the Faults theme is the selector theme. The target theme must be active to perform a
theme-on-theme selection. Features in this theme will be used to select features in the
Pipelines theme.

Step 2 Create the spatial query

Make the Pipelines theme active. From the Theme menu, choose Select By Theme.
The Select By Theme dialog will display. In the lower dropdown list, choose Faults.
In the upper dropdown list, choose Intersect. Your selections form this sentence:
"Select features of active themes that intersect the selected features of Faults.”

Step 3 Create the selection

Click New Set ArcView selects pipelines that intersect faults. Now that the vulnerable
pipelines are selected, the committee wants to determine their total number and length
so they can estimate potential repair and replacement costs.

Step 4 Examine the selected features

With the Pipelines theme active, click the Open Theme Table button. The Attributes
of Pipelines table opens. To see the selected records better, you will promote them.
Click the Promote button. Records for the selected pipelines now appear at the top of
the table. Next, you'll use the Summarize function to calculate the total number and
length of these pipelines according to owner.
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Step 5 Open the Summary Table Definition dialog

In the Attributes of Pipelines table, scroll to the right and click on the Owner field
name to make it active. ArcView will use the unique values in this field to summarize
the selected records in a new table. Click the Summarize button. The Summary
Table definition dialog box opens.

Step 6 Define the summary table

In the Field dropdown list, choose Length. In the Summarize by dropdown list,
choose Sum. Click Add. Your selection is added to the summary statistics box on the
right. Click the Save As button and navigate to your c:\temp directory. Type
pipe_length.dbf for the filename. Click OK to accept the filename.

Step 7 Create the summary table

Click OK to create the summary table. ArcView creates one record for each unique
owner it finds. The new table shows there are five owners of the selected pipelines.
The Count field reports the total number of pipelines for each owner, and the
sum_Length field lists their total length. You can now give this information to the
committee as the starting point for working with the responsible agencies to develop a
plan to deal with potential flooding and health risks.

Step 8 Close the project
From the File menu, choose Close All. Again from the File menu, choose Close
Project. Click No when you're prompted to save your changes.

5.4 Find polygons that intersect other polygons

Like earthquakes, floods require emergency planning and special programs for human
and property protection. Legislation requires communities in flood-prone areas to
participate in flood insurance programs. These programs, aimed at protecting property
owners, require owners to purchase flood insurance at government-subsidized rates.
As a participant in a flood insurance program, one city located on a major floodplain
developed a database containing the boundaries of 100-year and 500-year flood zones.
(These zones are expected to flood at least once during the designated time span.) The
city wants to notify all property owners within the 100-year zone about special low-
cost loans for elevating structures above the base flood level, thereby cutting
insurance costs. Using ArcView's theme-on-theme selection functionality, the city can
determine which land parcels are located within the 100-year flood zone and then
notify the owners about the loan program.

Estimated time to complete: 15 minutes

Step 1 Start ArcView and open the project

Start ArcView, if necessary, and open the project
introavianalyze\lesson02\L02_ex02.apr. When the project opens, you see a view
with two themes: Floodzones and Parcels. The 100-year flood zone is selected in the
Floodzones theme. To see all the features in both themes, you'll zoom out.



Step 2 Create the spatial query

Click the Zoom to Full Extent button E3. Next, you'll find out which parcels
intersect the 100-year flood zone. Make the Parcels theme active so that it is the
target theme. From the Theme menu, choose Select By Theme. In the lower
dropdown list, choose Floodzones to make it the selector theme. In the upper
dropdown list, choose Intersect. Your selections form this sentence: "Select features
of active themes that intersect the selected features of Floodzones."

Step 3 Create the sclection
Click New Set. ArcView selects parcels that intersect the 100-year flood zone.
To see the selected parcels better, you'll tum off the Flsodzones theme.

Step 4 Redraw the parcels theme

In the Table of Contents, click the Check box next to the Floodzones theme to tumn
it off. ArcView redraws the Parcels theme. Next, you'll open the theme table and
examine the selected records.

Step 5 Examine the results

With the Parcels theme active, click the Open Theme Table button. Click the
Promote button to display the selected records at the top of the table. Scroll to the
right to examine the attributes. The parcel attributes include assessor’s parcel number,
zoning codes, General Plan codes, acreage, owner name, owner address, and more.
The city now has a list of all parcels that would be affected by a 100-year flood as
well as the information it needs to contact the owners about the special loan program.

Step 6 Close the project

From the File menu, choose Close All. Again from the File menu, choose Close
Project. Click No when you're prompted to save your changes. If you want to go on
to the next lesson, leave ArcView running. Otherwise, choose Exit from the File menu
to close ArcView.

Self Test

(1) ArcView cannot determine where line features and polygon features intersect.
c True
c False

{2) In ArcView, you can find line features that intersect polygon features but you cannot find
polygon features that intersect line features.

c True
e False
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(3)f there are selected features in the selector theme, they will be used to select features in
the target thems when performing theme-on-theme selection.

e True
c False

(4) You can use theme-on-theme selection to find polygon features that intersect other
polygon features.

e True
c False

(5) It doesn't matter if you select features using lines or polygons as the selector theme; you'l
still get the same number of selected features.

e

(¥ Faise

True

(6) By default, if features in the selector theme are selected, how many of the selector
theme's features are used for theme-on-theme selection?

e 0

e 1

e All the selected features

C All the features in the theme

(7) To find overlapping polygons, you would choose this option in the Select By Theme dialog.
c Intersect

e Are Adjacent To

C Overlap

c Within a distance of (using -1 as the distance)

Finding features and joining their attributes

When you use theme-on-theme selection, ArcView uses the features in one theme to
find features (and their attributes) in another theme. The selected features and
attributes remain in separate theme tables. In a spatial join, however, ArcView GIS
appends the fields of one theme table (the source table) to those of another theme
table (the destination table) using the geographic locations of the features. The result
is one theme table containing data on features in both themes.

5.5 Join attributes based on containment

Suppose you're a wildlife biologist studying water sources on protected lands, such as
national parks, national forests, and wildlife reserves. When water sources become
scarce during the dry season, wild animals in these areas often migrate to grazing
lands that support livestock. You'd like to anticipate this situation and take measures
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to prevent it. To do so, you'll need to know how many water sources each area has.
You'll perform a spatial join to append the attributes of these areas to the water
sources found within them. Then you'll create a query to find the water holes that are
inside protected areas and summarize their attributes to find the number of water
holes in each protected area.

Estimated time to complete: 25 minutes

Step 1 Start ArcView and open the project

If necessary, start ArcView, and open the project
Introav\analyze\lesson03\L03_ex0l.apr. When the project opens, you see a view
with two themes, Water Holes and Range. Features in the Range theme are divided
into three classes: Unprotected Areas, Protected Areas, and Unknown. You want to
know the characteristics of the area each water hole lies in, so you'll join the attributes
of the Range theme to those of the Water Holes theme.

Step 2 Open the theme attribute tables

With the Water Holes theme active, hold down the Shift key and click on the Range
theme to make both themes active. Click the Open Theme Table button to open the
attribute tables for both themes. In this case, Attributes of Range is the source table
and Attributes of Water Holes is the destination table. The destination table is the one
that's active when you perform the join.

Step 3 Make the Shape field active in each table

In the Attributes of Range table, click on the Shape field to make it active. Now move
the Attributes of Range table out of the way and make the Attributes of Water Holes
table active. Click on the Shape field in the Attributes of Water Holes table. The
Shape field is common to both tables, and you have selected it in both tables.

Step 4 Join the tables

With the Attributes of Water Holes table active, click the Join button (3]

ArcView joins the Attributes of Range table to the Attributes of Water Holes table
based on the location of features in the two themes. Widen the Attributes of Water
Holes table so you can see more fields. The Attributes of Water Holes table
(destination table) now has fields appended from the Attributes of Range table (source
table). For each water hole, there is now a range code (Rcode) and description. Water
holes with a range code of 6 are located in national parks, forests, and reserves. You'll
build a query to select them. In a spatial join, you join two theme tables by using the
Shape field as the common field. For each feature in the first theme, a corresponding
feature in the second theme is found that satisfies one of these spatial relationships:
nearest or inside. In this case, ArcView uses the inside relationship to find the range
area that each water hole lies in. The attributes of the range are then appended to the
attributes of the water hole. If there is more than one water hole in a range area, the
attributes of that area are appended to each water hole.
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Step 5 Open the Query Builder
Make the view active. Both themes (Water Holes and Range) are active. Click on the
Water Holes theme to make it the only active theme. Click the Query Builder button

to open the Query Builder dialog.

Step 6 Select the water holes

Make sure the Update Values check box is checked. In the Fields list, double-click
[Reode]. Click the equals sign (=) button. Double-click on 6 (national parks, forests,
and reserves) in the Values list. Click New Set to select all the water holes in the
national parks, forests, and reserves. Close the Query Builder dialog box. You see
the selected water holes highlighted in yellow in the view. To see the attributes of the
selected water holes, you'll open the theme table.

Step 7 Examine the selected records

Click the Open Theme Table button and click the Promote button to move the
selected records to the top of the table. You may need to widen the table or scroll to
the right to see all the fields. Next, you'll summarize the selected water holes based on
the values in the Description field to determine the number of water holes in each
park, forest, and reserve.

Step 8 Define a summary table

In the Attributes of Water Holes table, click on the Description field to make it
active. From the Field menu, choose Summarize (or click the Summarize button).
The Summary Table Definition dialog opens. Click the Save As button and navigate
to your \temp directory. Type in watdes.dbf as the filename. Click OK to accept the
filename.

Step 9 Create the summary table

Click OK to create the summary table. ArcView creates one record for each park,
forest, and reserve that's named in the Description field. The Count field lists the
number of water holes in each one. Now you know which protected areas have water
sources and how many sources are in each area. You can study these sources to find
out which can support local wildlife throughout the dry season and which cannot.

Step 10 Close the project
From the File menu, choose Close All. Again from the File menu, choose Close
Project. Click No when you're prompted to save your changes.



5.6 Join attributes based on proximity

As a way of raising money to maintain protected areas, the government would like to
sponsor camera safaris to water holes in those areas. Your job is to evaluate access to
the water holes. You've discovered that only one of four protected areas is accessible
by land. The other three are too remote. As an alternative, the government would like
to fly tourists into these areas. You'll need to know how far each water hole is from
the nearest landing strip. Because tourists will have to travel over bumpy, unimproved
roads to get from landing strips to water holes, you want to find those water holes
within 20 kilometers of a landing strip to minimize driving time. To find those water
holes, you'll perform a spatial join to append the attributes of landing strips to the
water holes found nearest to them. ArcView calculates the distance from each water
hole to the nearest landing strip and, in a field called Distance, appends this
information to each water hole. You'll perform a query on this field to find out which
water holes are located less than 20 kilometers from a landing strip.

Estimated time to complete: 20 minutes

Step I Start ArcView and open the project

Start ArcView and open the project introavianalyze\lesson03\L03_ex02.apr. When
the project opens, you see a view with three themes: Airports, Water Holes, and
Range. In the Range theme, the three remote protected areas are labeled. The Water
Holes theme shows only the water holes inside these protected areas. The Airports
theme (active) shows all the landing strips for the entire region.

Step 2 Open the theme attribute tables

With the Airports theme active, hold down the Shift key and click on the Water
Holes theme. Now both themes are active. Click the Open Theme Table button to
open the theme attribute tables for both themes.

Step 3 Join the tables

In the Attributes of Airports table (source table), make the Shape field active. Also
make the Shape field active in the Attributes of Water Holes table (destination table).
With the Attributes of Water Holes table active, click the Join button to join the
Attributes of Airports table to the Attributes of Water Holes table. ArcView uses the
nearest relationship to find the landing strip closest to each water hole. Scroil to the
right in the Attributes of Water Holes table to see all the fields. The attributes of the
landing strip (Id) are appended to the attributes of the water hole. ArcView also
calculates the distance between each water hole and the closest landing strip and
places this value in a field called Distance. (This data is in UTM meters so the results
from the spatial join are also in meters). Whenever ArcView uses the nearest
relationship in a spatial join, a distance field is added to the joined table. Next, you'll
build a query to find the water holes that are less than 20 kilometers from a landing
strip.
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Step 4 Create a query

With the Attributes of Water Holes table active, click the Query Builder button to
open the Query Builder. Double-click [Distance] in the Fields list. Click the less than
sign (<) button. Type in 20000 for the query field.

Step 5 Create the selection

Click New Set to select all the water holes that are less than 20 kilometers from a
landing strip. Close the Query Builder. Click the Promote button to move the
selected records to the top of the table. Now you know which water holes are closest
10 landing strips. These sites meet your criteria for good camera safari sites. You want
to evaluate the remaining (unselected) sites for future development, however, so you'll
change the selected set to water holes that are more than 20 kilometers away from
landing strips.

Step 6 Switch selections

Click the Switch Selection button @ to select the water holes that are more than 20
kilometers away from a landing strip. Promote the selected records to the top of the
table by clicking the Promote button. The highlighted records are water holes that are
more than 20 kilometers from a landing strip. When you use the Switch Selection
button, ArcView changes the selected set of records to the previously unselected
records. If the records belong to a theme table, the selected and unselected sets of
features in the theme are also switched in the view. If no records are selected, using
the Switch Selection button will select all the records.

Step 7 Examine the view

Make the view active, Water holes more than 20 kilometers from landing strips are
highlighted. These water holes can be developed for future safaris by adding new
landing strips or by improving the roads leading from them to the nearest existing
landing strip. ArcView helped you meet your initial objective of evaluating access to
water holes. You know how far each water hole is from the nearest landing strip,
which ones are within 20 kilometers of existing landing strips, and which ones aren't.
If the camera safari project is successful in raising revenues for protected areas, both
the local economy and the protected areas will benefit.

Step 8 Close the project
From the File menu, choose Close All. Again from the File menu, choose Close
Project. Click No when you're prompted to save your changes.

Self test

(1) A spatial join appends attributes from one theme attribute table to another theme attribute
table.

e
c

True

False



{2) In a spatial join, attributes are assigned to the active table's records based on the
geographic locations of the themes' features.

e Truse
& False

(3) To perform a spatial join comectly, you must have the appropriate thems table activa.

(5) When you use spatially join two point themes, ArcView adds a new field named:
e Shape

E 16

& Length

c Distance

(6) Which fisld is used in a spatial join operation as the common table field?

E 1ype

c Point

c

e Shape

Location

{7) The two types of spatial joins are Nearest and:

c Inside

c Farthest

C Distance

> Adjacency

Advanced geoprocessing

ArcView GIS comes with an extension called Geoprocessing tools. It is very useful to

create a buffer and overlay data using the merge, dissolve, clip, intersect, and union
functions. You’ll use this tool in doing exercises in this section.
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5.7 Perform advanced geoprocessing

How a city's land is used affects all who live there. If a city has many areas dedicated
to industry, smog and noise pollution can negatively affect the quality of life for the
city's residents. City parks and open spaces, like vacant lots or ravines, can help make
a city more beautiful and offset the effects of noise and air pollution. In this exercise,
you'll investigate areas within a 300-meter buffer of industrial sites in one of the cities
in the world. You'll analyze these areas to see what types of land uses exist there.

Estimated time to complete: 30 minutes

Step 1 Start ArcView and open the project

Start ArcView and open the project introav\analyze\lesson04\104_ex01.apr. When
the project opens, you see a view called City that contains two themes: Parks and
Landuse.

Step 2 Set the view's background color

From the View menu, choose Properties. In the View Properties dialog, you'll see
Background Color alongside a box that shows the current color of the view's
background. Right now, the box has an X through it to show that no color is being
used for the background. Click Select Color to display then Color Picker. Click on
the Black square and click OK_ Notice that the box in the View Properties dialog is
updated to display the color that you chose. Click OK in the View Properties dialog to
apply the color to your view.

Step 3 Change the Table of Contents style

From the View menu, choose TOC style. This displays the Table of Contents Style
Settings dialog that you can use to change the look of your Table of Contents (TOC)
in all your views.

In the Line Flatness dropdown list, choose Flat.

In the Symbol Length dropdown list, choose Normal.

For Font, choose Times New Roman.

For Style, choose Bold Italic.

For Size, choose 10.

Click Apply. The TOC is updated with your new settings. If you like, take some time
to experiment with different settings to see how it affects the look of your TOC. When
you are finished, click Close.

Step 4 Load the Geoprocessing extension

Before you do any processing, you'll need to load the Geoprocessing extension, From
the File menu, choose Extensions. In the Extensions dialog, check the box next to
Geoprocessing. Click OK.
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Step 5 Simplify Landuse.shp with Dissolve
Geoprocessing can take a lot of time if your theme has many features. Make Landuse

the active theme and click the Open Theme Table button Notice that Landuse
has 12,876 features. Scroll to the right and find the DESC field. Landuse is classified
into nine categories, which are stored in the DESC field. These values are used to
symbolize Landuse in the view's TOC. By using Dissolve, you can reduce the number
of features from 12,876 to nine—-one feature for each landuse class in the theme. With
fewer features to process, subsequent geoprocessing tasks will take less time. This is a
good technique to use when you're working with themes consisting of many features.
Close the Attributes of Landuse table.

Step 6 Open Geoprocessing Wizard

From the View menu, choose GeoProcessing Wizard. The first panel of the
GeoProcessing Wizard displays the geoprocessing tools you can access with the
wizard. The first tool you'll use is Dissolve. Choose Dissolve option to dissolve
features based on an attribute and click Next. The second panel lets you choose the
theme with features you want to dissolve and the attribute to dissolve. Choose
Landuse as the theme you want to dissolve. For the attribute to dissolve, choose Desc

in the dropdown list. Specify the output file by clicking the Browse button J and
navigating to your introavianalyze\lesson04 folder. Name the ouput file land_disslv.
Click OK. Click Next then click Finish. The Dissolve process may take a few
moments. When it finishes, a new theme called Land_disslv.shp is added to the City
view.

Step 7 Examine the new theme

Make Land_disslv.shp the active theme and click the Open Theme Table button.
Notice that the Attributes of Land_disslv.shp table now contains only nine records.
All polygons belonging to the same DESC class now share a single record in the
attribute table. You can see how many polygons are represented by each class by
looking at the Count field. For instance, there are 119 polygons with a DESC value of
Agriculture, all of which now share the single record in the table. Close the Attributes
of Land_disslv.shp table.

Step 8 Symbolize Land_disslv.shp

Because Land_disslv.shp is a simplified version of Landuse, you'll use it for the rest
of the analysis in this exercise. Right now, it's symbolized with a single symbol. A
legend file called landuse.avl has already been created for you to use with
Landdiss.shp. Before continuing with the exercise, you'll apply this legend to
Landdiss.shp. In the TOC, check the box next to Land_dislvs.shp to turn the theme
on. Doubleclick on Land_dislvs.shp to open the Legend Editor. Click Load. In the
Load Legend browser, navigate to your introavianalyze\lesson04 folder and click on
landuse.avl. Click OK. In the Load Legend dialog that appears, make sure the Field
dropdown list says Desc. Click OK. In the Legend Editor, click Apply then close
Legend Editor. In the Table of Contents, move Parks to the top so that the order of
themes from top to bottom is: Parks, Land_dislvs.shp, Landuse. Tum off Landuse.
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Step 9 Update the Area and Perimeter fields

When you execute any of the geoprocessing tools, ArcView doesn't automatically
update the result theme's area and perimeter fields (for polygon themes) or the length
field (for line themes). You need to update these values using the Avenue script
Calcapl.ave. Calcapl.ave has already been added to this project. Make the Project
window active and click the Scripts icon. Click Open to open Calcapl.ave. The script
requires Land_dislvs.shp to be active. From the Window menu, choose City. In the
view, make Land dislvs.shp the active theme. Next, from the Window menu, choose

Calcapl.ave to make the script window active again, then click the Run button .

Note: When you run a script in ArcView GIS, the order of your actions is very
important. For Calcapl.ave to work correctly, the view window must be the last
active window before the script is run.

Now make the City view active once again. Open the Land_dislvs.shp theme table.
Notice that Area and Perimeter fields have now been added to the table. It is
important to keep the Area field up-to-date because you'll eventually use this field to
find out how much green space and residential areas exist near industrial sites. Close
the Attributes of Land_dislvs.shp table.

Step 10 Sclect industrial sites

The first step in finding the green spaces and residential areas near industrial sites is
to find all the areas within a certain distance of the industrial sites. You can find these
areas by buffering or using theme-on-theme selection. Because the objective is to find
out how much of the area is green space (parks, vacant lots, and ravines) and how
much is residential, you'll use a buffer. Buffering gives you more precise results than
theme-on-theme selection. With a buffer, you can find the exact areas within a certain
distance of the industrial zones. Theme-on-theme selection (with the Within A
Distance Of option) won't find these areas because it doesn't create new features at the
boundary of the distance specified. If you select some features before opening the
Create Buffers wizard, you can choose to buffer just the selected features or all the
features in the theme. To buffer only the industrial sites, you must first select them.

With Land_dislvs.shp active, click the Query Builder button . Make sure the
Update Values check box is checked. In the Fields list, double-click on [Desc]. Click
the equals sign button (=). In the Values list, double-click on Industrial.

Step 11 Examine the table

Click New Set and close the Query Builder. Examine the highlighted areas in the
view. These are the industrial sites that you'll be buffering in the next step. Click on
the Theme menu. Notice that the Create Buffers option (second from the bottom) is
grayed-out and not available. This is because you must set the view's map and
distance units before ArcView GIS can calculate a buffer. From the View menu,
choose Properties to display the View Properties dialog. The City dataset is
projected to State Plane-Feet so set the Map and Distance Units to feet. Click OK.
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Step 12 Buffer the industrial sites

In this step, you'll find the areas around the selected industrial sites by creating buffers
that extend to 300 meters. By finding the total area covered by the buffer polygons,
you'll have found the total area within 300 meters of the industrial sites of City. While
you're working through the Buffer Wizard, you can check your settings at any time by
clicking Back to retumn to a previous panel. The buffers will not be created until you
click Finish. From the Theme menu, choose Create buffers to display the first panel
of the Buffer Wizard. Choose the option Buffer the features of a theme. In the
dropdown list, choose Land_dislvs.shp as the theme to buffer. A checkmark appears
at the bottom indicating that you will use only the selected features of
Land_dislvs.shp. Click Next to apply these options. In the second panel of the Buffer
Wizard, choose the option Create the buffers at a specified distance of 300. Change
the Distance units to Meters in the bottom dropdown list. This will create buffer
areas 300 meters around all industrial sites in Land_dislvs.shp. Click Next to display
the final panel of the Buffer Wizard. Click Yes to dissolve barriers between buffers.
Choose the option Create buffers so they are only outside the polygon. Save the

buffers in a new theme. Click the Browse button and navigate to your
introav\analyzeMlesson04 folder. Keep the default filename buffl.shp. Click OK. It
may take a few moments for ArcView to process the buffers. When the process is
complete, the buffers are created in a new theme called Buffer] of Land_dislvs.shp.
Notice that the buffer zones cover the areas you are interested in. In the next step,
you'll change the symbol used to display the buffers so that you can see the
underlying data

Step 13 Change the buffer's symbology

With Buffer1 of Land_dislvs.shp active, from the Theme menu, choose Properties.
Change the name of Bufferl of Land_dislvs.shp to Buffer of Industry. Click OK.
Double-click on Buffer of Industry to display the Legend Editor. In the Legend
Editor, double-click on the Symbol to open the Symbol Window. In the Symbol

Window, click Fill Palette button . Click the first symbol (top left square) and in
the Qutline dropdown list, choose 2. This will make the width of the outline thicker

and easier to see. In the Symbol Window, click the Color Palette button In the
Color dropdown list, choose Outline. Click on a bright yellow square. The symbol is
updated in the Legend Editor. In the Legend Editor, click Apply. Now you can see the
selected industrial sites as well as the extent of the 300-meter buffer around these
areas. Close the Legend Editor and the Symbol Window.

Step 14 Clip Land_dislvs.shp with Buffer of Industry

To calculate the area of the city that falls within the 300-meter buffer zone, you'll clip
Land_dislvs.shp using the buffer theme. This will create a theme containing only
those landuse areas that fall within 300 meters of industrial sites. Because you no
longer need the selected set of industrial sites, you'll clear the selected industrial
features in Land_dislvs.shp. Make Land_dislvs.shp active and click the Clear

Selected Features button The clip operation is a part of the Geoprocessing
extension. To access it, from the View menu, choose GeoProcessing Wizard.
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Choose the option Clip one theme based on another and click Next. For the input
theme to clip, choose Land_dislvs.shp in the dropdown list. For the polygon overlay
theme, choose Buffer of Industry in the dropdown list. For the output file, click the

Browse button and navigate to your introavianalyze\lessson04 folder. Name the
new shapefile Area_total.shp. Click OK. Click Finish. The clip process may take a
few moments. ArcView reports on the processing in the status bar (in the lower-left
comer of the ArcView window). When the process is complete, a new shapefile
called Area_total.shp is added to the view. Tum it on. The area covered by
Area_total.shp represents all the areas in City that are 300 meters from the industrial
sites.

Step 15 Update the Area and Perimeter fields

When you clip a theme using another theme, new shapes are created in the output
theme. The new shapes need to have their Area and Perimeter fields updated. Make
Area_totalshp active and open its theme attribute table. Notice that all the polygons
have the same values for Area and Perimeter. Close the Attributes of Area_total.shp
table and make the City view active. Make Area_total.shp the active theme if it isn't
already. To calculate the proper areas, you'll run the script called Calcapl.ave. Make

the Calcapl.ave script window active. Click the Run button L&J to run Calcapl.ave. In
the Calculate dialog that appears, click Yes to update the Area field and the Perimeter
field. Make the City view active and open the Area_total.shp theme table. The Area
and Perimeter field now contain the correct values.

Step 16 Summarize Desc to find the total areas
To find out how much area is Residential and how much is Green Space, you'll
summarize the Desc field. In the Attributes of Area_total.shp table, click on the Desc

field name so that it is the active field. Click the Summarize button to open the
Summary Table Definition dialog. In the Field dropdown list, choose Area. In the
Summarize by dropdown list, choose Sum. Click Add then click OK. A summary
table called sum1.dbf is created. By looking at this table, you can find out how much
of the area within 300 meters of industry is residential and how much is green space.
18,180,739.7120 square feet, or 0.65 square, miles is residential. 20,211,314.6820
square feet, or 0.73, square miles is green space. This makes it clear that there is more
green space near industry than residential. To see each land use type, double-click on
Area_total.shp in the TOC. Click Load in the Legend Editor and load landuse.avi,
Click OK. Be sure that DESC is selected as the Field. Click OK, click Apply, and
close the Legend Editor. Uncheck Land_dislvs.shp to turn off its display and move
Parks to the top of the TOC. Now you can see all the land use types as well as the

parks.
Step 17 Save and close the project

From the File menu, choose Close All. Again from the File menu, choose Close
Project. Click Yes to save your changes.
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Self test

{1) Why s it possible for the cutput table of a Union operation to have blank records for some
fields?

e The records for these fields represent features that are present in only one of the input
themes.

e The records for these fields represent features that are present in both of the input
themes.

C The records for these fislds represent new features created by the overlay process.

” The records for these fields are filled in only after the Area, Perimeter, or Length fields
are updated

(2) It's possible to create a buffer around only one feature in a theme?
c True
e False

{(3) If you want to create buffers as multiple rings, you must specify:
e The specified distance representing the total extsnt of the buffer

(& The number of rings and the aftribute field whose values will be used as the distance
between rings

& The distance between rings and the attribute field whose values will be used as the
number of rings

C The number of rings and the distance between them

{4) Unlike theme-on-theme selaction, a buffer operation finds the exact distance from a
feature and draws it in the view.

C True
# False

(5) If you want to create a new theme containing only those features from one theme that fall
within the extent of polygon features in another theme, which operation would you use?

E Intersect

C Clip

e Union

c Theme-on-theme selection

(6) When you use ArcView's geoprocessing tools, ArcView automatically updates the result
theme's area, perimeter, and length fields.

e True
c False
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(7) Which of the following problems must be solved using a buffer?

e Finding the number of hospitals within a 15-mile range of an ambulance station.
C Determining the percentage of cropland within 10 meters of a road.

C Finding the number of nesting sites within a mile of a wolf pack’s territory.

c Finding the number of different land use types within a city's limits.

Suppose you have a point theme that contains three points representing hazardous waste
sites. The theme table has an atftribute fie!d containing the farthest distance away that
contaminants have been found from the sites. How can you map this information?

c Create a buffer using the attribute field to specify the distance between the rings.
c Create a buffer using the attribute field to specify the number of rings.

e Create a buffer using a specified distance.

e Create a buffer using the attribute field to specify the extent of the buffer

Merge can be used to append the features of a theme to those of another theme (or themes),
aven if their feature types (point, line, or polygon) are different.

e True
9 False
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Exercise 6

Creating your data sets

A shapefile theme is actually composed of three files, each of which has the shapefile
name and an extension-.shp (coordinate file), .shx (index file), and .dbf (attribute file).
ArcView uses the information stored in each of the files to draw the theme and
display the theme attribute table.

6.1 Work with shapefiles

Imagine that you are a biologist working for an establishment that protects ecological
biodiversity in the Bahia region of Brazil. Because your establishment's resources are
limited, your job is to target areas for protection to benefit the largest number of
species. You decide to use ArcView GIS to display themes showing the habitats of
various threatened species. By displaying these themes together in a view, you'll be
able to identify which areas have the most species in need of protection. Your
establishment can then concentrate its conservation efforts on these ecological
"hotspots.” Your first task is to create a detailed map of frog habitats in a small
subsection of the Bahia region. To do this, you'll select the features you want to show
from several themes that cover the entire region. Then you'll convert these selected
features to a shapefile and create a new theme.

Estimated time to complete: 20 minutes

Step 1 Start ArcView and load the project

If necessary, start ArcView, then open the project
Introavicreate\lesson01\L01_ex01.apr. When the project opens, you see a view that
contains several themes, including the Bahia region and point themes that show the
habitats of various species. First, you'll select the features for the new theme you want
to create,

Step 2 Select features

Click on the Frogs theme to make it active. Hold down the Shift key and click on the
Bahia theme to make it active as well. Next, click the Draw tool from dropdown list
of tools and select the Draw Rectangle tool. Draw a rectangle on the view where you
see a concentration of frogs. You'll use this rectangle to select features for two new
shapefile themes.

Step 3 Select the features inside the rectangle

Click the Select Features Using Graphic button l The features in both the Frogs
and Bahia themes that lie within or partially within the rectangle are selected and
highlighted in yellow.
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Step 4 Save the selected features to a new shapefile

With the features highlighted, from the Theme menu, choose Coavert to Shapefile.
The Convert to Shapefile dialog displays. Save the shapefile to your c:\temp folder.
In the File Name text box, change the name to frogs2.shp.

Step 5 Save the new shapefile

You're asked if you want to "Add shapefile as theme to the view?" If you answer
No, the selected features are saved in a shapefile but not displayed. If you answer Yes,
the selected features are saved in a shapefile and the shapefile is loaded as a new
theme in the view. Click No.

Step 6 Save the selected Bahia.shp features to a new shapefile

As you did in Step 4, navigate to your c:\temp folder to save the shapefile. In the File
Name text box, change the name to bahia2.shp. Click OK. The Convert to Shapefile
dialog again displays, asking you if you want to add the shapefile to the view. Click
No. The selected features are saved in a shapefile but not displayed.

Step 7 Create a new view and add the shapefiles

Now you'll create a new view and add the shapefiles you just created to the new view.
Make the Project window active and double-click on the Views icon to create a new
view.

Step 8 Add the new shapefiles as themes to the view

From the View menu, choose Add theme. The Add Theme dialog opens. If
necessary, navigate to your c:\temp folder and click once on the bahia2.shp theme to
highlight it. Hold down the Shift key and click on the frogs2.shp theme. Now both
themes are highlighted. Click OK. The themes are added to the new view.

Step 9 Turn on the themes
Tumn both themes on by clicking on their check boxes in the Table of Contents.
ArcView draws the Frogs2.shp and Bahia2.shp themes in the view.

Step 10 Continue to the next exercise
Leave the project open and continue to the next section.

6.2 Edit shapefiles

For this exercise, your task is to create a new shapefile theme showing the areas
where the highest concentrations of endangered species live. To do this, you'll display
themes showing the habitats of endangered species and create a new theme by
drawing polygons around areas that have the most species. Then you'll edit one of the
polygons to make it more accurate.

Estimated time to complete: 25 minutes
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Step 1 Start ArcView and open the project

IfLO1_exOl.apr is open, close Viewl and View3, then open View2 from the project
window. Otherwise, start ArcView if necessary and open the project
introavicreate\lesson01\L01_ex02.apr. When the project opens, you'll see View2
displaying the Bahia region with several species themes. You'll create a new theme
then add shapes to it.

Step 2 Create a new theme

From the View menu, choose New Theme. The New Theme dialog will be
displayed. In the Feature type dropdown list, choose Polygon. Click OK. Another
dialog displays asking you for a theme name.

Step 3 Save the new theme

Save the new theme to your c:\temp folder and name it hotspots.shp. Click OK.

A new theme called Hotspots.shp is added to your view, but it's empty. Next, you'll
add shapes to the new theme. Notice that the check box for the Hotspots.shp theme
has a dashed line around it, indicating that editing is allowed. Before you add features
(shapes) to this theme, you'll specify a new draw symbol.

Step 4 Change the theme's symbol to an outline

Double-click on the Hotspots.shp theme to open the Legend Editor. In the Legend
Editor, double-click on the Symbol to open the Fill Palette. Click on Pattern icon in
the first column of the third row to select it. Now open the Color Palette. In the Color
dropdown list, choose Background. Click on the Transparent color (the white box
in the first row and column with an "X" in it. Click Apply in the Legend Editor. Close
the Symbol Window and Legend Editor. With the new symbol, you'll be able to see
Theme undemeath the shapes you draw.

Step 5 Draw some features

In the Draw tools dropdown list, click the Draw Polygon tool. You will draw three
polygons in the areas with the highest concentration of different species in Bahia.
Click in the view, hold down the mouse button, and drag to create segments of your
first polygon. Each time you click on the view, a vertex is added to the polygon.
Double-click to close the polygon. Use the same procedure to create the other two
polygons. The Hotspots.shp theme now contains three shapes. You've decided that
one of the shapes needs to be edited because it doesn't include all the species habitats
you wanted.

Step 6 Select and zoom to a shape
You'll use the Pointer tool to select a shape and zoom in on it. Click the Pointer tool

then click on the polygon shapes you want to edit. Four selection handles appear

around the shape. Click Zoom to Selected button == to enlarge the selected shape.
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Step 7 Edit the vertices

Click the Vertex Edit tool E. A vertex handle appears at each of the shape's
vertices. Any vertex can be moved to change the shape of the polygon. Move the
Vertex Edit tool over one of the vertices until the mouse pointer changes to
crosshairs. Drag the vertex to a new position. You have just edited the outline of the

shape.

Step 8 Zoom to the extent of the edited theme

Click the Zoom to Active Themes button to display the entire shapefile theme
again. The vertices are still visible, but if you click anywhere outside the shape with
the Vertex Edit tool, they'll disappear.

Step 9 Save your edits

From the Theme menu, choose Stop Editing and click Yes to save your edits. The
changes you made to the polygon are saved in the shapefile. Notice that the dashed
line around the Hotspots.shp check box in the Table of Contents is now gone. This
indicates that the theme is no longer editable. The polygon you just edited is now the
selected feature (highlighted in yellow).

Step 10 Unselect the selected polygon

Click the Clear Selected Features button 3] to unselect the selected polygon.
You've created a new theme containing three polygons that indicate ecological
hotspots, areas where the highest concentrations of endangered species live. In the
next exercise, you'll add attributes to the theme table for each shape you created.

Step 11 Close the project

If you are continuing to the next section now, leave the project open. If you are not
continuing with the next exercise at this time, from the File menu choose Close All.
Again from the File menu, choose Close Project. Click No when you're prompted to
save your changes.

6.3 Add attributes to a shapefile

For each feature you create in a new theme, ArcView adds a record to the theme's
attribute table, But the theme attribute table has only one default field, called Shape,
that's visible. (An invisible field called ID is also added for each record.) In this
exercise, you'll add a new field called Name to the Hotspots.shp theme attribute table
then add values to it. To do this, you'll make the table editable.

Estimated time to complete: 15 minutes
Step I Open the project
If either LO1_exOl.apr or LO1_ex02.apr is open, go to Step 2. Otherwise, start

ArcView if necessary and open the project introavicreate\lesson01\L01_ex03.apr.
When the project opens, you see a view in which the Hotspots.shp theme is active.
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Step 2 Display the theme attribute table

From the Theme menu, choose Table. The Attributes of Hotspots.shp table displays.
The table currently shows one field, Shape. Notice that the Shape field name appears
in italics. This indicates that editing is not allowed. You'll make the table editable.

Step 3 Start editing the table

From the Table menu, choose Start Editing. The Shape field name now appears in
plain text, indicating that editing is allowed. From the Edit menu, choose Add Field.
The Field Definition dialog opens.

Step 4 Create a new field

In the Field Definition dialog, enter Hotspot Name in the Name field. Click Type
dropdown arrow and choose String, then click OK. If a message box appears saying
the field name is too long and ArcView will truncate it, click Yes. A new ficld named
Hotspot Name is added to the table. Next, you'll add values to this field.

Step 5 Select a record

Click on the first record in the table with the Select tool m ArcView highlights the
record in the table and the shape it's linked to in the view. You'll use the Edit tool to
assign a value to the record.

Step 6 Enter record values

Now you'll enter names for the ecological hotspots. Click on the Edit tool . Click
in the first cell in the Hotspot Name field. Type River Basin, then press Enter. The
order of the records corresponds to the order in which you added the shapes. In the
Hotspot field for the second record, type Interior and press Enter. In the Hotspot field
for the third record, type Coastal Plain and press Enter.

Step 7 Stop editing and save edits

From the Table menu, choose Stop Editing. Click Yes when prompted to save your
edits. The field names again appear in italics to indicate that the table is no longer
editable. ArcView saves your changes in the source data file, hotspots.dbf. If you
wanted, you could now build a query using the new attribute field or use it to label the
shapes in the view. The detailed map of frog habitats and the map of hotspots can help
you target those areas most in need of protection. Because both themes are based on
shapefiles, you can edit their features and attributes at any time.

Step 8 Close the project

From the File menu, choose Close All. Again from the File menu, choose Close
Project. Click No when you're prompted to save your changes.
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Self test

(1) A shapefile is an ArcView native file format for storing theme data.
@ True

C False

(2) in a polygon shapefile theme, you can add polygons using the Rectangle, Circls, or
Polygon Draw tools.

9 True
e False

(3) You can create a new theme and add your own features to it.

(5) A shapefile consists of at least three different files.
c True
e False

(6) After creating a new shapefile, only this field is present in the attribute table.
c Area

c Shape

c Length

e Coordinates

(7) if the Update Shape Attributes check box is selacted, the Shape Properties dialog
automatically updates the Area and Perimeter fields or the Length field.

cC True

C False

(8) If you want to edit an Arcinfo coverage in ArcView, what can you do?
c Convart the coverage to a shapefile

c Choose Start Editing from the Theme menu

(@ Copy the coverage using the Shapefile Manager

c Open its theme attribute table
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(9) Which tool do you use fo add features to a new theme?
c Shape tool

o Edit tool

e Theme tool

C Oraw tool

(10) If you add projected data to a projscted view, ArcView will:

c Open the Shapefile Manager so you can specify the projection

& Automatically set the view’'s map and distance units to the units of the projection
e Automatically set the view’s map and distance units to uninown

c Display a waming massage that your data may not display properly

Creating event themes from coordinates files

Sometimes you may have data that is not in a spatial format but does contain feature
location information. You might have, for example, a database of customer addresses,
a table of accident locations based on highway milepost locations, or a file of
endangered species sitings from Global Positioning System (GPS) readings. Can you
use this data in ArcView GIS? Yes. If you have files containing location information
for geographic features or occurrences, you can add them to an ArcView project as
event themes.

6.4 Add event themes

Suppose you're involved in a unique conservation program designed to help
endangered African wildlife and develop local economies at the same time. In this
program, permits are sold to foreign hunters allowing them to hunt in limited numbers
certain species of African wildlife. The money collected from the sale of permits will
go to local villages for building schools and hospitals. In return, villagers agree to
monitor protected areas and prevemt poaching inside these areas. During the last
month, more than 20 antelope have fallen prey to poachers inside protected areas.
You want to know exactly where these incidents took place and in which protected
areas they occurred. You've sent inspectors out armed with portable GPS equipment
to capture precise x,y locations. The x,y locations are measured in decimal degrees
(degrees of latitude and longitude expressed as a decimal), where x is the longitude
and y is the latitude. You've received the data in a dBASE-formatted file.

Estimated time to complete: 20 minutes

Step 1 Open the project

If necessary, start ArcView and open the project
introavicreate\lesson02\L02_ex01.apr. When the project opens, you see a view with
two themes, Villages and Protected Areas. Each village is a point; each protected
area is a polygon defining a conservation unit. There is one conservation unit for each
village. Beyond the Village Protection Areas is a large Federal Protection area. You'll
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bring a dBASE file containing x,y locations into the current project as an ArcView
table.

Step 2 Select a source table

Make the Project window active and click the Tables icon @ then click Add to
open the Add Table dialog. From the List Files of Type dropdown list (in the lower
left part of the dialog), choose dBASE [*.dbf]. This indicates you want to add a table
from a dBASE file. Navigate to introav\create\lesson02 and click on antelope.dbf.

Step 3 Add the source table to the project

Click OK to add the antelope.dbf table to your project. When the table opens, you see
two fields, X_coord and Y_coord. You'll use the location coordinates in these fields to
create a new theme of point features based on ArcView's shapefile format. The table
doesn't need to remain open, so you'll close it first.

Step 4 Open the Add Event Theme dialog box

Close the antelope.dbf table. Make the view active then from the View menu, choose
Add Event Theme. The Add Event Theme dialog displays. At the top of the Add
Event Theme dialog, you see two buttons. Each button represents a category of
events: XY (selected) or Route (clicking a button displays the fields appropriate for
the category chosen). Antelope.dbf is already selected in the Table list. ArcView
reads the field names in this table to find fields likely to contain x,y coordinates. The
names of these fields, X_coord and Y_coord. appear in the X field and Y field lists.

Step 5 Create an event theme

Click OK to create a new theme from the x,y coordinates in the antelope.dbf table.
The new theme, Antelope.dbf, appears in the view's Table of Contents. Click on the
check box next to the theme name to turn it on. ArcView draws the view with the new
theme. Now you can see exactly where the antelope poachings took place. For each
poaching site, you want to know the name of the protected area it's in. To get this
information, you'll perform a spatial join.

Step 6 Open both theme attribute tables

Make both the Antelope.dbf and Protected Areas themes active by holding down the
Shift key and clicking on each theme in the Table of Contents. Click the Open
Theme Table button to open the attribute tables for both themes.

Step 7 Prepare to join the tables

Make the Attributes of Protected Areas table active (this is the source table). Click on
the Shape field name to make it active. Now make the Attributes of Antelope.dbf
table (the destination table) active, and click on its Shape field name to make it
active.

Step 8 Join the tables
With the Attributes of Antelope.dbf table active, [rom the Table menu, choose Join.
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ArcView appends the attributes of each protected area to the poaching sites contained
within it. The Attributes of Antelope.dbf table displays with additional fields
appended from the Attributes of Protected Areas table. For each antelope poaching
site, there is now a name, which is the name of the protected area in which the
poaching incident occurred.

Step 9 Review the results

Now that you know the names of the protected areas where poaching incidents
occurred, you could use the Summarize function to find out how many antelope were
slain in each protected area and which villages need to be more vigilant.

Step 10 Closc the project

From the File menu, choose Close All. Again from the File menu, choose Close
Project. Click No when you're prompted to save your changes. If you are continuing
on to the lesson self test or to the next lesson, leave ArcView running. Otherwise,
choose Exit from the File menu to close ArcView.

6.5 Customizing ArcView’s interface
Menus, buttons and tools in each of the documents of ArcView can be removed or
retained to suit one needs. You will do this in this exercise,

Estimated time to complete: 5 minutes

Step 1 Start ArcView

If necessary, open ArcView and create a project. Highlight View in the project
window and click New. From the View click Properties. Change the name of the
view to Precipitation then Click OK. From the File click Clese All. This will return
you to project window. Create another view and name it Soil. Try to create up to 10
views with different names. When finished, return to the project window.

Step 2 Open Customize dialog box
Double click on any blank part of the button bar. This will display Customize dialog
box.

Step 3 Set customize dialog box properties
Set Type field to View then chose Menus as the Category. Press the Delete button to
remove each View menu except Close All.

Step 4 Change other Categories
Now change the Category to Buttons. Press the Delete button to remove each view
buttons. Repeat the same for Tools.

Step 5 Close View’s window

You‘ll notice that the View interface is now blank. This makes your project to look
tidy. Select and click Close All from the File. This will return you to the Project’s
window. Do not close your project.
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6.6 Writing Avenue scripts

Having completed the customization of your View interface the next step is to write
programs that will allow you to do what you want with the views. You’ll examine
codes written in ArcView Avenue language. You'll also leam how to execute codes
compiled with the language.

Estimated time to complete: 15 minutes

Step I Create a new script form

While you're at the Project interface, click Scripts then New. Click on Seript then
Properties. Type Display_View.training into the Name field. Close the Script
Properties window.

Step 2 Load Avenue codes

A code had been written for you for this exercise. Click on Script then Load Text
File. Now go to \introav\customize\display-view.ave for the file. Press OK.
Examine the code for few minutes before you proceed to the next step.

Step 3 Compile the program
Ready now to compile the program. Compile enables you to check for any syntax

errors in the codes. Click on the Compile tool [Z If you do not get any message, it
means the code has no syntax errors. You can even run the program to be sure it

works. Click on Run button . Go through the program. When you’re satisfied
close the script window.

Step 4 Using the compile code

In most cases you've to attach a compiled code to appropriate medium for use. The
medium can either be Menu, Button or Tool. This code will be attached to Button.
Open Customize dialog box. You did this in Step 2 of last section - Customizing
ArcView’s interface. Set Type field to View then chose Buttons as the Category.
Press the Separator button twice to create blank space. Press the New button to
create new button. Now go down and locate Click fiels. Double click on the space
provided at the right. Script Manager appears. From the Script Manager’s list of
compiled codes scroll to find the code you complied in Step 3 -
Display_View.training. Press OK. Double click for Help. Type in, Opens list of
view available on this project for the Input box that appears and Click OK. Likewise,
double click for Icon. Choose green diamond® then press OK. Close Customize
window.

Step 5 Open view window

Open one of the views you created in the last section. The button you just added will
appear at the button bar. Move the cursor over the button and look down at the status
bar. The text you typed for Help field appears.
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Step 6 Implement the program
Run the program from the View window now. Press the green diamond button. Use
few minutes to implement the program.

Step 7 Close the project
From the File menu click Close all. At the Project window, click File then Close
Project. When prompted to save the project press No.

7.7 Exploring ArcView’s system scripts
The best way to learn Avenue is by looking at the existing Avenue scripts. Some of
the sources of existing Avenue scripts are:

= ArcView Help

= Samples sub-folder in the main ESRI folder

= All ArcView's system scripts for menus, buttons and tool are accessible

Any of these scripts can be copied into the Script Editor window and be modified to
suit one need. You'll alter a system script in this exercise.

Estimated time to complete: 15 minutes

Step 1 Start ArcView
Start ArcView annd with the Views icon selected in the Project window, click the
New button to create a new view.

Step 2 Add a theme
Click the Add Theme button and navigate to \introav\customize and double click on
the Province theme. From the File menu click Close all.

Step 3 Create a new script form
In the project window select the Scripts icon and click the New button.

Step 4 Load script

Click the Load System Script button . You can also do the same by clicking on
Script then Load System Script...

Step 5 Add script to the editor

In the Script Manager dialog box that appears, scroll down to View.Identify. Select it
then click Ok. The script will appear in the Script Editor window.
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Step 6 Add another script

Place the cursor at the end of the script. Click the Load System Scripts button.
Scroll down and select View.ZoomInTool from the Script Manager that appears.
Click OK. The script will be added to end of View.Identify script.

Step 7 Compile the script
Click Compile button to compile the script.

Step 8 Change the name of the script
Select Script then Properties. Type New_Identify.view into the space for the Name
field.

Step 9 Associate the script with a button

Make the view active and double click on an empty part in the button or tool bar to
open the Customize dialog box. Select Views for Type field and Tools for Category
field. Double click on the input space for the Apply field. Select New_Identify.view
from the Script Manager dialog box and press OK.

Step 10 Close the Customize dialog box

Close the Customize dialog box. Open the view. Select the new button you’ve just
added and click on any feature of the theme. The Identify Results dialog box will
appear, the feature will flash, and the view will zoom in to the feature you selected.

Step 10 Close the project

You've just implemented simplest way to make use of existing ArcView's systems
scripts to suit your need. However, in most instances, you may have to alter the code
of the scripts you want to use. Close the project by selecting Close All from the File.
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Select Close Project from the File at the Project window. Do not save the project
when prompted to do so.

Self test
(1) A text filte can be a source for an event table.

@ True
c False

(2) You use the sams dialog to add XY events and linear events.
e True
C False

(3) The event theme attribute table is identical to the event source table.
e True
e False

{(4) Only a line theme can be created from a table containing address information.
c True

c False

(5) You cannot create themes from tables containing only latitude and longitude values.
C

c False

True

(6) ArcView uses the information in an event table to calculate XY locations and then draws
point features at those locations.

c True
e False

(7) You add an event theme by using this dialog.
c Create Events

C New Theme

c Add Event Theme

c Edit theme
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(8) In ArcView, locations stored in a tabular format and used to create theme features are
called:

e XY locators
e
e Events
¥ Points

Locators

(9) Event themes are automatically saved with your project as shapefiles.
E

e False

True

{10) Tables containing the locations of events are called:
* Event tables

c Event theme tables

e Event location tables

c Position tables
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Exercise 7
Using global positioning system (GPS)

GPS is a satellite-based radio-navigation system developed and operated by the U.S.
Department of Defense (DOD). GPS permits land, sea, and airbome users to
determine their three-dimensional position, velocity, and time 24 hours a day, in all
weather, anywhere in the world with a precision and accuracy far better than other
radio-navigation systems available today or in the foreseeable future. GPS consists of
three segments: space, control, and user. The GPS concept of operation is based upon
satellite ranging. Users figure their position on the earth by measuring their distance
from the group of satellites in space. The satellites act as precise reference points.
Each GPS satellite transmits an accurate position and time signal. The user's receiver
measures the time delay for the signal to reach the receiver, which is the direct
measure of the apparent range to the satellite. Measurements collected simultaneously
from four satellites are processed to solve for the three dimensions of position,
velocity and time. This tool is widely used in the agricultural research institutes. This
section focuses on the use of the tool.

7.1 Switching on the GPS and determination of Position
In this exercise you will use the GPS unit to locate the position of different fields and
calculate the area that they cover in ArcView. The objective is to provide you with a
step-by-step guide in collecting, downloading and querying your downloaded data in
ArcView. This exercise is written for the use of the GARMIN GPS 12 XL unit.

Step 1 Switch on the GPS

Press the Red button until the receiver turns on. The SATELLITE PAGE appears.
This page displays a map of the sky with each number representing the location of a
satellite within range. The Reception Graph undemeath the sky map displays for
each satellite the reception status (L| connection made; 8 lock-on achieved) and
strength is indicated by the length of bar. Generally, this page allows you to monitor
satellite signal reception and strength. Once the GPS is locked on to three satellites
with optimal reception, the next navigational screen appears, the POSITION PAGE.
This page display will give you

Latitude

Longitude

Elevation

Time and Date
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Note

Before starting recording data, check that the received signal is sufficiently strong (on your GPS, first screen:
check number of connected satellites [filled lines] and estimated position error [EPE]) the EPE should nol
exceed 5m. If the error keeps being higher than that, you probably have to move lo a betler location, wait until
the signal improves and then move back to the original location. Notice that the quality of the signal is
influenced by ground cover (trees) and nearby buildings (so, try to avoid collecting points too close to them).

Keep the GPS receiver always on, even if you are driving to a new location and/or are not recording data.
Keep a paper log of the data you record and of any particular feature you encounter during the point collection
that could help in the mapping process, e.g., the field runs along a path, track, road, a village boundary line. If
two or more fields share some boundary points, you should note it. If two fields are close to each other but do
not adjoin, you should also note down what separates the fields from each other. On the spot skelching of the
field shape and of other peculiarilies could also be useful (not the least for your own recollection of what you
have observed in case of doubt).

Plotting techniques:

Tracking

Pros:

It automatically records all your whereabouts (up to 1024 points).

It is an easy way lo record the boundary lines; you just follow them. Since tracking does not use the
waypoint memory, it allows you to collect separately waypoints to highlight specific features encountered
along the path (you should in any case take a point whenever you reach a comer of the field). If you
follow all the boundaries, extra information about shared borders is not required (the common border will
show on the track).

Since it records data in a continuous way, it allows for field geometry checking.

Cons:

If you or the person accompanying you is not sure of the boundaries to follow, you should tumn the
receiver off.

If for some reason you happen to wander all around the field before you get to the boundary line, then,
you either have to remove manually the unnecessary paints or you have to mark the correct walking path
by sloring supplementary waypoins. _

If you are mapping fields, which are separate from each other, you should deactivate tracking when
moving from a field to the next one. This is to avoid spurious point data collection.

Waypoints are not stored in the same file as track points, so you have to download two sets of dala.

Waypoints only

This can be an option if you can reach the comers of the fields by any other way than walking along the
boundary lines, e.g., the field is too large, there is a track that can easily bring you lo the opposite end of it by
car, and you are sure that the field has a regular shape. you should also use it, if your GPS receiver does not
allow for tracking. Another possible reason is that you are surveying part of the field on one day, part on
another day, and you start doing it from different locations, elc.

Pros:
It keeps your data files smaller and you only need to download one file.
You are (or should be) aware of when and where you mark the point so that you can easily record the
spatial fealure relafive lo the point.

Cons:
Single readings of a location can sometimes be incorrect. This results in an incorrect geometry of the
field.

It requires full records of the relevant spatial fealures, e.g., comer point, shared point, elc, and a ful
reference fo the field or fields the point belong to.

= ‘[Formntted: Bullets and Numbering
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Step 2 Marking your position

The main purpose of using GPS is to mark our positions. Keep the GPS unit for a
minimum of 30 seconds in one location, until coordinaes and altitude don’t change.
Note: By returning to the SATELLITE PAGE using either QUIT or PAGE, you can
check the current reception status as an additional indication of the accuracy of your
reading. This does not affect your averaging period. Press the button MARK once.
The MARK POSITION page will appear, with a default 3-digit name for your

present position in the upper-leRt portion of the page.

Step 3 Averaging

The GPS 12XL has positioning average function. This helps to reduce the effects of
Selective Availability (SA) error. You can therefore use this option before saving
your position. Highlight the AVERAGE? Field and press ENTER. The Figure of
Merit (FOM) field appears and a value will be displayed. Wait until this value
stabilizes before going to the next step.

Step 4 Rename (optional)

If you want you can rename the default name for a position marked otherwise go to
the next step. With the DOWN V¥ and UP A buttons, highlight the name field and
press ENTER. Enter the name GRP and press ENTER.

Step 5 Save

With the DOWN V¥ and UP A buttons, highlight SAVE and press ENTER. Your
position is now saved to the memory, and you will return to the previous Navigational
Screen. You can scroll through the different elements of the MARK display with the
DOWN V¥ and UP A buttons.

Note: The arrow button is used for all data entry. Use the A and ¥ buttons to select
letters, numbers, and menu options; use the P and <« buttons to move the cursor
forward or backward along the line. Use ENTER button to confirm your entry.

Step 6 Mark another position
Repeat Steps 2-5 for each position that you are measuring.

7.2 Downloading data from GPS

Afier you might have taken all the points with the GPS in the field, the data must be
transferred from the GPS to the computer for plotting. This section explains how to
accomplish this task.

Step 1 Run the program

Link the GPS unit with the COM1 or the COM2 serial port in your PC. Switch on the
GPS. Double click on file \introav\gps\g7towin.cxe. A window similar to below
appears. This program can be downloaded from http://home.attbi.com/~g7towin/
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Step 2 Download waypoints from GPS

Click on Waypoints and select Download Waypoints from GPS. In the status bar at
the middle of the screen, the status of the downloading process can be followed. Once
all waypoints are downloaded, the GPS unit can be switched off. The points also can
be downloaded via GPS menu.

Step 3 Save the Downloaded waypoints

Click on File and select Save As. From the dialog box that appears go to the temp
folder on your local hard disk and select it for Save In option. Type gps_data for File
name. Leave the format of the output as txt.

Step 3 Formatting the downloaded data

Starts Excel application. Click on File then Open. Specify the folder where you saved
the data you downloaded from the GPS for Look In option. Click on the file at the
File Name. If necessary you may need to specify txt format for Files of type. Click
Open. From the dialog box that appears next, accept all the defaults option except
Start import at row. For this option, type equivalent line number of row of ID 001
inside the input box. Click Next. Follow example from the below screen to complete
the next dialog box.



Text Import Wizard - Step 2 of 3

This scraen lets you set field widths (column breaks).

Lines with arrows signify a column break.

To CREATE a break line, click at the desired position.
To DELETE a break line, double click on the line.

To MOVYE a break line, click and drag it.
Datapreview = b
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Arrangement of imported GPS data into columns in Excel sofiware interface

Click Finish to complete the import. While at the workbook remove all the columns
except the location ID and coordinates (see below figure). When finished, save the

changes made to the file and exit Excel.
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7.3 Import GPS points into GIS software

The data imported and formatted need to be imported into a GIS software for plotting
and analysis. This is what this section is all about. You will use ArcView to do this
task.

Step 1 Open ArcView

Open your ArcView. In the Project window, click TABLES icon and click on Add.
Select Delimited Text(*.txt) then select the file you saved in Step 3 of the last
section (downloading). If necessary, close the Table document.

Step 2 Create a new view
In the Project window, click on Views and click on New.

Step 3 Create point coordinates

With the Viewl window on the foreground, click View then Add Event Theme.
Select the file you just added to the project. Select Easting and Northing for X and Y
fields respectively and press OK. Your waypoint file now appears in the Table of
Contents (TOC) of Viewl. Turn on the display of the theme to show your points.
Your points now show up on the map in mono-color circles. If they don't appear
within the view, click on the button "Zoom to Full Extent” and zoom in again to your
selected theme.

Step 4 Edit the point symbol
Double-click on the theme in the TOC to show the LEGEND EDITOR window.
Double-cllck on the Symbol. The PALETTE window opens. Click on the MARKER

palette Select the green circle with a black border. From the Size pull-down
menu, choose size 6. Click on the button for the COLOR palette. From the Color;
pull-down menu, select Foreground and choose Yellow as color. Close the
PALETTE window. In the LEGEND EDITOR window, Click Apply then close the
window.

7.4 Create polygons from points

Now that your points are in ArcView, we can make lines and polygons from these
points. In this example, we will create a shapefile, which consists of the polygons of
different fields, and calculate the surface area and perimeter length in meters, for each
field. Furthermore, we will use an extension (Xtool) to do this.

Step 1 Load the extension

Copy the file on \introav\gps\xtools.avx into the Ext sub-folder of Esri main folder
on your local hard disk. Click File - Extensions. Scroll to Xtools extension and Mark
it. Click OK.



Step 2 Select points.
Open the table of the point theme. Select the four points that constitute a field. Close
the table.

Step 3 Join the points

Click on Xtools then click on Make One Polygon from Points. Select the point
theme name if not the one selected for the first dialog box that appears. In the
second dialog box that appears, type in Fieldl for File Name (1 denotes the first field
being made). Appropriate number should be given here for the number of field being
made e.g. the second field will be 2 and so on). Save this file on your temp file. Click
OK. A theme named Field(x) is added to your TOC. Click on the theme to draw it on
the view.

Step 4 Repeat steps 2and 3
Repeat Step 2 and Step 3 for all other fields you measured in the field.

Step 5 Merge the polygons into one file

Click on File then Extensions. Scroll to the extension Geoprocessing, then Mark it.
Click OK. Click View then Geoprocessing Wizard. From the dialog box, select
Merge themes together. Click Next. From the dialog box that follows, for (1, select
all the field polygons name you created) and for (2, save the output file to your
temp folder as Fields). Click Finish. A new theme Fields is added to your view.
Click on it to draw it on the view. Your fields are in one file but the table now has a
record corresponding to the number of the field merged.

7.5 Determine areas of polygons

To calculate the length and area of features in ArcView, you first have to change the
View to an equal-area projection and to define what units of length you are using.
Moreover, the program you’ll use for this task is coded using Avenue of ArcView.
You'll need to attach this program to a button on a view.

Step 1 Load avenue program
Close View window. Select Scripts on the Project menu then select New. Click
Script and select Load Text File. Highlight this file from \introav\gps\ calcacre.ave.

Click OK. Click Compile tool to compile the program. Select Script then
Propertics. Type Area-calculation.view for the script name and then press OK.
Close the Script window.

Step 2 Attach the program to a button

Double click on any blank portion of the Project button bar to open Customize
window. Choose View for Type and Buttons for Category. Click New to create new
button to hold the program. Double click Click and select Area-calculation.view as
the program to be executed when the button is clicked. You can even assign an icon to
the button. Close the Customize window. Open View window. Check to confirm that
the button had been attached to the button bar.
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Step 3 Select a projection for the view
With the View window that contains your polygons active, select View then
Properties. In the window View Properties, , for both Map Units and Distance Units

Note:

If your data are not collected using UTM coordinate then you must project the
view before proceeding to the next step. In the window View /properties, select
Projection then select UTM and the appropriate zone

choose meters. Click OK to return to View window.

Step 4 Calculate an area

With the View1 window active, click the button you just added. This will calculate
Area and Perimeter for each of your polygons. The result of the area calculation is
stored in the table of your theme. Click Open Theme Table button to view the result.

7.6 Editing polygons

Features such as polygons and lines can be edited to fit reality. Such edits that you can
do include splitting a polygon. You will do this in this exercise to conclude our
discussion on use of GPS.

Step 1 Make the theme editable
With the View1 window active, select your shapefile in the TOC. Click Theme then
click Start Editing. You are now ready to split your polygon into parts.

Step 2 Select from draw tool

Click then pull down the Draw tool ?‘. and Select Polygon split button ]E] Draw a
line through the polygon as in (a). Double click when you are finished. The resulting
polygons will look like (B) after you double clicked. Open the theme table. A new
record with empty record is created for the new polygon

(a) (b)
Step 3 Update the area and perimeter data
You can now update the area and perimeter data. Follow Step 4 of the section 8.5 to

do this.

Step 4 Close ArcView
Close all documents and exit from ArcView.
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Exercise 8

Using ArcView Spatial Analyst

ArcView Spatial Analyst (SA) works with Grid (raster) data sources unlike ArcView
GIS that works with feature data sources. In this section, you'll leam how to display
and manage grid themes, and how to create and explore new data.

8.1 Using grid themes

You'll will load SA extension and add grid theme to a new view. In addition, you'll
display and query the grid themes you added, and learn about how to create and save
new themes from the existing ones.

Step 1 Start ArcView
Start ArcView. At the Project window, from the File menu choose Extensions.
Scroll to Spatial Analyst and the check the box against it. Press OK. Choose View

icons at the left of the Project window. Click New to open a new view.
2 Extensions L x|
Avadable Exensions.
| MISID Image Support Al oK ]
NITF Image Suppont |
| Poini-Profler
| Projection Utity Wizard
| Repot Witer J Resel |
¥l SpatalAnsiyt ™ Make Defaut
| TIFF B0 Image Suppest -.J
About:

Step 2 Add and draw a grid theme

From the View window press the Add button . At the Add Theme dialog box
that appears, choose Grid Data Source for Data Source Type. Now, navigate to the
\introsa\sa. Double click on elevgrad. An elevation grid theme will be added to the
view. Click on the theme to draw it.

Step 3 Change the colors of the legend

There are specialized color ramps provided in the ArcView’s system you could use to
change the color of your legend. Double click on the Elevgrd in the TOC (Table of
Contents) to display the Legend Editor. Click the Classify button and change the
number of classes to 7 in the Classification dialog box. Press Ok. Scroll down the
Color Ramps field and select Elevation #2. Click Apply and close Legend Editor.
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Step 4 Enhance the display

Creating a composite display of themes can enhance your map. Here, you can use
elevation theme as the color and hillside values of elevation as the brightness. Add
hillshd to the view from \introsa\sa. Double click again on the elevgrd in the TOC to
display the Legend Editor. Press the Advanced button on the Legend Editor. Choose
hillshd as for Brightness Theme field. Accept the default value for Minimum Cell
Brightness and Maximum Cell Brightness by pressing OK on the Advanced Options
dialog box. Press Apply on the Legend Editor and close it.

Note:

A grid data source is a raster data set comprised rows and columns of data. A grid
data set can either be based on integer or floating point. An integer based grid data
set has an associated table like feature data source. However, a floating point

based grid data set is not associated with table. Hence, the Open Table button
is not always available even when the theme is active. One way to examine data in
grid data set based on floating point is by viewing the distribution of data.

Step 5 Examine the data distribution

Clickk on elevegrd theme to make it active. Click the Histogram button @
Examine the graph. The x-axis displays the classes in the theme’s legend, and the y-
axis shows the number of cells, in the theme for each class. Close the Histogram of
Elevgrd window.

Step 6 Examine data distribution within a selected area

Create a shape with Draw tool @ on the view. Click on the Elevgrd theme to make
itactive. Click the Histogram button.

Note:
The tools you use to view data on feature data sets can also be used on grid theme
based on integer.

Step 7 Derive new themes

Analyzing existing grid theme can help you to create new grid themes. For example,
we can derive new slope theme from our elevgrd theme. Let do it. Make elevgrd
theme active by clicking it. From the Surface menu choose Derive Slope. Click on
the new theme created to draw it. It is easy.

Step 8 Rename the new theme

Make the slope theme active. From the Theme menu choose Properties. Change the
theme name to Slope. Close the Theme Properties dialog box. The theme name had
changed to Slope.
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Step 9 Save the new theme
Make the Slope theme active. From the Theme menu choose Save Data Set. On the
Save Data Set dialog box that appears specify \introsa\sa\Slope_new and click OK.

Note:

SA stores a grid data set in a separate folder (directory). Besides this, SA also
stores specific information on each grid data set in a folder called INFO. Because
of this, you cannot rename, copy, or delete grid data sets using your Operating
System similar functions. Use Managing Data Sources...module of SA to do any of

Step 10 Convert themes

In some case you might want to convert floating point theme into groups or integer.
This will enable you to work with the associated table. Make the Slope theme active.
From the Analysis menu, click Reclassify. From the Reclassify Values dialog box;
click Classify. Change the Number of Classes to 5 and press OK. Press Ok on the
Reclassify Values dialog box. Now open the table of the new theme. The classes
were just numbered. You will convert Slope into an integer-based theme in the next
step.

Step 11 Convert into integer

From the File menu, click on Export Data Source. Click OK on the Export File
Type dialog box. From the Export Grids dialog box specify Slope_new you saved
in Step 9 and press OK. On the Export File: dialog box type in Slope_asc for the
File Name. For Directories and Drives, specify /introsa/sa. Again, from the File
menu click on Import Data sources. Click OK for Import Data Source dialog box.
Specify Slope_asc for the File Name and press OK on Import ASCII Raster Files
dialog box. On the Output Grid: dialog, type in Slope_int for Grid Name and
\introsa\sa for drive and directory. Click Yes to convert the data into an integer. Click
Yes to add the grid to the view. Check the new theme.

Step 12 Explore the table
As indicated earlier on, once you have a grid theme data based on integer, a table is
associated. You can therefore manipulate the table, as you want. Make Slope_int

theme active. Click on the Open Table button Click on the Select tool E.
Select a row in the table by clicking the cursor in that row. Multiple areas of the map
are selected and highlighted. It means that the selected areas have a value clicked on
the table. At this stage close the project. Do not save.
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8.2 Creating and analyzing surface data

ArcView Analyst was developed purposely to provide tools and concepts for solving
spatial problems. You’ll use field data to solve a spatial problem in this section.
Subsequent sections deal more on this. The underline problem in this section is that a
farmer wants to understand soil chemistry of his farm so as to know how to apply
right quantity of chemicals. You'll use point data to create a surface of potassium
content of the soil in the farm. Subsequently, you'll generate contours that will show
areas of potassium deficiency.

Step 1 Load data into a new view

If necessary, start ArcView and load SA extensions. Open a new view. Add the
shapefile soilmap.shp in your /introsa/sa. Likewise add farm_bnd.shp Check the
themes to draw it.

Step 2 Create surface from point data

Looking at the point theme drawn on the view, you'll find out that the data scattered
across the farm. We need to create a data for other areas in the field where there are
no data. Make soilmap theme active. From the Surface menu choose Interpolate
Grid. On the Output Grid Specification dialog, from the list on Output Grid
Extent choose Same as farm_bnd, change Number of Rows to 100, click OK. On
the Interpolate Surface dialog, set Method to Spline, Z Value Field to Seil_k. Click
OK. Check the newly created theme to draw it.

Step 3 Create contours of a surface

Make Surface from soilmap theme active. From the Surface menu choose Create
Contours. From the Contour Parameter dialog change the Contour interval to 100
and click OK on the dialog box. Draw the newly created theme.

Step 4 Determine areas below critical value
Make the Contours theme active. Let assume the minimum potassium desirable is

300. Click on the Query Builder tool . To see the all the areas below 300,
construct the query as shown below.

(TCortou] < 300] 2] et ]

Add To Set I
v Select From Set |
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Uncheck all themes except Contours and farm_bnd themes. The highlighted areas
have potassium content lower than 300. Close the project.

Spatial analysis
In the last topic you worked with grid themes and used some of the built-in tools of
SA.

Types of spatial analysis vary from simple to sophisticated. Spatial analysis canl be divided
into six categories: queries and reasoning, measurements, transformations, descriptive
summaries, optimization, and hypothesis testing.

Queries and reasoning are the most basic of analysis operations, in which the GIS is used
to answer simple questions posed by the user. No changes occur in the database and no
new data are produced.

Measurements are simple numerical values that describe aspects of geographic data. They
include measurement of simple properties of objects, such as length, area, or shape, and of
the relationships between pairs of objects, such as distance or direction.

Transformations are simple methods of spatial analysis that change data sets by combining
them or comparing them to obtain new data sets and eventually new insights.
Transformations use simple geometric, arithmetic, or logical rules, and they include
operations that convert raster data to vector data or vice versa. They may also create fields
from collections of objects or detect collections of objects in fields.

Descriptive summaries attempt to capture the essence of a data set in one or two numbers.
They are the spatial equivalent of the descriptive statistics commonly used in statistical
analysis, including the mean and standard deviation.

Optimization techniques are normative in nature, designed to select ideal locations for
objects given certain well defined criteria. They are widely used in market research, in the
package delivery industry, and in a host of other applications.

Hypothesis testing focuses on the process of reasoning from the results of a limited sample
to make generalizations about an entire population. It allows us, for example, to determine
whether a patter of points could have arisen by chance based on the information from a
sample. Hypothesis testing is the basis of inferential statistics and forms the core of
statistical analysis, but its use with spatial data can be problematic.

In this section you will make use of other numerous tools in SA to solve spatial
problems. The problems you'll tackle here are hypothetical but good for propping you
to solve your immediate problems and asking more questions. We'll deal mainly with
suitability and more on surface analyses mapping.

8.3 Customer suitability

In order to eliminate the menace of middlemen in the cost of apple production,
farmers were encouraged to come together and to set up stores in urban areas and sell
their products through these stores. A study was carried out on the performances of
these stores by a private market survey organization. In the study it was found that 20
— 40 year old with above average education and income are potential customers to be
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targeted. It was also shown that people prefer stores nearer to their homes. The
farmers wanted to know if the kind of people living near these stores meets these
criteria. The outcome of this will help them to make decision on what to do with the
stores.

Step 1 Load the SA extension
If necessary, start ArcView. At the Project window, from the File menu choose
Extensions. Click in the check box labeled Spatial Analyst the click Ok.

Step 2 Open a new view

Choose Views icon at the left of the Project window. Click New to open a new
view. From the View menu choose Properties. Set the Map Units of the view to
meters. Click OK.

Step 3 Load necessary data into the view

At the View window, press the Add Theme button @ Navigate to \introsa and
double click on the sa folder. Choose Feature Data Source as the Data Source Type.
Press Shift key then select these 3 themes — Lifestyle.shp, Pop.shp, and Stores.shp.
Check both Lifestyle and Stores theme so as to draw them. You may need to
rearrange the 2 themes for you to see both drawn themes.

Step 4 Create a map of distance from stores

Make the Store theme active. From the Analysis menu, choose Find Distance Select
Same as Lifestyle.shp for the Output Grid Extent and type in 250 as the Output
Grid Cell Size. Click OK. Draw the newly created Distance to Stores.shp theme.
Move the Store theme up in the TOC. You now have a continuous map of distance
from all locations to the stores.

Step 5 Reclassify to obtain a map of stores within the limit of customers

Click on the Distance to Stores to make it active. From the Analysis menu choose
Reclassify. On the Reclassify Values dialog box, click Classify button. For the
Classification dialog box, change Number of Classes to 2 then click OK. When
you're back to the Reclassify Values dialog box, in the first class range of the Old
Values, type 0 — 3000 and press Enter key. Click on the corresponding New Value
of the range and type 1 then press Enter key. For the second class range of the Old
values, type 3000 — 40000 and press Enter key. Type 0 for its New Value and press
Enter key. Click OK on the Reclassify Values dialog box then draw the new theme —
Reclass of Distance to Stores.shp. You now have a map showing all the stores and
suitable areas for trading. The next step is to find out if the potential customers are
within the area in each store.

Step 6 Lifestyle data
The Lifestyle theme you added earlier has all you need to map the kind of customers
the farmer’s need. Let look at the table associated with theme. Make the Lifestyle

theme active. Click on the Open Table button . The t three fields (Hh-seg8, Hh-



segl5, and Hh-seg37) represent the type of customer needed. The groups are referred
to by the Market Analysts as “Movers and shakers”, “Great beginnings”, and Urban
Up and Comers” respectively. The field Total represents the total number of people
sampled for the area. The last field Tot_% is the percentage of people that falls into
the right customers. This field was calculated by summing the 3 fields that describe
the customers then divided by the Total field (normalizing the data) and multiplied by
100 to get the percent value. Close the table.

Step 7 Convert to grid

We need to convert the Lifestyle theme to grid. Tum off display of all themes except
Lifestyle theme. From the Theme menu choose Convert to Grid. On the dialog that
appears, type Customer for the Grid Name and navigate to \introsa\sa for
directories and press OK. From the Conversion Extent dialog box, select Same As
Distance to Stores.shp for Qutput Grid Extent and press OK. Choose Tot_% field
for the Pick field for cell values on the Conversion field dialog box and press OK.
Click Yes to add the new theme to the view. Scroll up the TOC and turn on the new
theme.

Step 8 Create a suitability map of good customers

Click on the Customer theme to make it active and make sure all the themes except
Customer theme is on. From the Analysis menus choose Reclassify. Click the
Classify button on the Reclassify Values dialog box. Change Number of Classes to
10 then click OK. Click Ok on the Reclassify Values dialog box. Double click on
the Reclass of Customer theme to open the Legend editor. Change the Legend Type
to Graduated Color. Click the Classify button and change the Number of Classes to
10 then press OK. Choose Value as the Classification field, click Apply then close
the Legend Editor.

Step 9 Rearrange the themes

Rearrange the theme so that Store theme will at top follow by Distance to Store theme
then Reclass of Customer theme. Make the Store theme active then open its table.
Select all records with negative revenues. What can you deduce from this analysis?
Do not close this project.

8.4 Population suitability

The result from our last analysis for the 3 stores with negative revenues was that they
are not within the limit of good customers. However, for the other 3 stores do we
know if enough people are in the area? Hence, we need the population suitability map
to answer this question. Particularly, we need a population density map of the area to
do this task and this is exactly what we will attempt in this section.

Step 1 Prepare your theme

Turn off the display of all themes. Scroll down the TOC and make the Pop theme
active then tumn it on.
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Step 2 Create a population density theme

From the Analysis menu choose Calculate Density. From the dialog box that appears
let the Output Grid Extent and Cell Size to be the same as Customer theme then
press OK. When the Calculate Density dialog box appears, choose Popl100 in
Population Field list, type in 3000 as the Search Radius, Kernel as the Density Type
and Square Kilometer as Area Units then click OK. Scroll to the top of the TOC and
turn on the new theme.

Step 3 Chart the population density with each profitable store area

Let take a clue from the stores that are profitable to determine the population needed
to make a store profitable. We will therefore use the results to reclassify the
population density. Click on Stores theme to make it active. Make sure the 3
profitable stores are still selected. Double click on the Store theme to open the legend
Editor. Change the Legend Type to Unique Values, the Values Field to Storename,
click Apply then close the Legend Editor. From the Analysis menu, choose
Summarize Zones. From the Summarize Zones dialog box, choose Storename as
the field defining the zone then click OK. From the next dialog box, choose Density
from Pop.shp as the theme to be summarized and click OK. Next choose Max as the
statistic to chart, click OK from the last dialog box. See the chart below.

Values of Density from Pop.shp Summarized Within the Zones of
Stores.shp

2000
1800

1800
1700 [J.Joe's Calming Ground

Max of Density from Pop.shp O Joe's Nervous Pastry
1500 O Joe's Java Gentry

1400
1300
1200
1100

Zones

Step 4 Classify the population density

The chart will now enable us to determine the lower and upper limit of population
density needed for a store to break even. From the chart, we can see that the minimum
population density is around 1200 while the upper equivalent is about 2000. It implies
that areas where the population density is below 1200 people per square kilometer are
not suitable. Likewise, areas close to and over 2000 people per square kilometer are
highly suitable. We can therefore say 0 — 1000 = not suitable, 1000 — 1400
=Suitable, 1400 — 1900 = more suitable and 1900 — 3000 = most suitable.

Step 5 Create the population density map

Turn off all the themes. Click on the Density from Pop theme to make it active. From
the Analysis menu choose Reclassify. Click the Classify button on the Reclassify
Values dialog box and change Number of Classes to 4 then Click OK. Enter the
following sets of Old values ranges = New Values: 0 — 1000 = 1, 1000 - 1400 = 2,
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1400 — 1900 = 3, 1900 — 3000 = 4. Click OK on Reclassify Values dialog box.
Double click on the new theme created — Reclass of Density from Pop.shp to open
the Legend Editor. Change the Legend Type to Graduated Color. Click the Classify
button and change the Number of Classes to 4 and press OK. Choose Values as
Classification Field. Enter for Label as following: 1 = Not suitable, 2 = Suitable, 3 =
More suitable and 4 = Most suitable. Click Apply and close the Legend Editor. Turn
on the display of Reclass of Density from Pop.shp theme. What can you deduce from
this map?

8.5 Distances suitability

The maps created so far were presented to the committee and during one of its
deliberation it was decided new store will be opened in the favorable areas. However,
the existing stores will be maintained but new one to be established should be at least
3 Km far away from the old ones. To answer this question once again you need to
produce a distances suitability map. You'll reclassify Distance to Stores.shp created
earlier on from Stores.shp to do this task. The new classification will be as follows: 0
- 6000 = 7 6000 — 40000=10

Step 1 Find distance to stores map

Tum off the display of all themes. Scroll down and click on the Distance to
Stores.shp to make it active. If you do not have this then create it again by following
Step 5 of Customer suitability mapping section.

Step 2 Reclassify the theme

From the Analysis menu choose Reclassify. Click the Classify button on the
Reclassify Values dialog box. Change Number of Classes to 2 then click OK. Enter
the following sets of Old values = New values: 0 - 6000 = 7 and 60000 — 99999 = 10.
Click OK.

Step 3 Label the new theme

Double click on the new Reclass of Distance to Stores.shp theme to open the Legend
Editor. Change the Legend Type to Graduated Color. Click on Classify and change
Number of Classes to 2. Choose Values as the Classification Field. Enter the
following for the Label: 1 = Not suitable location and 2 = Suitable location then
click Apply to close the Legend Editor. Tumn on the display of the theme. From this
map you should be able to discern possible areas the new stores can be established.

8.6 Suitable areas

You now have three weighted grid themes representing the high percentages of good
customers, high population density, and distances away from existing stores. These
three maps can be combined to obtain ranked suitable areas. We can do this by adding
the three themes together then dividing the result by 3. Let do this.

Step 1 Combine the three themes

Turn of all the themes. From the Analysis menu choose Map Calculator. Expand the
Map Calculator window so that the full names of the themes can be seen. Double
click on [Reclass of Distance to Stores.shp] from the layers list. Click the Addition
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button . Double click on [Reclass of Density from Pop.shp]. Click the addition
button. Lastly, double click on [Reclass of buyer] then click the addition button.

Now click to the right of expression box. Click on division button then type in 3
or click the number 3 button. Click on the Evaluate button then close the Map
Calculator dialog box.

Step 2 Reclassify the new theme

Double click on the newly created theme (Map Calculationl) in TOC to open the
Legend Editor. Change the Legend Type to Graduated Color. Click the Classify
button and change the Number of Classes to 7 and click OK. Choose Value as the
Classification field, click Apply then close the Legend Editor.

Step 3 Turn on the display of the theme
Tum on the display of ranked suitability map. The best sites to locate new stores are
areas with values closer to 10.

8.7 Surfaces of crop yield

We focused mainly on suitability mapping in our previous exercises. We’ll now look
at surfaces analysis. This is a common thing we do in agricultural researches.
Particularly, the use of SA to create and analyze raster themes of continuous surfaces
will be examined.

Step I Open a new view

Close any project in the ArcView. ON the Project window, from File menu choose
New Project. Choose Views icons at the left of the project window. From the View
menu, choose Properties and set the Map Units to meters. Click OK to close View
Properties window.

Step 2 Load a text file of crop yield into the view

Make the Project window Active, choose Tables icon @ then click Add from the
Project menu. Change the List Files of Types to Delimited Text(*.txt). For
Directories and Drives go to \introsa\sa then highlight yield.txt then press OK. Close
the Table. Make the View window active then choose Add Event Theme from the
View menu. Set Table to yield.txt, X field to X_coord, and Y field to Y_coord then
press OK on Add Event Theme window. Tumn on the display of Yield.txt theme.

Step 3 Create a surface of cru%i,eld

Click the Add Theme button and navigate to \introsa\sa. Highlight the theme
Thefarm and press OK. This theme will be the geographic extent of our study. Click
on the Yield.txt to display if you've not done so before. From the Surface menu,
choose Interpolate Grid, On the Output Grid Specification dialog box, set the
Output Grid Extent to be Same As Thefarm.shp, set Cell Size to 3 meters, then
Click OK. Set Method to Spline, Z Value Field to Yield and Weight to 0.01 then
Click OK. Display the new theme — Surface from Yield.txt.
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Step 4 Reclassify yield surface

Click on the Surface from the Yield.txt to make it active. Choose Reclassify from
the Analysis menu. Click the Classify button then enter in 5 in the Classification
dialog box for the Number of Classes and click OK. Click OK on the Reclassify
Values window. This will reclassify the yield surface. Turn on the Reclass of Surface
from Yield.txt. Double click on its legend to bring up the Legend Editor. Set the
Legend Type to Graduated Color, Classification Field to Value, and Color Ramps to
Green monochromatic. Click Apply, and close the Legend Editor window. Which
areas show the highest crop yield?

Step 5 Create a contour map

The nature of the farm’s terrain plays significant role in yield distribution. So let
examine this. Click Add Theme button then navigate to \introsa\sa and choose Grid
Data Source as the Data Source Type. Double click on dem to add it as theme. Tum
on the theme Dem. Click on Dem to make it active. From the Surface menu choose
Create Contours. Accept the default values from the dialog box that appears by
pressing OK. Draw the new theme — Contours of Dem. What is your opinion about
the theme?

Step 6 Create a map of slope

Turn off the display of the Contours of Dem. Make Dem theme active. From the
Surface menu choose Derive Slope. Now draw the newly created grid theme Slope
of Dem. We can see now areas of steepest slope and the flatter areas, which are
indicators of erosion and deposition respectively.

Step 7 Create a map of aspect

The major limiting factor of crop yields in the Northern Hemisphere is sunlight. A
southerly aspect with enough moisture will likely yield more because it gets more
sunlight. So let create the aspect of this farm. Turn off the display of Slope of Dem
theme. Make Dem theme active. From the Surface menu choose Derive Aspect.
Draw the newly created theme — Aspect of Dem.

Step 8 Check the relationship between yield and aspect

Let examine the relationship among the variables we've produced so far. First let see
the relationship between yield and aspect then you can do the same thing for
relationship between yield and slope. Double click on the Aspect of Dem to open the
Legend Editor. Click the Classify button and set the Number of Classes to 12 then
click OK in the Classification dialog box. Set Color Ramps to Full Spectrum and
click Apply. Close the Legend Editor. Click on Reclass of Surface from Yield.txt
to make it active. Choose Histogram By Zone from the Analysis menu. From the
dialog box that appears choose Value as the field that defines the zones and click OK.
From the next dialog box choose Aspect of Dem as the theme defining the value to
chart. Now expand the window so that the full chart may be observed. What
deduction can you make from the chart?
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8. 8 Soil chemistry and crop yield

We've seen from the last section how the knowledge of relationship between yield
and terrains can help us to make good decision on farming. Besides this, the
application of chemicals is also germane to successful farming. We will look at the
organic content (OC) of soil — OC determines the water holding capacity of soil as
well as source of nutrients to crops. Potassium is also very important. It improves
absorption and use of soil nutrients and also improves drought and disease resistance.

Step I Load necessary data

Make the View active by clicking at the window. Turn off the display of all themes.
Click the Add Theme button then change the Data Source Types to Feature Data
Source. Navigate to \introsa\sa\ and add shapefile soilmapshp to the view. Turn on
the display of the Soilmap.shp theme.

Step 2 Create a surface of organic matter

Make Soilmap.shp theme active. From the Surface menu choose Interpolate Grid.
On the Output Grid Specification dialog box set the Qutput Grid Extent and Output
Grid Cell Size to be Same as Dem. Click OK. From the next dialog box that appears,
set Method to Spline, Z Value Field to Organic_m then clicks OK. Make the new
theme active by clicking on it. From the Theme menu, choose Properties. Change
the theme name to Organic matter then click OK. Turn on the new theme Organic
matter. Can you comment on this?

Step 3 Examine the relationship between OC and yield

Click on the Reclass of Surface from Yieldtxt to make it active. Choose
Summarize Zones from the Analysis menu. From the Summarize Zones dialog box,
choose Organic matter as the theme to summarize. From the next dialog box, select
Mean as the statistic to chart. Do you have any Comment(s) on the chart?

Step 4 Create a surface of potassium

Do Step 2 once again. When you get to Z Value Field, set the field to Seil_k. Change
the new theme name to Potassium content then draw the theme. Can you make any
comment(s) on this theme?

Step 5 Examine the relationship between potassium and yield
Follow Step 3 for this step also. What can you say about this chart also?

Step 6 Close ArcView
Close the view. Choose Exit on the Project menu. Do not save your project when
prompted to do so.

8.9 Using functions in SA

Most of the functions available in SA are not included in the interface. These
functions, which are not available, can only be used through Avenue programming,
You’ve learnt a little bit on how to use Avenue in previous exercise. In this exercise,
you'll use an Avenue program to generate watersheds for Syria.
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Step 1 Import an Avenue program
If the ArcView is not running, start it. Make Spatial Analyst extensions available to

ArcView. Click on Scripts ..  document button then click New. Click on Script
then Load Text File. Navigate to \introsa\sa\ and click on file wshed.ave Click OK to
accept the file. A program will be loaded onto your script window now.

Step 2 Change the name of the script

Click on Script then Properties. On the dialog box that appears type in Generate-
Wshed against the Name field. You can peruse the program for a short while before
proceeding to the next step.

Step 3 Compile the program

Click on the Compile the seript button . If you do not receive any error
messages, close the script window and move to the next step. If you receive any error
messages, try to [ix it and compile again.

Step 4 Assign the compiled program to a button

Double click on any blank area of either buttons or tools bars. Set the Customize
dialog box that appears using the below form. You should be able to do this with ease
as you've done this in one of the previous exercises.

wshed-modelapr

¢ Customize:

| Tope: [View ~]  Ed. |
1" Category: [Buttons =]
|

FE ® EE® m%;

New I Separator I Delete |

After you've finished the setting close the Customize window.
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Step 5 Create a view

Click on Views document button then click New. A View] window will be

displayed. Click Add button . Change Data Source Types to Grid data Source
then navigate to /introsa/sa and click on Syria_dem. Click Ok to add the grid theme
onto your view. Now again change the Data Source Types to Features data Source
then navigate to /introsa/sa and click on Syria_major-rivers.

Step 6 Run the program

Move the theme Syria_dem up the TOC and click it to make it active. Now click on
the blue diamond button you created in Step 4. Wait until a new grid theme is added
onto your view.

Step 7 Examine the new theme

Click the Check box near the new grid theme to turn it on. Do it to the Syria_major-
rivers theme also. Examine the watersheds generated from the DEM and the network
of major rivers in Syria. You can edit the program code to generate river network and
flow length of each river. Therefore, with a DEM of your study area you can quickly
delineate watershed and define and describe a stream network that crosses a surface.

8.10 Using Grid Analyst

As enunciated in the last section, many of the functions one can use in SA are not
included in the interface. However, some independent users had developed many
interfaces so as to make these functions easier to use. One of these interfaces is Grid
Analyst (GA). More of these are available at ESRI web site -
(http://arcscripts.esri.com/) To use GA, you’ve to put the necessary files into ArcView
folder on your computer. The GA extension has much functionality but we will only
use Resample functions in this exercise.

Step I Extract GA file
Navigate to \introsa\sa and double click on Gridanalyst.zip. The file is compressed
so extract all the files into \esri\av_gis30\arcview\ext32,

Step 2 Open ArcView

Open your ArcView if not already opened. Click on File then Extensions. From the
Extensions dialog box that appears scroll down and locate Grid Analyst (ver. 1.1)
from the available extensions. Check on the box against this extension and click OK.

Step 3 Create a new view
Click on New on the Untitled dialog box to create new view. On the View Interface

that appears, click on Add button. Change Data Source Types to Grid Data
Source and navigate to \introsa\sa and click on soil_500 to add the theme. The theme
you’ve just added is at resolution of approximately 300m. Out task is to degrade this
theme to 1 km (1000m) because the other themes in the project that we want to use
this theme with are of resolution 1 km.
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Step 4 Sct the theme projection

The theme soil_500 is projected to UTM. So, you’'ll set the unit of measurement to
meter. Click on View then Properties. Set Map and Distance units to meters and
click OK.

Step 5 Check the theme properties

Click on Theme then Properties. The theme properties dialog box that appears
indicates at the Cell size field 513.9442. This is the resolution of the theme. You can
also obtain this information by setting the Analysis properties dialog from the
Analysis then Properties menus (see below). This is only the avenue to set your
default extent on which all other grid themes in the project will be based.

4 Analysis Properties: Viewl

Analysis Extent | Same As Sod_500m =]
Lot [E3waoonT Top[377oizassss
Bottom [3352363135295 Right [374681.600811
Analysis Cell Size | S2me As Sod 500m =1
Casis P1392

Number of Rows 198
Number of Colamms 124

Arslysis Mask IEETIGHTTN - |

ok Corcel |

Step 6 Resample the theme

Click on Transform Grid then Resample. Set the New cell size to 1000 on the
Resample dialog box that appears and click OK. A new theme named Resamplel of
(soil_500) will be appended on view1. Examine this theme’s properties. What do you
notice? This is one of the capabilities of GA. Click on Grid Analyst menu and check
what functions available for your grid analysis likewise check also Generalize Grid
menu. You can do a lot using SA, GA and other functions to accomplish your grid
analyses.

Step 7 Close the program

You can now close ArcView program. Click on File then Close All. On the Project
window, click on File then Exit. Do not save your work.
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Image processing

Basic processing is done to the image you will use for GIS analysis. The company
responsible for the acquisition of images does the first processing. However, in-house
image processing is also required before the image can be analyzed. Processing that is
required include data import to a specific image processing software, checking for
data quality, image enhancement, image registration, normalization and mosaicing.
That is, after the image had been imported it must be examined critically for any
error. Any error found must be corrected. Thereafter the image enhancement
techniques need to be applied to improve visualization of spectral and textural
features. The image also needs to be registered to a geographic coordinate system so
also it must be corrected for certain influences such as atmospheric conditions. And, if
the need arises, images so far processed must be joined together.

Data import

In most cases, ERDAS IMAGINE (EI) cannot read the image you’ll work with. So
there is need to import the image into El. However, you need details about the image.
The details essential for importing include numbers of row, column and band. This
normally accompanied the image in a separate file. Let import one image in this
section,

Step 1 Examine the header file

Click Start of your computer operating system then select Program followed by
Accessories. Choose WordPad. On the WordPad click on File then Open. On the
Open dialog box, change Files of type to All Documents(*.*), navigate to
\introerd\import for Look in , highlight LM5171035008720590.H1 for the File
name. Click Open. Shown below is some of important information clipped from the
file you just opened.

NDF_REVISION=2.00;
DATA_SET_TYPE=EDC_MSS;
PRODUCT_NUMBER=01100071000190001;
PIXEL_FORMAT=BYTE;
PIXEL_ORDER=NOT_INVERTED,;
BITS_PER_PIXEL=8;

PIXELS_PER_LINE=3442; = Number of columns
LINES PER_DATA_FILE=3495; = Number of rows
DATA_ORIENTATION=UPPER_LEFT/RIGHT;
NUMBER_OF_DATA_FILES=4; = Number of bands
DATA_FILE_INTERLEAVING=BSQ; = File formal
TAPE_SPANNING_FLAG=1/1;
START_LINE_NUMBER=I;
START_DATA_FILE=1;
LINES_PER_VOLUME=13980;
BLOCKING_FACTOR=1;

Close WordPad afler you finishing perusing the file.
Step 2 Start ERDAS IMAGINE (EI)
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Start EI P Close Viewer1 window by clicking at the Close icon X on the right.

=

. . . I rt
On the EI main window, click Import button i . On the Import/Export
window, click on the Type list and select Generic Binary. Select File for Media.

Step 3 Import the image

=
Click Open File button _‘l for Input File: (*). For the Look in: of the Input File
window, navigate to \itroer\import\ and highlight LM5171035008720590.H1 file

and click OK. Likewise click on Open File button = for Outout File: (*.img). For
the Look in: of the Output File window, navigate to \itroer\import\. Image folder
should appear in this field when completed. Type in Syria_175_035_87 for the File
name. Click OK twice. Your Import/Export window should look like the picture
shown below. If you are satisfied, click OK on the window.

s Import/Export - X

* Impot ¢ Export

Type: IGernlc Binary :l
e (NN - |
Input File: (%) Output File: [*.img]

|m5muasmamssan =3 I ls,m_ws_uss_srfng L |

| ] LM5171035008720590.H1 ﬂ
| ] LM5171035008720530 HI
| ] LM5171035008720590 11
|| LM5171035008720590.12
|

LMS171MB?2059’J.]3‘ I:J

4]
|33 mages [ |3 images |

[0k | Cose | DataView. |  Hep |

The next window Import Generic Binary Data appears. On the window, select
BSQ for Data Format, Unsigned 8 bit for Data Type, 3495 for # Rows, 3442 for #
Cols, and 4 for # Bands. These figures were taken from the header file you examined
in Step 1. Now, click the box against field Bands in Multiple files. BSQ Band File
dialog box now appears. Now click Open Folder button of the Filename (*.). On the
Filename window, click on Goto and select \itroer\import\, highlight the file that
ends with 12 then press OK. You'll be taken back to BSQ Band File dialog box.
Your task is to select all the four bands to the right — Band File Name. Now set Band
# 10 the number of the next band you want add, 2 and press Set. Continue this until all
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the bands are added. When you finished, the dialog box should look like the window
below. Press OK on the window.

You'll be taken back to Import Generic Binary Data window. At this stage, the
window should look as shown below.

¢ Tmport Generic BinaryData x|
Data Deseription Tape/Fie Optons
: : —
i DolaFomat  [B50 - ‘i o] = |
’ Data Type  [Ursgred 881 - wprace [l = '
I= S Eptes || Febesdebpee [0 |
Image Disenions I BSQOpon
e O I~ Bards inMubiie Fles
LneHesderBptes: [0 = :
i = BadHoadaBypex [0 = |
inhu |3"gﬁ 2| #pede |2 3] | Bad TrolecByns: |0 il i
L ! |
Losd Opliors,. | SeveOglo.. |
Op| Proview Uphons .. | Prevew | Hop |
[ tos | Inport Options ..~ | Bach |

Now press Ok on the Import Generic Binary Data window. Wait until the processing
is done then press OK on the Job Status window.

Step 4 Open the imported image
Now that you've successfully imported the raw image into the EI format, let open the

image. Click on Viewer button On the Viewer #1 window click Open

114



Layer button = . Select Layer to Add window appears. Navigate to
\introerd\import and highlight the file Syria_175_035_87. Click Raster Options of
the Select Layer to Add window. Set the fields on the below window then press OK.

Locate Zoom in Button O on the Viewer #1 and zoom in on the image. Likewise

pan on the image by using Pan button ﬁ‘

Select Layer To Add; o~ i = _XJ

File nmcm'

Display as : I‘Fme Colot | oK |
Layers to Colors: Cancel I
‘ned [T—ﬂ'..m Iz_iF“ [1_‘j| Hop |

I [ Orent (mage ta Ma System Goto ... I

W Clear Display 7 SetView Exter
¥ FittoFrame [V No Stretch
I~ DataScaing I~ Background Transparent

[0 Husg ] o | EL

Step 4 Close the Viewer
If you've finished, click on File menu of the Viewer #1 then click Close.

Data quality

The quality of image needs to be ascertained before any processing commences.
Likely quality problems to be encountered are dropped lines, repeated lines,
anomalous values in pixels, and mismatching of bands. You'll correct some of these
errors in this section.

Step 1 Open an image

If necessary, start EI. Click on Open Layer button. Navigate to \introerd\quality\
and highlight quality_ref.img. Click on the Raster Options of Select Layer To Add
window. Set all the parameters in the window that appears as shown in the window
below.
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Seleed Layer To Add:
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Click OK on the window when you finished

Step 2 Examine the image

Look at the upper part of the image. You'll see strange lines. These lines need to be
examined to determine what kind of error correction to apply. The lines that make up
this strange line could either be dropped lines, repeated lines or lines with just
anomalous values in pixels. Remember that dropped lines usually contain zero values
while anomalous values in pixel can either be lower or greater than average value of
the neighboring pixels.

Step 3 Check if the lines are band specific or affects all the bands

On the Viewer #1 window. click on Zoom button g Use this button to zoom a
little on any of the lines. Now, click on Raster then Band Combination of the
Viewer #1. Set Layers Combinations for window appears. Arrange the 2 windows as
shown below.

PO v aneat

@8 NV mtARNE WNAQ "

=d D

=t oy =
7 P [ﬂ-ir.'-frw Ei [15sre gy =l r'_’_fj
e e e (L
P Ba: fosk deg 2] [thwret 2 =l I’_Ef

C=1_tov | Om | wa |
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Look at the band combination. It is 4-3-2. Change each band to 4 so as to read 4-4-4
then press Apply on the Set Layer Combination window. Can you see the line again?
If the lines are seen, it means band 4 has the error. Repeat for bands 3, 2, and 1. Note
all the bands that have the strange lines.

Note: If the line you are examining affects large areas; it means the correction has to
be done for the affected bands separately. This will involve exporting the image back
to BSQ and converting each band to EI format. Each will now be opened for
correction. Afier correcting for each band, you then stack them back. This is
cumbersome. Alternatively, correction can be made pixel by pixel especially when
only few pixels are affected. This is what you'll do in the subsequent steps.

Step 4 Examine the affected bands one by one

Click on Raster then Band Combinations. Compose only for the band you want to
examine (e.g. 2-2-2). Now, click Zoom in button and zoom in on the one strange line
until you reach the last resolution of the image (i.e. point where you see the pixels).
Click on the Utility menu then Inquire Cursor. Set the list box at upper left of the
window that appears to File, see below.

e =% |1300_42m23 Y: |1n14237553 Pheels gl

Projection: Unknown

_ Laper || Band | FILE PIXEL | LUTVALUE |  HISTOGRAM
=l : } £5.000 120224.000

Alvjel <> o[ e d[m=] w |

Step 5 Examine the values

Click on the Move Cursor to Center of Window button g The Crosshair line
appears at the center of the image. Use other black buttons to move from one pixel to
the other. As you move around the pixels, note the values of each pixel in the boxes
(FILE PIXEL - digital number (DN)). Now click on the Move Cursor to Center of
window again then click at center where the lines cross and pick it to a strange line.

Move around the line horizontally using any of these buttons _‘..I LI and note the

values. Move to a good line using either up A or down ﬂ Buttons. Move along
the line as you did for strange line and note the values. Can you detect any anomaly
between the values in the two lines? Certainly, the DN values for pixels in the strange
lines are either lower or higher than the values of the pixels in the non-strange lines.
How many lines can you detect to have these strange values?
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Note: If you want to replace the values by line this is when to look at the value of Y
Pixel at the top right of the window. This is the line number.

Step 6 Replace the bad line pixel by pixel

When few pixels are affected it is faster to replace bad pixels with good ones pixel-
by-pixel. However, when a large area is affected, line replacement is the preferred
choice. Click on Raster menu then Tools. A Raster window appears. Click on

Create Rectangle AOI button O on the tool then use this to draw a box over the
pixel you want to change. Get average DN value from either the top or bottom

neighboring pixel and record the value down. Click on Fill Area button o on the
same tool. Area Fill window appears. Type in your new value into the space provided
against Fill With list box and press Enter then click Apply on the window.

Step 7 Verify the value entered for the bad pixel

Click on the Start/Update Inquire Cursor button + on the button bar of Viewer #1
window. A window you're familiar with appears. Use Crosshair pointer of the
window to check the value of the pixel just replaced.

Step 8 Bad pixels

In the last 3 steps you examined strange lines, which contain pixels with anomalous
values. But pixels with anomalous values can exist separately in the image. These are
referred to as bad pixels. You‘ll look for one in the image being examine and correct
.

Step 9 Check for bad pixels

While the quality_ref.img is still opened in the Viewer #1, let the image fit to the
window again. Zoom into any part of the image until the last resolution. Using the
Band Combinations of the Raster menu, change the image composition to 3-3-3-3

Click on the Start/Update Inquire Cursor button il on the button bar of Viewer #1
window. Set the List box to File, type 2300 against X: box and 1300 against Y: box.
You’ll see a pixel with black color. Check for the DN value of this pixel. and the
values for its neighboring pixels, The value for this pixel is lower than average value,
It is a bad pixel so it must be corrected. Compute an average value from one of the
good pixel near it and record it down.

Step 10 Replace the value of bad pixel
Now follow Step 6 to correct the bad pixel identified. You can use few minutes to pan
the image for possible more bad pixels. Correct any bad pixel found.

Step 11 Close EI

So far in this section, you corrected for major problems associated with image quality.
You can close the program. From the Season menu of EI, click on Exit Imagine. Press
No for printing the Log file.
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Image enhancement

Image enhancement can be achieved either by improving detail visibility (spatial
enhancement) or by manipulating the brightness levels (spectral enhancement).
Among the spatial enhancement techniques, resolution merge provides the best
overall visual results. Resolution merge redistributes the DNs belonging to a lower
resolution image over the pixels of a higher resolution image to increase visual
details. As such it belongs to the image enhancing techniques. In ERDAS you can
access the Resolution Merge window by clicking on Interpreter and choosing Spatial
Enhancement. Enhancement of the spectral and textural features can be obtained by
modyfing the contrast (perceived color difference among neighbouring pixels). This
section deals with latter.

Step 1 Start EI

Start EI Click on the Viewer button to create another viewer window, Viewer #2.
Click on the Season menu in the main EI menu bar then Tile Viewers. The two
viewers arranged side by side.

Step 2 Display images
Click on Open Layer button @ of the Viewer #1. Click on Recent and highlight
the image you worked with in the last section — quality_ref.img then press OK. Click
on Raster Option of the window. Look at the below image to set next window that
appears.

Select Layer To Add: s 0 ‘_‘_- i . x|

File nwuopﬁm|

Display as: | True Color | .-———IGK
LoestoCoos: [
R e chel

P ) : Golo...
¥ Clear Display I~ 5S¢

¥ Fitlo Frame ¥ No Stetch

[ Data Scaiing [~ Background Transparent

oty [T Using [Newesthegbor =] _Heb | &

Open the same image on Viewer #2. Set all the parameters as the above window turn
off No Stretch option.

Step 3 Examine the image displayed

Look at the images displayed in the two viewers. Certainly, the image displayed in
Viewer #2 gives a better visibility. When images are displayed in EI with the No
Stretch turns off, a linear contrast stretch is applied to the data file values. In many
cases this will provide a well stretched image suitable for visual interpretation.
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However, you can further enhance the image using a variety of techniques in El
especially when you want more details about a specific area (Area of Interest —AOI).
Let examine some of these tecniques.

Step 4 Adjust image contrast
The image quality_ref should be displayed in a viewer. In the Viewer menu bar, select
Raster — Contrast — Brightness/Contrast. The Contrast Tool dialog opens.

x|
!:"fl\‘? ----.j.....im
Drezgh——f—— w

Apply I Reset I

[ Cose |  Breakponts.. | Hep |

In the dialog box, change the number or use the slider bars to adjust the image
brightness and contrast. Click Apply. The image in the Viewer is redisplayed with
new brightness values. Click Reset then Apply in the dialog box. This will undo any
changes made to the image in the Viewer. Click Close in the dialog box.

Step 5 Use piecewise linear stretches

Place the cursor in the Viewer #1 and right click your mouse. Select Zoom In By 2.
Do this two more times. Now use the Pan tool to move the body of a lake in the
image into the center. In the Viewer menu, select Raster — Contrast — Piecewise
Contrast The Contrast Tool dialog box opens. With your pointer over the image in
the Viewer #1, right click the mouse and select Inquire Cursor, The Inquire Cursor
dialog box opens. In the Viewer #1, drag the middle of Inquire Cursor to the one of
the edges of the lake. Using either the Move Right or Move Left buttons, move the
Inquire Cursor over the lake while keeping an eye on the lookup table (LUT) values
in the blue color band, as reported in the Inquire Cursor dialog. This gives you an idea
of the range of data file values in the lake. Write down the lowest and highest values.

Step 6 Specify a range for the stretch

In the Contrast Tool dialog box, click Blue under Select color. Under Range
Specification, for Low range, type in any value slightly lower than the lowest value
you wrote down and for To, type in any value slightly above your highest value
and press Enter key. Drag the Brightness slide bar (the top slider bar) to 60. Click
Apply in the Contrast Tool dialog box. You can now see more details and also the
lake has more contrasts.

Step 7 Close all the windows
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In the Contrast Tool Dialog box, click Reset then Apply. Click Close in the Contrast
Tool dialog box and also click Close in the Inquire Cursor dialog box. Finally, retum
the image to its window size.

Step 8 Manipulate histograms

Another technique available in El that allows you to improve the visibility of a
displayed image is Histogram manipulation. In the Viewer menu bar, select Raster
— Contrast — Breakpoints. The Breakpoint Editor opens. Click on the list box at the
top of the Breakpoint Editor and select Green. Drag the breakpoints of the lookup

table graph.

Step 9 Display the RGB graphs

Click on the List box and select RGB. All three histograms display in the Breakpoint
Editor. Experiment by dragging the breakpoints of the lookup table graph in different
color bands (Red, Green, and Blue) then click Apply.

Step 10 Close the editor
Select Raster — Undo from the Viewer menu bar. This will undo the edits you just
made.

Step 11 Close the software

You are now familiar with some of the techniques that are used with EI to improve
visual interpretation of an image being displayed for processing vis-a-vis spectral and
textural features. Now, close the program, enter for No when prompted to print the
Log File.

Image registration

The features on the image to be processed need to be fixed onto the correct position of
the earth (rectification) and be transformed into a standard projection. The outputs
from the image processing are usually compared with similar processed images but of
different dates or with other thematic data sets and the outputs are also overlay with
other existing data sets. This implies that these different data sets must match one and
another (registration). Therefore, the image you are processing must match existing
data sets. Either rectification or reprojection can be used to accomplish this task.
We'll examine these concepts in this section and subsequent ones

Step 1 Examine ground control points (GCP)

Examine the two pictures below. The first picture shows the number and distribution
of ground control points collected in the field for image rectification. The second
picture shows the position of each point on the image to rectify. In addition, each
point is accompanied with an image that you'll be able to see the exact location.
These images can be found in \introerd\georef. They are in JPG format and
numbered serially. The first image is named ref-1.jpg, second ref-2.jpg, etc. Check to
see that you can locate each of the point on the image.
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Step 2 Start the EI

Start El and click Open Layer button. Navigate to \introerd\georef\ and highlight
geo_re.img. For the raster option, compose the image bands as 7-4-2, let the image fit
to frame, and stretch it. Click OK for Select Layer to Add window.

Step 3 Set up georeferencing parameters

On the Viewer #1 click Raster — Geometric Correction. From the Set Geometric
Model window, select Rubber Sheeting then press OK. On the next window that
appears, select Projection then Add/Change Projection. Projection Chooser window
appears. On this window select Custom. Set the next window — (Edited) Projection
Chooser as shown below then Press OK.

ita (Eited) Projection Chooser [ A ]

Standard Custom |
Projection Type | UTM Rl
Spheroid Name: |WGs e4 - L’
Datum Name: |wiGs &4 | _Deee. |
UTM Zere: [ 3| | o |
NORTH or SOUTH: [Nodh =] Concel |
_teo |
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Again, on the Rubber Sheeting Properties window, select Set Projection for GCP
Tool. Select Vector Layer (New Viewer) on GCP Tool Reference Setup window
and press OK. Reference Vector layer Window appears. On this window, set Files of
type to Shapefile(*shp) then highlight ref-point.shp from \introerd\georef and press
OK. Now press Ok on the Reference Map Information window. Press Close on the
Rubber Sheeting Properties window.

Step 4 Digitize the points

By now six windows are displayed for the digitizing purpose. There are Viewer #1 to
#4, Geo Correction Tools, and GCP Tool. Using the image with GPS points shown
earlier and the ref_l.jpg, identify the exact position of location one on the image
displayed in Viewer #1. You will need to zoom in and pan on the image. When you

are sure you've located the point, click on Start GCP Editor button @ on the
Geo Correction Tool. Move your cursor to the exact position on Viewer #1 and click
the location. Click again on the Start GCP Editor button and click Point #1 in the
Viewer #2. Look at the GCP Tool window; the coordinates of the points you digitized
had been filled. The best method is to digitize the four corners of the image before
the rest. So, follow the same step to digitize for location 13 then for location 12.
After you finished digitizing the first three points, the next button to use for
registering other points is on GCP tool window. Therefore, click on Create GCP

button & on the GCP Tool window and click on the point you want to digitize for
location 4 on the Viewer #2. The corresponding position will be digitized for you on
the Viewer #1. However, you have to check if the location the system indicated is
correct. If the location is correct accept it and repeat the step for others. If it is not
correct but you can identify the correct position move the point to that position. If it is
not correct and you cannot identify the correct position delete it. You can delete a
record by clicking on the record at the record number (GCP #x) column then right
click and select Delete Selection from the menu list.

Step 5 Resample the image
When you finished registering all the points, click on Display Resample Image

Dialog button of the Geo Correction Tool. Accept all the default values from
the Resample dialog window that appears except the Output(*.img) field. Here
navigate to \introerd\georef and type in geo_reg.img for the File name then press Ok
on the Resample window. Press OK when the next window that appears reported Job
Done.

Step 6 Close all the windows
Close all the windows except the main menu window of EI. If you are prompted to
save anything press No.



Step 7 Open the resampled image

Create a new viewer then open the new image you've just resampled. Set the
parameters of the Add Layer window as you did in previous steps. Look at the image
and comment on it. Let wait a while to discuss the output of this exercise.

Hardcopy image registration

One of the sources of data into our GIS database is conversion of our hardcopy maps
into electronic format. The map needs to be scanned then be registered. We’ll do this
in this section,

Step 1 Open a scanned map

If necessary, start EI. Click the Open Layer of the Viewer #1. On the Select Layer to
Add window that appears, set Files of types to TIFF(*.tif) then navigate to
\introerd\georef and highlight ezraa.tif file. Click on the Raster Option and turn on
Fit toFrame and Tum off No Stretch. Press OK on the Select Layer to Add window.

Step 2 Delete the existing map model

Click on the Utility menu of the Viewer #1 then Layer Info. Imageinfo window
appears. Click on the Edit menu of this window then Delete Map Model. Click Yes
on the next message box that appears. Close Imagelnfo window.

Step 3 Get the geographic coordinates of the map
Look at the four comers of the map and record down the decimal form of the
coordinates. The table below gives the values for the map displayed. Note that the
values in degrees should be converted into decimal.

Corner X-Lon|Y-Lat
Upper left | 36.25 33.00
| Upper right | 36.50 | 33.00

Lowerright | 36.50 32.83
Lowerleft | 36.25 32.83

Step 4 Setup the registration parameters

Click on Raster menu of the Viewer #1 then Geometric Correction. Set Geometric
Model window appears. Select Rubber Sheeting on the window list and press OK.
From the Rubber Sheeting Model Properties window that appears, click on
Projection then Add/Change Projection. Select Custom from the next window that
appears and set up the parameters as shown in the picture below.
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Press OK of the window when you are done. You are back to Rubber Sheeting Model
Properties window. Click on the Set Projection for GCP Tool from the window.
GCP Tool Reference Setup window appears. Click on the option Keyboard Only and
press OK. Click OK on the Reference Map Information window that appears,

Step 5 Digitize the points
You're now familiar with the windows displayed. Let the upper right of the map

focuses in the Viewer f1. Click on Start GCP Editor button @ on the Geo
Correction Tool then click exactly on the point where the longitude and latitude lines
intersect. Look up at the Viewer #2 and make sure the point is exactly where it is
supposed to be. Go to GCP tool window a record tagged GCP #1 had been created for
the point you just digitized. Enter the X value of the point you digitized into the XRef.
column and the corresponding Y value into Yref. column then press Enter key.

Repeat the same steps for other two comers. Use Create GCP button of the GCP
Tool window to digitize the last point. The values for the XRef. and Yref. fields, will
be added automatically by the system for this last point. However, check that the
values are correct.

Step 6 Resample the scanned map

Click Display Resample Image Dialog button @ of the Geo Correction Tool.
Accept all the default values from the Resample dialog window that appears except
the Output(*.img) field. Here navigate to \introerd\georef and type in map-reg.img
for the File name then press OK on the Resample window. Press OK when the next
window that appears reported Job Done. Close all the displayed windows except the
El main menu window.

Step 7 Open the resampled image

Open the new image you created. Remember to set the Files of type of the Select
Layer to Add window to Imagine Image(*.img). The features on the map are now
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fixed to the correct position of the earth but it is not projected. We will project the
map in the next section. Do not close Viewer#f1.

Image projection

You’ve rectified and projected images in previous sections. However, in some cases
you’ll need to reproject one or more data sets into a common projection. The scanned
map rectified in the last section is in geographic coordinates. Assuming most of the
data sets you are using are in another projection, you'll be compelled to transform the
rectified map into that projection. Let project the map into Universal Transverse
Mercator (UTM) projection.

Step 1 Get the value of x and y coordinates

You'll be required to supply the cell size in meter for the output map. The simple
method to use is by measuring the length of the map in meter and divides the value by
the numbers of grids. For the map you’re about to project to UTM, the cell size was
measured as 3.4 by 3.4 m.

Step 2 Project the image

it

DataPrep

Click ===—=== button on the main window of EI. Select Reproject Images.
Reproject Images windows opens. Let map_reg.img file be for the Input File while
/introerd/georef\map_proj.img file be for the Output File. Choose UTM WGS 84
North for the Categories and UTM Zone 37 for the Projection. Enter 3.4 for X: space
and 3.4 Y: space.

Step 3 Close the program
Close all the displayed windows and exit EL

Mosaicing

Mosaicing is a procedure to stitch together two or more scenes in the most seamless
possible way without affecting the spectral information present in the single scenes. In
most cases you'll need to mosaic images while doing image processing.

Step 1 Open EI and load images to a viewer

Open the EI software. Click Open Layer button of the Viewer #1 and Navigate to
\introerd\mosaic. Highlight image_l.img and press OK. Select Raster Option.
Compose the bands to 4-3-2 and Mark on the option Fit to Frame. Mark off option
No Stretch then Press OK. Open for others three images - image_2.img,
image_3.img, and image_d4.img. For each of these, Compose the bands to 4-3-2,
Mark off Clear Display, mark on Fit to Frame and mark off No Stretch.

Step 2 Examine the displayed images

Examine the four images you just displayed into one viewer. Although you can see
them to fit they actually overlap. Our task is to combine the 4 images without the
overlaps.

Step 3 Add images for mosaic
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DataPrep

On the EI window, click Dataprep button then Mosaic menu. Mosic
Tool window appears. On the window, click the Add Images icon & . The add
Images for Mosaic dialog opens. In the dialog under Image Filename, Select
Image_l.img, Select Compute Active Area under Image Area Options then click
Add. Repeat for others 3 images - Image_2.img, Image_3.img, and Image_4.img.
When you are finished adding the four images. the Mosiac Tool window should lock
like the following:

[
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Click Close in the Add Images for mosaic window.

Step 4 Match the images

Click the Image Matching icon B8 in the Mosaic Tool window. The Matching
Options dialog box opens. Select Overlap Areas under Matching Method of the

=]

window then click OK. Click the Intersection icon —= in the Mosaic Tool window

tool bar. Click again the Function icon ﬁ of the Mosaic Tool window tool bar. In
the Set Overlap Function dialog box that appears, select Average under Selection
Function then click Apply. Click Close in the Set Overlap Function dialog box.

Step 5 Run the mosaic

In the Mosaic Tool window, select Process — Run Mosaic. The Run Mosaic dialog
opens. In the Run Mosaic dialog under Output File Name, click on the Open Folder
button and navigate to \introerd\mosaic. Type in image_mosaic.img for the
Filename. Click OK for the Run Mosaic dialog. A job status dialog box opens. Click
OK on this window when the mosaic operation is finished.
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Step 6 Close the Mosaic Tool window
Select File — Close from the Mosaic Tool window, Do not save any changes if you're
asked.

Step 7 Open the output image

Click the Viewer button in the EI main bar to create a second Viewer. In the second
Viewer, select File — Open — Raster or click the Open layer button. The Select
Layer to Add window opens. In the window under Filename, click on
image_mosaic.img. Click the Raster Options also of the window. Enable the Fit to
Frame option, disable the No Stretch Option and click OK. The output mosaic file
displays in the viewer.

Step 8 Tile the viewers
In the EI menu bar, select Session — Tile Viewers. The two viewers are now side by
side. Compare the images in the two viewers

Step 9 Exit the EI

You've leant a lot about the ways to process images before using them for intended
purposes. Now, exit the EI software and do not save data to file.
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Introduction

The exercises of the Tutorial are arranged in 2 manner that provides a structured approach to the understanding of GIS,
Image Processing, and the other geographic analysis techniques the Idrisi32 system provides. The exercises are organized
as follows:

Using IDRISI Exerciscs
Exercises in this section introduce the fundamental terminology and operations of the IDRISI system, including setting
user preferences, display and map composition, and working with databases in Database Workshop.

Introductory GIS Exercises

This set of exercises provides an introduction to the most fundamental raster GIS analytical tools. Using case studies, the
tutorials explore database query, distance and context operators, map algebra, and the use of cartographic models and
IDRISY's grphic modeling environment Macro Modeler to organize analyses. The final exercises in this section explore
Multi-Criteria and Multi-Objective decision making and the use of the Decisiong Making Wizard in IDRISL

Advanced GIS Exerciscs

Exercises in this section illustrate a range of the possibilities for advanced GIS analysis using IDRISI. These include
regression modeling, predictive modeling using Markov Chain analysis, database uncertainty and decision risk and Geo-
statistics.

Introductory Image Processing Exerciscs

‘This sct of exercises steps the user through the fundamental processes of satellite image classification, using both super-
vised and unsupervised techniques.

Advanced Image Processing Exercises

In this section, the techniques explored in the previous set of excrciscs are expanded w include issues of classification
uncertainty and mixed-pixel classification. Idrisi provides a suite of wols for advanced image processing and this set of
exercises highlights their use. The final exercise focuses on Vegetation Indices

Database Development Exercises
The final section of the Tutorial offers three exercises on database development issues. Resampling and projecting data
are illustrated and some commonly available data layers are imported.

We recommend you complete the exercises in the order in which they are presented within each section, though this is
not strictly necessary. Knowledge of concepts presented in cadier exercises, however, is assumed in subsequent exercises.
All users who are not familiar with the IDRIS] system should complete the first set of exercises, Using IDRISI, first.
After this, a user new to GIS and Image Processing might wish to complete the introductory GIS and image processing
exercise sections, then come back to the advanced exercises at a later time. Users familiar with the system should be able
to proceed directly to the particular exercises of interest. In only a few cases are results from one exercise used in a later
excrcise.

As you are working on these exercises, you will want to access the Program Modules section in the on-line Help System
any time youn encounter a new module. You may also wish to refer to the Glossary section for definitions of unfamiliar
terms.

When action is required at the computer, the section in the exercise is designated by a letter. Throughout most exercises,
numbered questions will also appear. These questions provide opportunity for reflection and self-assessment on the con-
cepts just presented or operations just performed. The answers to these questions appear at the end of each excreise.

When working through an exercise, examine every result (even intermediate ones) by displaying it. 1f the result is not as
expected, stop and rethink what you have done. Geographical analysis can be likened to a cascade of operations, each one
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depending upon the previous one. As a result, there are endless blind alleys, much like in an adventure game. In addition,
crrors accumulate rapidly. Your best insurance against this is to think carefully about the result you expect and examine
every product to see if it matches expectations.

Data for the Tutorial are installed to a set of six folders, one for each Tutorial section as outlined above. The default
installation folder for the data is given on the first page of each section.

As with all IDRIS] documenmation, we welcome your comments and suggestions for improvement of the Tutnrial.
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Tutorial Part 1: Using ldrisi

Using IDRIS] Exercises
‘The 1DRISI Environment

Display: Layers and Collections

Display: Navigating Map Query

Map Composition

Palettes, Symbols, and Creating Text Layers
Data Structures and Scaling

Vector Collections and SQL

Data for the exercises in this section are installed (by default—this may be customized during program installation) to a
folder called \1drisi32 Tutorial\Using Idrisi32 on the same drive as the Idrisi32 program folder was installed.
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Exercise 1-1
The IDRISI Environment

Getting Started

To start IDRISI, double click on the IDRISI applicaton icon in the Idrisi32 Program Folder. This will load the IDRISI

system.

a)

Once the system has loaded, notice that the screen has four distinct components. At the top, we have the main
menu. Underneath we find the tool bar of icons that can be used to control the display and aceess commonly
uscd faciliies. Below this is the main workspace, followed by the status bar.

Depending upon your Windows setup, you may also have a Windows task bar at the very bottom of the screen.
If the screen resolution of your computer is somewhat low (e.g, 800 x 600), you may wish to change your task
bar scttings to autohide.! This will give you extra space for display—always an essential commaodity with a GIS.

Now move your mouse over the tool bar icons. Notice that a short text label pops up below each icon to tell you
its function. This is called a bint, Several other features of the IDRISI interface also incorporate hints.

Data Paths

b)

Click onto the File menu and choose the Data Paths option. This option accesses the Project Environment
madule to allow you to set the data paths of your file folders. Note that you can also access this same module by
clicking the left-most tool bar icon.

A project is an organization of data files, both the input files you will use and the output files you will create. The
most fundamental element is the Working Folder. The Working Folder is the locauon where you will typically find
most of your input data and will write most of the results of your analyses.2 The first time Idrisi32 is launched,
the working folder by default is named:

c:\Idrisi32 Tutorial\Using Idrisi32\
Ifit is not set this way already, change the Working Folder to be that shown above.’

In addition to the Working Folder, you can also have any number of Resouree Foiders. A Resource Folder is any
folder from which you can read data, but to which you typically will not write data.

For this exercise, define one resource folder:

1. This can be done from the START menu of Windows. Choose START, then SETTINGS, then Task bac. Click “always on top” off and “autohide”
on. When you do this, you simply need 10 move yout cutsor to the bottom of the screen in order to make the task bar visible.

2. You can always specify a different input or output path by typing that full path in the file name hox ditcetly or by using the browsc hutton and select-
ing another folder.

3. These instructions assume that the default paths were accepted during installation. 1f you chose to install the tutotial data t another ocation dudng
instalation, or if you moved the data t another location aficr installagion, adjust these inswructions accordingly.
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c:\1drisi32 Tutorial\ Introductory GIS

If this is not correctly set, use the Add or Remove buttons to specify the correct Resource Folder. Note that to
remove folders, you must highlight them in the list box first and then click the Remove button.

) The Project Environment should now show c:\Idrisi32 Tutoral\Using Idrisi32 as the Working Folder and
c:\1drisi32 Tutorial\Introductory GIS as the Resource Folder. Click on the Save As button and specify TUTO-
RIAL as the file name. This saves your settings in a file named TUTORIAL.ENYV (the .env extension stands for
Project Environment File). At a later time, you can use the Project Environment menu to re-load these settings,
through the File/Open command from the Project Enviconment menu,

IDRISI maintains your Project Environment settings from one session to the next. Thus they will change only if
they are intentionally altered. As a consequence, there is no need to explicitly save your Project Environment
settings unless you expect to use several Project Environments and wish to have a quick way of alternating
between them.,

d) Now click the OK button to exit the Project Environment dialog, You are now ready to start exploring the
IDRISI system.

The introduction to cach section of the Tutorial explains in which folder the data for the exercises of that section are
installed. Whenever you begin a new tutorial section, change your Project Environment accordingly.

A Special Note to Educators

In normal use, the Working Folder is used for both input and output data. However, if multiple students will be using the
same data in a laboratory setting, you may prefer to set the Project Environment as follows:

Working Folder: A temporary folder to hold all smdent output data.
Resource Folder(s): The folder(s) in which the original tutorial input data are stored.

Note that all the files that comprise mster (.rgf), vector (vlx), or signature (.sgf) collections must be in the same folder.
When an exercise requires students to add new files from the working folder to collections stored in a resource folder,
they should first copy all the collection elements from the resource folder to the working folder.

Dialog Boxes and Pick Lists

Each of the menu entries, and many of the ol bar icons, access specific IDRISI zodules. A module is an independent
program element that performs a specific operation. Clicking a menu entry thus results in the launching of a dialog box
{or window) in which you can specify the inputs to that aperation and the various options that you wish to use.

c) There are three ways to launch IDRISI module dialog boxes. The most commonly used modules have toolbar
icons. Click the Display icon (the fifth from the left) to launch the Display Launcher dialog, Close the dialog by
clicking the X in the upper right corner of the dialog window. Now go to the Display menu and click on the Dis-
play Launcher menu entry. Close the dialog again. Finally, under the File menu, choose the Shortcut On menu
entry. This opens a small utility, located at the bottom of the IDRISI window, that lists all IDRISI modules
alphabetically. Shortcut will stay open until you choose the Shortcut Off command under the File Menu. Click
the dropdown list arrow on Shorteut and scroll down until you find Display, then click on it. Note that you may
also type the module name directly into the Shorteut box. In the Tutorials, you will typically be instructed to find
module names in their menu location to reinforce the way in which a module is being used. The dialog box will
be the same, however, no matter how it has been opened.
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f) Notice first the three buttons at the bottom of the Display Launcher dialog. The OK button is used after all
options have been set and you are ready to have the module do its wark. Cancel always aborts the operation and
closes the dialog, Click the Cancel button now. You will notice that the dialog disappears without anything hap-
pening. Then run Display Launcher again.

2 The Help button can be used to access the context-sensitive Help System. You probably noticed that the main
menu also has a Help button. This can be used to access the IDRISI Help System at its most general level. How-
ever, accessing the Help button on a dialog will bring you immediately to the specific Help section for that mod-
ule. Try it now. Then close the Help window by clicking the X button in its upper-right corner.

The Help System does not duplicate information in the manuals. Rather, it is a supplement, acting as the primary technical
reference for specific program modules. In addition to directions for operating the module and explanations of options,
the Help System also provides many helpful tips and notes on the implementation of these procedures in the IDRISI sys-
tem.

Dialogs are primarily made up of standard Windows clements such as input boxes (the white boxes) in which text can be
entered, radio buttons (such as the file type radio button group), check boxes (such as those to indicate whether or not the
map layer should be displayed with a legend), buttons, and so on. However, IDRISI has incorporated some special dialog
clements to facilitate your use of the system.

h) In the Display Launcher, make sure the File Type indicates that you wish to display a raster layer. Then click the
small button with the ellipses, just to the right of the left input box. ‘This will launch the pick %z, IDRISI uses this
specially-designed selection tool throughout the system.

The pick list displays the names of map layers and other data clements, organized by folders. Notice that it lists your
Woarking Folder first, followed by each Resource Folder. The pick list always opens with the Working Folder expanded
and the Resource Folders collapsed. To expand a collapsed folder, click on the plus sign next to the folder name. To col-
lapse a folder, click on the minus sign next to the folder name. A listed folder with no plus/minus symbol is an indication
that the folder contains no files of the type required for that particular input box.

1) Collapse and expand the two folders. The pick list was invoked from an input box asking for the name of a ras-
ter layer. Therefore the files listed are all the raster layers in each folder. Now expand the Working Folder. Find
the raster layer named SIERRADEM and click on it (use the serollbar on the right to help find it if you need to).
You will notice that the layer you clicked upon becomes highlighted. At this point, click on the OK button of
the pigk list. Notice how its name is now entered into the input box on Display Launcher and the pick list disap-
pears.

Note that double clicking on a layer in the pick list will achieve the result of both selecting the layer and clicking OK. Also
note that double clicking on an input box is an alternate way of launching the pick list.

i Now that we have selected the layer to be displayed, we need to choose an appropriate palette (a sequence of
colors used in rendering the raster image). In most cases, you will use one of the standard palettes represented by
radio buttons. However, you will learn later that it is possible to create a virtually infinite number of palettes, In
this instance, the Quantitative (Standard IDRISI) palette is selected by default and is the palette we wish to use.

k) Notice that the autoscale check box has been selected automatically by the display system. This will be explained
in greater detail in a later exercise. However, for now it is sufficient to know that autoscaling is a procedure by
which the system determines the correspondence between numeric values in your image (SIERRADEM) and
the color symbols in your palette.

4. Note that when input filenames are chosen from the Pick List or typed without a full path, IDRISH first Jooks for the file in the Working Folder, then
in cach Resource lolder until the file is found. Thus, if files with the same name exist in both the Working and Resource Tulders, the file in the Working
Folder will be used.
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) The legend and title check boxes are self-explanatory. For this illustration, be sure that these check boxes are
also selected and then click OK. The image will then appear on the screen.

This image is a Digital Elevation Model (DEM) of an area in Spain.

The Status and Tool Bars

‘The Status Bar at the bottom of the screen is poimarily used to provide information about a map window.

m) Move the mouse over the map window you just launched. Notice how the status bar continuously updates the
column and row position as well as the X and Y coordinate position of the mouse. Also notice what happens
when the mouse is moved off of the map window.

All map layers will display the X and Y positions of the mouse—coordinates representing the ground position in a spe-
cific geographic reference system (such as the Universal Transverse Mercator system in this case). However, only raster
layers indicate a column and row reference (as will be discussed further below).

Also note the Representative Fraction (RF) on the left of the status bar. The RF expresses the current map scale (as seen
on the screen) as a fraction reduction of the true earth. For example, an RF = 1/5000 indicates that the map display
shows the earth 5000 times smaller than it actually is.

n) Like the pasition ficlds, the RF field is updated continuously. To get a sense of this, click the icon marked Maxi-
mize Display of Layer Frame (pause the cursor aver the icons to sce their names). Notice how the RF changes.
Then click the Restore Original Window icon. These functions are also activated by the END and HOME keys.
Press the END key and then the HOME key.

As indicated eardier, many of the tool bar icons launch module dialogs, just like the menu system. However, some of them
are specifically designed to access interactive features of the display system, such as the two you just explored. These tool
bar icons will be reviewed more systematically in the next mtorial exercise.

Menu Organization

As distributed, the main menu has nine sections: File, Display, GIS Analysis, Modeling, Image Processing, Reformat,
Data Entry, Window List, and Help. Collectively, they provide access to almost 200 analytical modules, as well as a host
of specialized udlities. The Display, Data Entry, Window List and Help menus are self-evident in their intent However,
the others deserve some explanation.

As the name suggests, the File menu contains a series of utilities for the import, export and organization of data files.
However, as is traditional with Windows software, the File menu is also where you set user preferences.

0) Open the User Preferences dialog from the File menu. We will discuss many of these option later. For now,
click on the Revert to Defaults button to ensure that your settings are set properly for this exercise. Click OK.

The Reformat menu contains a series of modules for the purpose of converting data from one format to another. It is
here, for example, that one finds routines for converting between raster and vector formats, changing the projection and
grid reference system of map layers, generalizing spatial dara and extracting subsets.

The GIS Analysis and Image Processing menus contain the majority of modules. The GIS Analysis menu is two to four
levels deep, with its primary organization at level two. The first four menu entries at this second level represent the core
of GIS analysis: Database Query, Mathematical Operators, Distance Operators and Context Operators. The others repre-
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sent major analytical areas of Statistics, Decision Support, Change and Time Sedes Analysis, and Surface Analysis. The
Image Processing menu includes ten submenus.

The modeling menu includes tools and facilities for constructing models as well as information for calling IDRISI capa-
bilities from user-written programs.

)] Go to the Surface Analysis submenu under the GIS Analysis main menu and explore the four sub-menus there.
Note that most of the menu entries that open module dialog boxes (i.c., the end members of the menu trees) are
indicated with capital letters but some are not. Those designated with capital letters are capable of being used as
procedures with the LDRISI Macro Language (IML). Now click on the CONTOUR menu entry in the Feature
Extraction sub-menu to lhunch the CONTOUR module.

o) From the CONTOUR dialog, specify SIERRADEM as the input raster image. (Recall that the pick list may be
launched with the Pick List button, or by double-clicking on the input box.)

Enter the name CONTOURS as the output vector file. For output files, you cannot invoke the pick list to
choose the filename because we are creating a new file. (For output filename boxes, use the pick list button only
when you wish to direct the output to a folder other than the Wosking Folder, or when you wish to see a list of
filenames already present in the Working Folder.)

Change the input boxes to specify a minimum contour value of 400 and a maximum of 2000, with a contour
interval of 100. You can leave the default values for the other two options. Enter a descriptive title to be
recorded in the documentation of the output file. In this case the title "100 m Contours from SIERRADEM"
would be appmpriatc.5 Click OK. Note that the status bar shows the progress of this module as it creates the
contours in two passes—an initial pass to create the basic contours and a second pass to generalize them. When
the CONTOUR madule has finished, IDRISI will automatically display the result.

The automatic display of analytical results is an optional feature of the System Settings of the User Preferences dialog
(under the File menu). The procedures for changing the Display Settings will be covered in the next exercise.

1) Move your cursor over the CONTOURS map window. Note that it does not display a column and row value in
the status bar. This is because CONTQOURS is a vector layer.

Composer

s) To appreciate the difference between raster and vector layers better, dose the CONTOURS map window by
clicking on the X button on its upper-right corner. Then, with the SIERRADEM display active, dlick the Add
Layer option of the Composer dialog and specify CONTOURS as the vector layer and Uniform Black as the
symbol file. Click OK to add this layer to your composition.

Compaoser is one of the most important tools you will use in the construction of map compositions. It allows
you to add and remove layers, change their hierarchical position and symbolization, and ultimately save and print
map compositions. Composer will be explored in far greater depth in the next exercise. However, for now note
the zoom and pan buttons at the bottom of Composer. These are duplicated by the arrow keys (for Pan) and the
PgUp and PgDn keys (for Zoom) on the keyboard.

1) Experiment with the Zoom and Pan options. The logic of their action is based on the concept of an airplane.

5. While entering titles is always optional {the module will run if this is Jcft blank), you are encouraged to always enter titles for your output files. In the
coutse of a GIS analysis it is common o produce dozens of vutput files. Descriptive titles are one way 10 quickly identify the conteats of these files.
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Imagine that the view you see is that which would be seen from an airplane. PgUp moves your point of view up
{thus seeing more, but with less detail) while PgDn moves your point of view down (presenting greater detail,
but a smaller field of view). Similarly Pan Left moves the aircraft to the left and Pan down moves it down. You
will quickly become familiar with this logic.

Now pan to an area of interest and zoom in until the cell structure of the raster image (SIERRADEM) becomes
evident. As you can sce, the raster image is made up of a fine cellular structure of data elements (that only
become evident under considerable magnification). These cells are often referred to as pixels. Note, however,
that at the same scale at which the raster structure becomes evident, the vector contours still appear as thin lines.

In this instance, it would seem that the vector layer has a higher resolution, but looks can be deceiving. After all, the vec-
tor layer was derived from the raster layer. In part, the continuity of the connected points that make up the vector lines
gives this impression of higher resolution, However, the generalization stage also served to add many additional interpo-
lated points to produce the smooth appearance of the contours. The chapter Introduction to GIS in the IDRISI Guide
to GIS and Image Processing Volume 1 discusses raster and vector GIS data structures.

Alternative Graphic Displays

The construction of map compositions through the use of Display Launcher and Composer will represent one of the
most important tools you will use in GIS. These will be explored in much further depth in the following exercise. How-
ever, IDRISI provides a variety of other means for viewing geographic data. To finish off this exercise, we will explore the
ORTHO module which provides a facility for creating three-dimensional displays.

u) Click on the Display Launcher icon and specify the raster layer named SIERRA234. Note that the palette
options are disabled in this instance because the image represents a 24-bit full color image® (in this case, 2 satel-
lite image created from bands 2, 3 and 4 of a Landsat scene). Click OK.

v) Now choose the ORTHO option from the DISPLAY menu. Specify SIERRADEM as the surface image and
SIERRA234 as the drape image. Since this is a 24-bit image, you will not need to specify a palette. Keep the
default settings for all other parameters except for the output resolution. Choose one level below your display
system's resolution.’ For example, if your system displays images at 1024 by 768, choose 800 by 600. Then click
OK. When the map window appears, press the END key to maximize the display.

The three dimensional (i.e., orthographic) perspective offered through ORTHO can produce extremely dramatic displays
and is a powerful tool for visual analysis. The surface image is not limited to elevation models, but may be any quantitative
and continuous image (e.g., rainfall, population density).

The rest of the exercises in this section of the Tutorial focus primarily on the elements of the Display System.

6. A 24-bit image is 2 spedal form of raster image that contains the data for three independent calor channels which are assigned o the red, green and
blue primaries of the disphry system. Lach of these three channels is represeated by 256 levels, leading w over 16 million displayable colors. However,
the ability of your system to resolve this image will depend upon your graphics system. This can easily be deteemined by minimizing IDRISI and clicking
the tight mouse button on the Winduows desktop. Then choose the Settings tab of the display propestics dialog, If your system is set for 24-bit teue color,
you are secing this image at its fullest color resolution. However, it is as likely as not that you ate secing this image at some lower cesolution. [1igh wlor
sertings (13 or 16 hit) look almost indistinguishahle from 24-bit displays, but use far less memory (thus typically allowing a higher spatial resolution).
However, 256 color settings provide quite poor approximations. Depending upon your system, you will probably have a choice of settings in which you
trade off culor resulution for spatial resolution. ideally, you should choose a 24-bit true color or 16-bit high color option and the largest spatial fesolu-
ton avaibblke. A minimum of 800 by 600 spadal resolution is recommended, but 1024 by 768 or better is more desirable.

7. If you find that the resulting display has gaps that you find undesirable, chouse a lower resolution. In most instances, you will want to choose the
highest eesolution that produces a continuous display. The size of the images used with ORTHO (number of col and rows) infh the result,
so in one case, the best result may he abtained with one resolution, while with another dataset, a different resolution is required.
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Exercise 1-2
Display: Layers and Collections

The digital representation of spatial data requires a series of constituent elements, the most important of which is the map
dayer. A layer is a basic geographic theme, consisting of a set of similar features. Examples of layers include a roads layer, a
rivers layer, a land use layer, a census tract layer, and so on. Feafures are the constituents of map layers, and are the most
fundamental geographic entitics—the equivalent of maolecules, which are in turn compounds of more basic atomic fea-
tures such as nodes, vertices and lines.

At a higher level, layers can be understood to be the basic building blocks of z4ps. Thus a map might be composed of a
state boundaries layer, a forest lands layer, a streams layer, a contours layer and a roads layer, along with a variety of ancil-
lary map components such as legends, titles, a scale bar, north arrow, and the like,

With traditional geographic representations, the map is the only entity that we can interact with. However, in GIS, any of
thesc levels is available to us. We can focus the display on specific features, isolated layers, or we can view any of a series
of multi-layer custom-designed maps. It is the layer, however, that is unquestionably the most important of these, Layers
are not only the basic building blocks of maps, but they are also the basic elements of geographic analysis. They are the
variables of geographic models. Thus our exploration of GIS logically starts with map layers, and the display system that
allows us to explore them with the most important analytical too! at our disposal—the visual system.

Displaying Map Layers

Since the eardiest days of automated cartography and GIS, map layers have been digitally encoded according to two funda-
mentally different logics—raserand vector. The fact that both formats are still very much in use attests to the fact that each
has special strengths. Indeed, most GIS software systems, including IDRISI, have moved towards the integration of the
twa. Thus, as you work with the system, you will work with both forms of representation.

a) Click on the DISPLAY icon on the tool bar. Note that separate options are included for raster and vector layers,
as well as a map compasition option (which we will explore in the next exercise). Despite the fact that their rep-
resentational structures are very different, your means of displaying and interacting with them is identical.

Display the vector layer named SIERRAFOREST. Select the User-defined symbaol option, invoke the pick list
for the symbol files and choose the symbol file FOREST. Turn the title and legend options off. Click OK.

This is a vector layer of forest stands for the Sierra de Gredos area of Spain. We examined 2 DEM and color
composite image of this area in the previous exercise. Vector layers are compased of points, which are linked to
form lines and arcal boundaries of polygnnaﬂ Use the zoom (PgUp and PgDn) and pan keys (the arrows) to
focus in on some of these forest polygons. If you zoom in far enough, the vector structure should become
quickly apparent.

b) Press the Home key to restore the orginal display and then the End key to maximize the display of the layer.
Now select the Cursor Inquiry Mode icon on the toolbar (the ane with the question mark and arrow). When you

8. Arcal featurcs, such as provinees, are commonly called polygons because the points which define theit boundaties are always joined by suaight lines,
thus producing a multi-sided figure. If the points arc close enough, a linar or polygonal feature will appear to have a smooth boundary. However, this
is only a visual appearance.
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move the cursor into the map display, notice that it changes to a cross-hair. Click on a forest polygon. The poly-
gon becomes highlighted and its ID is shown near the cursor (this may take a moment), Click on several other
forest polygons. Also click on some of the white areas between these polygons. Then click on the Feature Prop-
erties button on Compaser (or on the Feature Properties tool bar icon to the immediate right of the Cursor
Inquiry Made icon), and continue to click on polygons. Note the information presented in the Feature Proper-
ties box that opens below Composer.

What should be evident here is that vector representations are feature-oriented—they describe features—entities with dis-
tinct boundaries—and there is nothing between these features (the void!). Contrast this with raster layers.

<)

d)

Click on the Add Layer button on Composer. This dialog is a modified version of Display Launcher with
options to add cither an additional raster or vector layer to the current composition. Any number of layers can
be added in this way. In this instance, select the raster layer option and choose SEERRANDVI from the pick list
options. Then choose the NDVI palette and click OK.

This is a vegetation biomass image, created from satellite imagery using a simple mathematical model.? With this
palette, greener areas have greater biomass. Areas with progressively less biomass range from yellow to brown to
red. This is primarily a sparse dry forest area.

Notice how this raster layer has completely covered over the vector layer. This is because it is on top and it con-
tains no empty space. To confirm that both layers are actually there, click on the check mark beside the SIER-
RANDVI layer in the Composer dialog, This will temporarily turn its visibility off, allowing you to see the layer
below it.

Make the raster layer visible again by clicking to the left of the file name. Raster layers are composed of a very
fine matrix of cells commonly called pixcls,m stored as a matrix of numeric values, but represented as a dense
grid of varying colored rectangles.!! Zoom in with the PgDn key until this raster structure becomes apparent.

Raster layers do not describe features in space, but rather the fabric of space itself. Each cell describes the condi-
tion or character of space at that location, and every cell is described. Since Cursor Inquiry Mode is still on, first
click on the SIERRANDVI file name on Composer then click onto a variety of cells with the cursor. Notice
how each and every cell conmins a value, Consequently, when a raster layer is in a composition, we cannot see
through to any layers below it. This is not the case with vector.

Change the position of the layers so that the vector layer is on top. To do this, click the name of the vector layer
(SIERRAFOREST) in Composer so that it becomes highlighted. Then hold the left button down over the high-
lighted bar and drag it down until the pointer is over the SIERRANDVI file name and it is highlighted, then
release the mouse button. This will change its position.

With the vector layer on top, notice how you can see through to the layer below it wherever there is empty
space. In some instances, you may find that you wish to convert a raster layer to vector simply to take advantage
of this implication for display. However, the polygons themselves obscure everything behind them. This can be
alleviated by using a different form of symbolization.

9. NDVI and many othee vegetation indices are discussed in detail in the chapter Vegetation Indices in the IDRISI Guide to GIS and Image Pro-
cessing Yolume 2 and in Tutorlal exercise 5-7.

10. The word paxelis a contraction of the words petwre and elewent. Technically a pixel is a graphic clement, while the data value which underlies it is a grid
cell value. However, in common patdance, it is not unusual to use the word pixel 10 refer to both.

11. Unlike most raster systems, this version of IDRISI docs not assume that all pixcls arc square. By comparing the number of columns and rows against
the courdinate range in X and Y respectively, it determines theit shape automatically, and will disphy them cither as squares or rectangles accordingly.
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f) Select the SIERRAFOREST layer in Compaser. Then click on the Layer Properties button. Layer Properties, as
the name suggests, displays some important details about the selected (highlighted) layer, including the palette or
symbol file in use.

To change the symbol file used to display the SEERRAFOREST layer, click on the pick button next to the sym-
bol file name and choose the symbol file named FOREST2. The display will automatically update. Then click on
the OK button to remove the Layer Properties dialog,

Unlike the solid polygon fill of the FOREST symbol file, the FOREST2 symbol file uses a cross hatch pattern
with a dear background. As a result, we can now see the full layer below. In exercise 1-4, you will learn how to
create symbol files such as these.

From the steps above, we can dearly see that vector and raster layers are different. However, their truc relative strengths
are not yet apparent. Over the course of many more exercises we will learn that raster layers provide the necessary ingre-
dients to a large number of analytical operations—the ability to describe continuous data (such as the continuously vary-
ing biomass levels in the SIERRANDVI image), a simple and predictable structure and surface topology that allows us to
model movements across space, and an architecture that is inherently compatible with that of computer memory. For
vector layers, the real strength of their structure lies in the ability to store and manipulate data for whole collections of lay-
ers that apply to the features described.

Layer Collections

2 Remove all map windows from the screen by choasing Close All Windows from the Window List menu.

h) Bring up Display Launcher and choose to display a vector layer. Then click on the pick list button and find the
entry named MAZIP. Notice that there is a plus (+) sign beside it. Click on it and notice that a whole set of layer
names are then listed below it. Sclect the layer named MEDHOMVAL. Use the default Quantitative symbol file
and make sure the autoscaling, ttle, and legend options are selected. Click OK. The resulting map shows median
home values (in Dollars) in eastern Massachusetts by ZIP code reginns.12

Vector Layer Collections

MAZIP is a vector layer collection. In IDRIS, a collection is a group of layers that are specifically associated with each
other. In the case of vector layers, a single vector layer that acts as a spatial frame is associated with a dat table of statis-
tics for the features depicted. A spatial frame is simply a layer that describes only the geographic character of features and
not their attributes. By assodating a data table with attribute data for each feature, a layer can be formed from each such
dara field.

1) To get an understanding of this we will open IDRISI's relational database manager, Database Workshop. Make
sure the median home value MEDHOMVAL) map window has focus (click on its banner if you are unsure—it
will be highlighted when it has focus). Then click on the Database Workshop icon on the tool bar (a grid pattern
on the right side of the toolbar).

Ordinarily Database Workshop will ask for the name of the database and table to display. However, since the
map window with focus is already associated with a database, it displays that onc automatically. Resize the map
window and Database Workshop dialog so you can see both on the screen.

Notice that the column names of the table match the layer names that were displayed when you selected MAZIP

12, ZIP codes are US postal codes. They are stored in this database as text strings because of their leading 0.
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in the pick list (including MEDHOMVAL). In database terminology, each column is known as a ffe/d The rows
are known as recrds, each of which represents a different feature (in this case different ZIP code districts). Acti-
vate Cursor Inquiry Mode and click on several of the polygons in the map. Notice how the active record in
Database Workshop (as indicated by the arrow at the left of the Database Wotkshop table) is immediately
changed to that of the polygon clicked.

) With a linked data table, each field becomes a different layer. Notice that Database Workshop has an icon on the
far right that is identical to that used for Display Launcher. As the icon would suggest, this can be used as a
shortcut to display any of the data fields. To use it, we need to choose the layer to display by simply clicking the
mouse into any cell within the column of the field of interest. In this case, move over to the MEDHHINC
(Median Household Income) field and click into any cell in that column. Then dlick the Display Current Field as
Map Layer icon (the one that looks like Display Launcher) on Database Workshop. You are not given any
choices here because this is meant as a quick display utility. You can modify the display through the Layer Prop-
erties dialog.

There are three ways in which you can specify a vector layer that is part of a collection. The first is to select it from the
pick list as we did to start. The second is to display it from Database Workshop. Finally, we can use Display Launcher and
simply type in the name using dor-Jogic. Notice the names of the two layers currendy displayed from the MAZIP collection
{as visible both in Composer and on the Map Window banners). Each starts with a prefix equal to the collection name,
followed by a dot ("."), followed by the name of the data field from which it is derived. This same naming convention can
be used to specify any layer that belongs to a collection. You may now close the map windows and Database Workshop.

k) How is a collection established? It is done with the facility called Collection Editor, found under the File menu.
Open Collection Editor and select Open from its File menu. The standard Windows File Open dialog appears
with a "Files of Type" option at the bottom of the dialog, Click on it and select Vector Link Files (*.vix). A link
file establishes the link between a spatial frame file and a database table. Choose the file named MAZIPVLX
and click Open.

Notice that a vector link file contains four components—the name of the vector spatial frame, the database file,
the database table, and the link field.

The spatial frame is any vector file which defines a set of features using a set of unique integer identifiers. In this
casc, the spatial definition of the zip code areas, MA_ZIPCODES.

The database file can be any Microsoft Access format file. In cases where a dBASE (.dbf) file is available, Data-
base Workshop can be used to convert it to Access format. This vector collection uses a database file called
MA_ZIPSTATS.

Database files can contain multiple tables. The VLX file indicates which table should be used. In this case, the
Demographics table is used (and is the only table in the database).

The link field is the field within the database table that contains the identifiers that link (i.c., match) with the
identifiers used for features in the spatial frame. ‘This is the most important element of the vector link file, since
it serves to establish the link between records in the database and features in the vector frame file. The IDR_ID
ficld is the link field for this vector collection. it contains the identifiers that match the feature identifiers of the
polygon features of MA_ZIPCODES.

Our intention here is simply to examine the structure of an existing VLX file. Click on the X in its upper right
corner to close Collection Editor. Answer No if you are asked to save any changes you may have made,

We have just learned that collections of vector layers can be created by linking a vector spatial frame to a data table of
attributes, In the next exercise we will explore how this can facilitate certain types of analysis. Before this, however, we
will explore how raster layers can also be grouped into collections.
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Raster Layer Groups

With raster layers, the logic of creating a collection is very different. A raster collection is exactly that—a collection of lay-
ers that are grouped together. Again, Collection Editor is used to create the collection. However, in this case, it is used to
create a raster grosp file (.rgf).

)} Again, open Collection Editor from the File menu. By default Collection Editor opens ready to construct a new
raster group file, Sclect and add (using the Insert After option) each of the following files in turn. You may
mult-select files by holding down the shift key to select several files listed together or by holding down the con-
trol key to select several files individually. The order in which you multi-select the files does not impact the order
in which that are transfered to the group file, so you will need to select/add more than once.

SIERRAL1
SIERRA2
SIERRA3
SIERRA4
SIERRAS
SIERRA7
SIERRA234
SIERRA345
SIERRADEM
SIERRANDVI

If you make any mistakes, simply remove and insert as necessary until the collection is correct. Then choose the
Save As option from the Collection Editor’s File menu, give the file name SIERRA and close the dialog,

Raster collections are not associated with a table per se. However, as a collection of layers they provide a range of power-
ful capabilitics, including the ability to provide tbular summaries about the characteristics of any location.

m) Bring up Display Launcher and sclect the raster layer option. Then click on the pick list button. Notice that your
SIERRA collection appears with a plus sign, as well as the individual layers from which it was formed. Click on
the plus sign to list the members of the collection and then select the SIERRA345 image. You should now see
the text "sierra.sierra345” in the input box. Notice that this sequence is the same as for a vector collection. Since
this is a 24-bit composite, you can now click OK without specifying a palette (this will be explained further in
the next exercise). This is a color composite of Landsat bands 3, 4 and 5 of the Sierra de Gredos area. Leave it
on the screen for the next section.

With raster layer collections, the individual layers exist independent of the group (which is not true of vector collections).
Thus, to display any one of these layers we can specify it either with its direct name (e.g,, SLERRA345) or with its group
name attached (e.g, SIERRA.SIERRA345). What is the benefit, then, of using a group?

n) We will need to work through several exercises to fully answer this question. However, to get a sense, click on
the Feature Properties button of Composer. Then move the mouse and use the left mouse button to click ontn
various pixels around the image and look at the Feature Properties box. Next click on the Toggle Graph/Table
button at the bottom of the Feature Properties box and continue to click on the image.

Vector layers have features such as points, lines and polygons. However, raster layers do not contain features per se. The
closest equivalent is the pixel. Cursor Inquiry Mode allows you to inspect the value of any specific pixel. However, with a
raster group file you can examine the values of the whole group at the same pixel location, producing a table or graph as
desired.
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A Challenge

In your Using 1drisi32 tutorial data folder you will find a vector file of postal codes (NETHERLANDS, VCT) and a data-
base related to these districts (NLDZIP3.MDB). Create a vector collection for these data (using the Collection Editor)

and print out a map of the distribution of persons per houschold (Persons/HH) in the Netherands (hint: Composer has
4 print option).
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Exercise 1-3
Display: Navigating Map Query

As should now be evident, one of the remarkable features of a GIS is that maps can be actively queried. They are not sim-
ply static representations of singular themes, but collections of data that can be viewed in myriad ways. In this exercise, we
will consolidate and extend some of the interactive map query techniques already discussed.

Feature Properties

a) First, close any open map windows. Then use Display Launcher and select the raster layer SIERRA234 under
the SIERRA group you created in the previous exercise. It is important here that this be selected from the group
(i.c., that its name is specified as SIERRA.SIERRA234 in the input box). Again, since this is a 24-bit image, no
palette is needed.

A 24-bit image is so named because it defines all possible colors (within reason) by means of the mixture of Red, Green
and Blue (RGB) additive primaries needed to create any color. Each of these primaries is encoded using 8 bits of com-
puter memory (thus 24 bits over all three primaries) meaning that it encodes up to 256 levels from dark to bright for each
1:;rim:u'y.13 This yields a total of 16,777,216 combinations of color—a range typically called #rue color.'* 24-bit images spec-
ify exactly how each pixel should be displayed, and are commonly used in Remote Sensing applications. However, most
GIS applications use "single band" images (i.c., raster images that only contain a single type of information), thus requir-
ing a palette to specify how the grid values should be interpreted as colors.

b) Keeping SIERRA.SIERRA234 on the screen, use Display Launcher to also show SIERRASIERRA4 and
SIERRA.SIERRANDVL. Use the Grey Scale palette for the first of these and the NDVI palette for the second.

<) Each of these two images is 2 "single band"” image, thus requiring the specification of a palette. Each palette con-
tains up to 256 consecutive colors. Click on Feature Properties (either from Composer or the tool bar). Now
click on varous pixels in the image and notice, in particular, the values for the three images. You can adjust the
spacing between the two columns by moving the mouse over the column headings and dragging the divider left
or right.

As you can see in the Feature Properties bax, the 24-bit image actually stores three numeric values for each pixel—the
levels of the red, green and blue primaries (each on a scale from 0-255) as they should be mixed to produce the color

viewed.

The SIERRA.SIERRA4 image is a Landsat satcllite Band 4 image and shows the degree to which the landscape has
reflected near-infrared wavelength energy from the sun. It is identical in concept to a black and white photograph, even
though it was taken with a scanner system rather than a camera. This single band image is also quantized to 256 levels,
ranging from 0 (depicted as black with the Grey Scale palette) to 255 (shown as white with the Grey Scale palette). Note

13. In the binaty number system, (0000000 (8 hits) cquals () in the decimal system, while 11111111 (8 hits) cquals 255 in the decimal system (a total of
256 values).

14. The degree to which this image will show its e alors will also depend upon your graphics system and its setting, You may wish to review your set-
tings by looking at your display system propertics (acecssible through Contral Panel). With the system set to 256 culurs, the renditinn may seem some-
what poor. Obviously, setting the system to 24-bit {true color) will give the hest peeformance. However, many systems offer 16-hit color which is almost
indistinguishable from 24-bit.

Exercise 1-3 Display: Navigating Map Query 17



that this band is also one of the three components of SIERRA.SIERRA234. In SIERRA.SIERRA234, the Band 4 compo-
nent is associated with the red primary.!®

In the SIERRA.SIERRA4 image, there is a direct correspondence berween pixel values and colors. For example, in the
Grey Scale palette, middle grey occupics the 128th position (half way between black at 0 and white at 255), which will be
assigned to any pixcls that have a value of 128. However, notice that the SIERRA SIERRANDVI image does not have
this correspondence, Here the values range from -0.30 to 0.72. In cases such as this, IDRISI uses a system of awtoscaling to
assign cell values to palette colors. We will explore the issue of autoscaling more thoroughly in exercise 1-6. For now, sim-
ply recognize that, by default, the system evenly divides the actual number range (-0.30 to 0.72) into 256 classes and
assigns each a color from the palette. For example, all cells with values between -0.300 and -0.296 are assigned color 0,
those between -0.296 and -0.292 are assigned color 1, and so on.

d) The graphing option of Feature Properties also works by autoscaling. Click on the Toggle graph/table button at
the bottom of the Feature Properties box 1o change the display 0 graph mode and then click around any of the
displayed images. By default, the bars for each image are scaled in length between the minimum and maximum
for that image. Thus a half-length bar would signify that the selected pixel has a value half way between the min-
imum and maximum for that image. This is called independent scaling. However, notice that there is also a button
to toggle this to relative scaling. In this case, all the bars are scaled to a uniform minimum and maximum for the
entire group. Try this and notice that you will be required to specify the minimum and maximum to be used.
You can use the default offered.

The use of a collection clearly is of considerable assistance when querying a group of related layers. Collections may also
be used for simultancous mavigadon of collection members.

Collection Linked Zoom

) Close the Feature Properties box cither by clicking its icon on the tool bar, or by clicking the Feature Properties
button once again on Composer. Notice that this does not turn off the simpler Cursor Inquiry Mode. Click onto
its tool bar icon to turn this feature off as well. Now move the three images on your screen so that you can see
as much as possible of all three. Then click on the SIERRA.SIERRA234 layer to give it focus. Using the Pan and
Zoom keys, move around this image.

Normally pan and zoom opernations only affect the map window that has focus. However, since each of these
map windows belongs o 2 common group, their pan and zoom operations can also be linked.

f) Select the Collection Linked Zoom icon on the tool bar (14th from left). Now pan and zoom around any of the
images and watch the effect! We can also see this with the Zoom Window openation. Zoom Window is a proce-
dure whereby you can delineate a specific region you wish to zoom into. To explore this, click on the Zoom
Window icon (12'F from the left) and then move the mouse over one of your images. Notice the shape of the
cursor. We will zoom into an area that just encloses the large lake to the north. Move the mouse to the upper-left
corner of the rectangular area you will zoom into. Then hold down the left mouse button and keep it down
while you drag the rectangle until it encloses the lake region. When you let go of the mouse, this region will be
zoomed into. Notice the effect on the other group members! Finally, click on the Restore Original Window icon
(13'}I from the left) on the tool bar (or press the Home key). Note that this linked zoom feature can be mmed
off at any time by simply clicking onto the Collection Linked Zoom icon again.

15. 1t has become common to specify the primarics from long to short wavelength (RGB) while satellite image bands are commonly specified from
short to long wavdengths (e, SIERRA234 which is compused from the green, red and near-infrared wavelengths, and assigned the blue, green and red

primarits respectively).
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Even though they are quite different in their construction, it should now be evident that vector and raster collections are
very similar in how they are handled. Layers within either type are similarly specified through the use of dof logie. Both can
also be queried in the same way.

Challenge

Clear the screen of all map windows and then use Display Launcher to display a couple of layers from the MAZIP collec-
tion. Then try the Feature Properties and Collection Linked Zoom operations on these layers.

Placemarks

As you zoom into various parts of a map, you may wish to save a particular view in order to return to it at a later time.
This can be achieved through the use of placemarks. A placemark is the spatial equivalent of a bookmark.

i Use Display Launcher to bring up any layer you wish. Then use the zoom and pan keys to zoom into a specific
vicw. Save that view by clicking on the Placemarks icon (next to the Collection Linked Zoom icon).

The Placemarks tab of the Map Properties dialog is displayed. We will explore this dialog in much greater depth
in the nest exercise. For now, click on the Add Current View as a Placemark button to save your view. Then
type in any name you wish into the input box that opens on the right, and click the Enter and OK buttons.

Now zoom to another view, add it as a second placemark, and then exit from the Placemarks dialog. Press the
Home key to restore the original map window. At this point, your view corresponds with neither placemark. To
return to one of your placemarks, click the placemark icon and then select the name of the desired placemark the
placemarks window. Then click the Go to Selected Placemark button.

IDRISI allows you to maintain up to 10 placemarks per map composition, where a compasition consists of a single map
window with one or more layers. In the next exercise, we will explore map compositions in depth. However, for now it is
simply necessary to recognize that placemarks will be lost if a map window is removed from the screen without saving the
compasition, and that placemarks apply to the composition and not to the individual map layer per se.
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Exercise 1-4
Map Composition

By now you have gained some familiasity with Composer—the utility that is present whenever a map window is on the
screen. However, as you will see in this illustration, it is but ane piece of a very powerful system for map composition.

Map Components

A map compasition consists of onc or more map layers along with any number of ancillary map components, such as
titles, a scale bar and so on. Here we review each of these constituent elements.

Map Window

The map window is the window within which all map components are contained. A new map window is created each
time you use Display Launcher. The map window can be thought of as the piece of paper upon which you create your
compoasition. Although Display Launcher sets the size of the map window automatically, you can change its size either by
pressing the END or HOME keys. You can also move the mouse over one of its borders, hold the left mouse button
down, and then drag the border in or out. Note that you can, in principle, maximize the window by clicking its maximize
button on its banner. However, we do not recommend this as you will not be able to access Composer.

Layer Frame

The layer frame is a rectangular region in which map layers are displayed. When you use DISPLAY Launcher, and choose
not to display a title or legend, the layer frame and the map window are exactly the same size. When you also choose to
display 2 legend, however, the map window is opened up to accommodate the legend to the right of the layer frame. In
this case the map window is larger than the layer frame. This is not merely a semantic distinction. As you will see in the
practical sequence below, there is truly a layer frame object that contains the map layers and that can be resized and
moved. Each map compasition contains one layer frame.

Legends

Legends can be constructed for raster layers and point, line and polygon vector layers. Like all map components, they are
sizable and positionable. The system allows you to display legends for up to five layers simultancously. The text content
of legends is derived either from the legend information carried in the documentation file of the layer involved, or is con-
structed automatically by the system.

Scale Bar

The system allows a scale bar to be displayed for which you can control its length, text, number of divisions and color.

North Arrow

The standard north arrow supplied allows not only text and color changes, but can also be varied in its declination (jts
angle from grid north). Declination angles are always specified as azimuths (as an angle from 0-360° clockwise from
north).
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Titles

In addition to text layers (which annotate layer features), you also have the ability to add up to three free-floating titles.
These are referred to as the tide, sub-title and caption. However, they are all map objects of identical character and can
thus be used for any purpose whatsoever.

Text Frame

In addition to titles, you can also incorporate a text frame. A text frame is a sizable and placeable rectangular box that
contains text. It is commonly used for blocks of descriptive text or credits. There is no limit on the amount of text,
although it is rare that more than a paragraph or two will be used (for reasons related to map composition space).

Graphic Insets

IDRISI also allows you to incorporate up to two graphic insets into your map. A graphic inset can be either 2 Windows
Metafile (wmf), an Enhanced Windows Metafile (.emf) or 2 Windows Bitmap (bmp) file. It is both sizable and placeable.
Note that the Windows Metafile (wmf) format has now been superseded by the Enhanced Windows Metafile (.emf),
which is preferred.

Map Grid

A map grid can also be incorporated into your composition quite easily. Parameters include the position of the origin and
the increment (i.c., interval) in X and Y. The grid is automatically labeled and can be varied in its color and text font.

Backgrounds

All map components have backgrounds. By default, all are white. However, each can be varied individually or as a group.
The layer frame and map window backgrounds deserve special mention.

When one or more raster layers is present in the composition, the background of the layer frame will never be visible.
However, when only vector layers are involved, the layer frame background will be evident wherever no feature is present.
For cxample, if you were creating a map of an island with vector layers, you might wish to color the layer frame back-
ground blue to convey the sense of its surrounding ocean.

Changing the map window background is like changing the color of paper upon which you draw the map. However,
when you do this, you may wish to force all other map components to have the same color of background. As you will sce
below, there is a simple way to force all map components o adopt the color of the map window background.

Building the Composition

As soon as you launch a map window, you begin the process of creating a map composition. IDRISI will automatically
keep track of the paositions and states of all components. However, they will be lost unless you specifically save the com-
position before closing the map window.

a) Use Display Launcher to launch a map window with the raster layer named WESTLUSE. Choose the user-
defined palette WESTLUSE. Also, be sure the legend and title options are both checked. Then dick OK.

Display Launcher provides a quick composition facility for a single layer, with automatic placement of both the title and
the legend (if chosen). To add further layers or map components, however, we will need to use other tools. Let's first add
some further layers to the composition. All additional layers are added with Composer.

b) Click on the Add Layer button of Composer. Then add the vector layer named WESTROAD using the symbol
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file also named WESTROAD. Then click on Add Layer again and add the vector text layer named WEST-
BOROTXT. It also has a special symbal file, named WESTBOROTXT.

The text here is probably very hard to read. Therefore, press the END key (or click the Maximize Display of
Layer Frame button on the tool bar) to enlarge your compaosition. Depending upon your display resolution, this
may or may not have helped much. However, this is a limitation of your display system only. When it is printed,
the text will have significantly better quality (because printers characteristically have higher display resolutions
than monitors).

An additional feature of text layers is that they maintain their relative size. Use the PgUp and PgDn keys (or the
corresponding buttons on Composer) to zoom into the map. Notice how the text gets physically bigger, but
retains its relative size. As you will see later, there is a way in which you can specifically set the relationship
between map scale and text size.

Modifying the Composition

d)

Press the HOME key and then the END key to return to the previous state of the composition. Then click the
Map Propertics button on Composer. This tabbed page dialog contains the means of controlling all non-layer
components of the composition,

By default, the Map Properties dialog opens to the Legends tab. In this case, we need to add a legend for the
roads layer. Notice how the first legend object is set to WESTLUSE layer. ‘This was set when you chose to dis-
play a legend when first launching the layer. We therefore will need to use one of the other legend objects. Click
the down arrow of the layer name input box for Legend 2 for a list of all the layers in the compasition. Select the
WESTROAD layer. Notice how the isibk property is automatically selected. Now click the Select Font button
and set the text to be 8-point, the font to be Arial, the style to be regular, and the color o be black. Then click
the Select Font button for the WESTLUSE legend and make sure it has the same settings. Then click OK.

When Display Launcher initiates the display, it is in complete control of where all elements belong. However,
after this, when any new component is added, it expects us to place the components ourselves. Clearly this new
legend is not where we want it. Therefore, mave the mouse over the roads legend and double click onto it. This
will produce a sct of sizing/move bars along the edge of the component. Once they appear, the component can
be either resized and/or moved. In this case, we simply want to move it. Place the mouse over the legend and
hold the left button down to drag it just below the lands use legend. Then to fix it in place (and thereby stop the
drag/size operation), click on any other map component (or the banner of the map window). Do this now. You
will know you have been successful if the sizing bars disappear.

Now move the mouse over the title and click the right mouse button. Right clicking over any map composition
element will launch the Map Properties dialog with the appropriate tab for the map component involved.!
Notice how the Title component has been set to visible. Again, this was set when the land use layer was
launched. When the title option was selected in Display Launcher, it adopted the text of the titde entry in the
documentation file for that layer.!” However, we are going to change this. Change the tide to read "Westbor-
ough, Massachusetts.” Then click on the Select Font button and change the font to Times New Roman, bold
italic style, maroon color and 22 point size.

Next, click into the Caption Text input box and type "Land Use / Land Cover." Set the font to be bold 8 point

16. In the case of right clicking over the layer frame, the default legend tab is activated.

17. If the tide entry in the documentation file is blank, no title will appear even though space has been keft for it
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Arial, in maroon. Then click OK. We will place this caption above the land use legend. Therefore, double click
onto each of the roads and land use legends in turn to move them down so that this lepend caption can be
placed above the land use legend (but not higher than the layer frame).

Now bring up Map Properties again and seclect the Graphic Insets tab. Use the browse button to find the
WESTBOROQ.BMP bitmap. Select this file and then set the Stretchable property on and the Show Border option
off. Then click OK. You will immediately note that you will need to both position and size this component.
Double click onto the inset and move it so that its bottom-right corner is in the bottom-right corner of the map
window, allowing 2 small margin equal to that between the layer frame and the map window. Then grab the
upper-left grab bar and drag it diagonally up and to the left so that the inset occupies the full width of the legend
area (again leaving a small margin equal to that placed on the right side). Also be sure that the shape is roughly
square. Then click any other component (of the map window banner) to set the inset in place.

Now bring up Map Properties again and select the Scale Bar tab. Set the Units Text to Meters, the number of
divisions to 4 and the length 10 2000. Also click the Select Font button and set it to 8-point regular black Aral
and click OK. Then double dick onto the scale bar and move it to a position between the inset and the roads
legend. Click onto the map window banner to set it in place.

Now bring up Map Properties again and select the Background tab. Click into the Map Window Background
Color box to bring up the color selection dialog. Select the upper-left-most color box and click the Define Cus-
tom Colors button. This will yield an expanded dialog in which colors can be set graphically, or by means of
their RGB or HLS color specifications. Set the Red, Green and Blue coordinates to 255, 221 and 157 respec-
tively. Then dick on the Add to Custom Colors button, followed by the OK button. Now that you are back at
the Background tab, check the box labeled Assign Map Window Background Color to All Map Components.
Then dlick OK.

This time select the Map Grid tab from Map Properties. Set the origin X and Y coordinates to 0 and the incre-
ment in both X and Y to be 2000. Set the color (by clicking onto its box) to be the bright cyan (aquamarine)
color in column 5, row 2 of the color selection options. Set the Decimal Places to 0 and the Grid Line Width to
1. Then set the font to regular 8-point Arial with an Aqua color (to match the grid). Then dlick OK to see the
result.

Finally, bring up Map Propertics and go to the GeoReferencing tab. We will not change anything here, but sim-
ply examine its contents. This tab is used to set specific boundaries to the composition and the current view.
Note that the units are specified in the actual map reference units, which may represent a multiple of ground
units. In this case, each map reference unit represents 20 meters. Note also the entries to change the reladonship
of Reference System coordinates to Text Points. At the moment, it has been set to 1. This means that each text
point is the equivalent of 1 map unit, which in turn represents 20 meters. Thus, for example, a text label of 8
points would span an equivalent of 160 meters on the ground. Changing this value to 2 would mean that 8-point
text would then span 320 meters. Try this if you would like. You will need to dick on OK to have the change
take place. However, be sure to change it back 1 1 before finishing,

Next, let's go to the North Arrow tab. We will not be placing a north arrow on this map. However, you can see
that options exist to change the color, declination and text associated with the symbol. Like all other compo-
nents, the North Arrow is also placeable and sizable.

To finish, click on OK to exit Map Properties.
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Saving and Printing the Composition

This completes our composition of the map. Naturally, it would be nice to save and/or print the composition. For this,
we need to return tn Compaser.

n)

P

Click the Save Composition button on Composer. Note the variety of options you have, However, only the first
truly saves your composition in a form that will allow you to re-create and further edit or extend your map com-
position. Click it now, and save it to a Map Compasition named WESTBORO. This will create 2 map composi-
ton file named "westboro.map” in your working folder. However, note that it only contains the instructions on
how to create the map and not the actual data layers. It assumes that when it recreates the map, it will be able to
find the layers you reference in cither the Working Folder or one of the Resource Folders of the current project
environment. Thus if you wish to copy the composition to another location, you should remember to copy both
the ".map" file and all layer, palette and symbol files required. (The Idrisi File Explorer may be used to copy
files)

Once you have saved your compaosition, remove it from the screen. Then call Display Launcher and select the
Map Composition File option and search for your composition named WESTBORQ., Then simply click OK to
view the result. Once your compasition has finished displaying, you are exactly where you left off.

Now select the Print Compaosition button from Composer. Sclect your printer and review its properties. If the
properties box for your printer has a Graphics tab, select it and look at the settings. Be sure it has been set to the
finest graphics option available. Also, if you have the choice of rasterizing all graphic objects (as opposed to
using vector graphics directly), do so. This is important since printers that have this option typically do not have
enough memory to draw complex map objects in vector directly. With this choice, the rasterization will happen
in the computer and not the printer (a better solution).

After you have reviewed the graphics options, set the paper orientation to landscape and then print your map.

Final Important Notes About Printing and Composition
The results you get with printing will depend upon a variety of factors including:

You should always work with True Type fonts if you intend to print your map. Non-True Type fonts cannot be
rotated properdy (or at all) by Windows (even on screen). In addition, some printers will substitute different
fonts for non-True Type fonts without asking for your permission. True Type fonts are always specially marked
by Windows in the font selecton dialog,.

Some printers provide options to render True Type fonts as grphics or to download them as "soft fonts.”
Experiment with both options, but most printers with this option require the "soft fonts" option in order to
print text backgrounds correctly.

Probably the best value for money in printers for GIS and Image Processing lies with color ink jet printers,
However, the quality of paper makes a huge difference. Photo quality papers will yield stunning results, while
draft quality papers may be blurred with poor color fidelity.

Save the WESTBORQO map compaosition for use in Exercise 1-6.
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Exercise 1-5
Palettes, Symbols and Creating Text Layers

Throughout the preceding exercises, we have been using palettes and symbol files to graphically render map layers. In this
cxercise, we explore how to create these files. In addition, we explore the creation of text layers (a major form of annota-

tion) through digitizing,

Creating Palettes

Both symbol files and palettes are created with Symbol Workshop. However, given the frequency with which we will need
to create palettes, a special icon is available on the tool bar tn access the palette option of Symbol Workshop.

2)

b)

c)

d

h)

Find the icon for Symbol Workshop: Palettes (seventh from the left) and dick it. We will create a new palette to
render topographic surfaces. Notice the large matrix of boxes on the right. These represent the 256 colors that
are possible in a color pa.lette.m Right now they are all set to the same color. We will change this in 2 moment.
Now move your mouse over these boxes and notice as the mouse is over each box a hint is displayed indicating
which of the 256 palette entries that box represents.

Click into the box for palette entry 0. Since you have not yet specified an output file name, you will immediately
be asked for one before you continue. Specify the name TERRAIN and click OK.

You will now be presented with the standard Windows color dialog, The color we want for this entry is black,
which is the sample color in the lower-left corner of the basic colors section of the dialog box. Select it and then
click OK.

Now click into the box for palette entry number 17. Define a custom color by setting the values for Red, Green
and Blue to 136 222 64 and click OK. Then set the From blend option to 0 and the To blend option to0 17 and
click the Blend button.

Now locate palette entry 51 and set its RGB values to 255 232 123. Set the blend limits from 17 to 51 and dlick
the Blend button.

Set palette entry 119 to an RGB of 255 188 76. Then blend from 51 to 119.
Set palette entry 238 to an RGB of 180 255 255. Then blend from 119 to 238.

Finally, set palette entry 255 to white. This is the sample color in the lower right corner of the basic colors sec-
tion (or you can set it with an RGB of 255 255 255). Then blend from 238 to 255. This completes the palette.
We can save it now by selecting the Save option from Symbol Workshop's File menu. Exit from Symbol Work-
shop.

Now use Display Launcher to view the image named ETDEM using the TERRAIN palette you just created.

18. This limit of 256 colors per palette is sct by Windows,
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Creating Symbol Files

The map you just displayed is of elevation in Ethiopia. The next thing we will do is to add a vectar line layer of the prov-
ince boundaries to the clevation display.

i) Use the Add Layer button on Composer and add the file named ETPROV with the Uniform Black symbol file.
As you can see, these lines (thin solid black) are somewhat too dark for the delicate palette we've created. There-
fore, let's create a new symbal file using grey lines.

i Open Symbol Wotkshop either from the Display menu or by clicking on its icon (sixth from the left). Under
Symbol Workshop's File menu, select New. When the New Symbol File dialog appears, click on Line and spec-
ify the name GREY.

k) Now select line symbol 0 and set its width to 1 and its style to solid. Then click on the color box to access the
Windows color dialog to set its color to RGB 128 128 128. (lick OK to exit the color selection dialog and again
to exit the line symbol dialog,

)} Now click on the Copy button. By default this function is set to copy the symbol characteristics from symbol 0

to all other symbols. Therefore all 256 symbols should now appear the same as symbol 0. Choose Save from the
Symbol Workshop File menu and close Symbol Workshop.

m) We will now apply the symbol file we just created to the province boundaries vector layer in the map display.
Click on the entry for ETPROV in the Composer list (to select it), then click the Layer Properties button.
Change the symbol file to GREY. Then click on the OK button of the Layer Properties dialog. The more subte
medium grey province boundaries go well with the colors of the elevation palette. Click OK on the Layer Prop-
erties box.

Digitizing Text Layers

Our next step will be to create a set of labels for the provinces of Ethiopia. This will be done by creating a symbol file for
the text symbols, and a text layer with the label features.

n) Open Symbol Workshop, and use the New option of the File menu to create a text layer with the name
PROVTEXT. Select text symbol O and set its characteristics to 12 point bold italic Times New Roman in
maroon. Click OK to return to the main Symbol Workshop dialog, and use the Copy button to copy this symbal
to all other categories. Then Save the file (from the File menu) and exit Symbol Workshop.

We now have a symbol file to use in labeling the provinces. To create the text layer with the province names, we will use
the IDRISI on-screen digitizing utility. Before beginning, however, examine the provinces as delineated in your composi-
tion. Notice that if you start at the northernmoast province and move clockwise around the boundary, you can count 11
provinces, with two additional provinces in the middle—a northern one and a southern one. This is the order we will dig-
itize in: number 1 for the northernmost province, number 2 for that which borders it in the clockwise direction, and so
on, finishing with number 13 as the more southerly of the two inner provinces.

0) First, press the END key to make your composition as large as possible. Then click the digitize icon on the tool
bar (the onc with the cross in a circle). If the highlighted layer in Composer is the ETPROV layer, then you will
be asked if you wish to add features to this existing layer, or create a new layer. Indicate that you wish to create a
new layer. If, on the other hand, the highlighted layer in Composer was the ETDEM layer, it would automati-
cally assume that you wished 10 create a new layer since ETDEM is raster, and the on-screen digitizing feature
always creates vector layers.
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p) Specify PROVTEXT as the name of the layer to be created and click on Text as the layer type. For the symbol
file, specify the PROVTEXT symbol file you just created. Specify 1 as the index of the first feature, make sure
the Automatic Index feature is selected, and click OK. Now move to the middle of the northernmost province
and click the left mouse button. Enter Tigray as the text for the label. Most other clements can be left at their
default values. However, select the Specify Rotation Angle option, and leave it at its default valuc of 90°.'? Also,
the relative caption position should be set to Center. Then click OK.

9 Repeat this action for each of the remaining provinces. Their names and their feature ID's (the symbol type will
remain at 1 for all cases) are listed below. Remember to digitize them in clockwise order. For the two center
provinces, digitize the northern one first.

2 Welo

3 Harerge
4 Bale

S Sidamo
6 Gamo Gofa
7 Kefa

8 flubabor
9 Welega
10 Gojam
it Gonder
12 Shewa
13 Arsi

Don't worry if you make any mistakes, since they can be corrected at a later time. When you have finished, click
the right mouse button to signal that you have finished digitizing ‘Then click the Save Digitized Data icon on the
tool bar (2 red arrow pointing downward, 2 icons to the right of the digitize icon) to save your text layer.

1) When we initially created this text layer, we made all text labels horizontal. Let's delete the label for Shewa and
put it on an angle with the same orientation as the province. Make sure the text layer, PROVTEXT is high-
lighted in Composer. Click on the Delete Feature button on the tool bar (2 red X to the right of the digjtize
icon). Then move the mouse over the Shewa label and click the left mouse button to select it. Press the Delete
key on the keyboard. IDRISI will prompt you with 2 message to confirm that you do wish to delete the feature.
Click Yes. Click on the Delete Feature icon again to release this mode. Now click the Digitize button and indi-
cate that you wish to add a feature to the existing layer. Specify that the index of the first feare to be added
should be 12, ‘Then move the cursor to the center of the Shewa province and click the left button, As before,
type in the name Shewa, but this time, indicate that you wish to use lnteractive Rotation Specification Mode.
Then dick OK and move the cursor to the right. Notice the rotation angle line. This is used simply to facilitate
spedification of the rotation angle. The length of the line has no significance—only the angle is meaningful. Now
rotate the line to the northeast to an angle that is similar to the angle of the province itself. Finally click the left
mouse button to place the text.

If you made any mistakes in constructing the text layer, you can correct them in the same manner. Otherwise,
click the right mouse button to finish digitizing and then save your revised layer by clicking on the Save Digi-
tized Data icon on the tool bar.?®

5) To complete your composition, place the legend for the elevation layer in the upper-left corner of the layer

19. Text rotation angles atc specified as azimuths (i.c., cockwise from north). Thus, 90° yiclds standard horizontal 1ext while 270° produces text that is
upside-down.

20. 1 you forget to save your digitizing, IDRISE will ask if you wish w save your data when you exit.
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frame. Since the background color is black, you will want to use Map Properties to change the text color of the
legend to be white and its background ta be black.

Add any other map components you wish and then save the composition under the name ETHIOPIA.

u) Save the ETHIOPLA map composition for usc in Exercise 1-6.
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Exercise 1-6
Data Structures and Scaling

a) Use Display Launcher to view both the WESTBORO and ETHIOPIA map compositions created in Exercises
1-4 and 1-5.2! Notice the difference between the legends for the WESTLUSE layer of the WESTBORQ com-
position and the ETDEM legend of the ETHIOPIA composition. To appreciate the reasons for this difference,
choose the 1drisi File Explorer from the File menu or click on its icon (the second from the left).

‘The Idrisi File Explorer is a general purpose utility for listing, examining and managing your IDRISI daa files. The left-
hand panel lists all of the various file types that are used in IDRISI, while the right-hand panel is used to select a specific
file. When you open Idrisi File Explorer, it automatically lists the files in your working folder. However, the drop-down
list box to the upper-right can be used to select any of your resource folders or selected system folders.

b) Using the drop-down list box in the upper-right corner, select the folder that contains the WESTLUSE and
ETDEM raster images.

The lower third of Explorer contains a variety of utilitics for copying, deleting and renaming files, along with a second set
of utilities for viewing file contents. We will use these latter operations in this exercise.

c) Highlight the WESTLUSE layer by clicking upon its entry in the right-hand panel. Notice that the name is listed
as "westluse.rst”. This is the actual data file for this raster image, which has an ".rst" file extension. Notice, how-
ever, that the pancl on the left indicates that operations on these files also involve a second file with an ".rdc”
extension. The ".rdc" file is its accompanying metadata file. The term mefadata means "data about data”, i.e., doc-
umentation (which explains the “rdc" extension—it stands for "raster documentation®).

d) Now with WESTLUSE highlighted, click on the View Structure button. This shows the actual data values
behind the upper left-most portion (8 columns and 16 rows) of the raster image. Each of these numbers repre-
sents a land use type, and is symbolized by the corresponding palette entry. For example, cells with 2 number 3
indicate forested land and are symbolized with the third color in the WESTLUSE palette. Use the arrow keys to
move around the image. Then exit from the View Structure dialog,

€) Making sure that the WESTLUSE raster layer is stll highlighted in Explorer, now click on the View Metadata
button, This button accesses the Metadata module (also accessible from the File menu or the fourth icon on the
tool bar) which will show us the contents of the "westluse.rdc” file. This file contains the fundamental informa-
tion that allows the file to be displayed as a raster image and to be registered with other map data.

The file type is specificd as binary, meaning that numeric values are stored in standard IEEE basc 2 format. The
View Structure utility allows us to view these values in the familiar base 10 numeric system. However, they are
not directly accessible through other means such as a word processor. IDRISI also provides the ability to con-
vert raster images to an ASCU? format, although this format is only used to facilitate import and e.xport_23

21. If you did nut complete the catlier exercises, display the raster image WESTLUSL with the paletic WESTLUSE and a legend. Also disphy ETDEM
with the TERRAIN palette (or the Quantitative Standard Idrisi palette) and a legend. Then continue with this excreise.

22. ASCI is the American Standard Cuode for Information Interchange. It was one of the catlicst coding standards for the digital representation of
alphabetic characters, numerals and symbals. Each ASCLI character takes one byte (8 bits) of memory. Recently, a new system has been introduced o
cope with non-US alphabet systems such as Greek, Chinese and Arabic. This is called UNICODLE and requires 2 bytes per character. IDRISI accepts
UNICODL for its text layers since the software is used worldwide. However, the ASCH format is still very much in vsc as a means of storing single byte
codes (such as Roman numetals), and is a subset of UNICODLE. ’
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The data type is byte. This is a special sub-type of integer. Integer numbers have no fractional parts, increasing
only by whole number steps. The byte data type includes only the positive integers between 0 and 255. In con-
trast, files designated as having an integer data type can contain any whole numbers from -32768 o + 32767.
The reason that they both exist is that byte files only require one byte per cell whereas integer files require 2.
Thus, if anly a limited integer range is required (as in this casc), use of the byte data type can halve the amount of
computer storage space required. Raster files can also be stored as real numbers, as will be discussed below.

The columns and rows indicate the basic raster structure. Note that you cannot change this structure by simply
changing these values. Entries in a documentation file simply describe what exists. Changing the structure of a
file requires the use of special procedures (which are extensively provided within IDRISI).

The seven ficlds related to the reference system indicate where the image exists in space. The Georeferencing
chapter in the IDRISI Guide to GIS and Image Processing Volume 1 gives extensive detils on these
entrics. However, for now simply recognize that the reference system is typically the name of a special reference
system parameter file (called a2 REF file in IDRISI) that is stored in the GEOREF sub-folder of the IDRISI pro-
gram directory. Reference units can be meters, feet, kilometers, miles, degrees or radians (abbreviated m, ft, km,
mi, deg, rad). The unit distance multiplier is used to accommodate units of other types (e.g, minutes). Thus, if
the units are one of the six recognized unit types, the unit distance will always be 1.0. With other types, the value
will be ather than 1. For example, units can be expressed in yards if one sets the units to feet and the unit dis-
tance to 3.

The positional error indicates how close the actual location of a featurc is to its mapped position. This is often
unknown and may be left blank or may read snénoyn. The resolution field indicates the size of each pixel (in X)
in reference units. It may also be left blank or may read unknown. Both the positional error and resoltuion fields
are informational only (i.c., are not used analytically).

The minimum and maximum value fields express the lowest and highest values that occur in any cell, while the
display minimum and display maximum cxpress the limits that are used for scaling (see below). Commonly, the
display minimum and display maximum values are the same as the minimum and maximum values.

The value units field indicates the unit of measure used for the attributes while the value error field indicates
cither an RMS value for quantitative dam or a proportional error value for qualitative data. The value error field
can also contain the name of an error map. Bath fields may be left blank or read anknown. They arc used analyti-
cally by only a few modules.

A data flag is any spedial value. Some IDRISI modules recognize the data flags background or missing data as indi-
cating non-data.

f) Now click on the Legend tab. This contains interpretations for each of the land use categories. Clearly it was this
information that was used to construct the legend for this layer. You can now close Metadata.

£ Now highlight the ETDEM raster layer and dlick the View Structure button. What you will initally see is the
zeros which represent the background area. However, you may use the arrow keys to move farther to the right
and down until you reach cells within Ethiopia. Notice how some of the cells contain fractional parts. Then exit
from View Structure and click in View Metadata,

Notice that the daw type of this image is rcal. Real numbers are numbers that may contain fractional parts. In
IDRISI, raster images with real numbers are stored as single precision floating point numbers in standard IEEE

23. Older versions of IDRISI fully supported the ASCIL format. As a consequence, many analytical modules do recognize and can work with this for-
mat. However, it is slow and inefficient for data storage. Because current programming languages can now work with binary files as casily as ASCH, we
have decided  disoontinue suppott for ASCLL other than fot impott/export.
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format, requiring 4 bytes of storage for each number. They can contain cells with data values from -1 x 10" w0
+1 x 107 with up to 7 significant figures. In computer systems, such numbers may be expressed in general for-
mat (such as you saw in the View Structure display) or in scientific format. In the latter case, for example, the
number 1624000 would be expressed as 1.624¢+006 (i.c., 1.624 x 109,

Notice also that the minimum and maximum values range from 0 to 4267.

Now dick the Legend tab. Notice that there is no legend stored for this image. This is logjcal. In these metadata
files, legend entries are simply keys to the interpretation of specific data values, and typically only apply to quali-
tative data. In this case, any value represents an clevation.

Remove everything from the screen except your ETHIOPLA composition. Now open up Symbol Workshop to
create a new palette named TEST16. Make palette entry 0 black and palette entry 1 the yellow found in column
2 row 1 of the basic colors. Make palette entry 15 the green found in column 3 row 4 of the basic colors and
then blend from 1 to 15, Set the Autoscale Maximum entry to 15. Save the palette and then exit from Symbol
Workshop. Then use Display Launcher to display ETDEM with your TEST16 palette. Be sure that the legend
option is sclected.

Notice that this is yet another form of legend.

What should be evident from this is that the manner in which IDRISI renders cell values as well as the nature of the leg-
end depends upon a combination of the data type and the symbol file.

When the data type is cither byte or integer, and the layer contains only positive values from 0-255 (the range of
permissible values for symbol codes), IDRISI will automatically interpret cell values as symbol codes. Thus, a
cell value of 3 will be interpreted as palette color 3. In addition, if the metadara contains legend captions, it will
display those captions.

If the data type is integer and there are more than 256 data values, or if the data type is real, IDRISI will auto-
matically assign cells to symbols using a feature known as aufoscaling and it will automatically construct a legend.

Autoscaling divides the data range into as many categories as are included in the Aufoseale Min to Autescale Max
range specified in the palette (commonly 0-255, yielding 256 categories). It then assigns cell values to palette col-
ors using this relationship. Thus, for example, an image with values from 1000 to 3000 would assign the value
2000 to palette entry 128,

The namre of the legend created under autoscaling depends upon the number of symbols in the palette. If the
number of palette entries between the Awtoscale Min to Autoscale Max range of the palette is not greater than the
maximum number of visible legend categories specified in User Preferences?* (16 by default), then IDRISI dis-
plays separate legend boxes and the range of values applicable to each (such as the rendition of ETDEM using
TEST16). However, if the number of palette entries exceeds this maximum (such as the rendition of ETDEM
using the TERRAIN palette in your ETHIOPIA map), IDRISI constructs 2 continuous legend showing the
position of representative values.

‘There is one further legend type you may encounter. Use Display Launcher to examine the SIERRA4 layer using
the Grey Scale palette. Be sure the legend option is on but that autoscaling is not selected.

In this case, the image is not autoscaled (cell values all fall within 2 0-255 range). However, the range of values
for which legend captions are required cxceeds the maximum set in User Prcfcrcnccs,z’ so IDRIS] provides a

24. User Preferences can be changed under the Lile menu.

25. The maximum number of displayable legend categorics can be increased to no mote than 48.
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scrollable legend. To understnd this effect further, click on the Layer Properties in Composer. Then alternately
click on and off the autoscale property. Notice how the legend changes.

You will also notice that when the autoscale feature is clicked on in Layer Properties, the contrast of the image is
improved. The Display Min and Display Max sliders also become active when autoscaling is active. Click
autoscaling on and then try sliding these with the mouse. They can also be moved with the keyboard arrow keys
(hold down the shift key with the arrows for smaller increments).

Slide the Display Min slider to the far left. Then press the right arrow twice to move the Display Min to 26 {or
close to it). Then move the Display Max slider to the far right, followed by three clicks of the left acrow to move
the Display Max to 139, Notice the start and end legend categories on the display.

When the Display Min is increased from the actual minimum, all cell values lower than the Display Min are
assigned the lowest palctte entry (black in this case). Similady, all cell values higher than the Display Max are
assigned the highest palette entry (white in this casc). This is a phenomenon called satwration. This can be very
effective in improving the visual appearance of autnscaled images, particularly those with very skewed distribu-
tions.

Use Display Launcher to display SIERRA2 with the Grey Scale palette and without autoscaling. Clearly this
image has very poor contrast. Create a Histogram Disphy of this image using HISTO from the Display menu
{or its toolbar icon). Specify SIERRAZ as the image name and click OK, accepting all defaults.

Notice that the distribution is very skewed (the maximum extends to 96 despite the fact that very few pixels
have values greater than 60). Given that the palette ranges from 0-255, the dark appearance of the image is not
surprising. Virtually all values are less than 60 and are therefore displayed with the darkest quarter of palette col-
ors.

If Layer Properties for SIERRA4 is still visible on the screen, click the OK button to keep your settings and
remove it. Then be sure that SIERRAZ2 has focus and click Layer Properties again. Now click autoscaling on.
This provides a big improvement in contrast since the majority of cell values now cover half the color range
(which is spread between the minimum of 23 and the maximum of 96). Now slide the Display Max slider to a
value around 60. Notice the dramatic improvement! Click the Save Changes button. This saves the new Display
Min and Display Max values to the metadata file for that layer. Now whenever you display this image with
autoscaling, these enhanced settings will be used.

Remove all images and dialogs from the screen. Then open the COMPOSITE module, either from the Display
menu or from its toolbar icon 9 from left). Here we can create 24-bit composite images. Specify SIERRA4,
SIERRAS and SIERRA7 as the red, green and blue bands, respectively. Call the ourput SIERRA457. We will use
the default settings to create a 24-bit composite with original values and stretched samation points and default
saturation of 1%. Click OK.

After the image has displayed, click on Layer Properties on Composer. Notice that three sets of sliders are pro-
vided—one for each primary color. Also notice that the Display Min and Max values for each are set to values
other than the actual minimum and maximum for each band. This was caused by the saturation option in COM-
POSITE. They have each been moved in so that 1% of the data values is saturated at each end of the scale for
each primary.

Experiment with moving the sliders. You probably won't be able to improve on what COMPOSITE calculated.
Note also that you can revert to the original image characteristics either by clicking the REVERT or CANCEL
buttons.

Scaling is a powerful visual wol. In this exercise, we have explored it only in the context of raster layers and palettes.
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However, the same logic applies to vector layers. Note that when we use the interactive scaling tools, we do not alter the
actual data values of the layers. Only their appearance when displayed is changed. When we use thesc layers analytically
the original values will be used (which is what we want).

To finish this exercise we will use File Explorer a bit further to examine the structure of vector layers.

m) Open Iddsi File Explorer and select vector layers from the list in the left-hand panel. Then choose the
WESTROAD layer and click on View Structure. As you can see, the output from this module is quite different
for vector layers. Indeed, it will even differ between vector layer types.

The WESTROAD file contains a vector line layer. However, what you see here is not the actual way it is stored.
Like all IDRISI data files, the truc manner of storage is binary. To get a sense of this, cancel the View Structure
dialog and then click the View Binary button. Clearly this is unintelligible. The View Structure procedure for vec-
tor layers provides an interpreted format known as "Vector Export Format".2% That said, the logical correspon-
dence between what is seen in View Structure and what is contained in the binary file is very close. The binary
version does not contain the interpretation strings on the left, and it encodes numbers in a standard 1IEEE
binary format.

n) Remove any displays related to View Structure or View Binary. Then click on the View Metadata button. As you
can see, there is a great deal of similarity between the metadata file structures for raster and vector. The primary
difference is related to the data type field, which in this case reads 1D type. Vector files always store coordinates
as double precision real numbers. However, the ID field can be either im::gt:r27 or real, When it contains a real
number, it is assumed that it is a free-standing vector layer, not associated with a database. However, when it is
an integer, the value may represent an 1D that is linked to a data table, or it may be a free-standing layer. In the
first case the vector feature IDs would match a link field in a database that contains attributes relating to the fea-
tures. In the second case the vector feature 1Ds would be embedded integer attributes such as elevations or
landuse codes.

o) You may wish to explore some other vector files with the View Structure option to see the differences in their
structure. All are self-evident in their organization, with the cxception of polygon files. To apprediate this, exit
from the Metadata display and find the AWRAJAS2 vector layer. Then click on View Structure. The item that
may be difficult to interpret is the Number of Parts. Most polygons will have only one part (the polygon itsclf).
However, polygons that contain holes will have more than one part. For example, a polygon with two holes will
list three parts—the main polygon, followed by the two holes.

)] Exit from View Structure. To finish this exercise, delete the palette you created eardier named TEST16. Simply
click on the Palette file type in the left pancl and then click on the TEST16 file in the rght panel. Then dlick on
the Delete button. Click Yes when prompted whether to delete the file.

26. A vector export format file has a ".vxp" extension and is editable. The CONVERT module ean import and export these files. In addition, the con-
tent of View Structute can be saved as a VXP file (simply click on the SAVE button). Furthermure, you can edit within the View Structure dialog, 1f you
edit a VXD file, he sure to re-import it under 2 new name using CONVERT. This way your osiginal file will be keft intact. The Help System has more
details on this process.

27. The integer type is not further broken down into a byte subtype as it is with raster. In fact, the integer furmat used for vector files is technically 2
long integer, with a range within + /- 2,000,000,
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Exercise 1-7
Vector Collections and SQL

As we saw in Exercise 1-2, a vector collection is created through an assodation of a dambase of attributes and a vector
spatial frame. As a consequence, standard database management procedures can be used to query and manipulate the
database, thereby offering counterparts to the database query and mathematical operators of raster GIS.

One of the most common means of accessing database tables is through a special language known as Structured Query
Language (SQL). IDRISI facilitates your use of SQL through two primary facilitics: filter and calculate.

Filter

a) Clear your screen and use Display Launcher to display the MedHomVal vector layer from the MAZIP vector
callection. Then open Database Workshop, cither from the GIS Analysis/Database Query menu or from its
icon. Move the table to the bottom right of the screen so that both the table and the map are both in view, but
overlap as little as possible.

b) Now click the Filter Table icon (the one that looks like a pair of dark sunglasses) on the Database Workshop
toolabar . This is the SQL Filter dialog, The left side contains the beginnings of an SQL Sclect statement while
the right side contains a utility to facilitate constructing an SQL expression.

Although you can directly type an SQL expression into the boxes on the left, we recommend that you use the
utility on the right since it ensures that your syntax will be correct.?®

We will filter this data table to find all ZIP code areas in which the median home value is greater than four times
the median income:

The asterisk after the Select keyword indicates that the output table should contain all fields. You will commonly
leave this as is. However, if you wanted the result to contain only a subset of fields, they could be listed here,
separated by commas.?’

The From clause is alrecady understood to be the current table.

The Where clause is the heart of the filter operation, and may contain any valid relational statement that uld-
mately evaluates to true or false when applied to any record.

The Order By clause is optional and can be left blank. However, if a field is selected here, the results will be
ordered according to this field.

) Either type directly, or use the SQL expression tabs to create the following expression in the WHERE clause

28. 5QL is sumewhat particular about spacing—a single space must exist between all expression components. In addition, ficld names that contain
spaces or unusual characters must be enclosed in squate brackets. Use of the SQL exptession utility on the tight will place the spaces correctly and will
enclose all fickd names in hrackets.

29. Noe that if the data table is actively linked to one or more maps and you only usc a subsct of output fields, one of these should be the 1D field. Oth-
erwise an error will be reported.
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box:
[MedHomVal] > (4 * |[MedHHinc] )

Note the spaces on either side of the ">" (greater than) operator and the "™*" (multiply) operator. Also note the
use of parentheses to produce an unambiguous result. Then click OK.

When the expression completes successfully, all features which meet the condition are shown in the Map Window in red,
while those that do not are shown in dark blue. Note also that the table only contains those records that meet the condi-
tion (i.c., the red colored polygons). As a result, if you click on a black polygon using Cursor Inquiry Mode the record will
not be found.

d) Now click the Toggle Filter on Map icon (the one that looks like a lightming bolt) on and off several imes. This
is a simple utility that allows you to quickly see the underlying map upon which the analysis was based. Note that
if several maps are displayed from the collection, all will show the filter result.

) Finally, to remove the filter, click the Remove Filter icon (the light glasses).

Calculate

f) Leaving the databasc on the screen, remove all maps derived from this collection. We need to add a new data
field for the next operation and this can only be done if the data table has exclusive access to the table (this is a
standard security requirement with databases). Since each map derived from a collection is actively attached to
its database, these nced to be closed in order to madify the structure of the table.

2 Go to the Database Workshop Edit menu and choose the Add Field option. Call the new field MFrado and set
its data type to Single Precision Real. Scroll to the right of the database to verify that the field was created.

h) Now click on the Calculate Ficld Values icon (+=). In the Set clause input box, select MFratio from the drop-
down list of database ficlds. Then enter the following expression into the Equals clause (use the SQL expression
tabs or type directly):

[Males| / |[Females|

Note the spaces on either side of the division operator. Then click OK and indicate, when asked, that you do
wish to madify the database. Scroll to the MFratio field to see the result.

1) Be sure that the table cursor (i.e., the selected cell) is in any cell within the MFratio field. Then click the Display
icon on the Database Workshop toalbar to view a map of the result. Note the interesting spatial distribution.

Challenge

Create a Boolean display of those towns in Massachusetts in which there are more males than females (i.e., the male/
female ratio is greater than one).

The database query operations we performed in this exercise were carried out using the attributes in a database. This was
possible because we were working with a single geography, the Zip code zones of Massachusetts, for which we had mul-
tiple attributes. We displayed the results of the database operations by linking the database to a vector file of the ZIP code
zones. As we move on to Part 2 of the Tutorial, we will learn to use the raster GIS tnols provided by IDRISI to perform
database query and other analyses on layers that describe different geographies.
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Tutorial Part 2: Introductory GIS Exercises

Introductory GIS Exercises
Cartographic Modeling
Database Query
Distance and Context Operators
Exploring the Power of Macro Modeler
Cost Distances and Least Cost Pathways
Map Algebra
Multi-Criteria Evaluation—Criteria Development and the Boolean Approach
Multi-Criteria Evaluation—Non-Boolean Standardization and Weighted Linear Combination
Multi-Criteria Evaluation—Ordered Weighted Averaging
Muld-Criteria Evaluation—Site Selection Using Boolean and Continuous Results

Mult-Criteria Evaluation—Multiple Objectives

Data for the first six exercises in this section are installed (by default—this may be customized during program installa-
tion) to a folder called \Idrisi32 Tutorial\ Introductory G1S on the same drive as the 1drisi32 program folder was installed.
Data for the five Multi-Criteria Evaluation exercises may be found (by default) in the folder \Idrisi32 Tutorial\MCE.
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Exercise 2-1
Cartographic Modeling

A cartographic model is a graphic representation of the data and analytical procedures used in a study. Its purpose is to
help the analyst organize and structure the necessary procedures as well as identify all the data needed for the study. It also
serves as a source of documentation and reference for the analysis.

We will be using cartographic models extensively in the Introductory GIS portion of the tutorial exercises. Some models
will be provided for you, and others you will construct on your own. We encourage you to develop a habit of using carto-
graphic madels in your own work.

In developing a cartographic model, we find it most useful to begin with the final product and proceed backwards in a
step by step manner toward the existing data. This process guards against the tendency to let the available data shape the
final product. The procedure begins with the definition of the final product. What values will the product have? What will
those values represent? We then ask what data are necessary to produce the final product and define each of these data
inputs and how they might be obtained or derived. The following example illustrates the process:

Suppose we wish to produce a final product that shows those areas with slopes greater than 20 degrees. What
data are necessary to produce such an image? To produce an image of slopes greater than 20 degrees, we will
first need an image of all slopes. Is an image of all slopes present in our database? If not, we take one step fur-
ther back and ask more questions: What data are necessary to produce a map of all slopes? An elevation image
can be used to create a slope map. Does an elevation image exist in our database? 1f not, what data are necessary
to derive it? The process continues until we arrive at existing data.

The existing data may already be in digital form, or may be in the form of paper maps or tables that will need to be digi-
tized. If the necessary data are not available, you may need to develop a way to use other data layers or combinations of
data layers as substitutes.

Once you have the cartographic model worked out, you may then procede to run the modules and develop the output
data layers. With Release 2 of Idrisi32, a graphic madeling environment, the Macro Maodeler, was introduced. The Macro
Moadeler may be used to construct and run models. However, when you construct a model in the Macro Modeler, you
must know which modules you will use to produce output data layers. In effect, it requires that you build the model from
the existing data to the final product. Hence, in these exercises, we will be constructing conceptual cartographic models as
diagrams, then we will be building models in the Macro Modeler once we know the sequence of steps we must follow.
Building the models in the Macro Modeler is worthwhile because it allows you to correct mistakes or change parameters
and then re-run the entire model without running each individual module again by hand.

‘The cartographic model disgrams in the Tutorial will adhere, w0 the extent possible, to the conventions of the Macro
Moadeler in terms of symbology. We will construct the cartographic models with the final output on the right side of the
model and the data and command elements will be shown in similar colors to thaose of the Macro Modeler. However, to
facilitate the use of the Tutorial exercises when printed from a black and white printer, each different data file type will be
represented by a different shape in the Tutorial. (The Macro Modeler uses rectangles for all input data and differentiates
file types on the basis of color.) Data files in the Tutorial are respresented as shown in Figure 1. Image files are repre-
sented by rectangles, vector files by triangles, values files by ovals, and tabular data by a page with the comer turned

down. File names are written inside the symbol.
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Raster Image Files Vector Files Artribute Values Files Tabular Data

Figure 1

Modules are shown as parallellograms, with module names in bold letters, as in the Macro Modeler. Modules link input
and output data files with arrows. When an operation requires the input of two files, the arrows from those two files are
joined, with a single arrow pointing to the module symbol (Figure 3).

Figure 2 shows the cartographic model constructed to execute the example described above. Starting with a raster eleva-
tion model called ELEVATION, the module SLOPE is used to produce the raster output image called SLOPES. This
image is of all slope values and is used with the module RECLASS to create the final image, HIGH SLOPES, showing
those areas with slope values greater than 20 degrees.

elevation —>/ slope %—» slopes —»/ reclass /Lv high slopes

Figure 2

Figure 3 shows a model in which two raster images, area and population, are used with the module OVERLAY (the divi-
sion option) to produce a raster image of population density.

population

“——r/ overlay /—P pop_density
|

area

Figure 3

For more information on the Macro Modeler, see the chapter The Idrisi Macro Modeler in the IDRISI Guide to GIS
and Image Processing Volume 1.

You will become quite familiar with cartographic models and using the Macro Modeler ta eonstruct and run your models
as you work through the Introductory GIS tutorial exercises.
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Exercise 2-2
Database Query

In this exercise, we will explore the most fundamental operation in GIS, database query. With database query, we are ask-
ing one of two possible questions. The first is a guery by location, "What is at this location?” ‘The second is a guery &y attibute,
"Where are all locations that have this attribute?” As we move the cursor across an image, its column and row position as
well as its X and Y coordinates are displayed in the stats bar at the bottom of the sereen. When we click on the cursor
inquiry mode icon (the question mark and arrow icon) and then on different locations in the image, the value of the cell,
known as the z value, is displayed next to the cursor. As we do this, we are querying by location. In later exercises, we will
look at more elaborate means of undertaking query by location (using the modules EXTRACT and CROSSTAB), as well
as the ability to interactively query a group of images at the same time. In this exercise, we will primarily perform database
query by attribute.

To query by attribute, we specify a condition and then ask the GIS to delineate all regions that have that condition. If the
condition involves only a single attribute, we can use the modules RECLASS or ASSIGN to complete the query. If we
have a condition that involves multiple attributes, we must use OVERLAY. The following exercise will illustrate these
procedures. If you have not already done so, read the section on Database Query in the chapter Introduction to GIS in
the IDRISI Guide to GIS and Image Processing Volume 1 prior to beginning the exercise.

a) First, we will set up the data paths that will be used in this exercise. Sclect Data Paths from the File menu.
Choose the folder in which the introductory GIS exercise data are installed as your working folder.* Click the
OK button to save your settings to the default project environment file.

b) Use DISPLAY Launcher to display a raster layer named DRELIEF. Choose the Idrisi Standard palette and both
Tide and Legend. Autoscaling will automatically be invoked, since DRELIEF has real data type. Click OK. Use
cursor inquiry mode to examine the values at several locations.

This is a refief ot lopographic image, sometimes called a digital elevation model, for an area in Mauritania along the Senegal River.
The area to the south of the river (inside the horseshoe-shaped bend) is in Senegal and has not been digitized. As a result
it has been given an arbitrary height of ten meters. Our analysis will focus on the Mauritanian side of the river.

This area is subject to flooding each year during the rainy season. Since the area is normally very dry, local farmers practice
what is known as "recessional agriculture” by planting in the flooded areas after the waters recede. The main crop that is
grown in this fashion is the cereal crop sorghum.

A project has been proposed to place a dam along the north bank at the northernmost part of this bend in the river. The
intention is to let the flood waters enter this area as usual, but then raise a dam to hold the waters in place for a longer
period of time. This would allow more water to soak into the soil, increasing sorghum yields. According to river gauge
records, the normal flood stage for this area is nine meters.

In addition to water availability, soil type is an important consideration in recessional sorghum agriculture because some
soils retain moisture better than others and some are more fertile than others. In this area, only the clay soils are highly
suitable for this type of agriculture.

©) Display a raster layer named DSOILS. Note that the Qualitative palette is automatically selected as the default

30. £f you are in a laboratory situation, you may wish to create a new folder for youe own work and choose it as your warking folder. Select the folder
containing the data as a resource folder. This will facilitate wating your results to your own folder, while still accessing the original data from the
resource folder.
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for this image. IDRISI uses a set of decision rules to guess if an image is qualitative or quantitative and sets the
default palette accordingly. In this case it has chosen well. Check that both the Title and Legend options are
selected and click OK. This is the soils map for the study area.

In determining whether to proceed with the dam project, the decision makers need to know what the likely impact of the
project will be. They want to know how many hectares of land are suitable for recessional agriculture. If most of the
flooded regions turn out to be on unsuitable soil types, then increase in sorghum yield will be minimal, and perhaps
another location should be identified. However, if much of the flooded region contains clay soils, the project could have a
major impact on sorghum production.

Our task, a rather simple one, is to provide this information. We will map out and determine the area (in hectares) of all
regions that are suitable for recessional sorghum agrculture. This is a classic database query involving a compound condi-
tion. We need to find all areas that are:

located in the normal flood zone AND on clay soils.

To construct a cartographic model for this problem, we will begin by specifying the desired final result we want at the
right side of the model. Ultimately, we want a single number representing the area, in hectares, that is suitable for reces-
sional sorghum agriculture. In order to get that number, however, we must first generate an image that differentiates the
suitable locations from all others, then calculate the area that is considered suitable. We will call this image BESTSORG.

Following the conventions described in the previous exercise, our cartographic model at this point looks like Figure 1. We
don’t yet know which module we will use to do the area calculation, so for now, we will leave the module symbol blank.

h
bestsorg —I-/ Hsgigai

Figure 1

The problem description states that there are two conditions that make an area suitable for recessional sorghum agricul-
ture: that the area be flooded, and that it be on clay soils. Each of these conditions must be represented by an image. We'll
call these images FLOOD and BESTSOIL. BESTSORG, then, is the result of combining these two images with some
operation that retains only those areas that meet both conditions. If we add these elements to the cartographic model, we
get Figure 2.

ha
/ /L' bestsorg ‘_“‘/ /l" suitabl

flood

bestsoil

Figure 2

Because BESTSORG is the result of a multiple attribute query, it defines those locations that meet more than one condition.
FLOOD and BESTSOIL are the results of gk atfribute queries because they define those locations that meet only one

Tutorial Part 2: Introductory GIS Exercises 44



condition. The most common way to approach such problems is to produce Boolean™! images in the single attribute queries.
The multiple attribute query can then be accomplished using Bookan Algebra.

Boolean images (also known as binary or logical images) contain only values of 0 or 1. In a Boolean image, a value of 0 indi-
cates a pixel that does not meet the desired condition while a value of 1 indicates a pixel that does. By using the values 0
and 1, logical operations may be performed between multiple images quite easily. For example, in this exercise we will
perform a Jogical AND operation such that the image BESTSORG will contain the value 1 only for those pixels that meet
both the flood AND sail type conditions specified. The image FLOOD must contain pixels with the value 1 only in those
locations that will be flonded and the value 0 everywhere else. The image BESTSOLL must contain pixels with the value 1
only for those areas that are on clay soils and the value 0 everywhere else. Given these two images, the logical AND con-
dition may be calculated with a simple multiplication of the two images. When two images are used as variables in 2 mul-
tiplicadon operation, a pixel in the first image (e.g, FLOOD) is multiplied by the pixel in the same location in the second
image (e.g., BESTSOLL). The product of this operation (e.g, BESTSORG) has pixels with the value 1 only in the loca-
tons that have 1's in both the input images, as shown in Figure 3 below.

FLOCD BESTSOIL BESTSORG
0 X 0 = 0
0 X 1 = 0
1 X 0 = o
Figure 3 1 X 1 = 1

This logic could cleardy be extended to any number of conditions, provided each condition is represented by a Boolean
image.

The Boolean image FLOOD will show areas that would be inundated by a normal 9 meter flood event (i.e., those areas
with clevations less than 9 meters). Therefore, to produce FLOOD, we will need the clevation model DRELIEF that we
displayed eatlier. To create FLOOD from DRELIEF, we will change all elevations less than 9 meters to the value 1, and
all elevations equal to or greater than 9 meters to the value 0.

Similarly, to create the Boolean image BESTSOIL, we will start with an image of all sail types (DSOLLS) and then we will
isolate only the day soils. To do this, we will change the values of the image DSOILS such that only the chy sails have the
value 1 and everything else has the value 0. Adding these steps to the cartographic model produces Figure 4.

31. Although the word binary is commonly used to describe an image of this natute (unly 1's and 0's) we will use the term Bookan to avoid confusion with
the use of the term binary to tefer to 2 form of data file storage. The name Boolean is detived from the name of George Booke (1815-1864), who was one
of the founding fathers of mathematical logjc. Ln addition, the name is approptiate because the operations we will perform on these images are known
as Boolean Algebra.
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Figure 4

We have now arrived at a place in the cartographic model where we have all the data required. The remaining task is to
determine exactly which IDRISI modules should be used to perform the desired operatons (currently indicated with
blank module symbols in Figure 4). We will add the module names as we work through the problem with IDRISL. When
we have completed the entire exercise, we will then explore how Macro Modeler and Image Caleulator might be used to
do picces of the same analysis.

First we will create the image FLOOD by isolating all areas in the image DRELIEF with elevations less than 9 meters. To
do this we will use the RECLASS module.

d)

Now let's examine the characteristics of the file DRELIEE (You may need to move the DSOILS display to the
side to make DRELIEF visible)) Click on the DRELIEF display to give it focus. Once the DRELIEF window
has focus, click on the Layer Properties button on Composer.

1. What are the minimum and maximum elevation values in the image?

Before we perform any analysis, set your User Preferences so that analytical results are automatically displayed.
To do this, open User Preferences under the File menu. On the System Settings tab, enable the option to auto-
matically display the output of analytical modules if it is not already enabled. Click on the Display Settings tab
and choose the QUAL256 palette for qualitative display and the IDRIS256 palette for quantitative display. Also
select the automatically show title and automatically show legend options. Click OK to save these settings.

We are now ready to create our first Boolean image, FLOOD.

H

Choose RECLASS from the GIS Analysis/Database Query menu. We will reclassify an image file with the user-
defined reclass option. Specify DRELIEF as the input file and enter FLOOD as the output file. Then enter the
following values in the first row of the reclassification parameters area of the dialog box:

Assign a new value of: 1
To values from: 0
To just less than: 9

Continue by dlicking into the second row of the reclass parameters table and enter the following:

Assign a new value of: 0
To values from: 9
To just less than: 999

Click on the Save as .RCL file button and give the name FLOOD. An .RCL file is a simple ASCII file that lists
the reclassification limits and new values. We don’t need the file right now but we will use it with the Macro
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Modeler at the end of the exercise. Click the Qutput Documentation button and enter a title for the new image
and "Boolean" as the new value units.* Press OK.

Note that we entered "999" as the highest value to be assigned the new value 0 because it is larger than all other
values in our image. Any number larger than the actual maximum of 16 could have been used because of the
"just less than" wording,

2 When RECLASS has finished, look at the new image named FLOOD (which will automatically display if you
followed the instructions above). This is 2 Boolean image, as described above, where the value 1 represents areas
meeting the specified condition and the value 0 represents areas that do not meet the condition.

h) Now let's create a Boolean image (BESTSOIL) of all areas with clay soils. The image file DSOILLS is the soils
map for this region. If you have closed the DSOILS display, redisplay it.

2 What is the mameric value of the clay soil class? (Use the cursor inquiry tool from the tool bar.)

We could use RECLASS here o isolate this class into a Boolean image. If we did (although we won't), our sequence in
specifying the reclassification would be as follows:

Assign a new valuc of: 0
To values from: 0
To just less than: 2

Assign a new value of: 1
To values from:
To just less than: 2

Assign a new value of: 0
To values from: 3
To just less than: 999

Notice how the range of values that are not of interest to us have to be explicidy set to 0 while the range of interest (soil
type 2) is set to 1. In RECLASS, any values that are not covered by a specified range will retain their original values in the
output imagc."‘3 Notice also that when a single value rather than a range is being reclassified, the original value may be
entered twice, as both the "from" and "to" values.

RECLASS is the most general mecans of reclssifying or assigning new values to the data values in an image. In some
cases, RECLASS is rather cumbersome and we can use a much faster procedure, called ASSIGN, to accomplish the same
result. ASSIGN assigns new values to a set of integer data values. With ASSIGN, we can choase to assign a new value to
cach original value or we may choose to assign only two values, 0 and 1, to form a Boolean image.

Unlike RECLASS, the input image for ASSIGN must be either integer or byte—it will not accept original values that are
real. Also unlike RECLASS, ASSIGN automatically assigns a value of zero to all data values not specifically mentioned in
the reassignment. This can be particularly useful when we wish to create a Boolean image. Finally, ASSIGN differs from
RECLASS in that only individual integer values may be specified, not ranges of valucs.

To work with ASSIGN we first need to create an attribute values file that lists the new assignments for the existing dam

32. Value units and titkes are for documentation putposes only and are theeefure optional. It is recommended, howeve, that you do fill thesc in. Lnter-
ing a title gives you an appormunity to think about what the output image represents in the context of your analysis. Lotering value units makes you think
about what the values in the new image should be.

13. The output of RECLASS is always integer, however, so real values will be rounded to the nearest integer in the output image. This does not affect
our analysis here since we are reclassifying to the integer values 0 and { anyway.
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values. The simplest form of attribute values file in IDRISI is an ASCH text file with two columns of data (separated by
one or more spaces) 34 The left column lists existing image "features" (using feature identifier numbers in integer format).
The right column lists the values to be assigned to those features.

In our case, the features are the sail types to which we will assign new values. We will assign the new value 1 to the origi-
nal value 2 (clay soils) and will assign the new value 0 to all other original values. To create the values file for use with
ASSIGN we use a module named EDIT.

i) Use Edit from the GIS Analysis/Database Query menu to create 2 values file named CLAYSOIL. We want all
areas in the image DSOQILS with the value 2 to be assigned the new value 1 and all other areas to be assigned 2 0.
Our values file might look like this:

10
21
30
40
50

As previously mentioned, however, any feature that is not mentioned in the values file is automatically assigned
a new value of zero. Thus our values file only really needs to have a single line as follows:

21

Type this into the Edit screen, with a single space between the two numbers. From the File menu on the Edit
dialog box (not the main menu) choose Save As and save the file as an attribute values file with the name CLAY-
SOIL. (When you choose attribute values file from the list of file types, the proper filename extension, .avl, is
automatically added to the file name you specify.) Click Save and when prompted, choose integer as the data

type.
We have now defined the value assignments to be made. The next step is to assign these to the raster image.

] Run ASSIGN from the GIS Analysis/Database Query menu. Since the soils map defines the features to which
we will assign new values, enter DSOILLS as the feature definition image. Enter CLAYSOIL as the attribute val-
ues file. Then for the output image file, specify BESTSOIL. Finally, enter a title for the output image and press
OK

k) When ASSIGN has finished, BESTSOIL will automatically display. The data values now represent clay soils
with value 1 and all other areas with the value 0.

We now have Boolean images representing the twa criteria for our suitability analysis, one created with RECLASS and the
other with ASSIGN.

While ASSIGN and RECLASS may often be used for the same purposes, they are not exactly equivalent, and usually one
will require fewer steps than the other for a particular procedure. As you become familiar with the operation of each, the
choice between the two modules in each particular situation will become more obvious.

At this point we have performed single attribute queries to produce two Boolean images (FLOOD and BESTSOIL) that
meet the individual conditions we specified. Now we need to perform a multiple attribute query to find the Jocations that
fulfill both conditions and are therefore suitable for recessional sorghum agriculture,

As described cardier in this exercise, 2 multiplication operation between two Boolean images may be used to produce the
logical AND result. In IDRISI, this is accomplished with the module OVERLAY. OVERLAY produces new images as a

34. More complex, multi-ficld atitibute values filcs are accessible through Database Workshop.
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result of some mathematical operation between two existing images. Most of these are simple arithmetic operations. For
example, we can use OVERLAY to subtract one image from another to examine their difference.

As illustrated above in Figure 3, if we use OVERLAY to multiply FLOOD and BESTSOIL, the only case where we will
get the value 1in the output image BESTSORG is when the corresponding pixels in both input maps contain the value 1.

OVERLAY can be used to produce a variety of Boolean operations. For example, the cover option in OVERLAY pro-
duces a logical OR. The output image from a cover operation has the value 1 where cither or both of the input images
have the value 1.

3. Construct a table simiilar to that shown in Figure 3 to illustrate the OR operation and then suggest an OVERLAY
aperation other than cover that could be used to produce the same result.

1) Run OVERLAY from the GIS Analysis/Database Query menu to multiply FLOOD and BESTSOILL to create
a new image named BESTSORG. Click Output Documentation to give the image a new title, and specify "Bool-
ean" for the value units. Examine the result. (Change the palette to QUAL256 if it is difficult to see)) BEST-
SORG shows all locations that are within the normal flood zone AND have clay soils.

m) Our next step is to calculate the area, in hectares, of these suitable regions in BESTSORG. This can be accom-
plished with the module AREA. Run AREA from the GIS Analysis/Database Query menu, enter BESTSORG
as the input image, select the tabular output format, and calculate the area in hectares.

4. How many bectares within the flood sone are on Clay soils? What is the nieaning of the other reported area figure?

Adding the module names to the cartographic model of Figure 4 produces the completed cartographic model for the
above analysis, shown in Figure 5.

drelief -+/ reclass /L. flood
/overiay/L. bestso —"/ area /L’ha_ bl
dsoils — rg suita
assign /_y bestsoil

Figure 5

The result we produced involved performing single attribute queries for each of the conditions specified in the suitability
definition. We then used the products of those single attribute queries to perform a multiple attribute query that identified
all the locations that met both conditions. While quite simple analytically, this type of analysis is one of the most com-
monly performed with GIS. The ability of GIS to perform database query based not only on attributes but also on the
location of those attributes distinguishes it from all other types of database management software.

The area figure we just calculated is the total number of hectares for all regions that meet our conditions. However, there
are several distinct regions that are physically separate from each other. What if we wanted to calculate the number of
hecrares of each of these potential sorghum plots separately?
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When you look at a raster image display, you are able to interpret contiguous pixels having the same identifier as a single
larper feature, such as a soil polygon. For example, in the image BESTSORG, you can distinguish three separate suitable
plots. However, in raster systems such as IDRISI, the only defined "feature” is the individual pixel. Therefore since cach
separate region in BESTSORG has the same attribute (1), IDRISI interprets them to be the same feature. This makes it
impossible to calculate a separate area figure for each plot. The only way to calculate the areas of these spatially distinct
regions is to first assign cach region 2 unique identifier. This can be achieved with the GROUP module.

GROUP is designed to find and label spatially contiguous groups of like-value pixels. It assigns new values to groups of
contiguous pixcls beginning in the upper left corner of the image and proceeding left to right, top to bottom, with the first
group being assigned the value zero. The value of a pixel is compared to that of its contiguous neighbors. If it has the
same value, it is assigned the same group identifier. Lf it has a different value, it is assigned a new group identifier. Because
it uses information about neighboring pixels in determining the new value for a pixel, GROUP is classified as a Context
Operator. More context operators will be introduced in later exercises in this group.

Spatial contiguity may be defined in two ways. In the first case, pixels are considered part of a group if they join along one
or more pixel edge (left, right, top or bottom). In the sccond case, pixels are considered part of a group if they join along
edges or at corners. The latter case is indicated in IDRISI as indluding diagonals. The option you use depends upon your
application.

Figure 6 illustrates the result of ranning GROUP on a simple Boolean image. Note the difference caused by including
diagonals. The example without diagonal links produces eight new groups (identifiers 0-7), while the same original image
with diagonal links produces only three distinct groups.

original image no diagonals induding diagonals
tj110]1 0jo0]1]2 ojo]1}2
1jolof1 o1 1] 1] 2 oj1]1}]2
ojt1jofo 3{411]1 1{0] 1|1
1]op1j0 5(6]17]1 of1]0f1
Figure 6
n) Run GROUP from the GIS Analysis/Context Operators menu on BESTSORG to produce an output image

called PLOTS. Include diagonals and enter a tite for the output image. Click OK. When GROUP has finished,
examine PLOTS. Use cursor inquiry mode to examine the data values for the individual regions. Notice how
cach contiguous group of like-value pixels now has a unique identifier. (Some of the groups in this image are
small. It may be helpful to use the category "flash” feature to see these. To do so, place the cursar on the legend
color box of the category of interest. Press and hold down the left mouse button. The diplay will change to show
the selected category in red and everything else in black. Release the mouse button to return the display to its
normal state.)

5. How many groups were produced? (Remember, the first group is assigned the value zera )

Three of these groups are our potential sorghum plots, but the others are groups of background pixels. Before we calcu-
late the number of hectares in each suitable plot, we must determine which group identifiers represent the suitable sor-
ghum plots so we can find the correct identifiers and area figures in the area table. Alternatively, we can mask ot the
background groups by assigning them all the same identifier of 0, and leaving just the groups of interest with their unique
non-zero identifiers. The area table will then be much easier to read. We will follow the latter method.

In this case, we want to create an image in which the suitable sorghum plots retain their unique group identifiers and all
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the background groups have the value 0. There are several ways to achieve this. We could use Edit and ASSIGN or we
could use RECLASS. The easiest method is to use an OVERLAY operation.

6. Which OVERLAY option can you use to yield the desired image? Using which imagesé

o) Perform the above operation to produce the image PLOTS2 and examine the result. Change the palette to
QUAL256. As in PLOTS, the suitable plots are distinguished from the background, each with its own identifier.

P) Now we are ready to run AREA (found in the GIS Analysis/Database Query menu). Use PLOTS2 as the input
image and ask for tabular output in hectares.

7. What is the area in hectares of each of the potential sorghum plots?

Figure 7 shows the additional step we added to our original cartographic model. Note that the image file BESTSORG was
used with GROUP to create the output image PLOTS, then these two images were used in an OVERLAY operation to
mask out those groups that were unsuitable. The model could also be drawn with duplicate graphics for the BESTSORG
image.

bestsorg

[

——»/ group /—»| plols

Figure 7

Finally, we may wish to know more about the individual plots than just their areas. We know all of these areas are on clay
soils and have clevations lower than nine meters, but we may be interested in knowing the minimum, maximum or aver-
age elevation of each plot. The lower the elevation, the longer the area should be inundated. This type of question is one
of database query by location. In contrast with the pixel-by-pixel query performed at the beginning of this exercise, the
locations here are defined as areas, the three suitable plots.

The module EXTRACT is used to extract summary statistics for image features (as identified by the values in the feature
definition image).

q) Choose EXTRACT from the GIS f\n:ll)‘siS/Damba.sc Query menu. Enter PLOTS2 as the feature definition
image and DRELIEF as the image to be processed. Choose to calculate all listed summary types. The results will
automatically be written to a tabular ourput.

8. What is the average elevation of each of the potential sorghum plots?

In this exercise, we have looked at the most basic of GIS operations, database query. We have learned that we can query
the database in two ways, query by location and query by attribute. We performed query by location with the cursor
inquiry mode in the display at the beginning of the exercise and by using EXTRACT at the end of the exercise. In the rest
of this exercise we have concentrated on query by attribute. The tools we used for this were RECLASS, ASSIGN and
OVERLAY. RECLASS and ASSIGN are similar and can be used to isolate categories of interest located on any one map.
OVERLAY allows us to combine queries from pairs of images and thereby produce compound queries.
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One particularly important concept we learned in this process was the expression of simple queries as Boolean images
(images containing only ones and zeros). Expressing the results of single attribute queries as Boolean images allowed us to
use Boolean or logical operations with the arithmetic operations of OVERLAY to perform multiple attribute queries. For
example, we learned that the OVERLAY multiply operation produces a logical AND when Boolean images are used,
while the OVERLAY cover operation produces a logical OR.

We also saw how a Boolean image may be used in an OVERLAY operation to retain certain values and mask out the
remaining values by assigning them the value zero. In such cases, the Boolean image may be referred to as a Boolean mask
or simply as a mask image.

Using Macro Modeler with this Exercise

The Macro Modeler is a graphic environment that allows you to construct and run a model. It cannot be used entirely as
a substitute for the conceptual cartographic models we drew in this exercise because it requires that you know which
modules you will use. However, once you have worked out a conceptual cartographic model, you may then build it in
Macro Modeler, While you may construct the entire model, then run it, while you are learning it may be best to run the
model after adding each step so you can examine the output and verify that you are using the correct sequence of steps.
Now we will use Macro Modeler to replicate the first part of this exereise, up to finding the first area figure.

r) Choose Macro Modeler either from the Modeling menu or from its toolbar icon. The modeling environment
then opens.

s) We will proceed to build the model working from left to right from Figure 5 above. Begin by clicking on the ras-
ter image icon and choosing the file DRELIEE Before getting too far, go to the File menu on the Macro Mod-
eler and choose Save As. Give the model the name Exer2-2.

t) Now click the module icon and choose RECLASS from the maodule list. Note that whenever a module is placed,
its output file is automatically placed and is given a temporary filename. Right click on the output file symbol and
edit the name to be FLOOD2 (so as not to overwnte the file FLOOD which we created earlier). Right click on
the RECLASS symbol and examine the module parameters box. While most modules will have module parame-
ters exactly as in the main dialog boxes, some modules have some differences between the way the main dialog
works and the way the module works in the Macro Modeler. RECLASS is such a module. On the main dialog,
you entered the reclassification sequence of values to be used. In the Macro Modeler, these values must be
entered in the form of a reclass (.rcl) file.

In the module parame- |
e il Boxds; M Parameters : reclass M= EL

label for each parame- [nputs :
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) Input image
column and the choice [ L I I

for that parameter in Dutputs :
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choice is available for a Additional parameters :

[Output image [ tmpo00 |
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glc list of choices by e t}?e - Flasterlayer Qﬂm layer
clicking on the right Classification type File Mode Values file
column, as shown in Name of RCL file Vector layer
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Choose Raster Layer. Click on Classification Type and choose File Mode. Then click on .RCL file name and
choose FLOOD (we saved this earlier from the RECLASS dialog box. These .rcl files may also be created with
Edit or by clicking the New button on the .rel file pick list.) Finally, choose Byte/Integer as the output data type
and click OK. Essentially, we have filled out all the information nceded in the RECLASS dialog box and have
stored it in the model. Now connect the input file, DRELIEF, to RECLASS by clicking the connect icon on the
toolbar, This turns the cursor into a pointing finger. Click DRELIEF and hold down the left mouse button
while dragging the cursor to the RECLASS symbol. When you let the button up, you will see the link formed
and will hear a snapping sound if your computer has sound capabilities.

u) This is the first step of the model. We can run it to check the output. Save the model by choosing Save from the
Macro Modeler File menu or by clicking the Save icon. Then run the model by choosing Run from the menu bar
or with the Run icon. You will be prompted that the output layer, FLOOD2, will be overwritten if it exists. Click
Yes to continue. The image FLOOD2, which should be identical to the image FLOOD created earlier, will auto-
matically display.

v) Continue building the model until it looks like that in Figure 8. Save and run the model after adding each step to
check your intermediate results. Each time you place a module, right click on it and fill out the parameters
exactly as you did when working with the main dialogs. Note that the module Edit cannot be used in the Macro
Modeler, but you have already created the values file CLAYSOIL and may use it with ASSIGN. Also note that
the AREA module does not provide tabular output in the Macro Modeler. Stop with the production of BEST-
SORG and run AREA from its main dialog rather than from the Macro Modeler.

dreliet —5/ reclass ]L» flood?

dsoils
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Figure 8

One of the most useful aspects of the Macro Modeler is that once 2 model is saved, it can be altered and run instantly. It
also keeps an exact record of the operations used and is therefore very helpful in discovering mistakes in an analysis. We
will continue to use the Macro Modeler as we explore the core set of GIS modules in this section of the tutorial. For more
information on the Macro Modeler sec the chapter The Idrisi Macro Modeler in the IDRISI Guide to GIS and
Image Processing Volume 1, the on-line Help System entry for Macro Modeler.

Using Image Calculator with this Exercise

It is extremely important to understand the logic of reclassification and overlay as they form the core of many analyses
that use GIS. The best way to gain this understanding is by performing each operation then examining the result to verify
that it is as expected. However, IDRISI does offer a shortcut that allows users to perform several individual operations at
once from one dialog box—Image Calculator. The Image Calculator allows users to enter full mathematical or logical
expressions using either constants or images as variables. It offers many of the functions of RECLASS and OVERLAY,
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as well as other modulcs, in one dialog box.

w)

To sce how the creation of BESTSORG in this exercise could be done with Image Calculator, open it from the
GIS Analysis/Database Query menu and choose the Logjcal Expression operation type since we are finding the
logical AND of two criteria. Type in the output image name BESTCALC. (We will give our result here a differ-
ent name so that we can compare it to BESTSORG.) Now enter the expression by clicking on the components
such that the expression is exactly as shown below. Note that you may type in file names or press the insert
image button to choose a file name from the pick list. If you do the latter, brackets will automatically enclose the
file names.

BESTCALC = ([DRELIEF|<= 9)AND(DSOLLS|=2)

Press Process Expression and when the calculation is finished, compare the result to that obtained in step 1
above which we called BESTSORG. (You will need to give BESTCALC focus, then in Layer Properties change
the palette to QUAL256 and disable autoscaling,)

Note that we could nat finish our analysis solely with Image Calculator because it does not include the GROUP, AREA
or EXTRACT functions. Also note that in developing our model, it is much easier to identify errors in the process if we
perform each individual step with the relevant module and examine cach result. While Image Calculator may save time, it
does not supply us with the intermediate images to check our logical progress along the way. Because of this, we will often
choose to use individual modules or the Macro Modeler rather than Image Calculator in the remainder of the tutorial

exercises.

At this point you may delete all of the files you created in this exercise. The Delete udlity is found in the IDRISI File

Explorer under the File menu. Do not delete the original data files DSOILS and DRELIEE

Answers to the Questions in the Text

1. The mimumum value is 5 meters while the maximum value is approximately 16 meters. These data are found in the

Min. Value and Max. Value fields of the documentadon file.
2. The Clay soils have the value 2,
3. IMAGE 1 covers IMAGE 2 to produce QUTPUT

0 1 1
0 0
1 1

1

— D

0
The Maximum oveday operation would produce the same result.

4, 3771.81 hectares are on Clay soils. The other area figure reported is for the unsuitable areas.
5. Eleven groups were produced.

6. OVERLAY multiply BESTSORG and PLOTS.

7. 1887.48, 1882.17 and 2.16 hecrares.

8. Group 1 - 8,04m, Group 3 - 7.91m, Group 8 - 8.72m
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Exerctse 2-3
Distance and Context Operators

In this excrcise,” we will introduce two other groups of analytical operations, distance and context operators. Distance
gperators calculate distances from some feature or set of features. In a raster environment, they produce a resultant image
where every pixel is assigned a value representing its distance from the nearest feature. There are many different concepts
of distance that may be modeled. Eudfidean, ot straight-line, distance is what we are most familiar with, and it is the type of
distance analysis we will use in this exercise. In IDRISI, Euclidean distances are calculated with the module DISTANCE.
A related module, BUFFER, creates buffer zones around features using the Euclidean distance concept. In Exercise 2-5
another type of distance, known as cost distance, will be explored.

Context gperators determine the new value of a pixel based on the values of the surrounding pixels. The GROUP module,
which was used in Exercise 2-2 to identify contiguous groups of pixels, is a context operator since the group identifier
assigned to any pixel depends upon the values of the surrounding pixels. In this exercise, we will become familiar with
another context operator, SURFACE, which may be used to calculate slopes from an elevation image. The slope value
assigned to cach pixel depends upon the elevation of that pixel and its four nearest neighbors.

We will use these distance and context operators and the tools we explored in cardier exercises to undertake one of the
most common of GIS analysis tasks, switabikity mapping, a type of multi-criteria evaluation. A suitability map shows the
degree of suitability for a particular purpose at any location. It is most often produced from multiple images, since most
suitability problems incorporate multiple criteria. In this excrcise, Boolean images will be combined using the OVERLAY
module to yield a final map that shows the sites that meet all the specified criteria. This type of Boolean multi-criteria eval-
vation is often referred to as anstraint mapping, since each criterion is defined by a Boolean image indicating areas that are
cither suitable for use (value 1) or constrained from use (value 0). The map made in Exercise 2-2 of sites suitable for sor-
ghum agriculture is a simple example of constraint mapping, In later exercises, we will explore tools for non-Boolean
approaches to multi-criteria suitability analysis.

Our problem in this excrcise is to find all areas suitable for the location of a light manufacturing plant in a small region in
central Massachusetts near Clark University. The manufacturing company is primarily concerned that the site be on fairly
level ground (with slopes less than 2.5 degrees) with at least 10 hectares in area. The local town officials are concerned
that the town's reservoirs be protected and have thus specified that no facility can be within 250 meters of any reservoir.
Additionally, we need to consider that not all land is available for development. In fact, in this area, only forested land is
available. To summarize, sites suitable for development must be:

i) on land with slopes less than 2.5 degrees;

ii) outside a 250-meter buffer around reservoirs;
iii) on land currently designated as forest; and
iv) 10 hectares or greater in size.

Two images for this area are provided, a relief map named RELIEF, and a land use map, named LANDUSE. The study
area is quite small to help speed your progress through this exercise.

a) To become familiar with the stdy area, run ORTHO from the Display menu with RELIEF as the surface image
and LANDUSE as the drape image. Accept the default output file name ORTHOTMP and all the view defaults.
Indicate that you wish to use a user-defined palette called LANDUSE and a legend, and choosc the output reso-

35. At this point in the cxerciscs, you shoukd be able w displry images and operate modules such as RECLASS and OVERLAY without step by step
instructons. 1f you arc unsore of how to fill in a dialog box, usc the defaules. 1t is abways a good idea to enter descriptive titles for ourput files
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lution that is one step smaller than your Windows display (e.g, if you are displaying at 1024 x 768, choose the
800 x 600 output).

As you can see, the study area is dominated by deciduous forest, and is characterized by rather hilly topography.

We will go about solving the suitability problem in four steps, one for each suitability criterion.

The Slope Criterion

The first criterion listed is that suitable sites must be on land with slopes less than 2.5 degrees. Our goal in this first step
then is to produce a Boolean image for areas meeting this criterion. We will call the image SLOPEBOOL.

To organize our analysis for this step, we first ask what the final image will represent. SLOPEBOOL should be a Boolean
image in which all pixels with slopes less than 2.5 degrees have the value 1 and all other pixels have the value 0. To create
this image, we will need to have an image of all slope values. As an image of all slopes does not exist in the databas, it
must be calculated. As indicated in the introduction to this exercise, the module SURFACE calculates a slope image from
an clevation image. The elevation image we have is RELIEE Once the image of slopes is in our database, we can use a
reclassification to isolate only those slopes that meet our criteron. (This is very similar to isolating elevations that will be
flooded from all other elevations in Exercise 2-2.)

l. Before reading abead, fill in the cartographic model of Figure 1 to depict the steps described above.

module? module?

relief —/ /Lb slopes ~7/ /L-b slopebool

b) Display RELIEF with the Idrisi Standard p:lJan-.'% Explore the values with cursor inquiry mode.

On a topographic map, the more contour lines you cross in a given distance (i.e., the more closely spaced they are), the
steeper the slope. Similarly, with a raster display of a continuous digital elevation model, the more palette colors you
encounter across a given distance, the more rapidly the elevation is changing, and therefore the higher the slope gradient.

Creating a slope map by hand is very tedious. Essentially, it requires that the spacing of contours be evaluated over the
whole map. As is often the case, tasks that are tedious for humans to do are simple for computers (the opposite also tends
to be true—tasks that scem intuitive and simple to us are usually difficult for computers), In the case of raster digital cle-
vation models (such as the RELIEF image), the slope at any cell may be determined by comparing its height to that of
each of its neighbors. In IDRISI, this is done with the module SURFACE. Similardy, SURFACE may be used to deter-
mine the direction that a slope is facing (known as the asped/) and the manner in which sunlight would illuminate the sur-
face at that point given a particular sun position (known as analytical hillshading).

c) Launch Macro Modeler from its toolbar icon or from the Modeling menu. Place the raster file RELIEF and the
module SURFACE. Link RELIEF to SURFACE. Right click on the output image and give it the filename
SLOPES. Then right click on the SURFACE module symbol to access the module parameters. The dialog
shows RELIEF as the input file and SLOPES as the output file. The default surface operation, slope, is correct,
but we need to change the slope measurement to be degrees. The conversion factor is necessary when the refer-
ence units and value units are not the same. In the case of RELIEF, both are in meters, so the conversion factor

36. Por this exercise, make sure that your Display Preferences (under User Preferences in the Vile menu) are set to the default values by pressing the
Revert to Defaults button.
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may be left blank. Choose Save As from the Macro Modeler File menu and give the new model the name Exer2-
3. Run the model (click yes to all when prompted about overwriting files) and examine the resulting image.

The image named SLOPES can now be reclassified to produce a Boolean image that meets our first criterion—areas with
slopes less than 2.5 degrees.

d) Add the module RECLASS to the model. Connect SLOPES tm it, then right click on the output image and
change the image name to be SLOPEBOOL. Right click on the RECLASS module symbol to sct the module
parameters. All the default settings are correct in this case, but as we saw in the last exercise, when run from the
Macro Modeler, RECLASS requires a text file (.rel) to specify the reclassification values. In the previous exer-
cise, we saved the .rcl file after filling out the main RECLASS dialog, You may create .ccl files like this if you pre-
fer. However, you may find it quicker to create the file using a facility in Macro Modeler.

Right click on the input box for .rcl file on the RECLASS module parameters dialog, This brings up a list of all
the .rel files that are in the project. At the bottom of the pick list window are two buttons, New and Edit. Click
New.

This opens an editing window into which you can type the .rel file. Information about the format of the file is
given at the top of the dialog, We want 1o assign the new value 1 10 slopes from 0 1o just less than 2.5 degrees
and the value 0 to all those greater than or equal to 2.5 degrees. In the syntax of the .rel file (which matches the
order and wording of the main RECLASS dialog), enter the following values with a space between each:

1025
025 999

Note that the last value given could be any value greater than the maximum slope valuc in the image. Click Save
As and give the filename SLOPEBOOL. Click OK and notice that the file you just created is now listed as the
.rcl file to use in the RECLASS module parameters dialog, Close the module parameters dialog,

€) Save the model then run it (click yes to all when prompted about overwriting files) and examine the result.

The Reservoir Buffer Criterion

The second criterion for locating the light manufacturing plant is that suitable areas must be outside 250-meter buffer
zones around reservoirs. A buffer zonc is an area that falls within a certain distance of a particular feature or set of fea-
tures. Qur second step is to create a Boolean image that represents this condition. The image will contain the value 1 for
all pixels that are further than 250 meters from a reservoir and the value 0 for all pixels that are within 250 meters of a res-
ervoir.

In planning the anlaysis for this step, we know thar we will need 1o calculate distance from reservoirs and to isolate a set
of those distances. Before constructing the cartographic model, however, we will need to know more details about the
modules from which we may choose. Specifically, we need to know the type of input they require and the type of output
they produce.

IDRISI includes several distance operators, all located under the GIS Analysis/Distance Operators menu. Two could be
used to produce the image we need, DISTANCE or BUFFER. Both require as input an image in which the target features
from which distances should be calculated have non-zero values and every other pixel has the value 0.

1. How could you ereate a Boolean image of reservoirs? From shich image would you derive this? (There are too differsnt
nrodules you could use.)
3] Display the image named LANDUSE using the user-defined palette LANDUSE. Determine the integer land-

use cade for reservoirs.
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Either RECLASS or Edit/ASSIGN could be used to create a Boolean image of reservoirs. Both require a text file be cre-
ated outside the Macro Modeler. We will use Edit/ASSIGN to create the boolean image called RESERVOIRS.

2 Open Edit from the Data Entry menu or from its toolbar icon. Type in:
21
(the value of reservoirs in LANDUSE, a space and a 1). Choose Save As from Edit’s File menu, choose the
Attribute Values File file type, give the name RESERVOIRS, and save as Integer, Close Edit.

h) In the Macro Modeler, place the values file RESERVOIRS and move it to the left side of the model, under the
slope criteria branch of the model. Place the raster image LANDUSE under the values file and the module
ASSIGN to the right of the two data files. Right click on the output file of ASSIGN and change the name to be
RESERVOIRS. Before linking the input files, right click on the ASSIGN module symbol. As we saw in the pre-
vious exercise, ASSIGN uses two input files, a raster feature definition image and an attribute values file. The
input files must be linked to the module in the order they are listed in the module parameters dialog. Closc the
module parameters dialog then link the input raster feature definition image LANDUSE to ASSIGN the link the
attribute values file RESERVOIRS to ASSIGN. This portion of the model should appear similar to the carto-
graphic model in Figure 2 (although the values file symbol in the Macro Modeler is rectangular rather than oval).
Note that the placement of the raster and values file symbols for the ASSIGN operation could be reversed—it is
the order in which the links are made and not the positions of the input files that determine which file is used as
which input. Save and run the model. Note that the slope branch of the model runs again as well and both ter-
minal layers are displayed..

reservoirs

—P/ assign /L. reservoirs

landuse

Figure 2

The image RESERVOIRS defines the features from which distances should be measured in creating the buffer zone.
This image will be the input file for whichever distance operation we use.

The output images from DISTANCE and BUFFER are quite different. DISTANCE calculates a new image in which
each cell value is the shortest distance from that cell to the nearest feature. The result is a distance surface (a spatially contin-
wous representation of distance). BUFFER, on the other hand, produces a categorical, mther than continuous, image. The
user sets the values to be assigned to three output classes: target features, areas within the buffer zone and areas outside
the buffer zone.

We would normally use BUFFER, since our desired output is categorical and this approach requires fewer steps. How-
ever, to become more familiar with distance operators, we will take the time to complete this step using both approaches.
First we will run DISTANCE and RECLASS from their main dialogs, then we will add the BUFFER step to our model in
Macro Modeler.

i) Run DISTANCE from the GIS Analysis/Distance Operators menu. Give RESERVOIRS as the feature image
and RESDISTANCE as the output file name. Examine this image. Note that it is a smooth and continuous sur-
face in which each pixel has the value of its distance to the nearest reservoir.

i) Now use RECLASS (from the GIS Analysis/Database Query menu) to create a Boolean buffer image in which
pixels with distances less than 250 meters from reservoirs have the value 0 and pixels with distances greater than
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or equal to 250 meters have the value 1. Call the resulting image DISTANCEBOOL.
2. What ralues did you enter into the RECLASS dialog bax to accomplish this?

3. Examine the result to confirm that it meets your expectations. 1t may be useful to display the LANDUSE image as
well. Does DISTANCEBOOL represent (with 1'5) those areas outside a 250m buffer zone around reservoirs?

The image DISTANCEBOOL satisfies the buffer zone criterion for our suitability model. Before continuing on to the
next criterion, we will see how the module BUFFER can also be used to create such an image.

k) Add the module BUFFER to Macro Modeler, to the right of the image RESERVOIRS and connect the image
and module. Right click to set the module parameters for BUFFER. Assign the value 0 for the target area, 0 for
the buffer zone and 1 for the areas outside the buffer zone. Enter 250 as the buffer width. Right click on the
output image and change the image name to be BUFFERBOOL. The second branch of your model will now be
similar to the cartographic model shown in Figure 3.

reservoirs

""/ assign /—b reservoirs _'/ buffer /—b bufferbool

landuse

Figure 3

DISTANCEBOOL and BUFFERBOOL should be identical, and cither approach could be used to complete this exer-
cise. BUFFER is preferred over DISTANCE when a categorical buffer zone image is the desired result. However, in
other cases, a continous distance image is required. The MCE exercises later on in the Tutorial make extensive use of dis-
tance surface images.

The Landuse Criterion

At this point, we have two of the four individual components required to produce our final suitability map. We will now
turn to the third, that only forested land is available for development.

4. Describe the contents of the final image for this criterion. You are already familiar with two methods for producing such an
image. Draw the cartograpbic model showing the steps and call the final image FORESTBOOL.

) You first must determine the numeric codes for the two forest categories (do not consider orchards or forested
wetlands) in the LANDUSE image. This can be done in a varety of ways. One easy method is to click on the
LANDUSE file symbol in the model, then click on the Descrbe (Metadata) icon on the Macro Modeler toolbar,
This opens the documentation file for the highlighted layer. Scroll down to see the legend categories and
descriptions. Then follow the cartographic model you drew above to add the required steps to the model to cre-
ate a Boolean map of forest lands (FORESTBOOL). Save and run the model. Note that you may use the
LANDUSE layer that is already placed in the model to link into this forest branch of the model. However, if you
wish you may alternatively add another LANDUSE raster layer symbol for this branch. (If you become stuck,
the last page of this exercise shows the full model.)

Combining the Three Boolean Criteria

The fourth and last condition to account for in our analysis is that suitable sites must have an area of 10 hectares or more.
At this point, however, we do not have any "sites" for which to caleulate area. We have three separate Boolean images,
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one for each of the previous conditions. Before we can begin to address the area criterion, we must combine these three
Boolean images into one final Boolean image that shows those areas where all three conditions are met.

In this case, we want to model the Boolean AND condition. Only those areas that meet all three criteria are considered
suitable, As we learncd in Exercisc 2-2, Boolean algebra is accomplished with OVERLAY.

m) Add the OVERLAY operations necessary to create this composite Boolean image showing areas that meet all
three conditions. To do this, you will need to combine two images to create a temporary image, and then com-
bine the third with that temporary image to produce the final result.’” Call this final result COMBINED, Save
and run the model.

5. W hich operation in OVERLAY did you use to produce COMBINED? Draow the cartograpbic nodel that illustrates
the steps taken to produce COMBINED from the three Boolean criteria images.

n) Examine COMBINED. There are several contiguous areas in the image that are potential sites for our purposes.
The last step is to determine which of these meet the ten hectare minimum area condition.

The Minimum Plot Size Criterion

As with the sorghum plots in the previous exercise, what appear to our eyes to be separate and distinct plots are all just
pixels with the same value (1) to a GIS. As we did in that eadier exercise, before calculating area we need to differentiate
the individual plots using a context operation called GROUP.

0) Add the madule GROUP to the model. Link COMBINED as the input file and change the output file to be
GROUPS. Choose to include diagonals in the GROUP module parameters dialog, Save and run the model,

6. Look at the GROUPS image. How can you differentiate between groups that had the value 1 in COMBINED (and
are therefore suitable) and groups that bad the value 0 in COMBINED (and are therefore unsuttable)?

)] We will account for unsuitable groups in a moment. First add the AREA module to the model. Link GROUPS
as the input file and change the output image to be GROUPAREA. In the AREA modulc parameters dialog,
choose to calculate area in hectares and produce a raster image output.

In the output image, the pixels of each group are assigned the area of that entire group. Use cursor inquiry mode
to confirm this. 1t may be helpful to display the GROUPS image beside the GROUPAREA image. Since the
largest group has a value much lacger than those of the ather groups and autoscaling is in effect, the GROU-
PAREA display may appear to show fewer groups than expected. Cursor inquiry will reveal that each group was
assigned its unique area. To remedy the display, make sure GROUPAREA has focus, then choose Layer Proper-
ties on COMPOSER. Set the display max to 17. To do sq, either drag the slider to the left or type 17 into the
display maximum input box and press Apply. The value 17 was chosen because it is just greater than the area of

the largest suitable group.

Altering the maximum display value does not change the values of the pixels. It merely tells the display system to satarate,
or set the autoscale endpoint, at a value that is different from the actual data endpoints. This allows more palette colors to
be distributed among the other values in the image, thus making visual interpretation easier.

We now want to isolate those groups that are greater than 10 hectares (whether suitable or not),

7. What modute is required to do thist Why im't Edit/ ASSIGN an option in this case?

qQ Add a RECLASS step to the model. Use either the Macro Modeler facility or the main RECLASS dialog box to

37. Note that all three images could be combined in one operation with Image Caleulator. The logical expression to use would be: [COM-
BINLED|=|SLOPLEBOOLIANDIBUFFERBOOLIAND|FORLSTBOOL
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create the .rd file needed by the RECLASS module parameters dialog box. Link RECLASS with GROUPAREA
to create an output image called BIGAREAS.

n) Finally, to producc a final image, we will nced to mask out the unsuitable groups that are larper than 10 hectares
from the BIGAREAS image. To do so, add an OVERLAY command to the model to multiply BIGAREAS and
COMBINED. Call the final output image SUITABLE. Again, you may wish to link the COMBINED layer that
is already in the model, or you may place another COMBINED symbol in the model.

The full model combining all the steps is given in Figure 4 below.

This exercise explared two important classes of GIS functions, distance operators and context operators. 1n particular, we
saw how the modules BUFFER and DISTANCE (combined with RECLASS) can be used to create buffer zones around
a set of features. We also saw that DISTANCE creates continuous distance surfaces. We used the context operators SUR-
FACE w calculate slopes and GROUP o identify contiguous areas.

We saw as well how Boolean algebra performed with the OVERLAY module may be extended to three (or more) images
through the use of intermediary images.

Do not delete your Exer2-3 model, nor the orginal images LANDUSE and RELIEE You will need all of these for the
next exercise where we will explore further the udility of the Macro Modeler.
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Answers to the Questions in Text

1. Use SURFACE with the image RELIEF to calculare an image of all slopes. Then use RECLASS with the slope image
to create the Boolean image SLOPEBOOL. Note that you could name the intermediate image (shown in the figures as

SLOPES) anything.

2. Usc cither RECLASS or Edit/ASSIGN with the image LANDUSE to create a Boolean image in which the reservoir
class (value 2 in LANDUSE) has value 1 and all other classes have value 0.

3. | Assign a new value of: | To all values from: | Tojustless than:

0 0 250

1 250 99999999

Note that the last value given in the RECLASS operation can be any number greater than the maximum distance value in
the image.

4. The image should have value 1 only where Deciduous and Coniferous Forest categories exist in the image LANDUSE
and 0 everywhere else. Either RECLASS or Edit/ASSIGN could be used.

5. The OVERLAY Multiply option is used to perform the Boolean AND operation.

6. There is no way to know which groups are derived from 1's and which groups are derived from 0's by examining only
the GROUPS image. You nced to compare GROUPS with COMBINED to visually distinguish between the two. A later
step in the exercise shows how to identify those groups that represent suitable areas.

7. RECLASS must be used as the original values here are real numbers. ASSIGN can only be used when the onginal data
type is integer or byte.
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Exercise 2-4
Exploring the Power of Macro Modeler

To this point we have used cartographic modeling mosty as an organizational tool. However, the Macro Modeler is more
than a layout tool for analyrical sequences, as we will explore in this exercise.

Using the Modeler to Explore “What If’ Scenarios

One of the most common activities in planning is the exploration of “what if” scenarios. Suppose the planners who set
the four criteda for the suitability study in Exercise 2-3 are concerned that perhaps their slope criterion of 2.5 degrees
might be too restrictive, and would like to examine the consequences of considering slopes up to 4 degrees as suitable for
development. If we hadn’t built a model, this would be tedious to re-calculate. With the model, we can change criteria and
examine the new results almost instantaneously.

a) If you have closed it, open Macro Modeler, then open the model file Exer2-3"%, Run the macro as it s to pro-
duce the image SUITABLE.
b) First we will see how the results change when we relax the slope criterion such that slopes less than 4 degrees are

considered suitable. Under the Macro Modeler File menu, choose Save As and give the model the new name
Exer2-4a. Examine the model and locate the step in which the slope threshold is specified. It is the RECLASS
module operation that links SLOPES and SLOPEBQOL. Right click on the RECLASS command symbol.

1. How is the slope threshold specified in the RECLASS parameters dialog boxi? Review the previous exercise if you are
uncertain. Then change the slope threshold from 2.5 to 4.

] Now change the name of the final cutput to SUITABLE2-4a (remember that this can be done using a right click
on the output layer symbol). Then save your model and run it

2 Describe the differences between SUITABLE and SUITABLE24a.,

SubModels

One of the most powerful features of Macro Modeler is the ability to save models as submodels. A submodel is a model
that is encapsulated such that it acts like 2 new analytical module.

To save your suitability mapping procedure as a submodel, select the “Save Model as 2 SubModel” option from the File
menu of Macro Modeler. You will then be preseated with a SubModel Properties form. This allows you to enter captions
for your submodel parameters. In this case, the submodel parameters will be the input and output files necessary to run
the model. You should use titles that are descriptive of the nature of the inputs required since the model will now become
a generic ?;ndeling function. Here are some suggestions. Alter the captions as you wish and then click OK to save the
submodel™.

38. If you don't have the macro modeer file from the provious cxercise, it is installed in the Introductory GIS data directory in a zip file called Exer2-
3.zip. Use your Windows Explorer toals w unzip the file and cxtract the contents to the same directory.
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d)

Layer or File Caption

Relief Relief Image

Landuse Land Use Image
Reservoirs Reservoir Classes
Forestbool Forest Classes

Suitable QOutput Suitability Image

To use your submodel, first click the “Data Paths / Project Environment” icon on the IDRISI toolbar (the far-
thest left) and add an additional resource folder to your project (but leave the working folder set as it is). You
will need to add the “\Idrisi32 Tutorial\Advanced GIS” folder that contains some layers that we will need.
Then click the New icon (the farthest left on the Macro Madeler toolbar) to start a new workspace. Then add
the following rwo layers from the Advanced GIS folder to your workspace:

DEM

LANDUSE91

And add the following two attribute values files from your Introductory GIS folder:
WESTRES
WESTFOR

Click on the LANDUSEY1 symbol to select it and click the Display icon on Macro Modeler. ‘This is a map of
land use and land cover for the town of Westborough (also spelled Westboro), Massachusetts, 1991. You may
also view the DEM layer in a similar fashion. This is a digital elevation model for the same area. The WESTRES
values file simply contains a single line of data to indicate that class 5 (lakes) will be assigned 1 to indicate that
they are the reservoirs (almost all of the lakes here are in fact reservoirs). The WESTFOR values file also con-
tains a single line to indicate that class 7 will be assigned 1 to indicate forest.

Now click on the SubModel icon. You will notice your submodel listed in the working folder. Select it and place
it in your workspace. Then do a right click onto it. Do you notice your captions? Now use the Connect tool to
connect each of your input files to your submodel and give any name you wish to your output file. Then run the
model.

3 How many ssitable areas did you find?

Submodels are very powerful because they allow you to extend the analytical capabilitics of your system. Once encapsu-
lated in this manner, they become generic tools that you can use in many other contexts. They also allow you to encapsu-
late processes that should be run independenty from other elements in your model.

39. Note that when the SubModd Parameters form comes up, the hayers may not be in the order you wish. To set a specific urdet, caneel out of the
SubModel Parameters diakyg and then click on cach of the inputs, and then the outputs, in the ordet in which you would like them t appeat. Then go
back to the Save Model as a SubMaodel option.
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Dynalinks and Dynamic Modeling

A Dynalink is 2 “dynamic link”—a link that introduces a feedback loop, thereby introducing change over tme for
dynamic modeling.

8

h)

To introduce DynaLinks, click on the Open model icon (second from the left) and select the model named
RESIDENTIAL GROWTH. As the name suggests, this model predicts areas of growth in residential land
within existing forest land. The study area is again Westborough Massachusetts. First, run the model. The image
that is displayed at the end shows the original areas of residential land in blue and new areas of growth in light
green. The logic by which it works is as follows (click on each layer mentioned to select it and use the Display
ol to view it as you go along):

- the image named RESIDENTIAL91 shows the original areas of residential land in 1991.

- the image named LDRESSULT maps the inherent suitability of land for residential uses. It is based on factors
such as proximity to roads, slope and so on.

- a filtering process is used t downweight the suitability of land for residential as one moves away from existing
areas of residential. The procedure uses a filter that is applied to the boolean image of existing residential areas.
The filter vields a result (PROXIMITY) that has zeros in areas well away from existing residential arcas and ones
well within existing residential areas. However, in the vicinity of the edge of existing residential areas, the filter
causes a gradual transition from one to zero. This result is used as a multiplier to progressively downweight the
suitability of areas as one moves away from existing residential areas (DOWNWEIGHT).

- the RANDOM module is used to introduce a slight possibility of forest land converting to residential in any
arca (RANDOM SEED).

- all growth is constrained within existing forest areas (FOREST91).

- after suitabilities are downweighted, combined and constrained (FINAL SUITABILITY), cells are rank
ordered in terms of their suitability (RANKED SUITABILITY), while excluding consideration of areas of exist-
ing residential land. This rank ordered image is the reclassified to extract the best 500 cells. These become the
new areas of growth (BEST AREAS). Thesc are combined with existing areas of residential land to determine
the new state of residential land (NEW RESID). The final layer then illustrated both new and original areas
{GROWTH).

We will now introduce a DynaLink to make this a dynamic process. Click on the DynaLink icon (the one that
looks like a lightning bolt). 1t works just like the Connect tool. Move it aver the image named NEW RESID,
hold the left button down and drag the end of the DynaLink to the RESIDENTIAL91 image. Then release the
mouse button. Now run the model. The system will ask how many iterations you wish—indicate 7 and check
the option to display intermediate images.

Now run the process again but do not display intermediates. Note in particular how the names for
RESIDENTIAL91, NEW RESID and GROWTH change. On the first iteration, RESIDENTIAL91 is one of
the input maps, and is used towards the production of NEW RESID_1 and GROWTH_1. Then before the sec-
ond iteration starts, NEW RESID_1 is substituted for RESIDENTIAL91 and becomes an input towards the
creation of NEW RESID_2 and GROWTH_2. This production of multiple outputs for NEW RESID occurs
because it is the origin of a DynaLink, while the production of multiple outputs for GROWTH occurs because
it is a terminal layer (i.e., the last layer in the model sequence). If a model contains more than one terminal layer,
then cach will yield multiple outputs. Finally, notice that the at the end, the original names reappear. For terminal
layers, there is an additional implication - a copy of the final output (GROWTH_7 in this case) is then made
using the original name specified (GROWTH).
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As you can see, DynaLinks are very powerful. By allowing the substitution of outputs to become new inputs, dynamic
models can readily be created, thereby greatly extending the potential of GIS for environmental modeling,

Batch Processing using DynaGroups

A batch process is one in which we process 2 group of data files all at one time. Many systems, including IDRISK, provide
macro scripting languages to facilitate batch processing. However, Macro Modeler provides an even easier way to under-
take batch processes.

)

k)

Use Display Launcher to examine the image named MAD82JAN. This is an image of Normalized Difference
Vegetation Index (NDVI) data for January 1982 produced from the AVHRR system aboard onc of the NOAA
series weather satcllites. The original image was global in extent (with a 8 km resolution). Here we see only the
island of Madagascar. NDV1 is calculated from the reflectance of solar energy in the red and infrared wavelength
regions according to the simple formula:

NDVI = (IR-R) / (IR + R)

This index has values that can range from -] to +1. However, real numbers (i.e., those with fractional parts)
require more memory in digital system that integer values. Thus it is common to rescale the index into a byte (0-
255) range. With NDVI, vegetation areas typically have values that range from 0.1 to 0.6 depending upon the
amount of biomass present. In this case, the data have been scaled such that 0 represents an NDVI of -0.05 and
255 represents an NDV1 of 0.67.

You will note that MADB2JAN is only one of 18 images in your folder, showing January NDVI for all years
from 1981 through 1999 (18 years). In this section we will use Macro Modeler to convert this whole set of
images back to their original (unscaled) NDVI values. The backwards conversion is as follows:

NDVI = (Dn * 0.0028) — 0.05 where Dn is the scaled digital number

First, let’s create the model using MAD8S2JAN. Open Macro Modeler to start a new workspace (or click the
New icon). Then click on the Raster Layer icon and select MAD82JAN. Then click on the Module icon and
select SCALAR. Right click on SCALAR and change the operation to multiply and the value to 0.0028. Then
connect MAD82JAN to SCALAR. Now dlick on the Module icon and select SCALAR again. Change the opera-
tion for this second SCALAR to subtract and enter a value of 0.05. Then connect the output from the first SCA-
LAR operation to the second scalar. Now test the module by clicking on the Run icon. If it worked, you should
have values in the output that range from -0.05 to 0.56.

To perform this same operation on all files, we now neced to create a raster group file. Click on the Collection
Editor icon on the main IDRISI toolbar (third from the left). Then scroll the left pane undl you sce
MADB82JAN and click it to highlight it. Now hold down the shift key and press the down arrow until the whole
group (MADS2JAN through MAD99JAN) has been highlighted. Then click the Insert After button to select
these into the right pane. Finally, click Save As from the File menu and enter the new name MADNDVIL.

Now dick onto the MAD82JAN symbol to highlight it, and then click the Delete icon to remove it. Next, locate
the DynaGroup icon (it’s the one with a group file symbol along with a lightning bolt). Click it and select Raster
Group File. Then select your MADNDVI group file and connect it as the input to the first SCALAR operation
(use the standard Connect tool for this). Finally, go to the final output file of your model (it will have some form
of temporary name at the moment) and change it to have the following name:

NEW+<madndvi>
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This is a special naming convention. The specification of <madndvi> in the name indicates that Macro Modeler
should form the output names from the names in the input DynaGroup named MADNDVL. In this case, we are
saying that we want the new names to be the same as the old names, but with a prefix of NEW added on.

Now run the model to see how it works. You will be informed that there will be 18 iterations (you cannot
change this—it is determined by the number of members in the group file). Check the option to display interme-
diates. While it runs, note how the output file names are formed. At the end, it will also produce a mster group
file using the prefix specified (NEW). Remember o save your model before you move on.

Modeling Iterative Processes using DynaGroups with
Dynalinks

Another important role for DynaGroups and DynaLinks is in the execution of iterative processes. In this last section we
will explore how they can be used together in a very powerful fashion.

)

P

Open the model named MEAN. This has been specifically developed to work with your data. Note that it incor-
porates both a DynaGroup and a DynaLink. To calculate the average {mean) of your images of Madagascar, we
need to sum up the values in the 18 NDVI images and then divide by 18. The combined DynaGroup and
DynaLink accomplishes the summation, while the last scalar operation does the division.

Display the image named BLANK_NDVI As you can see, it only contains zeros. In the first itcration, the
model takes the first image in the DynaGroup (MAD82JAN) and adds it to BLANK_NDVI (using OVER-
LAY) and places the result in SUM_L. The DynaLink then substitutes SUM_1 for BLANK_NDVI1 and thus
adds the second image in the group (MADS3JAN) to SUM_1. At the end of the sequence, a final image named
SUM is created, containing the sum of the 18 images. This is then divided by 18 by the SCALAR operation to
get the final result. Run the model and watch it work. Note also that the output of the DynaGroup did not usc
any of the special naming conventions. ln such cases the system reverts back to its normal naming convention
for multiple outputs (numeric suffixes).

As 2 final example, open the model named STANDEYV. This calculates the standard deviation of images (across
the serics). It has already been structured for the specific files in this exercise. Run it and scc if you can figure out
how it works—the basic principles are the same as for the previous example.

Answers to the Questions in the Text

L. The reclass thresholds are actually specified in the .rcl file named SLOPEBOOL. The RECLASS parameters box sim-
ply lists the appropriate .rel file.

2. SUITABLE2-4a relaxes the criterion for stopes to include slopes up to 4 degrees. This creates more suitable areas, and
four contiguous areas are identified as compared to only one contiguous area in SUITABLE.
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Exercise 2-5
Cost Distances and Least-Cost Pathways

In the previous exercise, we introduced one of the IDRISI distance operators called DISTANCE. DISTANCE produces
a continuous surface of Euclidean distance values from a set of features. In this exercise, we will use a variant on the DIS-
TANCE module called COST. While DISTANCE produces values measured in units such as meters or kilometers,
COST calculates distance in terms of some measure of cost, and the resulting values are known as ws? distancer. Similar to
DISTANCE, COST requires a feature image as the input from which cost distances are calculated. However, unlike DIS-
TANCE, COST also requires a friction susface that indicates the relative cost of moving through each cell. The resulting
continuous image is known as a st distance surface.

The values of the friction surface are expressed in terms of the particular measure of cost being calculated. These values
often have an actual monetary meaning equal to the cost of movement across the landscape. However, friction values
may also be expressed in other terms. They may be expressed as travel time, where they represent the time it would take
to cross areas with certain attributes. They might also represent energy equivalents, where they would be proportional to
total fuel or caloties expended while traveling from a pixel to the nearest feature.

These friction values are always calculated relative to some fixed base amount which is given a value of 1. For example, if
our only friction was snow depth, we could assign areas with no snow a value of 1 (i.c., the base cost) and areas with snow
cover values greater than 1. If we know that it costs twice as much to traverse areas with snow six to ten inches deep than
it does to cross bare ground, we would assign cells with snow depths in that range a friction value of 2. Frictions are spec-
ified as real numbers to allow fractional values, and they can have values between 0 and 1.0 x 10", Frictions are rarely
specified with values less than 1 (the base cost) because a friction value less than 1 actually represents an aavleration or force
that acts to aid movement.

No matter what scheme is used to represent frictions, the resulting cost distance image will incorporate both the actual
distance traveled and the frictional effects encountered along the way. In addition, because friction values will always be
used to calculate cost distances, cost distance will always be relative to the base friction value or cost. For example, if a cell
is determined to have a cost distance of 5.25, this indicates that it costs five and a quarter times as much as the base cost
to get to this cell from the nearest feature from which cost was calculated. Or, phrased differeny, it costs the same
amount to get to that cell as it would to cross five and a quarter cells having the base friction. The module SCALAR may
be used to transform relative cost distance values into actual monetary, time, or other units.

The discussion above focuses on isotropic frictions, one of two basic types of frictional effects. Isotropic frictions are inde-
pendent of the direction of movement through them. For example, a road surface will have a particular friction no matter
which direction travel occurs. The road surface has characteristics (paved, muddy, etc)) that make movement easier (low
friction value) or more difficult (high friction value). We will work with this type of friction surface in this exercisc. The
IDRISI module COST accounts for isotropic frictional effects.

Those frictions that vary in strength depending on the direction of movement are known as anisotropic frictions. An example
is a prevailing wind where movement directly into the wind would cause the cost of movement to be great, while traveling
in the same direction as the wind would aid movement, perhaps even causing an acceleration. In order to effectively
model such anisotropic frictional effects, a dual friction surface is required—one image containing information on the
magnitude of the friction, and another containing information on the direction of frictional effect. The module
VARCOST is used to madel this type of cost surface. For more information, see the chapter on Anisotropic Cost Anal-
ysis in the IDRISI Guide to GIS and Image Processing Volume 2,

in this exercise, we will be working only with isotropic frictions, and therefore will be using the COST module. COST
offers two separate algorithms for the calculation of cost surfaces. The first, COSTPUSH, is faster and works very well
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when friction surfaces are not complex or network-like. The second, COSTGROW, can work with very complex friction
surfaces, including absolute barriers to movement.

An interesting and useful companion to the cost modules is PATHWAY. Once a cost surface has been created using any
of the cast modules, PATHWAY can be used to determine the least-cost route between any designated cell or group of
cells and the nearest feature from which cost distances were calculated,

We will use both the COST and PATHWAY modules in this exercise.

Qur problem concerns a new manufacturing plant. This plant requires a considerable amount of electrical energy and
needs a ransformer substation and a feeder line to the nearest high voltage power line. Naturally, plant exccutives want
the construction of this line to be as inexpensive as possible. Our problem is to determine the least-cost route for building
the new feeder line from the new plant to the existing power line.

a) Display the image named WORCWEST with the user-defined palette WORCWEST:*! (Note that Display
Launcher automatically looks for a palette or symbol file with the same name as the selected layer. If found, this
is entered as the default) This is a land use map for the western suburbs of Worcester, Massachusetts, USA, that
was created through an unsupervised classification of LANDSAT TM satellite imagery.42 Use Composer to add
the vector layer NEWPLANT, with the user defined symbol file NEWPLANT. The location of the new manu-
facturing plant will be shown with a large white circle just to the northwest of the center of the image. Then add
the vector file POWERLINE to the compasition, using the user defined symbol file POWERLINE. The exist-
ing power line is located in the lower left portion of the image and is represented with a red line. 1t is these two
features we want to connect with the least cost pathway.

b) Open Macro Modeler. We will construct a model for this exercise as we proceed.

Cost distance analysis requires two layers of information, a layer containing the features from which to calculate cost dis-
tances and a friction surface. Both must be in raster format.

First we will create the friction surface that defines the costs associated with moving through different land cover types in
this area. For the purposes of this exercise, we will assume that it costs some base amount to build the feeder line through
open land such as agricultural fields. Given this base cost, Table 1 shows the relative costs of having the feeder line con-
structed through each of the land uses in the suburbs of Worcester.

Land Use Friction | Explanation

Agriculture 1 the base cost

Deciduous Forest 4 the trees must first be felled, then removed and sold

Coniferous Forest 5 this woaod is not as valuable as deciduous hardwood, and
does not allow as great a cost recovery

Urban 1000 a very high cost—virtually a barrier

40, e further information on these algorithms, see Eastman, JR., 1989. Pushbroom Algodthms for Calculating Distances in Raster Grids. Proeedings,
AUTOCARTO 9, 288-297.

41. Lor this exercisc, make sure that your display settings (under Vile/User Preferences) ate set to the default values by pressing the Revert to Defaults
button.

42. ‘This is an imaye processing technique explored in the Introductory Image Processing [ixercises section of the Tutorial
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Pavement 1 the base cost

Suburban 1000 a very high cost—virtually a barrier

Water 1000 a very high cost—virtually a barrier. Residents do not
want power lines affecting the visual character of the
lakes and reservoirs

Barren/Gravel 1 the base cost

Table 1

You will notice that some of these frictions are very high. They act essentially as barriers. However, we do not wish
totally prohibit paths that cross these land uses, only to avoid them at high cost. Therefore, we will simply set the frictions
at values that are extremely high.

)
d

Place the raster layer WORCWEST on the Macro Modeler. Save the model as Exer2-5.

Access the documentation file for WORCWEST by clicking first on the WORCWEST image symbol to high-
light it, then clicking on the Metadata icon on the Macro Modeler toolbar. (You can also access Metadata from
under the Idrisi File menu outside the Macro Modeler). Determine the identifiers for each of the land use cate-
godes in WORCWEST. Match these to the Land Use categorics given in Table 1, then use Edit (under the Idssi
Data Entry menu) to create a values file called FRICTION. This values file will be used to assign the friction val-
ues to the land use categories of WORCWEST. The first column of the values file should contain the original
landuse categories while the second column contains the corresponding friction values. Save the values file and
specify real as the data type (because COST requires the input friction image to have real data type).

Place the values file you just created, FRICTION, into the madel then place the module ASSIGN. Right click
on ASSIGN 1o see the required order of the input files—the feature definition image should be linked first, then
the attribute values file. Close module properties and link WORCWEST and then FRICTION to ASSIGN.
Right click on the output image and rename it FRICTION. Save and run the model,

This completes the creation of our friction surface. The other required input to COST is the feature from which cost dis-
tances should be calculated. COST requires this feature to be in the form of an image, not a vector file. Therefore, we
need to create a raster version of the vector file NEWPLANT.

f

When creating a raster version of a vector layer in IDRIS], it is first necessary to create a blank raster image that
has the desired spatial characteristics such as min/max x and y values and numbers of rows and columns. This
blank image is then *‘updated” with the informaton of the vector file. The module INITIAL is used to create
the blank raster image. Add the module INITIAL o the model and right click on it. Note that there are two
options for how the parameters of the output image will be defined. The default, copy from an existing file,
requires we link an input raster image that already has the desired spatial characteristics of the file we wish to cre-
ate (the attribute values stored in the image are ignored). We wish to create an image that matches the character-
istics of WORCWEST. Also note that INITIAL requires an initial value and data type. The default value of 0
and data type byte are correct in this case. Close Module Parameters and link the raster layer WORCWEST,
which is already in the model, to INITIAL. You may wish to re-arrange some model elements at this point to
make the model more readable. You can also add a second copy of WORCWEST to your model rather than
linking the existing one if you prefer to do so. Right dlick on the output image of INITIAL and rename the file
BLANK. Save and run the module. We have created the blank raster image now, but must still update it with the
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vector informaton.

Add the vector file NEWPLANT to the model, then add the module POINTRAS to the model and right click
on it. POINTRAS requires two inputs—first the vector point file, then the raster image to be updated. The
default operation type, to record the ID of the point, is correct. Close module parameters. Link the vector layer
NEWPLANT then the mster layer BLANK to the POINTRAS module. Right click on the output image of
POINTRAS and rename this to be NEWPLANT. (Recall that vector and raster files have different file name
extensions, so this will not overwrite the existing vector file.) Save and run the model.

NEWPLANT will then automatically display. If you have difficulty secing the single pixel that represents the
plant location, you may wish to use the interactive Zoom Window tool to enlarge the portion of the image that
contains the plant. You may also add the vector layer NEWPLANT, window into that location, then make the
vector layer invisible by elicking in its check box in Compaoser. You should see a single raster pixel with the value
one representing the new manufacturing plant.

The operation you have just completed is known as vector-to-raster conversion, or rasterigation. We now have both of the
images needed to run the COST module, a friction surface (FRICTION) and a feature definition image (NEWPLANT).
Your model should be similar to Figure 1, though the arrangement of elements may be different.

friction

worcwest

/ assign /Lb friction

—_—m

—l/ pointras /LP newplant

‘7/ initial /—. blank

Figure 1

h)

In order

Add the COST module to the model and right click on it. Note that the feature image should be linked first,
then the friction image. Choose the COSTGROW algorithm (because our friction surface is rather complex).
The default values for the last two parameters are correct. Link the input files to COST, then right click on the
output file and rename it COSTDISTANCE. The calculation of the cost distance surface may take a while if
your computer does not have a very fast CPU. Therefore you may wish to take a break here and let the model
run.

When the model has finished running, use cursor inquiry mode to investigate some of the data values in COST-
DISTANCE. Verify that the lowest values in the image occur near the plant location and that values accumulate
with distance from the plant. Note that crossing only a few pixels with very high frictions, such as the water bod-
ies, quickly leads to extremely high cost distance values.

to calculate the least cost pathway from the manufacturing plant to the existing power line, we will need to sup-

ply the module PATHWAY with the cast distance surface just created and a raster representation of the existing power

line.

i)

Place the module LINERAS in the model and right click on it. Like POINTRAS, it requires the vector file and
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an input raster image to be updated. Close module parameters then place the vector file POWERLINE and link
it to LINERAS, Rather than run INITIAL again, we can simply link the output of the existing INITIAL pro-
cess, the image BLANK, into LINERAS as well. Right click on the output image and rename it POWERLINE.
Save the model, but don’t run it yet. Since the COST caleulation takes some time, we will build the remainder
of the model, then run it again.

We are now ready to caleulate the least-cost pathway linking the existing powerline and the new plant. the module PATH-
WAY works by choosing the least-cost alternative each time it moves from one pixel to the next. Since the cost surface
was calculated using the manufacturing plant as the feature image, the lower costs occur nearer the plant. PATHWAY,
therefore, will begin with cells along the power line (POWERLINE) and then continue choosing the least cost alternative
until it connects with the lowest point on the cost distance surface, the manufacturing plant. (This is analogous to water
running down a slope, always flowing into the next cell with the lowest elevation.)

k) Add the module PATHWAY to the model and right click on it. Note that it requires the cost surface image be
linked first, then the target image. Link COSTDISTANCE, then POWERLINE to PATHWAY. Right dlick on
the output image and rename it NEWLINE. Save and run the model.

NEWLINE is the path that the new feeder power line should follow in order to incur the least cost, according to the fric-
tion values given. A full cartographic model is shown in Figure 2.

M f assign L. friction
WoiGwest —’*f cost /‘b costdistance
A;m L |
/ pointras /L, newplant
7 initial L blank

7 lineras /—+ powerline
m —|
——rf pathway /L, newline

For a final display, it would be nice to be able to display NEWPLANT, POWERLINE and NEWLINE all as vector lay-
ers on top of WORCWEST. However, the output of PATHWAY is a raster image. We will convert the raster NEW-
LINE into a vector layer using the module LINEVEC. "To save time in creating the final product, we will do this outside
the Modeler.

Figure 2

1) Select LINEVEC from the Idrsi Reformat/Raster-Vector Conversion menu. The input image is NEWLINE
and the outpur vector file may be called NEWLINE as well.

m) Create 2 map composition with WORCWEST, NEWPLANT, POWERLINE and NEWLINE.

1. The place where the new feeder line neets the existing power line is clearly the position for the new transformer substation.
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How do you think PATHW.AY determined that the feeder line sbould join bere rather than somestbere else along the
power line? (Read carefully the module deseription for PATHW.AY in the on-line Help System.)

2. What would be the result if PATHW.AY were used on a Euclidean distance surface ereated using the module DIS-
TANCE, with the feattire image NEWPLANT, and POWERLINE as the target feature?

In this exercise, we were introduced to cost distances as a way of modeling movement through space where various fric-
tional clements act to make movement more or less difficult. This is useful in modeling such variables as travel times and
monetary costs of movement. We also saw how the module PATHWAY may be used with a cost distance surface to find
the least cost-path connecting the features from which cost distances were calculated to other target features.

In addition, we learned how to convert vector data to raster for use with the analytical modules of IDRISL. This was
accomplished with POINTRAS for point vector data and LINERAS for line vector data. A third module, POLYRAS, is
used for rasterization of vector polygon data. These modules require an existing image that will then be updated with the
vector information. INITLIAL may be used to create a blank image to update. We also converted the raster output image
of the new powedine to vector format for display purposes using the module LINEVEC. The modules POINTVEC and
POLYVEC perform the same raster to vector transformation for point and polygon vector files.

It is not necessary to save any of the images created in this exercise.

Answers to the Questions in the Text

1. PATHWAY evaluates all the pixels of the target features (the power line in this case) for their corresponding cumula-
tive cost distance value in the cost distance image. It chooses the pixel with the lowest value in the cost distance image as
the endpoint for the least cost pathway.

2. The least cost pathway in this case would be a straight line between the manufacturing plant and the pixel on the power
line that is closest (in terms of Euclidean distance) to the manufacturing plant.

Tutorial Part 2: Introductory GIS Exercises 76



Exercise 2-6
Mayp Algebra

in Exercises 2-2 and 2-4 we used the OVERLAY module to perform Boolean (or logical) operations. However, this mod-
ule can also be used as a general arithmetic operator between images. This then leads to anather important set of opera-
tions in GIS called map algebra.

Map Algebra refers to the use of images as variables in normal arithmetic operations. With a GIS, we can undertake full
algebraic operations on sets of images. In the case of IDRISI, mathematical operations are available through three mod-
ules: OVERLAY, TRANSFORM, and SCALAR (and by extension through the Image Calculator, which includes the
functionality of these three modules). While OVERLAY performs mathematical operations between two images, SCA-
LAR and TRANSFORM both act on a single image. SCALAR is used to mathematically change every pixel in an image
by a constant. For example, with SCALAR we can change a relief map from meters to fect by multiplying every pixel in
the image by 3.28084. TRANSFORM is used to apply a uniform mathematical transformation to every pixel in an image.
For example, TRANSFORM may be used to calculate the reciprocal (one divided by the pixel value) of an image, or o
apply logarithmic or trigopnometric transformations.

These three modules give us mathematical modeling capability. In this exercise, we will work primarily with SCALAR,
OVERLAY, and Image Calculator. We will also use a module called REGRESS, which evaluates relationships between
images or tabular data to produce regression equations. The mathematical operators will then be used to evaluate the
derived equations. Those who are unfamiliar with regression modeling are encouraged to further investigate this impor-
tant tool by consulting a statistics text. We will also use the CROSSTAB module, which produces a new image based on
all the unique combinations of values from two images.

In this exercise, we will create an agro-climatic zone map for the Nakuru District in Kenya. The Nakuru District lies in the
Great Rift Valley of East Africa and contains scveral lakes that are home to immense flocks of pink flamingos.

a) Display the image NRELIEF with the Standard Idrisi palette,*?

This is a digital elevation model for the area. The Rift Valley appears in the dark black and blue colors, and is flanked by
higher elevations shown in shades of green.

An agro-climatic zone map is a basic means of assessing the climatic suitability of geographical areas for various agricul-
tural alternatives. Qur final image will be one in which every pixel is assigned 1o its proper agro-climatic zone according to
the stated criteria.

‘The approach illustrated here is a very simple one adapted from the 1:1,000,000 Agro-Climatic Zone Map of Kenya
(1980, Kenya Soil Survey, Ministry of Agriculture). It recognizes that the major aspects of climate that affect plant growth
are moisture availability and temperature. Moisture availability is an index of the balance between precipitation and evap-
oration, and is calculated using the following equation:

moisture availability = mean annual rainfall / potential evaporation®®

While important agricultural factors such as length and intensity of the miny and dry seasons and annual variation are not

43. Vor this exercise, make sure your User Preferences are sct to the default values by opening Lile/Uscr Prefercnces and pressing the Revert to Defaults
button. Click OK to save the scttings.

44, The term pofential cvaporation indicates the amount of evapuration that perld occur if moisture were unlimited. Actual evaporation may be less than
this, since there may be dry petiods in which theee is simply no moisture avaibble 10 evaponate
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accounted for in this model, this simpler approach does provide a basic tool for national planning purposes.

The agro-dlimatic zones are defined as specific combinations of moisture availability zones and temperature zones. The
value ranges for these zones are shown in Table 1.

‘v Moisture Availability | Moisture Availability Temperature Temperature
Zone Range Zone Rangse (°C)
7 <0.15 9 <10

6 0.15-0.25 8 10-12

5 0.25-0.40 7 12-14

4 0.40-0.50 6 14-16

3 0.50 - 0.65 5 16-18

2 0.65 - 0.80 4 18-20

1 >0.80 3 20-22

2 22-24

Table 1 1 24-30

For Nakuru District, the area shown in the image NRELIEF, three darta sets are available to help us produce the agro-cli-
matic zone map:

i) a mean annual rainfall image named NRAIN;
if) a digijtal elevation model named NRELIEF;
iii) tabular temperature and altinde data for nine weather stations.

In addition to these data, we have a published equation relating potential evaporation to elevation in Kenya.

Let's sce how these pieces fit into a conceptual cartographic model illustrating how we will produce the agro-climatic
zones map. We know the final product we want is 2 map of agro-climatic zones for this district, and we know that these
zones are based on the temperature and moisture availability zones defined in Table 1. We will therefore need to have
images representing the temperature zones (which we'll call TEMPERZONES) and moisture availability zones (MOIST-
ZONES). Then we will need to combine them such that each unique combination of TEMPERZONES and MOIST-
ZONES has a unique value in the result, AGROZONES. The module CROSSTAB is used to produce an output image
in which each unique combination of input values has a unique output value,

To produce the temperature and moisture availability zone images, we will need to have continuous images of tempera-
ture and moisture availability. We will call these TEMPERATURE and MOISTAVAILL. These images will be reclassified
according to the ranges piven in Table 1 to produce the zone images. The beginning of the cartographic model is con-
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structed in Figure 1.

moistavail —*/ reclass /L; moistzones

—»/ crosstab agzones

temperature —/ reclass /L.. temperzones

Figure 1

Unfortunately, ncither the temperature image nor the moisture availability image are in the list of available data—we will
need to derive them from other data.

The only temperature information we have for this area is from the nine weather stations. We also have information
about the clevation of each weather station. In much of East Africa, including Kenya, temperature and elevation are
closely correlated. We can evaluate the relationship between these two variables for our nine data points, and if it is
strong, we can then use that relationship to derive the temperature image (TEMPERATURE) from the available elevation
in‘mge.'15

The elements needed to produce TEMPERATURE have been added to this portion of the cartographic model in Figure
2. Since we do not yet know the exact nature of the relationship that will be derived between elevation and temperature,
we cannot fill in the steps for that portion of the model. For now, we will indicate that there may be more than one step
involved by leaving the module as unknown (7277).

nrelief

== 7/ 7777 /L, temperature
‘ —» Derived Relationship

weather station
clevation and
temperature data

Figure 2

Now let's think about the maoisture availability side of the problem. In the introduction to the problem, moisture availabil-
ity was defined as the ratio of rainfall and potential evaporation. We will need an image of cach of these, then, to produce
MOISTAVAIL. As stated at the beginning of this exercise, OVERLAY may be used to perform mathematical operations,
such as the ratio needed in this instance, between two images.

We already have a rainfall image (NRAIN) in the available data set, but we don't have an image of potential evaporation
(EVAPO). We do have, however, a published relationship between elevation and potential evaporation. Since we already
have the elevation model, NRELIEF, we can derive a potential evaporation image using the published relationship. As
before, we won't know the exact steps required to produce EVAPO until we examine the equation. For now, we will indi-
cate that there may be more than one operation required by showing an unknown module symbaol in that portion of the

45. Lixercise 3-6 of the Tutorial presents another method for developing a full mster surface from point dara.
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cartographic model in Figure 3.

nrelief

Mo

nrain

evapo

Published

Relationship

Figure 3

Now that we have our analysis organized in a conceptual cartographic model, we are ready to begin performing the oper-
ations with the GIS. Our first step will be to derive the relationship between elevation and temperature using the weather

station data, which are presented in Table 2.

moistavail

| Station Number | Elevation (ft) | Mean Annual Temp. (°C)
_1____-_‘?];6.00 .—_1"5.70
2 |7a200 |10
3 Cmo200 | 1370
) ‘o100 | 1240
5 6024.00 18.20
6 6001.00 16.80 -
j_'.-’ - _;52; _-_16.30— S =
LB 7001.00 16.30 -
KN C EE
Table 2

We can see the nature of the relationship from an initial look at the numbers—the higher the elevation of the station, the
lower the mean annual temperature. However, we need an equation that describes this relationship more precisely. A sta-
tistical procedure called regression analysis will provide this. In IDRISI, regression analysis is performed by the module
REGRESS.

REGRESS analyzes the relationship either between two images or two attribute values files. In our case, we have tabular
data and from it we can create two attribute values files using Edit. The first values file will list the stations and their ele-
vations, while the second will list the stations and their mean annual temperatures.

b) Use Edit from the Data Entry menu, first to create the values file ELEVATION, then again to create the values
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file TEMPERATURE. Remember that cach file must have two columns separated by one or more spaces. The
left column must contain the station numbers (1-9) while the right column contains the attribute data. When you
save each values file, choose Real as the Data Type.

c) When you have finished creating the values files, run REGRESS from the GIS Analysis/Statistics menu.
(Because the output of REGRESS is an equation and statistics rather than a data layer, it cannot be implemented
in the Macro Madeler.) Indicate that it is a regression between values files. You must specify the names of the
files containing the independent and dependent variables. The independent vanable will be plotted on the X axis
and the dependent variable on the Y axis. The linear equation derived from the regression will give us Y as a
function of X. In other words, for any known value of X, the equation can be used to calculate a value for Y. We
later want to usc this equation to develop a full image of temperature values from our elevation image. Therefore
we want to give ELEVATION as the independent variable and TEMPERATURE as the dependent variable.
Press OK.

REGRESS will plot a graph of the relationship and its equation. The graph provides us with a variety of information.
First, it shows the sample data as a set of point symbols. By reading the X and Y values for each point, we can sce the
combination of elevation and temperature at each station. The regression trend line shows the "best fit" of a lincar rela-
tonship to the data at these sample locations. The closer the points are to the trend line, the stronger the relationship. The
correlation coefficient ("r") next to the equation tells us the same numerically. If the line is sloping downwards from left
to the right, "r” will have a negative value indicating a "negative” or "inverse” relationship. This is the case with our data
since as elevation increascs, temperature decreases. The correlatdon coefficient can vary from -1.0 (strong negative rela-
tionship) to 0 (no relationship) to +1.0 (strong positive reladonship). In this case, the correlation cocfficient is -0.9652,
indicating a very strong inverse relationship berween elevation and temperature for these nine locations.

The equation itself is a mathematical expression of the line. In this example, you should have arrived (with rounding) at
the following equation:

Y = 26985 - 0.0016 X

The equation is that of a line, Y = a + X, where ais the Y axis intercept and & is the slope. X'is the independent variable
and Y'is the dependent variable.

In effect, this equation is saying that you can predict the temperature at any location within this region if you take the ele-
vation in feet, multiply it by -0.0016, and add 26.985 to the result. This then is our “model™:

TEMPERATURE = 26.985-0.0016 * [NRELIEF]

d) You may now close the REGRESS display. This model can be evaluated with either SCALAR (in or outside the
Macro Modeler) or image Calculator. In this case, we will use Image Calculator to create TEMPERATURE.
Open lmage Calculator from the GIS Analysis/Mathematical Operators menu. We will create 2 Mathematical
Expression. Type in TEMPERATURE as the output image name. Tab or dlick into the expression to process
input box and type in the equation as shown above. When you are ready to enter the filename NRELIEF, you
can click the Insert Image button and choose the file from the pick list. Entering file names in this manner
ensures that square brackets are placed around the file name. When the entire equation has been entered, press
Save Expression and give the name TEMPER. (We are saving the expression in case we need to return to this
step. If we do, we can simply click Open Expression and run the equation without having to enter it again.)
Then click Process Expression.

The resulting image should look very similar to the relief map, except that the values are reversed—high temperatures are
found in the Rift Valley, while low temperatures are found in the higher elevations.

46. If you were evaluating this portion of the maded in Macro Modeler, you would need to use SCALAR twice, fiest to multiply NRELILEE by -0.0016 w0
prixduce an output file, then again with that result to add 26.983.
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€) To verify this, drag the TEMPERATURE window such that you can see both it and NRELIEE

Now that we have a temperature map, we need to create the second map required for agro-climatic zoning—a moisture
availability map. As stated above, moisture availability can be approximated by dividing the average annual rainfall by the
average annual patential evaporation.

We have the rainfall image NRAIN already, but we need to create the evaporation image. The relationship between eleva-
tion and potential evaporation has been derived and published by Woodhead (1968, Studies of Potential Evaporation in
Kenya, EAAFRQ, Nairobi) as follows:

E, (mm) = 2422 - 0.109 * clevation(fect)
We can thercefore use the relief image to derive the average annual potential evaporation (E,).

f) As with the eadier equation, we could evaluate this equation using SCALAR or Image Calculator. Again use
Image Calculator to create a mathematical expression. Enter EVAPO as the output filename, then enter the fol-
lowing as the expression to process. (Remember that you can press the Insect Image button o bring up a pick
list of files rather than typing in the filename directly.)

2422 - (0.109*{NRELIEF])
Press Save Expression and give the filename MOIST. Then press Process Expression.

4] We now have both of the pieces required to produce a moisture availability map. We will build a model in the
Macro Modeler for the rest of the exercise. Open Macro Modeler and place the images NRAIN and EVAPO
and the module OVERLAY. Connect the two images to the module. Right click on the OVERLAY module and
select the Ratio (zero option) operation. Close module parameters then right click on the output image and call
it MOISTAVAILL. Save the model as Exer2-6 then run it.

The resulting image has values that are unitless, since we divided rainfall in mm by potential evaporation which
is also in mm. When the result is displayed, examine some of the values using the cursor inquiry mode. The val-
ues in MOISTAVALL indicate the balance between rainfall and evaporation. For example, if a cell has a value of
1.0 in the result, this would indicate that there is an exact balance between rainfall and evaporation.

5. What would a value greater than 1 indicate? What would a value less than 1 indicate?

At this point, we have all the information we need to create our agro-climatic zone (ACZONES) map. The government
of Kenya uses the specific classes of temperature and moisture availability that were listed in Table 1 to form zones of
varying agricultural suitability. Our next step is therefore to divide our temperature and moisture availability surfaces into
these specific classes. We will then find the various combinations that exist for Nakuru District.

h) Place the RECLASS module in the model and connect the input image MOISTAVAIL. Right click on the out-
put image and rename it MOISTZONES. Right click the RECLASS symbol. As we saw in earlier exercises,
RECLASS requires a text .rcl file that defines the reclassification thresholds. The casiest way to construct this
file is to use the main RECLASS dialog. Close Module Parameters.

Open RECLASS from GIS Analysis/Database Query. There is no need to enter filenames. Just enter the values
as shown for moisture zones in Table 1, then press Save as .RCL file. Give the file name MOISTZONES. Right
click 1o open the RECLASS module parameters in the model and enter MOISTZONES as the .rel file. Save and
run the model.

i) Change the MOISTZONES display to use the IDRIS256 palette and autoscaling,

2. How many moisture availability zones are in the image? Why is this different from the number of Jones given in the
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table? (If you are having trouble answering this, you may wish to examine the doc tation file of MOISTALAIL)

The information we have concerning these zones is published for use in all regions of Kenya. However, our study area is

only a small part of Kenya. It is therefore not surprising that some of the zones are not represented in our result.

)

Next we will follow a similar procedure to create the temperature zone map. Before (l()ing so, however, first
check the minimum and maximum values in TEMPERATURE to avoid any wasted reclassification steps. High-
light the TEMPERATURE raster layer in the model, then click the Metadata icon on the Macro Modeler tool-
bar. Use Check for the minimum and maximum data values in TEMPERATURE. Then use the main
RECLASS dialog again to create an .rcl file called TEMPERZONES with the ranges given in Table 1. Again,
change the palette to be IDRIS256 and invoke autoscaling,

Place another RECLASS model element and rename the output file TEMPERZONES, Link TEMPERATURE
as the input file and right click to open the module parameters. Enter the .rcl file, TEMPERZONES, that you

just created.

Now that we have images of temperature zones and moisture availability zones, we can combine these to create agro-cli-
matic zones. Each resulting agro-climatic zone should be the result of a unique combination of temperature zone and
moisture zone.

3. Previously we nsed OVERLAY 1o combine two images. Given the criteria for the final image, why can't we use
OVERLAY for this final step?

The operation that assigns a new identifier to every distinet combination of input classes is known as cross-clas-
sification. In IDRISI, this is provided with the module CROSSTAB. Place the module CROSSTAB into the
model. Link TEMPERZONES first and MOISTZONES second. Right click on the output image and rename it
AGROZONES. Then right click on CROSSTAB to open the module parameters. (Note that the CROSSTAB
module when run from the main dialog offers several addition output options that are not available when used
in the Macro Modeler.)

The cross-classification image shows all of the combinations of moisture availability and temperature zones in the study
area. Notice that the legend for AGROZONES explicitly shows these combinations in the same order as the input image
names appear in the title.

Figure 4 shows one way the model could be constructed in Macro Modeler. (Your model should have the same data and
command elements, but may be arranged differently.

nrain

} istaval reclass /3  moistzones.
‘r/omhy/amaav{ / —|

evapo

| crosstab /4| agrozones

temperature -7/ reclass /+ temperzones

Figure 4
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In this exercise, we used Image Calculator and OVERLAY to perform a variety of basic mathematical operations. We
used images as variables in evaluating equations, thereby deriving new images. This sort of mathematical modeling (also
termed map algebra), in conjunction with database query, form the heart of GIS. We were also introduced to the module
CROSSTAB, which creates a new image based on the combination of classes in two input images.

Optional Problem

The agro-climatic zoncs we have just delineated have been studied by geographers to determine the optimal agricultural
activity for each combination. For example, it has been determined that areas suitable for the growing of pyrethrum, a
plant cultivated for use in insect repellents, are those defined by combinations of temperature zones 6-8 and moisture
availability zones 1-3.

b Create a map showing the regions suitable for the growth of pyrethrum.
4. There are several ways to create a map of areas suitable for pyrethrum. Describe bow you made your map.

We will not use any of the images created in this exercise for later exercises, so you may delete them all if you like, except
for the original data files NRAIN and NRELIEFE

This completes the GIS tools exercises of the Introductory GIS section of the Tutorial. Database query, distance opera-
tors, context operators, and the mathematical operators of map algebra provide the tools you will use again and again in
your analyses.

We have made heavy use of the Macro Modeler in these exercises. However, you may find as you are learning the system
that the organization of the main menu will help you understand the relationships and common uses for the modules that
are listed alphabetically in the modeler. Therefore, we encourage you to explore the module groupings in the menu as
well. In addition, some modules cannot be used in the modeler (e.g, REGRESS) and others (e.g, CROSSTAB) have
additional capabilitics when run from the menu,

The remaining exercises in this section concentrate on the role of GIS in decision support, particularly regarding suitabil-
ity mapping,

Answers to the Questions in the Text

1. The values in MOISTAVAIL are the result of dividing NRAIN by EVAPQ. If a value is greater than 1, the NRAIN
value was larger than the EVAPQ value. This would indicate a positive moisture balance. If a value is less than 1, the
NRAIN value was smaller than the EVAPQ value. This would indicate a negative moisture balance.

2. Only 5 zones (1-5) are in the image because the range of values is only 0.36 - 1.02 in MOISTAVALL.

3. We can't use OVERLAY in this situation because we want each unique combination of zones to have a unique value in
the output image. With OVERLAY, the combination of temperature zone 2 and moisture zone 4 would give the same
result as moisture zone 2 and temperature zone 4.

4. Look at the legend of AGROZONES and determine which classes represent the desired combinations of zones. Use
Edit to create a values file to assign those original zone values to the new value 1. Then use ASSIGN with AGRO-
ZONES as the feature definition file and the values file created.

Another method is t use Edit/ASSIGN or RECLASS with the zone maps, TEMPERZONES and MOISTZONES,
creating Boolean images representing only those zones suitable for pyrethrum. These two Boolean images could then be
multiplied with OVERLAY to produce the final result.
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This problem fits well into a MCE scenario. The goal is to explore potential suitable areas for residential development for
the town of Westborough: areas that best meet the needs of all groups involved. The town administrators are collaborat-
ing with bath devclopers and environmentalists and together they have identified several criteria that will assist in the
decision making process. This is the first step in the MCE process, identifying and developing criteria.

Original Data and Criteria Development

In order to determine which lands to consider for development, the town administration has identified three sets of crite-
ria: town regulations that limit where development can occur, financial considerations important to developers, and wild-
life considerations important to environmentalists. In this problem all criteria will be expressed as raster images.

Criteria are of two types, constraints and factors. Constraints are those Boolean criteria that constrain (i.e., limit) our anal-
ysis 0 particular geographic regions. No matter which method is eventually used to aggregate criteria, constraints are
always Boolean images. In this case, the constraints differentiate areas that we can consider suitable for residential devel-
opment from those that cannot be considered suitable under any conditions.

In contrast, factors are criteria that define some degree of suitability for all geographic repions. They define areas or alter-
natives in terms of a continuous measure of suitability. Individual factor scores may either enhance (with high scores) or
detract from (with low scores) the overall suitability of an alternative. (The degree to which this happens depends upon
the aggregation method used.) Factors can be standardized in a number of ways depending upon the individual criteria
and the form of aggregation eventually used.

In our example, we have two constraints and six factors that will be developed. We will now turn our attention to the
development of these criteria.

Note: Many of the tools needed to develop the initial criteria layers of this exercise were presented in carlier exercises. To
move more quickly to the new concepts of these exerdises, the initial criteria layers are provided. The data used to derive
these initial images in this section are included in the compressed supplemental file called MCESUPPLEMENTAL.ZIP.
If desired, you can uncompress and use these files to practice the initial stages of criteria development. The methods
needed were introduced in Exercises 2-2 through 2-5.

Constraints

The town's building regulations are constraints that limit the areas available for development. Let's assume new develop-
ment cannot occur within 50 meters of open water bodies, streams, and wetlands.

c) Display the image MCEWATER with the Qualitative palette.

To create this image, information about open water bodies, streams, and wetlands was brought into the database. The
open water data was extracted from the landuse map, MCELANDUSE. The streams data came from a USGS DLG file
that was imported then rasterized, The wetlands data used here were developed from classification of a SPOT satellite
image. These three layers were combined to produce the resultant map of all water bodies, MCEWATER.*’

4 Display the image WATERCON with the Qualitative palette.
This is a Boolean image of the 50 m buffer zone of protected areas around the features in MCEWATER. Arcas that

should not be considered are given the value 0 while those that should be considered are given the value 1. When the con-
straints are multiplied with the suitability map, areas that are constrained are masked out (i.c., set to 0), while those that are

47. The wethinds data is in the image MCEWETLAND in MCESUPPLEMENTALLZIP. The sitcams data is the vector file MCESTREEAMS we used
catlict in this exercise.
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not constrained retain their suitability scores.

In addition to the legal constraint developed above, new residential development will be constmined by current landuse;
new development cannot occur on already developed land.

c) Look at MCELANDUSE again. (You can quickly bring any image to focus by choosing it from the Window List
menu.) Clearly some of these categodes will be unavailable for residential development. Areas that are already
developed, water badies, and large transportation corridors cannot be considered suitable to any degree.

f) Display LANDCON, a Boolean image produced from MCELANDUSE such that areas that are suitable have a
value of 1 and areas that are unsuitable for residential development have a value of 0.4%

Now we will turn our attention to the continuous factor maps. Of the following six factors, the first four are relevant 1o
building costs while the latter two concern wildlife habitat preservation.

Factors

Having determined the constraining criteria, the more challenging process for the administrators was to identify the crite-
ria that would determine the relative suitability of the remaining areas. These criteria do not absolutely constrain develop-
ment, but are factors that enhance or detract from the relative suitability of an area for residential development.

For developers, these criteria are factors that determine the cost of building new houses and the attractiveness of those
houses to purchasers. The feasibility of new residential development is determined by factors such as current landuse
type, distance from roads, slopes, and distance from the town center. The cost of new development will be lowest on land
that is inexpensive to clear for housing, near to roads, and on low slopes. In addition, building costs might be offset by
higher house values closer to the town center, an area attractive to new home buyers.

The first factor, that relating the current landuse 1o the cost of clearing land, is essentially already developed in the
MCELANDUSE image. All that remains is to transform the landuse category values into suitability scores. This will be
addressed in the next section.

The second factor, distance from roads, is represented with the image ROADDIST. This is an image of simple linear dis-
tance from all roads in the study area. This image was derived by rasterizing and using the module DISTANCE with the
vector file of roads for Westborough.

The image TOWNDIST, the third factor, is a cost distance surface that can be used to calculate travel time from the town
center. It was derived from two vector files, the roads vector file and a vector file outlining the town center.

The final factor related to developers' financial concerns is slope. The image SLOPES was derived from an elevation
model of Westlmmugh.“

2 Examine the images ROADDIST, TOWNDIST, and SLOPES using the IDRISI standard palette. Display
MCELANDUSE with the Qualitative palette.

1 W bat are the values units for each of these continuous factors? Are they comparable?
2. Can categorical data (such as landuse) be thought of in terms of continuous suitability? How?

While the factors above are important to developers, there are other factors to be considered, namely those important to

48. MCELANDUSE categores 14 are considered suitable and atcgurics 3-13 are constrained.

49. MCEROAD, a vector file of rads; MCECENTER, a veetor file showing the town center; and MCEELLY, an image of elevation, can all be found
in the compressed file MCESUPPLEMENTAL. The cost-distance calculation used the cost grow aption and a friction surface where roads had a value
of 1 and off-riad arcas had a value of 3.
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environmentalists,

Environmentalists are concerned about groundwater contamination from septic systems and other residential non-point
source pollution. Although we do not have data for groundwater, we can use open water, wetlands, and streams as surro-
gates (i.c., the image MCEWATER). Distance from these features has been calculated and can be found in the image
WATERDIST. Note that a buffer zone of 50 meters around the same features was considered an absolute constraint
above. This does not preclude also using distance from these features as a factor in an attempt by environmentalists to
locate new development even further from such sensitive areas (i.¢., development MUST be at least 50 meters from water,
but the further the better).

The last factor to be considered is distance from already-developed areas. Environmentalists would like to see new resi-
dential development near currently-developed land. ‘This would maximize open land in the town and retain areas that are
good for wildlife distant from any development. Distance from developed areas, DEVELOPDIST, was created from the
original induse image.

h) Examine the images WATERDIST and DEVELOPDIST using the IDRISI standard palette,
3. What are the values units for cach of these continsious factors? Are they comparable with each other?

We now have the eight images that represent criteria to be standardized and aggregated using a variety of MCE
approaches. The Boolean approach is presented in this exercise while the following two exercises address other
approaches. Regardless of the approach used, the objective is to create a final image of suitability for residential develop-

ment.

The Boolean Approach

The first method that will be used to solve this MCE problem is the familiar Boolean approach. All eriteria (constraints
and factors) will be standardized to Boolean values (0 and 1) and the method of aggregation will be Boolean intersection
(multiplication of criteria). This is the most common GIS method of multiple criteria evaluation and it has been used
extensively in previous exercises (e.g, 2-2 and 2-3). While this technique is common, we shall see that Boolean standard-
ization and aggregation scverely limit analysis and constrain resultant land allocation choices. Subsequent exercises will
explore other approaches.

Boolean Standardization of Factors

While it is clearly appropriate that constraints be expressed in Boolean terms, it is not always clear how continuous data
(e.g., slopes) can be effectively reduced to Boolean values. However, the logic of Boolean aggregation demands all eriteria
(constraints and factors) be standardized to the same Boolean scale of 0 or 1. All of the continuous factors developed
above must be reduced 10 Boolean constraints as in previous cxercises. For each factor, a "crisp” or "hard” decision as to
what defines suitable areas for development must be made. The following are the decision rules for each factor.

Landuse Factor

Of the four landuse types available for development, forested and open undeveloped lands are the least expensive and will
be considered equally suitable by developers, while all other land will be considered completely unsuitable. Note that this
factor, expressed as 2 Boolean constraint, will make redundant the landuse constraint developed earlier. In later exercises,
this will not be the case.

i) Display a Boolean image called LANDBOOL. It was created from the landuse map MCELANDUSE using the
RECLASS module. In LANDBOOL image suitable areas have a value of 1 and unsuitable areas have a value of
0.
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Distance from Roads Factor

To keep costs of development down, areas closer to roads are considered more suitable than those that are distant. How-
ever, for a Boolean analysis we need to reclassify our continuous image of distance from roads to a Boolean expression of
distances that are suitable and distances that are not suitable. We will reclassify our image of distance from roads such that
areas less than 400 meters from any road are suitable and those equal to or beyond 400 meters are not suitable.

0} Display a Boolean image called ROADBOOL. it was created using RECLASS with the continuous distance
image, ROADDIST. In this image, areas within 400 meters of a road have a value of 1 and those beyond 400
meters have a value of 0.

Distance to Town Center Factor

Homes built close to the town center will yield higher revenue for developers. Distance from the town center is a function
of trave] time on area roads (or potential access roads) which was calculated using a cost distance function. Since develop-
ers are most interested in those areas that are within 10 minutes driving time of the town center, we have approximated
that this is equivalent to 400 grid cell equivalents (GCEs) in the cost distance image. We reclassified the cost distance sur-
face such that any location is suitable if it is less than 10 minutes or 400 GCEs of the town center. Those 400 GCEs or
beyond are not suitable.

k) Display a Boolean image called TOWNBOOL. 1t was created from the cost distance image TOWNDIST. in
the new image, a value of 1 is given to areas within 10 minutes of the town center.

Slope Factor

Because relatively low slopes make housing and road construction less expensive, we reclassified our slope image so that
thase areas with a slope less than 15% are considered suitable and those equal to or greater than 15% are considered
unsuitable.

)] Display a Boolean image called SLOPEBQOOL. 1t was created from the slope image, SLOPES.

Distance from Water Factor

Because local groundwater is at risk from septic system pollution and runoff, environmentalists have pointed out that
areas further from water bodies and wetlands are more suitable than those that are nearby. Although these areas are
already protected by a 50 meter buffer, environmentalists would like to see this extended another 50 meters. In this case,
suitable arcas will have to be at least 100 meters from any water body or wetland.

m) Display a Boolean image called WATERBOOL. 1t was created from the distance image called WATERDIST.
In the Boolean image suitable areas have a value of 1.

Distance from Developed Land Factor

Finally, areas less than 300 meters from developed land are considered best for new development by environmentalists
intcrested in preserving open space.

n) Display a Boolean image called DEVELOPBOOL. It was created from DEVELOPDIST by assigning a value
of | to areas less than 300 meters from developed land.

Boolean Aggregation of Factors and Constraints

Now that all of our factors have been transformed into Boalean images (i.e., reduced to constraints), we arc ready
aggregate them. In the most typical Boolean aggregation procedure, all eight images are multiplied together to produce a
single image of suitability. This procedure is equivalent to a logical AND operation and can be accomplished in several
ways in ldrisi, (e.g., using the Decision Making Wizard, the MCE module, a series of OVERLAY multiply operations, or
Image Calculator with a logical expression multiplying all the images).
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In assessing the results of an MCE analysis, it is very helpful to compare the resultant image to the original criteria images.
This is most easily accomplished by identifying the images as parts of a collection, then using the Feature Properties query
0] from the toolbar in any one of them.

0) Open the Display Launcher dialog box and invoke the pick list. You should see the file name MCEBOOL-
GROUP in the list with a small plus sign next to it. This is an image group file that has already been crcated
using Collection Editor. Click on the plus sign to sce a list of the files that are in the group. Choose MCEBOOL
and press OK. Note that the file name shown in the Display Launcher input box is MCEBOOLGROUPMCE-
BOOL. Choose the Qualitative palctte and click OK to display MCEBOOL.?®

P Use the feature properties query tool (from its toalbar icon or Composer button) and explore the MCEBOOL-
GROUP collection. Click on the image to check the values in the final image and in the eight ctiterion images.
The feature properties display may be repositioned by dragging,

4. What must be true of all criterion images for MCEBOOL fo bave a value 17 Is there any indication in MCE-
BOOL of bow many criteria ere met in any other case?

5. For those areas with the value 1, is there any indication which were better than others in terms of distance from roads,
ete.? If miore suitable land bas been identified than is required, bow nould one now choose between the aliernatives of suit-
able areas for development?

Assessing the Boolean Approach

Tradeoff and Risk

It should have been clear that 2 value of 1 in the final suitability image is only possible where all eight criteria also have a
value of 1, and a value of O is the result if even one criterion has a value of 0. In this case, suinability in one criteria cannot
compensate for a lack of suitability in any other. In other words, they do not frade off In addition, because the Boolean
Multicriteria analysis is a logical AND (minimum) operation, in terms of risk, it is very conservative. Only by exactly mect-
ing all criteria is a location considered suitable. The result is the best location possible for residential development and no
less suitable locations are identified.

These properties of no tradeoff and risk aversion may be appropriate for many projects. However, in our case, we can
imagine that our criteria should compensate for each other. We are not just interested in extreme risk aversion. For exam-
ple, a location far from the town center (not suitable when considering this one criteria) might be an excellent location in
all other respects. Even though it may not be the most suitable locaton, we may want to consider it suitable to some

degree.

On the other end of the risk continuum is the Boolean OR (maximum) aggregation method. Whereas the Boolean AND
require all criteria to be met for an area to be called suitable, the Boolean OR requires that at least one criteria be met. This
is clearly quite risky because for any suitable area, all but one criteria could be unacceptable.

Q Display the BOOLOR image using the Qualitative palette, It was created using the logical OR operation in
Image Calculator. You can see that almost the entire image is mapped as suitable when the Boolean OR aggrepa-
tion is used.

6. Deseribe BOOLOR. Can you think of a way to use the Boolean factors to create a suitability image that lies somenbere
between the extremes of AND and OR in terms of risk?

50. The interactive toals for collections {collection linked zoom and feature properties query) are only available when the image(s) have been displayed
as members of the collection, with the full dot logic name. If you displyy MCEBOOL without its collection reference, it will not he recognized as o
collection member.
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The exercises that follow will use other standardization and aggregation procedures that will allow us to alter the level of
both tradeoff and risk. The results will be images of continuous suitability rather than strict Boolean images of absolute
suitability or non-suitability.

Criterion Importance

Another limitaton of the simple Boolean approach we used here is that all factors have equal importance in the final suit-
ability map. This is not likely to be the case. Some criteria may be very important to determining the overall suitability for
an area while others may be of only marginal importance. This limitation can be overcome by weighting the factors and
aggregating them with a weighted linear average or WLC. The weights assigned govern the degree to which a factor can
compensate for another factor. While this could be done with the Boolean images we produced, we will leave the explora-
tion of the WLC method for the next exercise.

Spatial Contiguity and Site Size

The Boolean multicriteria result shows all locations that are suitable given the criteria developed above. However, it
should be clear that suitable areas are not always contiguous and are often scattered in a fragmented pattern. For prob-
lems such as residential development site selection, suitable but small sites are not appropriate. This problem of contiguity
can be addressed by adding a post-aggregation constraint such as "suitable areas must also be at least 20 hectares size."
This constraint would be applied after all suitable locations (of any size) are found. For more information on post-aggre-
gation constraints for site selection, please refer to exercise 2-10.

Do not delete any images used or created in this exercise. They will be used in the following exercises.

Answers to the Questions in the Text

1. Use Metadata to access the documentation file for the images and look at the Value Units fields. ROADDIST values
are in meters. TOWNDIST values are in units of cost-distance called Grid Cell Equivalents (GCE). SLOPES values arc in
percent. They are not directly comparable, i.e., we don't know how a value of 10 meters from the road compares with a
value of 4 degrees slope.

2. The categorical landuse image does not represent a spatially continuous variable. However, the relative suitability of
each landuse type for the objective being considered could be considered to be continuous, ranging from no suitability to
perfectly suitable. Each landuse type in the study area could be located on this suitability continuum.

3. Both are in meters, so in terms of distance they are comparable with each other. However, they may not be any more
comparable in terms of suitbility than the previous factors discussed. For example, 100 meters from water may represent
a very high suitability for that criteria while the same distance from developed areas might represent only marginal suit-
ability on that criteria.

4. All criterion images must have the value 1 for MCEBOOL o have the value 1. In the group query, one can tell how
many criteria met or failed. The aggregate image itself (MCEBOOL), however, carries no information to distinguish
between pixels for which all criteria are unsuitable and those for which all but one criteria were suitable.

5. All the information about the degree of suitability within the Boolean suitable area is lost. Because of this, there is no
information to guide the choice of 2 final set of arcas from all the areas described as suitable. Further analysis would have
to be performed.

6. Almost the entire image is mapped as suitable when the Boalean OR aggregation is used. One might think of several
ways to achieve a solution between AND and OR. For example, it would be possible to require 4 criteria to be met. This
could be evaluated by adding all the Boolean images, then reclassifying to keep those areas with value 4 or higher. How-
ever, the hard and arbitrary nature of the Boolean standardization limits the flexibility and wutility of any approach using
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